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Get Started

Set up Sybase® Control Center.

About Sybase Control Center for Unwired Platform
Sybase Control Center provides a single comprehensive Web administration console to
configure and manage Sybase products and their components.

Sybase Control Center combines a modular architecture, a rich administrative console,
agents, common services, and tools for managing and controlling Sybase products. Unwired
Platform is one of many Sybase products that use Sybase Control Center as it's management
and administrative tool.

As part of an Unwired Platform installation, Sybase Control Center can be used in three ways:

• In a personal development environment, developers may act as administrators to set up a
personal testing environment. Development administrators use Sybase Control Center to
deploy and configure packages, register messaging devices, and so on. No other additional
configuration or administration may be required.

• In a distributed or shared development environment, administrators use Sybase Control
Center to set up an Unwired Server, manage packages, manage devices, configure mobile
workflow packages, as well as review server and domain logs, and monitoring-related
data.

• In a production environment, administrators use Sybase Control Center on a regular basis
to perform the same tasks described for a shared development environment. They also
configure the operation of Unwired Servers, and administer day-to-day activities of the
production environment. Administrators must also routinely monitor the overall health
and performance of the system, which may include clusters and domains.

Documentation Roadmap for Unwired Platform
Learn more about Sybase® Unwired Platform documentation.

See Documentation Roadmap in Fundamentals for document descriptions by user role.
Fundamentals is available on Production Documentation.

Check the Sybase Product Documentation Web site regularly for updates: access http://
sybooks.sybase.com/nav/summary.do?prod=1289, then navigate to the most current version.

Unwired Platform Administration by Node
The left navigation pane in the Sybase Control Center for Unwired Platform console displays
a tree of administrable features in the form of nodes, some of which can be expanded to reveal
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a more granular view of the cluster environment. These nodes let you manage and configure
the main components of Unwired Platform.

Clicking nodes allows you to administer the following features through Sybase Control
Center. However, be aware of the following dependencies:

• There are two administration roles. Users with the platform administration role have
access to all nodes. Users with the domain administrator role see only the "Domains"
nodes for their assigned domains.

• You must have the correct Unwired Platform version and license for these nodes to be
functional when they are visible. For example, Sybase Mobile Sales and Sybase Mobile
Workflow products may not have all the same functionality as Sybase Unwired Platform.

Node Purpose

Cluster View general cluster properties and access the server list for the cluster,
and Relay Server configurations on the cluster level.

Domains Add, delete, enable, and disable domains. Expand this node to manage the
security, package, role mappings, cache group, synchronization group,
subscription, and connection configurations for each domain.

Servers View the list of servers, their properties, and their statuses. Expand this
node to manage individual Unwired Servers, to configure properties and
logs, and to apply pending changes.

Applications Add, view, delete, and edit applications, application users, application
connections, and application connection template operations as part of
application activation .

Security Add, view, edit, and delete domain administrators. Add or delete a se-
curity configuration. Each security configuration contains one or more
security providers for authentication, authorization, and auditing. Once
configured, security configurations can be assigned to domains and then
mapped to one or more packages, depending on the requirements for
each.

Workflows Deploy and manage mobile workflow packages and configure the noti-
fication mailbox. Deployed mobile workflow packages are listed below
this node. Use the individual mobile workflow nodes to manage mobile
workflow package properties, matching rules, context variables, error
logs, application connections, and, optionally, queue items.

Monitoring Create and manage settings for monitoring replication synchronization,
messaging synchronization, device notification, data change notification,
queue, package, user, and cache activities.

Cluster Administration Overview
The goal of cluster administration is to ensure that clusters and servers work smoothly, and
scale over time. By default, the Unwired Platform is installed as a one-node cluster. The one-
node cluster is supported for Online Data Proxy and in development or test environments.
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Production deployments of Unwired Platform are likely to require multiple nodes. Cluster
administration is mostly a nonroutine administration task.

See Installation Guide for Runtime > System Deployment Overview.

Table 1. Cluster administration tasks

Task Frequency Accomplished by

Installing the cluster One-time installation per cluster Unwired Platform installer

Setting up relay servers One-time initial installation and con-
figuration; occasionally adding serv-
ers to the cluster

Manual installation; manual set-
up using configuration files.

Suspending and resuming
server nodes

On demand, as required Sybase Control Center

Setting cluster properties,
including cache database
settings, monitoring data-
base setup, and so on

Once, or as cluster changes require Manual configuration using
files and .BAT scripts.

Administering the runtime
databases

Routine to ensure that the database
server is monitored and backed up,
that there is sufficient space for Un-
wired Platform metadata and cached
data tables, and that performance is
within acceptable limits (perform-
ance tuning)

Established processes and com-
mand line utilities. Consult with
your database administrator. See
System Administration > Oper-
ation Maintenance.

Reviewing licensing infor-
mation, including total li-
censed devices and cur-
rently used licenses count

Occasional, or as device user regis-
tration and deregistration occurs

Sybase Control Center. See Sys-
tem Administration > Operation
Maintenance.

Server Administration Overview
The goal of server administration is to ensure that Unwired Server is running correctly and that
it is configured correctly for the environment in which it is installed (development or
production). Server administration is mostly a one-time or infrequent administration task.

Table 2. Server administration tasks

Task Frequency Accomplished by

Installing the server One-time installa-
tion per server

Unwired Platform installer.
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Task Frequency Accomplished by

Configuring the server to:

• Set the replication and messaging syn-
chronization ports, as well as commu-
nication ports for administration and
DCN

• Create security profiles for secure
communication

• Set up secure synchronization
• Configure replication and messaging

push notifications
• Tune server performance

Postinstallation con-
figuration with infre-
quent tuning as re-
quired

Sybase Control Center for Un-
wired Platform.

Manage the outbound enabler configura-
tion for Relay Server.

• Configure Relay Server properties
• Manage certificates
• View logs
• Configure proxy servers for outbound

enabler

Postinstallation Sybase Control Center for Un-
wired Platform.

Setting server log file settings and subsys-
tem log levels

Once, unless log data
requirements change

Sybase Control Center for Un-
wired Platform.

Application and User Management Overview
The goal of application management is to register an application to Unwired Server as an
entity, create an application template that specifies application connection details for a user,
and activate applications either manually or automatically.

Table 3. Application and user management tasks

Task Frequency Accomplish by using

Create new applications to register applica-
tion entities with Unwired Server. A default
application template is created automati-
cally. Modify and delete applications as
part of application life cycle.

As required Sybase Control Center for Un-
wired Platform with Applica-
tions node, and Applications
tab.

Create or modify application connection
templates to specify details for native,
workflow, and proxy application connec-
tions.

As required Sybase Control Center for Un-
wired Platform, with Applica-
tion node, and Application Con-
nection Templates tab.
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Task Frequency Accomplish by using

For applications that need to be registered
manually, register an application connec-
tion to associate an application connection
with a user. This is not necessary for appli-
cations that are registered automatically.

As required Sybase Control Center for Un-
wired Platform, with Applica-
tion node, and Application Con-
nections tab.

View activated users, once they have logged
in with the activation code. Users must ei-
ther supply the activation code manually, or
the device client supplies the activation
code automatically as coded.

As required Sybase Control Center for Un-
wired Platform with the Appli-
cation node, and Application
Users tab.

Create a new activation code for a user
whose code has expired.

As required Sybase Control Center for Un-
wired Platform, with Applica-
tion node, and Application Con-
nections tab.

Review registered application connections
and users, delete application connections to
free licenses, delete application connec-
tions to remove users from the system

As required Sybase Control Center for Un-
wired Platform with the Appli-
cations node.

Manage subscriptions As required Sybase Control Center for Un-
wired Platform with the Pack-
ages node.

Information and guidelines:

Note: Application connection is not used for native replication applications at this time.

• Two activation options are available for onboarding, which refers to the process of
activating an authentic device client, user, and application entity, as a combination, in
Unwired Server:
• Automatic activation – requires a user to present credentials to use the application on a

supported device client.
• Manual activation – requires the user to present the activation code upon log on to a

supported device client. The system administrator establishes an activation code when
registering the application connection for the user.

• Native messaging applications can only be activated manually.
• Application template are used for automatic activation. Therefore, when setting up the

application template for automatic registration, be sure to set up the security configuration,
domain, the application ID, and automatic registration enabled properties in application
settings. Those are used for automatic application registration.
When a client application connects to the server with its application ID and credentials,
and requests automatic registration, the application ID is used to look up a matching
template. If that template allows automatic registration (the Automatic Registration
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Enabled property is set to true),the security configuration in the template is used to validate
the credentials. Upon successful validation of those credentials, the user identity is
registered in the Unwired Server. The client application may also include the security
configuration as part of the username (user@securityconfiguration) and in that case, the
security configuration (in addition to application ID) is used to look up a matching
template. If no or multiple templates are detected, the registration request fails.

• Supported device client activation options:

Device Client Type Automatic Registration Manual Registration

Workflow messaging X X

Native messaging X

Online Data Proxy X X

MBO Package Management Overview
The goal of mobile business object (MBO) package management is to make MBOs available
to device users. MBO package management typically requires a one-time deployment and
configuration, except for ongoing subscription management for messaging and Data
Orchestration Engine connector (DOE-C) packages.

Packages contain MBOs that are deployed to Unwired Server to facilitate access to back-end
data and transactions from mobile devices. Package types include UNIFIED packages, and
SAP® DOE-C packages.

A package, along with its current settings for cache groups, role mappings, synchronization
groups, connections, and security configuration, can be exported to an archive and imported
back into Sybase Control Center for backup or to facilitate a transition from a test environment
to a production environment.

Table 4. MBO package management tasks

Task Package
type

Frequency Accomplish by using

Deploy packages to a develop-
ment or production Unwired
Server

UNIFIED Once, unless
a new version
becomes
available

Sybase Control Center for Un-
wired Platform with the domain-
level Packages node

Control user access by assign-
ing security configurations for
each package, and mapping
roles if fine-grained authoriza-
tion is enforced through logical
roles

UNIFIED Once, unless
security re-
quirements of
the package
change

Sybase Control Center for Un-
wired Platform with the domain-
level Packages node
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Task Package
type

Frequency Accomplish by using

Set up the package cache inter-
val and cache refresh schedule
(for getting data updated on the
Unwired Server from the data
source)

UNIFIED Once, unless
data refreshes
need to be
tuned

Sybase Control Center for Un-
wired Platform with the domain-
level Packages node

Manage subscriptions (UNI-
FIED, and DOE-C), synchroni-
zation groups (UNIFIED), and
device notifications (UNI-
FIED) to customize how upda-
ted data in the cache is deliv-
ered to the device user

Varies Periodic, as
required

Sybase Control Center for Un-
wired Platform with the domain-
level Packages node

Export or import an MBO
package

UNIFIED On-demand,
as required

Sybase Control Center for Un-
wired Platform with the domain-
level Packages node

Review current/historical/per-
formance metrics

All Routine Sybase Control Center for Un-
wired Platform with the Monitor
node (available only to adminis-
trators)

Security Administration Overview
Perform security administration tasks to establish rules for the protection of enterprise and
administrative data and transactions.

Unwired Server coordinates data between enterprise information server (EIS) data sources
and device clients, meaning that transferred information is often proprietary, confidential, or
private. Therefore, the data and communication streams that carry information from Unwired
Server to other components in the Unwired Platform must be protected.

Unwired Platform has several security layers that protect data and transactions.
Administrators manage system and application authentication and authorization security
configurations at the cluster level, and perform role mapping at the domain and package levels.
By default, the 'admin' security configuration is used to authenticate and authorize all
administrative users, including domain administrators. All domain administrator logins must
be valid in the security repository configured for the 'admin' security configuration.

Platform administrators register domain administrators at the cluster level, and then assign
them to a domain from the domain-level Security Configurations tab. Security configurations
are assigned when domains are created, or subsequently, from the Domains node. Packages
must also be mapped to a security configuration at deployment; role mapping can be
configured at a later time.
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Sybase Control Center for Sybase Unwired Platform 7



Roles are used for MBOs and operations during development to indicate authorization
requirements. These roles are enforced by Unwired Server. At deployment or after
deployment, these logical roles can be mapped to physical roles to restrict which users have
access to MBOs and operations. Roles assigned at the MBO level are separate from operation-
level roles. However, package-level role mapping overrides domain-level role mapping. If the
same package is deployed to multiple domains and associated with the same security
configuration, then the domain-level role mapping is shared.

System Monitoring Overview
The goal of monitoring is to provide a record of activities and performance statistics for
various elements of the application. Monitoring is an ongoing administration task.

Use monitoring information to identify errors in the system and resolve them appropriately.
This data can also be shared by platform and domain administrators by exporting and saving
the data to a .CSV or .XML file.

The platform administrator uses Sybase Control Center to monitor various aspects of Unwired
Platform. Monitoring information includes current activity, historical activity, and general
performance during a specified time period. You can monitor these components:

• Security log
• Replication-based synchronization
• Messaging-based synchronization
• System queue status
• Data change notifications
• Device notifications (replication)
• Package statistics
• Device users
• Cache activity

To enable monitoring, platform administrators must set up a monitoring database, configure a
monitoring data source or create a new one, and set up monitoring database flush and purge
options. By default the installer created a monitoring database, however you can use another
one if you choose.

To control monitoring, platform administrators create monitoring profiles and configurations,
which define the targets (domains and packages) to monitor for a configured length of time. A
default monitoring profile is created for you by the installer. Monitoring data can be deleted by
the platform administrator as needed.

Get Started
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Table 5. System monitoring tasks

Task Frequency Accomplished by

Create and enable monitor-
ing profiles

One-time initial configuration with
infrequent tuning as required

Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Enable domain logging One-time setup with infrequent con-
figuration changes, usually as issues
arise

Sybase Control Center for Un-
wired Platform with the Do-
mains > <DomainName> >
Log node.

Review current/historical/
performance metrics

Routine Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Identify performance is-
sues

Active Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Monitor application and
user activity to check for
irregularities

Active Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Troubleshoot irregularities Infrequent Reviewing various platform
logs

Purge or export data On demand Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Mobile Workflow Package Administration Overview
The goal of mobile workflow package management is to make mobile workflows available
from the Unwired Server to device users. Mobile workflow package management typically
requires a one-time deployment and configuration, except for ongoing package maintenance.

The mobile workflow application is a simple business process application that delivers
functionality, such as sending requests and approvals through an e-mail application, to mobile
device clients on supported device platforms, including Windows Mobile, iOS.

Table 6. Mobile workflow package management

Task Frequency Accomplish by using

Deploy mobile workflow
packages

Once, unless a new version becomes
available

Sybase Control Center for Un-
wired Platform with the Work-
flow node
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Task Frequency Accomplish by using

Mobile workflow configu-
ration that includes e-mail
matching rules and context
variables

Once Sybase Control Center for Un-
wired Platform with the Work-
flow node

Device registration and
user assignments to mobile
workflow packages

Routine when new users or new de-
vices are added

Sybase Control Center for Un-
wired Platform with the Work-
flow > <WorkflowName> node

Monitor users and errors Routine Sybase Control Center for Un-
wired Platform with the Monitor
node

Starting and Stopping Sybase Control Center in Unwired
Platform

Sybase Unified Agent is used to start and stop Sybase Control Center.

There are two ways to start and stop the Sybase Control Center in an Unwired Platform
environment.

• By default, SybaseControlCenterX.X is installed to run as a Windows service, and is set by
the installer to start automatically.

• You can also use a command-line script as required.

• Start or stop from the Windows Control Panel; change automatic start and restart:

a) Open the Windows Control Panel.
b) Select Administrative Tools > Services.
c) Locate SybaseControlCenterX.X. If the service is running, the status column displays

“Started.”
d) To start or stop the service, right-click the service and choose Start or Stop.
e) Double-click the service.
f) To set the service to automatically start when the system starts, change the Startup

type to Automatic.
g) To restart the service in case of failover, choose the Recovery tab and change the First,

Second, and Subsequent failures to Restart Service.
Click Apply to save the modifications before closing the dialog.

• Manually starting Sybase Control Center by command-line script:

a) Enter the start command:

<UnwiredPlatform_InstallDir>\SCC-X_X\bin\scc.bat

• Manually stopping Sybase Control Center by command-line script:

Get Started
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a) Enter the stop command:

<UnwiredPlatform_InstallDir>\SCC-X_X\bin\scc.bat -stop

Note: You can use scc.bat -stop only to stop an SCC that was manually started with
"scc.bat"; it cannot stop the SCC windows service.

Cleaning Up the Flash Player Cache
Sybase recommends you clean up the Flash Player cache, after upgrading to the latest version
of Sybase Control Center. This is needed if you have used a previous version of Sybase
Unwired Platform on the same machine. This cleanup is only required once.

1. Navigate to C:\Documents and Settings\username\Application Data
\Macromedia\Flash Player\#SharedObjects .

2. Delete all files under this folder.

Note: Alternatively, go to the following link from a browser: http://www.macromedia.com/
support/documentation/en/flashplayer/help/settings_manager07.html. Use the Website
Storage settings panel to change storage capacity, or delete Websites to clean up the cache.

Getting Started with Production Clusters
Get started using Sybase Control Center in large production deployments of Unwired
Platform. These types of environments require additional set up steps before Unwired
Platform administration features can be accessed.

Getting Started After Installing
Perform postinstallation testing and configuration.

Prerequisites
Start Sybase Control Center.

Task

1. Install Adobe Flash Player 10.1 or later in the Web browser you will use to connect to
Sybase Control Center.

Flash Player is a free plug-in. You can download the latest version from http://
get.adobe.com/flashplayer/.

If Flash Player is already installed but you are not sure which version you have, go to the
Adobe test site at http://adobe.com/shockwave/welcome. Click the link that says Test
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your Adobe Flash Player installation. The version information box on the next page that
appears displays your Flash Player version.

2. To connect to Sybase Control Center, direct your browser to:

https://<scc_server_hostname>:8283/scc

Note: If you changed the default HTTPS port during installation, use the new port number
instead of 8283.

3. If you see an error about the security certificate, add Sybase Control Center to your
browser’s trusted sites zone (Internet Explorer) or add a security exception (Firefox).

4. Log in. Use the login account (supAdmin) and password that you set up during installation.
This account can be used for both SCC login, and SUP login.

5. Learn about Sybase Control Center. To open the help system, click ? in the upper-right
corner of the screen, or select Help > Online Documentation.

Setting Up Browser Certificates for Sybase Control Center Connections
To avoid security exceptions when launching Sybase Control Center, set up security
certificates correctly.

This task is required when:

• The browser session starts from a host computer that is remote from the Sybase Control
Center installation.

• The browser session starts on the same computer as Sybase Control Center and reports a
Certificate Error. The installer automatically sets up a local security certificate, but the
certificate installed for https in the web container keystore is a self-signed root certificate,
which is not recognized b the client browser.

• The host computer does not have Visual Studio Certificate Manager SDK installed.

Alternatively, follow browser-specific instructions to accept the certificate into the Windows
certificate store.

1. Change the default shortcut to use the full host name of the computer on which Sybase
Control Center has been installed.

The host name is required because the default self-signed generated certificate the installer
issues cannot be assigned to “localhost.”

For example, change the shortcut URL to something similar to:
"%ProgramFiles%\Internet Explorer\iexplore.exe" https://
SCChost.mydomain.com:8283/scc

2. Add the certificate to the Windows certificates store.

a) Extract the self-signed certificate:
<UnwiredPlatform_InstallDir>\JDKX.X.X_XX\bin\keytool.exe -
exportcert -alias jetty 
-keystore <UnwiredPlatform_InstallDir>\SCC-X_X\services
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\EmbeddedWebContainer\container\Jetty-X.X.XX\keystore -file 
cert.crt

b) Click Start > Run, type mmc, and then click OK to import the cert.crt file into the
host computer’s Windows store with the Windows Certificate Manager. The default
password for both the keystore and the alias is "changeit".

Logging Into Sybase Control Center With Installer Defined Password
The person acting as Platform administrator logs into Sybase Control Center for the first time
after all Unwired Platform components are installed. During installation, an administrator
user and password was defined. The Platform administrator must use these values to log into
Sybase Control Center.

This password is not intended to be a permanent authentication solution. The login is
authenticated by a PreconfiguredUser login module, which is enabled by default upon
installation of the Platform. Later in this task flow you will be replacing this module with an
LDAP authentication module used by both Unwired Platform and Sybase Control Center
components.

1. Launch Sybase Control Center.

2. Enter the installer-defined name and password.

3. Click Login.

Setting Up Administrator Authentication for Security
Configure login authentication and map roles to allow administrators to access Sybase
Control Center but identify them with an Unwired Platform role.

For first time logins, you can log into Sybase Control Center and the Unwired Platform
administration console with the password entered during Unwired Platform authentication.
For subsequent logins, you should configure authentication and RBAC (role base access
control) according to your enterprise security policy. For information, see Enabling
Authentication and RBAC for Administrators in the Security guide.

Configuring Memory Usage
(Optional) Determine whether you need to configure how much memory Sybase Control
Center uses, and if so which configuration method to use.

It is not usually necessary to configure memory usage for Sybase Control Center. This table
lists memory options you can set and circumstances under which you should consider
changing them.
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Modify this value When Guidelines

Maximum memory

• jvmopt=-Xmx – if

you are running SCC as
a Windows service

• SCC_MEM_MAX – if
you are starting SCC
from the command line

• You need to prevent Sybase Con-
trol Center from using more than a
given amount of memory

• SCC fails to start and may display
an error: Could not cre-
ate the Java Virtual
machine.

• An OutOfMemory error says
SCC is out of heap space

• A warning message about system
memory appears during the start
process

• The machine where SCC is instal-
led has less than 2GB of memory.
(Starting SCC on a machine with
less than 2GB of memory triggers
the startup warning message
about system memory.)

On machines with less than 2GB of
memory, set maximum memory to
256MB or more.

Default value: none. (On machines
with 2GB or more of memory, maxi-
mum memory is set dynamically and
is effectively limited only by the
amount of system memory available.)

Permanent memory

• jvmopt=-
XX:MaxPerm-
Size – if you are run-

ning SCC as a Win-
dows service

• SCC_MEM_PERM –
if you are starting SCC
from the command line

An OutOfMemory error says SCC is
out of permanent generation space

Increase by 32MB increments. If you
reach a value equal to twice the de-
fault and still see the OutOfMemory
error, contact Sybase technical sup-
port.

Default value: 128MB

You can change memory options in two ways:

• For Sybase Control Center started from the command line – execute commands to set one
or more environment variables before executing the scc command to start Sybase Control
Center. When you use this method, your changes to the memory options last only as long as
the current login session. This method is useful for testing new option values.

• For the Sybase Control Center service – modify a file used by the SCC service. When you
use this method, your changes to the memory options persist—Sybase Control Center uses
them every time it starts as a service.
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Changing a Memory Option on the Command Line
Before you start Sybase Control Center from the command line, you can issue a command to
change the value of a memory option temporarily.

Changes made using this method last only as long as the current login session. This method is
useful for testing new option values.

1. If Sybase Control Center is running, shut it down.

2. Set the environment variable. Specify a size in megabytes but do not indicate the units in
the command.
> set SCC_MEM_MAX=512

3. Use the scc command to start Sybase Control Center.

Changing a Memory Option for an SCC Windows Service
Add a jvmopt command to the scc.properties file to change a memory option (-Xmx or
-XX:MaxPermSize) for a Sybase Control Center Windows service.

When you use this method to set memory options, your changes are permanent—Sybase
Control Center uses them every time it starts as a service.

1. If Sybase Control Center is running, shut it down.

2. Open the SCC properties file:

<SCC-install-directory>\SCC-3_2\bin\scc.properties

3. Add (or modify, if it already exists) a jvmopt line specifying the memory size in Java
format. Use m for megabytes or g for gigabytes.

For example:
jvmopt=-Xmx512m

4. Save the file and start the Sybase Control Center Windows service.

Configuring the Automatic Logout Timer
(Optional) Set Sybase Control Center to end login sessions when users are inactive for too
long.

Prerequisites
Launch Sybase Control Center and log in using an account with administrative privileges.
(The login account or its group must have sccAdminRole.)

Task

1. From the menu bar, select Application > Administration.

2. Select General Settings.
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3. Click the Auto-Logout tab.

4. Enter the number of minutes after which an idle user will be automatically logged out.

Enter 0 or leave the box empty to disable automatic logout.

5. Click OK (to apply the change and close the properties dialog) or Apply (to apply the
change and leave the dialog open).

Manually Opening the Unwired Platform Console
If the Unwired Platform administration console does not appear automatically, you may need
to manually open it in Sybase Control Center (SCC). Once open, you can then use the Unwired
Platform administration console to manage the Unwired Server enabled mobile environment.

Prerequisites
Before managing a cluster, ensure that the login has SCC administration privileges.

Task

1. In the SCC menu, select View > Open > Resource Explorer.

2. From the list of resources, select the cluster you want to manage.

3. From the Resource Explorer menu bar, click Resources > Add.
The Unwired Server is added to the Perspective Resources window.

4. In the Perspective Resources window, mouse over the cluster you want to manage, click
the down arrow, and select Authenticate.

5. To authenticate against the cluster, select one of these:

• Use my current SCC login – SCC uses the administrator's initial SCC login
credentials to establish a connection to the Unwired Platform cluster. Use this option if
you have already mapped the SCC administrator role to the SUP administrator role.

• Specify different credentials – enter a new user name and password specifically for
logging in to this cluster. Use this option if SCC and Unwired Platform use different
authentication repositories. Using different credentials in this step is unnecessary if
SCC and Unwired Platform use the same security provider.

6. Click OK.

7. Mouse over the cluster you want to open, click the down arrow, and select Manage.

If you are successfully authenticated, the Unwired Platform console appears. If authentication
fails, see Sybase Control Center Issues in the Troubleshooting guide.

Registering a Resource as an SCC Managed Resource
Manually register a resource, such as a node or cluster, to administer it through Sybase Control
Center.

Manual registration is necessary if a cluster or node is not located within your network, and not
automatically detected and registered in the Sybase Control Center (SCC) Resource Explorer.
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1. In the SCC menu, select Resource > Register.

2. In the right administration pane of the Resource Registration dialog, enter the Resource
Name for the cluster you want to register.

3. Select the resource type of the cluster:

• Unwired Server Cluster – Select this resource type to use an Unwired Server
administration environment.

4. (Optional) Enter a description of the resource.

5. Click Next.

6. Enter the Host Name and Port Number of the primary server in the cluster.

Depending on the information you entered in the previous steps, one or both of these fields
may already be filled out.

7. (Optional) Indicate whether to add the resource to the perspective.

8. Click Finish.

Logging out of Sybase Control Center
Log out of a cluster when you finish your administration session.

In order to protect system security, Sybase recommends that you log out of Sybase Control
Center when you are not using the console.
Choose one of these methods:

• Click the Logout link at the top right corner of the console.
• From the Sybase Control Center menu, select Application > Logout.

Getting Started with Production Online Data Proxy
Get started using Sybase Control Center to manage light-weight applications, which use
proxy connections to back end data sources, in a production system.

Getting Started After Installing
Perform postinstallation testing and configuration.

Prerequisites
Start Sybase Control Center.

Task

1. Install Adobe Flash Player 10.1 or later in the Web browser you will use to connect to
Sybase Control Center.
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Flash Player is a free plug-in. You can download the latest version from http://
get.adobe.com/flashplayer/.

If Flash Player is already installed but you are not sure which version you have, go to the
Adobe test site at http://adobe.com/shockwave/welcome. Click the link that says Test
your Adobe Flash Player installation. The version information box on the next page that
appears displays your Flash Player version.

2. To connect to Sybase Control Center, direct your browser to:

https://<scc_server_hostname>:8283/scc

Note: If you changed the default HTTPS port during installation, use the new port number
instead of 8283.

3. If you see an error about the security certificate, add Sybase Control Center to your
browser’s trusted sites zone (Internet Explorer) or add a security exception (Firefox).

4. Log in. Use the login account (supAdmin) and password that you set up during installation.
This account can be used for both SCC login, and SUP login.

5. Learn about Sybase Control Center. To open the help system, click ? in the upper-right
corner of the screen, or select Help > Online Documentation.

Setting Up Browser Certificates for Sybase Control Center Connections
To avoid security exceptions when launching Sybase Control Center, set up security
certificates correctly.

This task is required when:

• The browser session starts from a host computer that is remote from the Sybase Control
Center installation.

• The browser session starts on the same computer as Sybase Control Center and reports a
Certificate Error. The installer automatically sets up a local security certificate, but the
certificate installed for https in the web container keystore is a self-signed root certificate,
which is not recognized b the client browser.

• The host computer does not have Visual Studio Certificate Manager SDK installed.

Alternatively, follow browser-specific instructions to accept the certificate into the Windows
certificate store.

1. Change the default shortcut to use the full host name of the computer on which Sybase
Control Center has been installed.

The host name is required because the default self-signed generated certificate the installer
issues cannot be assigned to “localhost.”

For example, change the shortcut URL to something similar to:
"%ProgramFiles%\Internet Explorer\iexplore.exe" https://
SCChost.mydomain.com:8283/scc

2. Add the certificate to the Windows certificates store.
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a) Extract the self-signed certificate:
<UnwiredPlatform_InstallDir>\JDKX.X.X_XX\bin\keytool.exe -
exportcert -alias jetty 
-keystore <UnwiredPlatform_InstallDir>\SCC-X_X\services
\EmbeddedWebContainer\container\Jetty-X.X.XX\keystore -file 
cert.crt

b) Click Start > Run, type mmc, and then click OK to import the cert.crt file into the
host computer’s Windows store with the Windows Certificate Manager. The default
password for both the keystore and the alias is "changeit".

Logging Into Sybase Control Center With Installer Defined Password
The person acting as Platform administrator logs into Sybase Control Center for the first time
after all Unwired Platform components are installed. During installation, an administrator
user and password was defined. The Platform administrator must use these values to log into
Sybase Control Center.

This password is not intended to be a permanent authentication solution. The login is
authenticated by a PreconfiguredUser login module, which is enabled by default upon
installation of the Platform. Later in this task flow you will be replacing this module with an
LDAP authentication module used by both Unwired Platform and Sybase Control Center
components.

1. Launch Sybase Control Center.

2. Enter the installer-defined name and password.

3. Click Login.

Setting Up Administrator Authentication for Security
Configure login authentication and map roles to allow administrators to access Sybase
Control Center but identify them with an Unwired Platform role.

For first time logins, you can log into Sybase Control Center and the Unwired Platform
administration console with the password entered during Unwired Platform authentication.
For subsequent logins, you should configure authentication and RBAC (role base access
control) according to your enterprise security policy. For information, see Enabling
Authentication and RBAC for Administrators in the Security guide.

Configuring Memory Usage
(Optional) Determine whether you need to configure how much memory Sybase Control
Center uses, and if so which configuration method to use.

It is not usually necessary to configure memory usage for Sybase Control Center. This table
lists memory options you can set and circumstances under which you should consider
changing them.

Get Started

Sybase Control Center for Sybase Unwired Platform 19



Modify this value When Guidelines

Maximum memory

• jvmopt=-Xmx – if

you are running SCC as
a Windows service

• SCC_MEM_MAX – if
you are starting SCC
from the command line

• You need to prevent Sybase Con-
trol Center from using more than a
given amount of memory

• SCC fails to start and may display
an error: Could not cre-
ate the Java Virtual
machine.

• An OutOfMemory error says
SCC is out of heap space

• A warning message about system
memory appears during the start
process

• The machine where SCC is instal-
led has less than 2GB of memory.
(Starting SCC on a machine with
less than 2GB of memory triggers
the startup warning message
about system memory.)

On machines with less than 2GB of
memory, set maximum memory to
256MB or more.

Default value: none. (On machines
with 2GB or more of memory, maxi-
mum memory is set dynamically and
is effectively limited only by the
amount of system memory available.)

Permanent memory

• jvmopt=-
XX:MaxPerm-
Size – if you are run-

ning SCC as a Win-
dows service

• SCC_MEM_PERM –
if you are starting SCC
from the command line

An OutOfMemory error says SCC is
out of permanent generation space

Increase by 32MB increments. If you
reach a value equal to twice the de-
fault and still see the OutOfMemory
error, contact Sybase technical sup-
port.

Default value: 128MB

You can change memory options in two ways:

• For Sybase Control Center started from the command line – execute commands to set one
or more environment variables before executing the scc command to start Sybase Control
Center. When you use this method, your changes to the memory options last only as long as
the current login session. This method is useful for testing new option values.

• For the Sybase Control Center service – modify a file used by the SCC service. When you
use this method, your changes to the memory options persist—Sybase Control Center uses
them every time it starts as a service.
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Changing a Memory Option on the Command Line
Before you start Sybase Control Center from the command line, you can issue a command to
change the value of a memory option temporarily.

Changes made using this method last only as long as the current login session. This method is
useful for testing new option values.

1. If Sybase Control Center is running, shut it down.

2. Set the environment variable. Specify a size in megabytes but do not indicate the units in
the command.
> set SCC_MEM_MAX=512

3. Use the scc command to start Sybase Control Center.

Changing a Memory Option for an SCC Windows Service
Add a jvmopt command to the scc.properties file to change a memory option (-Xmx or
-XX:MaxPermSize) for a Sybase Control Center Windows service.

When you use this method to set memory options, your changes are permanent—Sybase
Control Center uses them every time it starts as a service.

1. If Sybase Control Center is running, shut it down.

2. Open the SCC properties file:

<SCC-install-directory>\SCC-3_2\bin\scc.properties

3. Add (or modify, if it already exists) a jvmopt line specifying the memory size in Java
format. Use m for megabytes or g for gigabytes.

For example:
jvmopt=-Xmx512m

4. Save the file and start the Sybase Control Center Windows service.

Configuring the Automatic Logout Timer
(Optional) Set Sybase Control Center to end login sessions when users are inactive for too
long.

Prerequisites
Launch Sybase Control Center and log in using an account with administrative privileges.
(The login account or its group must have sccAdminRole.)

Task

1. From the menu bar, select Application > Administration.

2. Select General Settings.
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3. Click the Auto-Logout tab.

4. Enter the number of minutes after which an idle user will be automatically logged out.

Enter 0 or leave the box empty to disable automatic logout.

5. Click OK (to apply the change and close the properties dialog) or Apply (to apply the
change and leave the dialog open).

Manually Opening the Unwired Platform Console
If the Unwired Platform administration console does not appear automatically, you may need
to manually open it in Sybase Control Center (SCC). Once open, you can then use the Unwired
Platform administration console to manage the Unwired Server enabled mobile environment.

Prerequisites
Before managing a cluster, ensure that the login has SCC administration privileges.

Task

1. In the SCC menu, select View > Open > Resource Explorer.

2. From the list of resources, select the cluster you want to manage.

3. From the Resource Explorer menu bar, click Resources > Add.
The Unwired Server is added to the Perspective Resources window.

4. In the Perspective Resources window, mouse over the cluster you want to manage, click
the down arrow, and select Authenticate.

5. To authenticate against the cluster, select one of these:

• Use my current SCC login – SCC uses the administrator's initial SCC login
credentials to establish a connection to the Unwired Platform cluster. Use this option if
you have already mapped the SCC administrator role to the SUP administrator role.

• Specify different credentials – enter a new user name and password specifically for
logging in to this cluster. Use this option if SCC and Unwired Platform use different
authentication repositories. Using different credentials in this step is unnecessary if
SCC and Unwired Platform use the same security provider.

6. Click OK.

7. Mouse over the cluster you want to open, click the down arrow, and select Manage.

If you are successfully authenticated, the Unwired Platform console appears. If authentication
fails, see Sybase Control Center Issues in the Troubleshooting guide.

Logging out of Sybase Control Center
Log out of a cluster when you finish your administration session.

In order to protect system security, Sybase recommends that you log out of Sybase Control
Center when you are not using the console.
Choose one of these methods:
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• Click the Logout link at the top right corner of the console.
• From the Sybase Control Center menu, select Application > Logout.

Setting Up the Sybase Control Center Interface
Manipulate Sybase Control Center interface elements to set up the console according to your
requirements and preference.

User Interface Overview
This illustration labels important elements of the Sybase Control Center user interface so you
can identify them when they appear in other help topics.

Figure 1: Sybase Control Center User Interface

Toolbar Icons
Describes the icons in the Sybase Control Center toolbar for launching and managing views.

Table 7. Toolbar icons

Icon Name Description

Show/Hide Perspective Resources
View

Displays or minimizes the Perspective Resour-
ces view, which lists registered resources in this
perspective.

Launch Resource Explorer Opens the resource explorer, which lists reach-
able resources (both registered and unregis-
tered).
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Icon Name Description

Launch Heat Chart Opens the perspective heat chart, which gives a
status overview of the registered resources in
this perspective.

Close All Open Views Closes all open and minimized views.

Minimize All Views Minimizes all open views.

Restore All Minimized Views Returns all minimized views to their original
size.

Cascade All Open Views Arranges open views to overlap each other.

Tile All Open Views Vertically Arranges open views in a vertical manner.

Tile All Open Views Horizontally Arranges open views in a horizontal manner.

Sybase Control Center Functionality Not Applicable to Unwired Platform
Sybase Control Center is a standard management framework used by multiple products,
including Sybase Unwired Platform. Certain standard functions that appear in the user
interface cannot be used to administer Unwired Platform.

The following Sybase Control Center features can be disregarded in the context of Sybase
Unwired Platform:
• Alerts
• Schedules
• Heat charts
• Historical performance monitoring
• Logging
These features either do not apply to Sybase Unwired Platform or are redundant due to custom
functionality implemented in place of standard functions. The inapplicable Sybase Control
Center functionality cannot be removed, as it may be required by other Sybase product servers
also using Sybase Control Center.

Accessibility Features
This document is available in an HTML version that is specialized for accessibility. You can
navigate the HTML with an adaptive technology such as a screen reader, or view it with a
screen enlarger.

The Sybase CEP Option R4 documentation complies with U.S. government Section 508
Accessibility requirements. Documents that comply with Section 508 generally also meet
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non-U.S. accessibility guidelines, such as the World Wide Web Consortium (W3C) guidelines
for Web sites.

For information about accessibility support in the Sybase IQ plug-in for Sybase Central™, see
“Using accessibility features” in Chapter 1, “Introducing Sybase IQ” in Introduction to
Sybase IQ. The online help for Sybase IQ, which you can navigate using a screen reader, also
describes accessibility features, including Sybase Central keyboard shortcuts.

Note: You might need to configure your accessibility tool for optimal use. Some screen
readers pronounce text based on its case; for example, they pronounce ALL UPPERCASE
TEXT as initials, and MixedCase Text as words. You might find it helpful to configure your
tool to announce syntax conventions. Consult the documentation for your tool.

For information about how Sybase supports accessibility, see Sybase Accessibility at
http://www.sybase.com/accessibility. The Sybase Accessibility site includes
links to information on Section 508 and W3C standards.

Sybase Control Center Accessibility Information
Sybase Control Center uses the Adobe Flex application.

For the most current information about Adobe Flex keyboard shortcuts, see http://
livedocs.adobe.com/flex/3/html/help.html?content=accessible_5.html.

Note: To use Sybase Control Center with JAWS for Windows screen reading software
effectively, download and install the appropriate Adobe scripts. See www.adobe.com.

User Authorization
The authorization mechanism in Sybase Control Center employs login accounts and task-
based roles.

Access to Sybase Control Center is controlled by login accounts. You grant permissions to a
login account by assigning predefined roles that control tasks the user can perform in Sybase
Control Center, such as administration and monitoring of particular types of Sybase servers.
The roles can be assigned directly to login accounts or to groups; a login account inherits the
roles of any group to which it belongs. Component product modules assign some roles
automatically.

Sybase Control Center classifies roles as follows:

• System roles – define how a user can interact with Sybase Control Center.
• Product roles – define how a user can interact with a particular managed resource in Sybase

Control Center, for example the Replication Server named RepBoston01.

Note: The tools described here are for managing SCC-enabled login accounts; you cannot use
them to manage accounts and groups that are native to your managed resource.
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Assigning a Role to a Login or a Group
Use the security configuration options to add one or more roles to a Sybase Control Center
login account or to a group. Roles enable users to perform tasks such as monitoring servers or
administering Sybase Control Center.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task. To assign a
monitoring role for a server, first register the server.

Task
Assign the sccAdminRole to any login account that will perform administrative tasks in
Sybase Control Center.

1. From the application menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Click Logins or Groups.

4. In the table, select the login account or group to which you want to assign a role.

5. Click the Roles tab.

6. In the Available roles for resource list, select the role, then click Add. For example, to
grant administrative privileges, add the SCC Service:sccAdminRole. To grant monitoring
privileges, add the MonitorRole for the desired server and server type.

Note: Sybase Control Center product modules assign certain roles automatically, so you
might not need to add a MonitorRole.

If a role appears in the Has following roles list, this account or group has already been
configured with that role.

7. Click OK.

Removing a Role from a Login or a Group
Use the security configuration options to remove one or more roles from a Sybase Control
Center login acount or from a group.

Prerequisites
You must have administrative privileges to perform this task.

Task

1. From the menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Click Logins or Groups.
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4. Select the login account or group from which you want to remove a role.

5. Click the Roles tab.

6. Select the role, then click Remove.

7. Click OK.

Adding a Group
Use the security configuration options to create a new group.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task
Groups can make roles easier to manage. Rather than assigning roles to individual users,
assign roles to groups and add users to the groups or remove them as needed.

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Select Groups.

4. Click Create Group.

5. Enter a group name and a description.

6. Click Finish.

Removing a Group
Use the security configuration options to remove a group.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Select Groups.

4. Select the group to remove.

5. Click Delete.

6. Click OK to confirm the deletion.
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Adding a Login Account to a Group
Use the security configuration options to add one or more login accounts to a group.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Click Groups.

4. Select the group to which you want to assign an account.

5. Click the Membership tab.

6. Select the account, then click Add.

7. Click OK.

Removing a Login Account from a Group
Use the security configuration options to remove one or more login accounts from a group.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties, expand the Security folder.

3. Select Groups.

4. Select the group from which to remove members.

5. Click the Membership tab.

6. Select the login, then click Remove.

7. Click OK.

Adding a Login Account to the System
Use the security configuration options to create a native login account in Sybase Control
Center.

Prerequisites

• You must have administrative privileges (sccAdminRole) to perform this task.

Get Started

28 Sybase Unwired Platform



• If you intend to use LDAP or the operating system to authenticate users, configure the
appropriate authentication module.

Task

Note: Sybase does not recommend that you create a native login account for every Sybase
Control Center user. It is more efficient to configure Sybase Control Center to authenticate
users through their user accounts in LDAP or the operating system.

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Select Logins.

4. Click Create Login.

5. Enter a login name and expiration for the new account. Expiration is optional.

6. Click Next.

7. Select Specify new user information.

8. Enter details about the user:

• Title
• First name*
• M.I. (middle initial)
• Last name*
• Suffix
• E-mail address*
• Phone
• Ext.
• Fax
• Mobile
• Supports text messaging (checkbox)

*You must fill in the First Name, Last Name, and E-mail Address fields.

9. Click Finish.

Next
Grant privileges to the new login account. You can grant privileges by assigning Sybase
Control Center roles directly to the login accounts, or by assigning the login accounts to
groups and mapping Sybase Control Center roles to the groups. The group approach is
generally more efficient.
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Removing a Login Account from the System
Use the security configuration options to delete a Sybase Control Center login account.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Select Logins.

4. Select the login to delete.

5. Click Delete.

6. Click OK to confirm the deletion.

Modifying a User Profile
Use the security configuration options to suspend a login account, impose an expiration date,
or modify the account’s user information.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu bar, select Application > Administration.

2. In the Sybase Control Center Properties dialog, expand the Security folder.

3. Select Logins.

4. Select the login account to modify.

5. Click the General tab.

6. To suspend this account, click Login disabled.

7. To set the date on which this account will stop working, click the calendar icon next to the
Expiration field and select a data.

8. Click Apply.

9. Click the User Info tab.

10. Edit the user information.

When this user configures e-mail alert subscriptions, Sybase Control Center automatically
populates the subscription dialog with the e-mail address you enter here.

11. Click Apply.
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Administrator Logins and Role Mappings
Administrators must log into Sybase Control Center and can optionally be authenticated by
the Sybase Control Center X.X service, in addition to Unwired Server. Administrators are
authorized by either component, depending on the login used, and which predefined logical
roles the login is mapped to. There are different logical roles used for Sybase Control Center
authentication, and Unwired Server Server authentication.

If you authenticate and authorize an administrator with Sybase Control Center X.X, you are
determining what actions the administrator can perform in Sybase Control Center (for
example, registering Unwired Server as a resource). Whereas, authenticating and authorizing
an administrator for the Unwired Server administration plugin determines what type of
administrator the user is, and the scope and scale of responsibilities available: Platform
administrator (mapped to the SUP Administrator role) or Domain administrator (mapped to
the SUP Domain Administrator role).

If you are authenticating with Sybase Control Center X.X, you must manually edit a role
mapping file. Follow Sybase-approved instructions for modifying this file, as certain Sybase
Control Center roles are not to be used in the Unwired Platform administration environment.
For information about how to modify the role mapping file used for Sybase Control Center
administrator authorization, as well as how to enable administrator authentication to Unwired
Server, see Enabling Authentication and RBAC for Administrators in the Security guide.

Perspectives
A perspective is a named container for a set of one or more managed resources. You can
customize perspectives to provide the information you need about your environment.

As the main workspaces in the Sybase Control Center window, perspectives let you organize
managed resources. You might assign resources to perspectives based on where the resources
are located (continents, states, or time zones, for example), what they are used for, which
group owns them, or which administrator manages them. Perspectives appear as tabs in the
main window.

Every perspective includes a Perspective Resources view, which lists the resources in that
perspective and provides high-level status and descriptive information. Use the View menu to
switch from detail view to icon view and back.

You can open additional views—the heat chart, statistics chart, or alert monitor, for example
—as needed to manage the perspective’s resources. The views in a perspective display
information only about resources in that perspective.

One resource can appear in many perspectives.

Creating a Perspective
Create a perspective in which you can add and manage resources.

1. From the application menu bar, select Perspective > Create.
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2. Enter a name for your perspective. The name can contain up to 255 characters.

3. Click OK.

Removing a Perspective
Delete a perspective window.

1. Select the perspective tab you want to delete.

2. In the main menu bar, select Perspective > Delete.
The selected perspective disappears. If there are other perspectives, Sybase Control Center
displays one.

Renaming a Perspective
Change the name of your perspective.

1. Select the perspective tab you want to rename.

2. From the main menu bar, select Perspective > Rename..

3. Enter the new name for your perspective.

4. Click OK.

Views
Use views to manage one or more resources within a perspective.

In Sybase Control Center, views are the windows you use to monitor and manage a
perspective’s resources. You can re-arrange, tile, cascade, minimize, maximize, and generally
control the display of the views in your persective.

Each perspective includes these views:

• Perspective Resources
• Administration Console
• Heat chart
• Alert monitor
• Component log viewer
• Views that exist for each managed resource. These vary by resource type, but typically

include the statistics chart, the properties view, and a monitoring view.

Managing a View
Open, close, minimize, maximize, or restore a view in the current perspective.

You can:
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Task Action

Open a view Do one of the following:

• In the Perspective Resources view, click a resource, pull down its
menu using the handle to the right of the resource name, and select the
view to open.

• In the application menu bar, select View > Open and choose a view.

Close a view Select the view to close. In the application menu bar, select View > Close.
You can also click the X in the view’s upper right corner.

Maximize a view Click the box in the view’s upper right corner. The view enlarges to fill the
entire perspective window. Click the box again to return the view to its
former size.

Minimize a view Click the _ in the view’s upper right corner. The view shrinks to a small
tab at the bottom of the perspective window.

Minimize all views In the application menu bar, select View > Minimize All Views.

Restore a view Click the box on the minimized tab to maximize the view. Click the box
again to return the view to its former (smaller) size so you can see other
views at the same time.

Bring a view to the front In the application menu bar, select View > Select and choose the view you
want from the submenu.

Arranging View Layout in a Perspective
Use the view layout options to manage your perspective space.

Click one of these icons from the Sybase Control Center toolbar:

• Cascade all open views
• Tile all open views vertically
• Tile all open views horizontally

In a cascade, views overlap; in tiling arrangements, they do not.

Alternatively, you can arrange view layouts from the Sybase Control Center menu bar. From
the menu bar, select Perspective > Arrange and select your view layout.

Repository
The Sybase Control Center embedded repository stores information related to managed
resources, as well as user preference data, operational data, and statistics.

You can back up the repository database on demand, schedule automatic backups, restore the
repository from backups, and configure repository purging options. Full and incremental
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backups are available. A full backup copies the entire repository. An incremental backup
copies the transaction log, capturing any changes since the last full or incremental backup.

By default, Sybase Control Center saves backups as follows:

• Each full backup is stored in its own subdirectory in <SCC-install-directory>/
backup.

• Each incremental backup is stored in a file in <SCC-install-directory>/
backup/incremental.

Sybase recommends that you periodically move backup files to a secondary storage location
to prevent the installation directory from becoming too large.

Scheduling Backups of the Repository
Configure full and incremental backups of the repository to occur automatically.

Prerequisites
Determine your backup strategy, including when to perform full backups and incremental
backups. For example, you might schedule incremental backups every day and a full backup
every Saturday.

You must have administrative privileges (sccAdminRole) to perform this task.

Task

A full backup copies the entire repository. An incremental backup copies the transaction log,
capturing any changes since the last full or incremental backup.

1. From the main menu, select Application > Administration.

2. In the left pane, select Repository.

3. Click the Full Backup tab.

4. (Optional) To change the directory in which backups will be stored, click Browse and
navigate to the desired directory.

5. Select Schedule a Regular Backup.

6. Specify the day you want scheduled backups to begin. Enter a Start date or click the
calendar and select a date.

7. (Optional) Use the Time and AM/PM controls to specify the time at which backups occur.

8. Specify how often backups occur by setting the Repeat interval and selecting hours, days,
or weeks.

9. (Optional) To purge the repository after each backup, select Run a repository purge after
the backup completes.

10. If you include purging in the backup schedule, go to the Size Management tab and
unselect Automatically purge the repository periodically to disable automatic purging.
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11. Click Apply to save the schedule.

12. Click the Incremental Backup tab and repeat the steps above to schedule incremental
backups to occur between full backups.

Next
Set purging options on the Size Management tab.

Modifying the Backup Schedule
Suspend or resume repository backups or change the backup schedule.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu, select Application > Administration.

2. In the left pane, select Repository.

3. Choose the type of backup to modify:

• Click the Full Backup tab, or
• Click the Incremental Backup tab.

4. (Optional) To suspend or resume the backup schedule, select or unselect Schedule a
Regular Backup.
When you unselect (uncheck) this option, the scheduling area is grayed out and scheduled
backups no longer occur. However, the schedule is preserved and you can reinstate it at any
time.

5. To change the backup schedule, edit the Start date, Time, Repeat interval, or units. You
can also select or unselect Run a repository purge after the backup completes.

6. Click Apply to save the schedule.

Forcing an Immediate Backup
Perform an unscheduled full or incremental backup of the repository.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

1. From the main menu, select Application > Administration.

2. In the left pane, select Repository.

3. Choose the type of backup to run:
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• Click the Full Backup tab, or
• Click the Incremental Backup tab.

4. Click Back up Now.

Sybase Control Center saves the backup to the directory shown in the Location field.

Restoring the Repository from Backups
Load backup files into the repository database to revert undesirable changes or to recover from
a catastrophic failure.

If you configured Sybase Control Center to store backups somewhere other than the default
location, change the source directory in the copy commands in this procedure.

1. Shut down Sybase Control Center.

2. Copy the most recent full backup from <SCC-install-directory>/backup/
<generated_directory_name> to <SCC-install-directory>/
services/Repository. For example:

Windows:
copy C:\sybase\SCC-3_2\backup\repository.
270110161105\scc_repository.db 
C:\sybase\SCC-3_2\services\Repository

3. If you have no incremental backups to load,

a) Also copy the log file from <SCC-install-directory>/backup/
<generated_directory_name> to <SCC-install-directory>/
services/Repository. For example:

Windows:
copy C:\sybase\SCC-3_2\backup\repository.
270110161105\scc_repository.log 
C:\sybase\SCC-3_2\services\Repository

b) Skip to step 5 on page 36.

4. Start the repository database using the -ad option, which directs it to load transaction logs
(incremental backups) from the incremental directory. (The database loads full
backups automatically.) For example:

Windows:
cd <SCC-install-directory>\services\Repository

..\..\bin\sa\bin_<platform>\dbsrv11.exe scc_repository -ad 
<SCC-install-directory>\backup\incremental

The repository database loads the full backup and any subsequent incremental backups
present in the incremental directory. Incremental backups are loaded in date order.
After loading and saving, the database shuts down.

5. Start Sybase Control Center.
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If you loaded incremental backups, SCC starts normally (that is, no further recovery
occurs). If you copied a full backup to the Repository directory, the database recovers
the repository from the full backup.

Example: Loading incremental backups into the repository database

These commands start SQL Anywhere® on a 32-bit Windows machine:

% cd C:\sybase\SCC-3_2\services\Repository

% ..\..\bin\sa\bin_windows32\dbsrv11.exe scc_repository -ad  
C:\sybase\SCC-3_2\backup\incremental

Configuring Repository Purging
Change repository purging options.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task.

Task

As you decide how to purge your repository, consider that:

• Purging keeps the repository from absorbing too much disk space.
• By default, purging is enabled. It occurs once a day and purges data older than one day.
• Statistics and alert history can help you detect trends in server performance and user

behavior. The Sybase Control Center statistics chart can graph performance data over a
period of a year or more if the data is available. If you have enough disk space, consider
saving data for a longer period of time or disabling the purging of statistics or alert history.

• Changing the purge frequency and other options might affect Sybase Control Center
performance.

Note: If you configure purging as part of a scheduled backup of the repository, disable
automatic purging on the Size Management tab.

1. From the main menu bar, select Application > Administration.

2. Select Repository.

3. Click the Size Management tab.

4. To turn automatic purging on or off, click Automatically purge the repository
periodically.

Turn this option off if purging is configured as part of your scheduled full or incremental
backups.

5. Click purge options to turn them on or off:

• Purge statistics
• Purge alert history
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6. In Purge data older than, enter the number of days after which to purge repository data.

7. Click Apply, then OK.

Sybase Control Center Console
The console is a command-line interface for displaying details about the status of the Sybase
Control Center server and its subsystems.

When you use the scc command to start Sybase Control Center, it displays start-up messages
and then displays the console prompt.

Note: The console prompt does not appear if you start Sybase Control Center as a service, if
you direct the output of scc to a file, or if you start Sybase Control Center in the background.

Console Commands
Use the Sybase Control Center console to get status information on Sybase Control Center and
its ports, plug-ins, and services.

help Command
Display syntax information for one or more Sybase Control Center console commands.

Syntax
help [command_name] 

Parameters

• command_name – optional. status, info, or shutdown. If you omit command_name, help
returns information on all the console commands.

Examples

• Example 1 – returns information on the status command:

help status

Permissions

help permission defaults to all users. No permission is required to use it.

info Command
Display information about specified parts of the Sybase Control Center server.

If you enter info with no parameters, it returns information for every parameter.

Syntax
info [-a | --sys] 
[-D | --sysprop [system-property]] 
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[-e | --env [environment-variable]]
[-h | --help]
[-m | --mem]
[-p | --ports]
[-s | --services]

Parameters

• -a | --sys – optional. List all the services known to Sybase Control Center, indicate whether
each service is enabled, and list other services on which each service depends.

• -D | --sysprop [system-property] – optional. Display information about the specified Java
system property. Omit the system-property argument to return a list of all Java system
properties and their values.

• -e | --env [environment-variable] – optional. List all the environment variables in the
Sybase Control Center Java VM process environment. Omit the environment-variable
argument to return a list of environment variables and their values.

• -h | --help – optional. Display information about the info command.
• -m | --mem – optional. Display information about the server’s memory resources.
• -p | --ports – optional. List all the ports on which the Sybase Control Center agent and its

services listen, indicate whether each port is in use, and show the service running on each
port.

• -s | --services – optional. List all Sybase Control Center services, indicate whether each
service is enabled, and list other services on which each service depends.

Examples

• Example 1 – displays information about ports on this Sybase Control Center server:

info -p

Permissions

info permission defaults to all users. No permission is required to use it.

shutdown command
Stop the Sybase Control Center server if it is running.

Syntax
shutdown

Examples

• Example 1 – shuts down Sybase Control Center:

shutdown
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Permissions

shutdown permission defaults to all users. No permission is required to use it.

status Command
Display the status of the SCC agent, plug-in, or service components of Sybase Control Center.

Syntax
status [-a | --agent] 
[-h | --help] 
[-p | --plugin [plugin-name]] 
[-s | --service [service-name]]  
    

Parameters

• -a | --agent – display the status of the Sybase Control Center agent component.
• -h | --help – display information about the info command.
• -p | --plugin [plugin-name] – display the status of the specified Sybase Control Center

plug-in (for example, ASEMap, the Adaptive Server® management module). Omit the
plugin-name argument to return a list of plug-ins.

• -s | --service [service-name] – display the status of the specified Sybase Control Center
service (for example, the Alert service or the Messaging service). Omit the service-name
argument to return a list of services.

Examples

• Example 1 – displays status information on the Repository service:

status --service Repository

Permissions

status permission defaults to all users. No permission is required to use it.
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Administer

Use Sybase Control Center for Unwired Platform to administer and configure components of
a cluster registered as a managed resource. When you configure cluster components you are
setting up the elements required to mobilize your data. Once configured you perform ongoing
administration tasks to maintain the environment.

Clusters
As an organization grows, Unwired Platform administrators need to create a scalable IT
infrastructure using clusters. Clustering creates redundant Unwired Platform components on
your network to provide a highly scalable and available system architecture.

Organizations can seamlessly achieve high availability and scalability by adding more or
redundant instances of core components. Redundant instances of critical components provide
transparent failover.

In a production environment, the Unwired Platform deployment typically uses at least one
relay server. The connections to relay servers can be configured within a cluster instance from
Sybase Control Center.

Cluster-Affecting Configuration Changes
Before you configure Unwired Servers in a cluster, ensure you understand how changes are
synchronized to cluster members.

When you make a cluster-affecting change on the primary Unwired Server, those changes are
synchronized to all secondary servers in the cluster. This ensures that servers are configured
the same way and behave consistently within the cluster.

Cluster-affecting changes include:

• server configuration
• monitoring setup
• security configuration

Copying and Pasting Properties
Values displayed in property tables in Sybase Control Center can be copied and pasted.

Tables that support copying and pasting include monitoring properties, device properties, user
properties, registration templates, domain log properties, and sever log properties.
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1. To copy a value, right click the cell, then select Copy from the context menu.

2. To paste what you have copied, go to the property table you require, click the cell in
question, then select Paste from the context menu. You cannot paste in a table cell that is
read only, by you can copy a value from a table cell and paste it elsewhere (for example,
copy text input for a search).

Checking System Licensing Information
Review licensing information to monitor available and used device licenses, license expiry
dates, and other license details. This information allows administrators to manage license use
and determine whether old or unused device licenses should be transferred to new devices.

Unwired Platform licensing is configured during installation. However, if necessary, license
details can be changed at a later time. See Manually Updating and Upgrading License Files in
System Administration.

1. In the left navigation pane, select the top-level tree node.

2. In the right administration pane, select the General tab, and click Licensing.

3. Review the following licensing information:

• Server license type – the type of license currently used by Unwired Platform. For more
information on license types, see Platform Licenses in System Administration.

• Production edition – the edition of the software you have installed.
• Server license expiry date – the date and time at which the server license expires. When

a server license expires, Unwired Server generates a license expired error and Unwired
Server is stopped.

• Overdraft mode – allows you to generate additional licenses in excess of the quantity of
licenses you actually purchased. This enables you to exceed your purchased quantity
of licenses in a peak usage period without impacting your operation. This mode is
either enabled or disabled, as specified by the terms of the agreement presented when
you obtain such a license.

• Total device license count – the total number of device licenses available with your
license. This count limits how many devices can connect to your servers. See System
Administration for licensing information.

• Used device license count – the total number of licenses currently attached to devices.
If all of your available device licenses are in use, you can either upgrade your license or
manually delete unused devices to make room for new users. For workflow and Online
Data Proxy client devices, delete the Application Connections that are no longer in use.
For Native replication applications, delete Package Users on the respective Package.
For native messaging client applications, delete the Application Connections
associated with the native messaging clients not in use. See System Administration for
licensing information.
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• Device license expiry date – the date and time at which the device license expires.
When a device license expires, Unwired Server generates a license expired error and
connection requests from registered devices are unsuccessful.

• Used mobile user license count – the number of mobile user licenses currently in use.
Each such identity is registered with a specific security configuration. If a user is
registered with two different security configurations, even though the user may be the
same, it constitutes as two mobile users.

• Used application user license count – the number of application user licenses currently
in use. An application user may be registered as the user of one or more versions of a
device (using same application ID) from one or more devices.

4. Click Close.

Checking Cluster Status
Verify that a cluster is running.

In the left navigation pane, check the status (in brackets) beside the cluster name.

Relay Server
Relay Server acts as a reverse proxy for client devices communicating with the Unwired
Server cluster, and it provides load balancing for the Unwired Server cluster.

Relay Servers are deployed on the DMZ subnet. With a corresponding Outbound Enabler
(RSOE), Relay Server enables communication from the Unwired Server cluster to client
devices, via the Internet, without opening an inbound port on the internal firewall.

Each Unwired Server instance is supported by one or more RSOEs. Each RSOE opens
outbound connections to the Relay Server, to handle both inbound and outbound
communication channels, on behalf of the Unwired Server. Connections between the RSOE
and Relay Server use HTTPS protocol.

Relay Server also provides load balancing for the Unwired Server cluster by forwarding
requests from client devices to Unwired Servers in the cluster, by round-robin distribution.

Configuring a Relay Server
Choose a method of configuring a Relay Server. After you generate a Relay Server
configuration file, you can copy it to the Relay Server host, and quickly distribute the same
configuration to multiple Relay Server nodes, with minimal changes.

This task applies only to a locally installed Relay Server. It does not apply to the Sybase
Hosted Relay Service.

1. Create a Relay Server configuration.
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• Create a quick configuration to use default values for all but environment-specific
properties.

• Create a custom configuration to define all property values.

2. Generate a Relay Server configuration file.

3. Transfer the configuration file to all Relay Server hosts, making any required
modifications.

Creating a Quick Configuration
Create a Relay Server configuration primarily with system defaults, and create Outbound
Enabler (RSOE) processes for each Unwired Server.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Servers tab.

3. Click Quick Configure.

4. Specify these property values:

• Host – either the host name of the Relay Server, or the host name of the load balancer (if
any).

• Http port – the Relay Server HTTP port.
• Https port – the Relay Server HTTPS port.
• URL suffix – the URL suffix used by the RSOE to connect to a Relay Server.
• (Optional) Description – user-definable description of the Relay Server.

5. Check Advanced settings and specify these property values:

• Http user name – user name for RSOE authentication on the Web server (Relay Server
host).

• Http password – password for RSOE authentication on the Web server.

6. If your network uses an Internet proxy server, specify these property values:

• Proxy server host – host name of the Internet proxy server.
• Proxy server port – connection port on the Internet proxy server.
• Http proxy user – user name for RSOE authentication on the Internet proxy server.
• Http proxy password – password for RSOE authentication on the Internet proxy

server.

7. Click OK to generate a Relay Server configuration file, and the RSOE processes for each
Unwired Server.

Properties in the [backend_farm] and [backend_server] sections are populated
automatically, based on the Unwired Server's cluster name and host name. Tokens are
automatically generated.

Six RSOE instances (three each for messaging and replication ports) are created on each
Unwired Server host, but they not started.
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Next
Review the values in the Relay Server configuration file, and edit if necessary.

Creating a Custom Relay Server Configuration
Create a Relay Server configuration by specifying all configuration property values.

Launching the Relay Server Configuration Wizard
Launch the Relay Server Configuration wizard to create a configuration file with customized
property values.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Servers tab.

3. Click New.

Setting Relay Server General Properties
Set basic connection properties for the Relay Server.

Prerequisites
Launch the Relay Server configuration wizard.

Task

1. Specify these property values:

• Host – either the host name of the Relay Server, or the host name of the load balancer (if
any).

• Http port – the Relay Server HTTP port.
• Https port – the Relay Server HTTPS port.
• URL suffix – the URL suffix used by the RSOE to connect to a Relay Server.
• (Optional) Description – user-definable description of the Relay Server.

2. Check Configure relay server HTTP credentials and specify these property values:

• User name – user name for RSOE authentication on the Web server (Relay Server
host).

• Password – password for RSOE authentication on the Web server.

3. Click Next.

Define Server Farms and Cluster Nodes
Set connection properties for the Unwired Server cluster and its constituent nodes.

Repeat these steps to add or remove multiple Unwired Server clusters, as needed.

1. Define the Unwired Server cluster.

a) Specify these property values:
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• Farm ID – a string that identifies the Unwired Server cluster, for which the Relay
Server manages requests. This property is case-sensitive, and it must match the
value in the RSOE configuration.

• Type – the type of request managed by the Relay Server, Replication or Messaging
protocol.

• (Optional) Description – user-definable description of the Unwired Server
cluster.

b) Click +.
c) Repeat steps 1 and 2 to add multiple Unwired Server clusters.
d) To delete a configured Unwired Server cluster, select it in the list, then click the X

button.

2. Identify each Unwired Server instance in the cluster.

a) Select an existing Unwired Server cluster.
b) Specify these property values:

• Node ID – a string that identifies the Unwired Server in the cluster. This property is
case-sensitive, and it must match the value in the RSOE configuration.

• Token – the security token used by the RSOE to authenticate its connection with
the Relay Server. Each Unwired Server instance in the cluster can have a unique
token string (up to 2048 characters).

c) Click +.
d) Repeat steps 1 and 2 to add Unwired Server cluster nodes.
e) To delete a configured Unwired Server node, select it in the list and click X.

3. Click Next to review your settings, or click Finish to exit the wizard.

Reviewing Configured Relay Server Properties
Review the Relay Server configuration to confirm property values, before you generate the
configuration file.

1. Confirm the property values, ensuring that:

• No errors exist.
• All Unwired Server clusters are defined, and the correct type.

2. Click Finish.

The Relay Server is registered with Sybase Control Center, and it can be managed from the
Relay Servers tab for the Unwired Server cluster.

Next
When you have finished adding all required Relay Servers, set up one or more Outbound
Enabler (RSOE) for each Unwired Server in the cluster.
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Generating the Relay Server Outbound Enabler Configuration File
To quickly and easily replicate a common Outbound Enabler (RSOE) configuration to
multiple hosts, generate an RSOE configuration file.

Administrators can use Sybase Control Center to configure an initial RSOE for development.
Once a configuration proves valid and stable, the administrator can generate the RSOE
configuration file, then use regRelayServer.bat to apply it to Unwired Server hosts.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Servers tab.

3. Click Generate.

4. Choose Relay server outbound enabler configuration XML file, then click Next.

5. Select an output target for the file.

6. Click Finish.

Generating the Relay Server Configuration File
Generate all or part of a Relay Server configuration file. Then transfer the generated file to all
Relay Server hosts.

Generating a configuration file extracts the property values stored in the cluster database
during the configuration process, and writes them to a file.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Servers tab.

3. Click Generate.

4. Choose Relay server properties configuration file.

5. Select the parts of the file to generate:

• The entire file
• Either the server node definition area or the farm definition area

6. Select an output target for the file.

7. Click Finish.

Managing Configured Relay Servers
Relay Servers configured with Sybase Control Center are registered in the Unwired Server
cluster database. Administrators can view or edit configuration properties, and delete Relay
Servers in Sybase Control Center when they are displayed in the Relay Server tab.

Viewing or Editing Relay Server Properties
View or edit configuration properties for a selected Relay Server.
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Relaunching the Relay Server Configuration Wizard
Relaunch the Relay Server Configuration wizard to create a new Relay Server configuration
file, with customized property values.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Server tab.

3. Select a Relay Server.

4. Click Properties.

Setting Relay Server General Properties
Set basic connection properties for the Relay Server.

Prerequisites
Launch the Relay Server configuration wizard.

Task

1. Specify these property values:

• Host – either the host name of the Relay Server, or the host name of the load balancer (if
any).

• Http port – the Relay Server HTTP port.
• Https port – the Relay Server HTTPS port.
• URL suffix – the URL suffix used by the RSOE to connect to a Relay Server.
• (Optional) Description – user-definable description of the Relay Server.

2. Check Configure relay server HTTP credentials and specify these property values:

• User name – user name for RSOE authentication on the Web server (Relay Server
host).

• Password – password for RSOE authentication on the Web server.

3. Click Next.

Define Server Farms and Cluster Nodes
Set connection properties for the Unwired Server cluster and its constituent nodes.

Repeat these steps to add or remove multiple Unwired Server clusters, as needed.

1. Define the Unwired Server cluster.

a) Specify these property values:

• Farm ID – a string that identifies the Unwired Server cluster, for which the Relay
Server manages requests. This property is case-sensitive, and it must match the
value in the RSOE configuration.

Administer

48 Sybase Unwired Platform



• Type – the type of request managed by the Relay Server, Replication or Messaging
protocol.

• (Optional) Description – user-definable description of the Unwired Server
cluster.

b) Click +.
c) Repeat steps 1 and 2 to add multiple Unwired Server clusters.
d) To delete a configured Unwired Server cluster, select it in the list, then click the X

button.

2. Identify each Unwired Server instance in the cluster.

a) Select an existing Unwired Server cluster.
b) Specify these property values:

• Node ID – a string that identifies the Unwired Server in the cluster. This property is
case-sensitive, and it must match the value in the RSOE configuration.

• Token – the security token used by the RSOE to authenticate its connection with
the Relay Server. Each Unwired Server instance in the cluster can have a unique
token string (up to 2048 characters).

c) Click +.
d) Repeat steps 1 and 2 to add Unwired Server cluster nodes.
e) To delete a configured Unwired Server node, select it in the list and click X.

3. Click Next to review your settings, or click Finish to exit the wizard.

Reviewing Configured Relay Server Properties
Review the Relay Server configuration to confirm property values, before you generate the
configuration file.

1. Confirm the property values, ensuring that:

• No errors exist.
• All Unwired Server clusters are defined, and the correct type.

2. Click Finish.

The Relay Server is registered with Sybase Control Center, and it can be managed from the
Relay Servers tab for the Unwired Server cluster.

Next
When you have finished adding all required Relay Servers, set up one or more Outbound
Enabler (RSOE) for each Unwired Server in the cluster.
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Deleting a Relay Server Configuration
Delete a Relay Server configuration to remove all defined Unwired Server clusters, server
nodes, and RSOEs that connect to the Relay Server.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Server tab.

3. Select a Relay Server.

4. Click Delete.

Refreshing the Relay Server List
Refresh the Relay Server list to display current information about deployed and configured
Relay Servers.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Server tab.

3. Select a Relay Server.

4. Click Refresh.

Relay Server Tab Reference
Configuration property values that appear in the Relay Server tab for an Unwired Platform
cluster.

Column Description

Host either the host name of the Relay Server, or the host name of the
load balancer (if any).

Http port the Relay Server HTTP port.

Https port the Relay Server HTTPS port.

URL suffix the URL suffix used by the RSOE to connect to a Relay Server.

Unwired Server
The Unwired Platform runtime server is called Unwired Server. Unwired Server manages the
data exchange process between the enterprise and device clients to create a homogeneous
layer in a diverse mobile ecosystem. In a production environment, the Unwired Server must be
installed on a 64-bit host.

Unwired Server features include:

• Data services – supports connections to back-end data resources using these standard
technologies: enterprise databases with JDBC™ connections and Web Services (SOAP-
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style and REST-style) . Also supports connections to enterprise applications such as
SAP®.

• Data virtualization – introduces a layer called a mobile business object (MBO) between
your enterprise databases or applications, and the remote database on the device client.
Utilizes a cache database (CDB) to optimize device client access and minimize back-end
resource utilization.

• Device connection services – supports connections from various different platforms and
operating systems with different communication styles.
• Replication-based synchronization – A synchronization method where cached data is

downloaded to and uploaded from client database to server via replication. Typically,
mobile replication-based synchronization is used in occasionally connected scenarios.

• Messaging-based synchronization – In flight messages are queued in a messaging
cache. Synchronization occurs as messages are delivered to the device. Typically,
mobile messaging-based synchronization is used in always available and occasionally
disconnected scenarios.

Server List
Depending on the license you purchase and the type of environment you install, you may
deploy multiple Unwired Servers in a cluster.

If you have installed multiple servers as part of a clustered architecture, you must register these
servers first. Only servers that are installed on the same host as Sybase Control Center are
registered automatically. Once registered, remote servers also appear in the server list.

Servers are listed according to their cluster mode (that is, primary or secondary servers).
Sybase Control Center automatically identifies the primary server and lists it first, followed by
secondary servers.

Stopping and Starting a Server
Stop and start a server to perform maintenance or to apply changes to server settings. You can
perform this action as a two-step process (stop and start) or as a single restart process.

You can stop and start a server from Sybase Control Center for servers that are installed on the
same host as Sybase Control Center, as well as servers that are installed on different hosts.

Note: If someone manually shuts the server down, this action triggers multiple errors in
Sybase Control Center for Unwired Server until the console determines that the server is no
longer available. This takes approximately 30 seconds to detect. When this occurs you might
see multiple Runtime API throws exception errors logged. Wait for the server to
come online and log into the server again to resume your administration work.

Choose an appropriate process:

• To stop the server, click Stop. You can then perform the administration actions you require
that might require the server to be started. To then restart the server, click Start.
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• If you perform an administration action that requires a restart to take effect, click Restart.
This shuts the server down and restarts it in a single process.

As the server stops and starts, progress messages display in the Server Console pane.

Starting and Stopping RSOE
Start and stop an RSOE process as needed. All configured RSOEs are started by default when
the Unwired Server starts.

1. In the navigation pane, click Servers > ServerNode > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, select the RSOE instances,
and click Start or Stop.

Suspending and Resuming a Server
Suspend and resume a server to temporarily disallow clients to access the specific server for
routine maintenance. While the server is suspended, it remains running and available for all
administrative actions.

Prerequisites
Configure the Relay Server Outbound Enabler (RSOE) for Unwired Server in order to enable
the suspend and resume server functions.

Task
Choose an appropriate process:

• To suspend the server, click Suspend. Wait for about 1 minute, and click "refresh" button.
When the server status changes from suspend pending to suspended, you can
then perform the administration actions you required.

• To then resume the server, click Resume.

As the server suspends and resumes, progress messages display in the Server Console pane.

Pinging a Server
Ping a server to test the availability of backend server connectivity and verify the server state
(for example, started or stopped). By default ping uses whichever Internet Inter-ORB Protocol
call you configured (IIOPS by default) to test if a server's connection is available.

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select the General tab.

3. Click Ping.

The result displays in the console area.

Checking Unwired Server Status
Verify whether a server is running, stopped, or suspended.
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1. In the left navigation pane, select Servers.

2. In the right administration pane, select the General tab.

3. In the Status column, check the server status corresponding to the server you are
administering: running, stopped, suspended, suspend pending, or resume pending.

4. Use the controls in the administration console to start, stop, restart, suspend, or resume the
server, as required.

Server Properties
Server properties let administrators manage server configuration settings to ensure smooth
data exchange between the server and client. You can configure administration port,
replication, and messaging properties in the Server Configuration node of Sybase Control
Center.

Note: Properties you configure for an Unwired Server are cluster-affecting. Therefore, to
make sure they are propagated correctly, Sybase recommends that you set them only on a
primary cluster server.

General Server
Configure properties and security profiles for Unwired Server management and
communication ports. These ports process incoming replication synchronization,
administration, and data change notification requests. You must secure data transmission over
management and DCN communication ports by creating and assigning an SSL configuration
to the ports. You can also configure Unwired Server performance properties.

Configuring Security Profiles
Configure security profiles to secure communication between Unwired Server administration
and DCNs.

Prerequisites
Before creating a security profile, ensure that you possess digital certificates that have been
verified and signed by third-party trusted authorities, as well as import required certificates in
to the Unwired Server keystore.

Task

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.

3. In the right administration pane, select the General tab.

4. From the menu bar, select SSL Configuration.

5. Create a new Security Profile:

a) Name the security profile.
b) Enter the case sensitive certificate alias for the profile (defined in the server keystore).
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c) Select the Authentication option.

6. Click Save.

7. In the server restart dialog, click OK.

8. Restart the server for these changes to take effect.

Next
Use the profile to encrypt administration and DCN ports.

Management Ports
Management ports in Unwired Server process incoming administration connection requests
and manage these requests. Management ports use IIOPS by default, though IIOP can be
configured as well.

To configure the administration listener, you must know whether you want the communication
processes secured (using SSL) or unsecured. Secured (IIOPS) is enabled by default. If you
choose an unsecured administration process stream, simply reconfigure configure the port.

For information on complete setup tasks required to enable SSL in the server administration
environment, see Encrypting Synchronization with SSL for Replication in the Security guide.

Configuring SSL Properties
Configure SSL certificates and security profiles to facilitate Secure Sockets Layer (SSL)
encryption for communication ports in Unwired Platform.

Prerequisites
Ensure you have set up the server environment before you configure a security profile as part
of the server configuration. For more information, see Encrypting Synchronization with SSL
for Replication in the Security guide.

Task

Note: If you enable SSL for one node in a cluster, you must enable it for all other nodes, since
the secure connection is established at the cluster level. The port numbers for each node are not
dependent; that is, they can be identical or unique.

Task
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Defining Certificates for SSL Encryption
For the primary server, specify keystore and truststore certificates to be used for SSL
encryption of Unwired Platform communication ports. All security profiles use the same
keystore and truststore.

For secondary Unwired Servers, SSL properties are synchronized from the primary server.
Therefore for secondary servers, these properties are still visible, but cannot be edited.

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.

3. In the right administration pane, select the General tab.

4. From the menu bar, select SSL Configuration.

5. To configure SSL encryption for all security profiles, complete these fields:

• Keystore Location – the full path name indicating the location where the keys and
certificates are stored. Certificates used for administration and data change notification
ports are stored in the keystore. The path should be relative to <Unwired
Platform_InstallDir>\UnwiredPlatform-XX\Servers
\UnwiredServer.

• Keystore Password – the password that secures the key store.
• Truststore Location – the full path name for the public key certificate storage file. The

Certificate Authority (CA) certificates used to sign certificates store their public keys
in the truststore. The path should be relative to <Unwired
Platform_InstallDir>\UnwiredPlatform-XX\Servers
\UnwiredServer.

• Truststore Password – the password that secures the truststore.

6. Click Save.

Next
Create an SSL security profile that uses the selected certificates.

Creating an SSL Security Profile in Sybase Control Center
Security profiles define the security characteristics of a client/server session. Assign a security
profile to a listener, which is configured as a port that accepts client connection requests of
various protocols. Unwired Server uses multiple listeners. Clients that support the same
characteristics can communicate to Unwired Server via the same port defined in the listener.

Note: A security profile can be used by one or more servers in a cluster, but cannot used by
multiple clusters.

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.
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3. In the right administration pane, select the General tab.

4. From the menu bar, select SSL Configuration.

5. In the Configure security profile table:

a) Enter a name for the security profile.
b) Enter a certificate alias. This is the logical name for the certificate stored in the

keystore.
c) Select an authentication level:

If the security profile authenticates only the server, then only the server must provide a
certificate to be accepted or rejected by the client. If the security profile authenticates
both the client and the server, then the client is also required to authenticate using a
certificate; both the client and server will provide a digital certificate to be accepted or
rejected by the other.

Profile Authenticates Cipher suites

intl server • SA_EX-
PORT_WITH_RC4_40_MD5

• RSA_EX-
PORT_WITH_DES40_CBC_S
HA

intl_mutual client/server • RSA_EX-
PORT_WITH_RC4_40_MD5

• RSA_EX-
PORT_WITH_DES40_CBC_S
HA

strong server • RSA_WITH_3DES_EDE_CBC
_SHA

• RSA_WITH_RC4_128_MD5
• RSA_WITH_RC4_128_SHA

strong_mutual client/server

For example, this is
the required option
for mutual authenti-
cation of Unwired
Platform and Gate-
way.

• RSA_WITH_3DES_EDE_CBC
_SHA

• RSA_WITH_RC4_128_MD5
• RSA_WITH_RC4_128_SHA

Administer

56 Sybase Unwired Platform



Profile Authenticates Cipher suites

domestic server • RSA_WITH_3DES_EDE_CBC
_SHA

• RSA_WITH_RC4_128_MD5
• RSA_WITH_RC4_128_SHA
• RSA_WITH_DES_CBC_SHA
• RSA_EX-

PORT_WITH_RC4_40_MD5
• RSA_EX-

PORT_WITH_DES40_CBC_S
HA

• TLS_RSA_WITH_NULL_MD
5

• TLS_RSA_WITH_NULL_SHA

domestic_mutual client/server • RSA_WITH_3DES_EDE_CBC
_SHA

• RSA_WITH_RC4_128_MD5
• RSA_WITH_RC4_128_SHA
• RSA_WITH_DES_CBC_SHA
• RSA_EX-

PORT_WITH_RC4_40_MD5
• RSA_EX-

PORT_WITH_DES40_CBC_S
HA

• RSA_WITH_NULL_MD5
• RSA_WITH_NULL_SHA

6. Click Save.

7. From the Communication Ports menu, assign the security profile to the desired
management or communication ports.

Next
If you configure a secure port on one server, you must enable it on every node in the cluster,
then restart all servers in the cluster to commit the configuration changes.

Enabling OCSP
(Optional) Enable OCSP (Online Certificate Status Protocol) to determine the status of a
certificate used to authenticate a subject: current, expired, or unknown. OCSP configuration is
enabled as part of server level SSL configuration. OCSP checking must be enabled if you are
using the CertificateAuthenticationLoginModule and have set Enable revocation checking to
true.

Enable OCSP for an Unwired Server when configuring SSL.
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1. To enable OCSP when doing certificate revocation checking, check Enable OCSP.

2. Configure the responder properties (location and certificate information):

Responder Property Details

URL A URL to responder, including its port.

For example, https://ocsp.exam-
ple.net:80.

Certificate subject name The subject name of the responder's certificate.
By default, the certificate of the OCSP res-
ponder is that of the issuer of the certificate
being validated.

Its value is a string distinguished name (defined
in RFC 2253), which identifies a certificate in
the set of certificates supplied during cert path
validation.

If the subject name alone is not sufficient to
uniquely identify the certificate, the subject
value and serial number properties must be used
instead.

When the certificate subject name is set, the
certificate issuer name and certificate serial
number are ignored.

For example, CN=MyEnterprise,
O=XYZCorp.

Certificate issuer name The issuer name of the responder certificate.

For example, CN=OCSP Responder,
O=XYZCorp.

Certificate serial number The serial number of the responder certificate.

Replication
Replication synchronization involves synchronization between Unwired Server and a
replication-based mobile device application. Synchronization keeps multiple variations of the
data set used by a device application in coherence with one another by reconciling differences
in each. Reconciling differences before writing updates back to the enterprise information
server (EIS) maintains data integrity.

For replication synchronization, configure the corresponding port to receive incoming
synchronization requests from devices, as well as set up configuration to enable push
notification messages to the device when data changes in CDB. In a typical environment,
client applications running on devices will connect to the synchronization port via Relay
Server and Relay Server Outbound Enabler (RSOE). In those cases, the HTTP port will be
used.
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Configuring a Synchronization Listener
(Not applicable to Online Data Proxy)Configure the port to receive synchronization requests
from client devices. If you are using push synchronization, then also configure
synchronization listener properties.

Prerequisites
Determine whether you require an encrypted (secured) or unencrypted synchronization
stream. A secure synchronization stream uses SSL encryption; therefore, before setting up a
secure configuration, ensure that you possess digital certificates verified and signed by third-
party trusted authorities. The HTTPS protocol is slower than the HTTP protocol; use SSL only
if you require HTTPS. See Enabling SSL-Encrypted Synchronization in Unwired Server in
Security .

Task

1. In the left navigation pane, expand the Servers folder and select the server you want to
configure.

2. Select Server Configuration.

3. In the right administration pane, click the Replication tab.

4. If push synchronization is being added to the application, select  Listener from the menu
bar.

5. Select the protocol and port you require:

• If you do not require SSL encryption, choose Port. Sybase recommends this option if
you do not require a secure communication stream for synchronization. By default, the
port for HTTP is 2480.

• To encrypt the HTTP stream with SSL, choose Secure port. By default, the port for
HTTPS is 2481. The "Secure Sync Port" properties in the "Optional Properties" table
can be used to review and set the server identity and public certificate for the secure
synchronization port. See below.

6. Configure these properties:

• Synchronization Cache Size – sets the maximum cache size for the synchronization
port. The default is 50MB.

• Thread Count – sets the number of worker threads used for synchronization. The
default is 10. If you experience performance issues, you may need to increase this
value.

7. (Optional) Expand the optional properties section to configure these properties:

Note: You can only configure the encryption properties on the primary Unwired Server.
Secondary servers will inherit the values, where they become read-only.
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• E2E Encryption Certificate Password – set the password to unlock the encryption
certificate.

Note: Leave E2E Encryption values blank to disable end-to-end encryption.

• E2E Encryption Certificate – specify the file containing the private key that acts as the
identity file for Unwired Server.

• E2E Encryption Type – specify the asymmetric cipher used for key exchange for end-
to-end encryption. You can only use RSA encryption.

• Secure Sync Port Certificate – identifies the location of the security certificate used to
encrypt and decrypt data transferred using SSL.

• Secure Sync Port Certificate Password – is used to decrypt the private certificate listed
in certificate file. You specify this password when you create the server certificate.

• Secure Sync Port Public Certificate – specify the file containing the public key that acts
as the identity file for synchronization port.

• Trusted Relay Server Certificate – if relay server trusted certificate is configured,
identifies the public security certificate location.

• User Options – sets the command line options for starting the synchronization server.
These options are appended the next time the synchronization server starts. These are
the available user options:

Option Description

@ [variable | fil-
ePath]

Applies listener options from the specified environment var-
iable or text file.

-a <value> Specifies a single library option for a listening library.

-d <filePath> Specifies a listening library.

-e <deviceName> Specifies the device name.

-f <string> Specifies extra information about the device.

-gi <seconds> Specifies the IP tracker polling interval.

-i <seconds> Specifies the polling interval for SMTP connections.

-l <"keyword=val-
ue;...">

Defines and creates a message handler.

-m Turns on message logging.

-ni Disables IP tracking.

-ns Disables SMS listening.

-nu Disables UDP listening.
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Option Description

-o <filePath> Logs output to a file.

Note: Ensure that you enter the absolute file path for this
property.

-os <bytes> Specifies the maximum size of the log file.

-p Allows the device to shut down automatically when idle.

-pc [+ | -] Enables or disables persistent connections.

-r <filePath> Identifies a remote database involved in the responding ac-
tion of a message filter.

-sv <scriptVer-
sion>

Specifies a script version used for authentication.

-t [+ | -] <name> Registers or unregisters the remote ID for a remote database.

-u <userName> Specifies a synchronization server user name.

-v [0 | 1 | 2 | 3] Specifies the verbosity level for the messaging log.

-y <newPassword> Specifies a new synchronization server password.

Do not use the User Options property in Sybase Control Center to pass in these options:
-c, -lsc, -q, -w, -x, -zs.

For more information on synchronization server command line options, see MobiLink
Listener options for Windows devices  (http://infocenter.sybase.com/help/topic/
com.sybase.help.sqlanywhere.12.0.1/mlsisync/ms-listener-s-3217696.html) in the
SQL Anywhere® 12.0.1 online help.

8. Click Save.

Enabling Push and Pull Notifications
Configure push and pull for replication-based synchronization notifications.

Prerequisites
Determine the type of push synchronization gateway you require.

Task

This task sets the lightweight polling notification configuration for all clients. You can also
configure it individually for each device.

1. In the left navigation pane, expand the Servers folder and select the server to configure.
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2. Select Server Configuration.

3. In the right administration pane, click the Replication tab.

4. Select Notification Configuration from the menu bar.

5. To enable server-initiated push notification:

a) Select Enable Push-Based Notification.

Unselecting this option disables push synchronization and all related configuration
properties.

b) Enter a time interval in seconds, minutes, or hours to specify the frequency with which
the push notification table is polled. The default is 10 seconds.

6. To enable client-initiated push notification:

a) Select Enable Pull-Based Notification.

Unselecting this option disables pull synchronization and all related configuration
properties.

b) Enter a time interval in seconds, minutes, or hours to specify the frequency with which
the pull notification table is polled. The default is 10 seconds.

7. In the Notification Configuration menu, click Save.

Messaging
Messaging is a synchronization method used to maintain data integrity on device client
applications. It uses a JMS service to upload and download data changes to and from the
Unwired Server cache database. Messaging-based synchronization ports implement a
strongly encrypted HTTP-based protocol using a proprietary method.

Configure messaging in the Messaging tab of the Server Configuration node for the particular
server you are administering.

Configuring Messaging Synchronization Properties
(Not applicable to Online Data Proxy) Configure one or more synchronization ports to receive
service requests from devices.

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.

3. In the right administration pane, click the Messaging tab, and select  Listener.

4. Enter the synchronization port number. The default is 5001.

5. (Optional) Select Listen on multiple ports and enter the additional port numbers.

Depending on your environment, listening on multiple synchronization ports may provide
greater flexibility and reliability. High activity on particular ports, such as virus detection
and data inspection, may result in dropped packets or connections if alternate ports are
unavailable. When multiple ports are configured, all messaging traffic is still funneled to a
single listener.

6. Click Save.
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Configuring Apple Push Settings
Create a new Apple Push Notification Service (APNS) configuration that specifies the
application, security certificate, and ports that the service uses.

Apple push notifications alert offline iPhone users to the availability of new items awaiting
retrieval on Unwired Server. Push uses an IP connection only long enough for the Send/
Receive data exchange to complete. The feature overcomes network issues with always-on
connectivity and battery life consumption on 3G networks.

For more information on end-to-end iPhone application development and provisioning,
search for Apple Provisioning for iOS in System Administration.

Note: When configuring the Apple Push Notification Service, change the push gateway, push
gateway port, feedback gateway, and feedback gateway port values only when configuring
notifications in a development environment. To enable Apple push notifications, the firewall
must allow outbound connections to Apple push notification servers on default ports 2195 and
2196.

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.

3. In the Messaging tab, select Apple Push Configuration.

4. Click New.

5. Enter the Application name. This name corresponds to the Product Name specified in
Xcode.

6. Select one of:

• Use existing certificate – use a security certificate file that already exists on the server.
When you select this option, the list of available certificates appears in the Certificate
name menu.

• Use new certificate – create a new security certificate. When you select this option,
you must provide information to create a named security certificate file on the server.

7. If you selected Use existing certificate:

a) Select the desired certificate from the list.
b) Enter and confirm the certificate password.

8. If you selected Use new certificate:

a) Enter a name for the new certificate.
b) Specify a Base64-encoded string by choosing one of these:

• Browse from file – select a security certificate file on the server that contains the
Base64-encoded string.

• Base64-encoded string – manually enter the Base64-encoded string.
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c) If you selected a file from the server for the Base64-encoded string, you can overwrite
the existing certificate file with the details you specify during new certificate creation.
To do so, select the box adjacent to Overwrite existing certificate.

d) Enter and confirm the certificate password.

9. Click OK.

Configuring BlackBerry Push Settings
Create a new BlackBerry Push Service configuration that specifies the delivery method for the
service users.

BlackBerry push notifications alert offline users to the availability of new items awaiting
retrieval on Unwired Server. Push uses an IP connection only long enough for the Send/
Receive data exchange to complete. BlackBerry Push notifications overcome issues with
always-on connectivity and battery life consumption over wireless networks.

1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.

3. In the Messaging tab, select BlackBerry Push Configuration.

4. (Optional) Configure the BES response portioning value to fine tune the amount of HTTP
traffic the BES MDS server will accept from Unwired Server, in MB, KB and bytes.

By default, this setting is configured to 100 KB in Unwired Server, to accommodate older
BES servers. Newer BES servers are configured with a 1MB default. If you have a newer
BES server, you can improve performance by setting a higher value. You may need to
experiment to fine tune the correct value for your system configuration.

5. Select an existing BlackBerry push configuration, and click Properties to view its current
settings.

6. (Optional) create a new BlackBerry push configuration.

a) Click New.
b) Enter the Name of the configuration.
c) Enter the URL of the delivery service host. The URL is in the format: http://<DNS

or IP address>:<port number>. The default port is 8080.

d) (Optional) Enter a User name and Password required to access the URL. Confirm the
password.

e) BES (BlackBerry Enterprise Server) is selected by default.
f) (Optional) Click PAP to enable the Push Access Protocol (PAP), if you are using a Push

Proxy Gateway to deliver messages.
g) Click OK.

Configuring Unwired Server Performance Properties
To optimize Unwired Platform performance, configure the thread stack size, maximum and
minimum heap sizes, user options, and inbound and outbound messaging queue counts.
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1. In the left navigation pane, expand the Servers folder and select a server.

2. Select Server Configuration.

3. In the right administration pane, select the General tab.

4. From the menu bar, select Performance Configuration.

5. Configure these properties, as required:

• Host Name – the name of the machine where Unwired Server is running (read only).
• Thread Stack Size – the JVM -Xss option.
• Minimum Heap Size – the minimum size of the JVM memory allocation pool, in

megabytes. Sybase recommends that this value not fall 500 megabytes for a 32-bit
operating system, but 1 gigabyte is recommended. For a 64-bit operating system,
Sybase recommends 1 gigabyte for a normal configuration, but 2 gigabyte for a stress
configuration (which can vary depending on what RAM is available).

• Maximum Heap Size – the maximum size of the JVM memory allocation pool, in
megabytes. For a 32-bit operating system, Sybase recommends a 1.5 gigabyte
maximum heap size value. For a 64-bit operating system, Sybase recommends 1
gigabyte for a normal configuration, but 4 gigabyte for a stress configuration (which
can vary depending on what RAM is available).

Note: The synchronization differencing algorithms are a key feature of replication; this
technology runs in the JVM. You must provide adequate memory to these components. If
these algorithms are memory starved, the JVM spends an inordinate amount of time
garbage collecting memory, and synchronizations back up in the internal queues. You can
monitor process memory usage with tools like SysInternal’s Process Explorer to
determine the actual amount of memory in use by Unwired Platform, and adjust the JVM
heap size accordingly

Note: Always leave 4 gigabytes for the running of the OS and other applications that may
exist on the server.

6. (Optional) Expand the Show optional properties section and configure these properties,
as required:

• Maximum Number of In Memory Messages – specify the number of in-memory
messages to allow.

• User Options – other JVM options. For example, you can enable JVM garbage
collection logging by setting -XX:+PrintGCDetails. Or you can set the
permanent space which allocated outside of the Java heap with DJC_JVM_MAXPERM,
for example, DJC_JVM_MaxPerm = 512.

• Inbound Messaging Queue Count – the number of message queues used for incoming
messages from the messaging-based synchronization application to the server. Sybase
recommends a choose a value that represents at least 10% of active devices.

• Outbound Messaging Queue Count – the number of message queues used for
outbound messages from the server to the messaging-based synchronization
application. Sybase recommends a choose a value that represents at least 50% of active
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devices. However, if you are running 32-bit operating system, do not exceed a value of
100% of active devices.

• Subscribe Bulk Load Thread Pool Size – the maximum number of threads allocated to
initial bulk load subscription operations. The default value is five. Setting the thread
pool size too high can impact performance.

Note: If you increase either queue count property, ensure you also increase the MaxThread
property in the <hostname>_iiop1.properties file.

7. Click Save.

Saving and Refreshing an Unwired Server Configuration
Refreshing an Unwired Server configuration displays the latest effective configuration
information.

After successfully saving a server configuration, refresh the configuration to display the most
recent updates. To commit these changes to the server, restart the server before saving
subsequent updates. The refresh function must be used in conjunction with a server restart for
the displayed configuration to be applied.

If you refresh the configuration in between two sets of saved configuration changes without
injecting a server restart following the refresh, only the second set of changes are committed
and consequently displayed as the current set of properties used by Unwired Server.

Note: Follow the steps in exactly the order they appear. Otherwise, configuration changes will
be lost.

1. Reconfigure Unwired Server as required.

2. Click Save.

3. Click Refresh to display original values; the recent'y saved changes are not displayed.

4. Restart Unwired Server to commit those changes, using the method you prefer for server
restarts.

5. In the left navigation pane, expand the Servers folder and select a server.

6. Select Server Configuration.

7. In the right administration pane, select the appropriate tab and click Refresh.
Current server configuration properties committed with the restart action appear.

8. Make the next set of configuration changes, as required.

Reviewing Pending Changes
As you configure Unwired Server with Sybase Control Center, changes that require a server
restart are aggregated to the Pending Changes tab for the server name you are currently
administering.

Changes listed in this window require a server restart before they take effect.
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1. In the left pane, click the Unwired server you are currently logged into.

2. Click Pending Changes.

3. Review all listed changes that are pending.

4. If the changes are valid, click Restart to commit the changes.

5. A confirmation message to continue appears. Confirm that you want to restart the
server.

6. Review Unwired Server status messages on the General tab to ensure that the server has
restarted and changes have been committed successfully. If the update is successful, the
bolded text and asterisk (*) are also removed from the respective server name in the left
navigation pane.

Applying Multiple Unwired Server Configuration Changes
A server restart writes the changes made in Sybase Control Center to the appropriate Unwired
Server configuration file. To apply multiple server configuration changes with a single server
restart, you cannot make consecutive conflicting updates or refresh the configuration in
between saved changes.

Consider these important points when applying multiple changes to an Unwired Server
configuration:

• Failure to save a configuration change prior to restarting Unwired Server results in
configuration changes being lost.

• Failure to restart Unwired Server after saving a configuration change results in changes
being uncommitted; Unwired Server instead uses the values that currently exist in the
configuration file (that is, previous configuration properties and values).

• Cumulative saved changes are applied successfully upon server restart as long as these
updates do not conflict. Attempting to save two conflicting sets of changes fails. In this
case, inject a server restart in between each saved change to ensure that the required
updates are propagated across the server.

• Refreshing the server configuration displays the latest successfully saved configuration
information. If you click Refresh in between two sets of saved changes, only the most
recent saved updates are applied during a server restart.

When you must make multiple changes to the same component of the Unwired Server
configuration, follow this procedure:

Note: Follow the steps in exactly the order they appear. Do not use the Refresh function in
between saved changes. Otherwise, configuration changes will be lost.

1. Make the first set of configuration changes, as required.

2. Click Save.
A confirmation message appears in the administration console indicating the success or
failure of the save.

3. Make the second set of configuration changes, as required.
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4. Click Save.
A confirmation message appears in the administration console indicating the success or
failure of the save. If the save is unsuccessful, restart the server before reattempting these
updates.

5. Restart Unwired Server to commit the changes in steps 1 and 3, using the method you
prefer for server restarts.

6. In the left navigation pane, expand the Servers folder and select a server.

7. Select Server Configuration.

8. In the right administration pane, select the appropriate tab and click Refresh.
Current server configuration properties committed with the restart action appear.

Viewing Unwired Server Properties
View information, including host names, port numbers, version, and file location, to help you
manage an Unwired Server and its components.

1. In the left navigation pane, expand the Servers folder and select a server.

2. In the right administration pane, select the Properties tab.

3. Review Unwired Server properties.

Relay Server Outbound Enabler
The Outbound Enabler (RSOE) runs as an Unwired Server process and manages
communication between the Unwired Server and a Relay Server.

Each RSOE maintains connections to each Relay Server in a Relay Server farm. The RSOE
passes client requests to the Unwired Server on its Replication or Messaging port. Unwired
Server sends its response to the RSOE, which forwards it to the Relay Server, to be passed to
the client.

As an Unwired Server process, the RSOE always starts when Unwired Server starts. Unwired
Server monitors the process to ensure it is available. If an RSOE fails for any reason, Unwired
Server restarts it automatically.

Note: Sybase recommends three RSOE processes each, for both Replication and Messaging
ports.

Loading and Unloading HTTPS Certificates for RSOE
Load HTTPS certificates for the RSOE to add it to the Unwired Server node .

Note: You must use only RSA certificates.

If the Web server (Relay Server host) already uses a certificate signed by a CA for HTTPS
connections, you do not need to perform this task.

1. In the navigation pane, click Servers > ServerNode > Server Configuration.
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2. In the administration pane, select the Outbound Enabler tab, then click Certificate
Files.

3. Choose the action you want to perform:

• To add a new certificate, click +. Browse and select the .CRT file to upload, then click
Open.

• To replace a certificate in the store, select Overwrite the certificate file, then click
+.

• To delete a certificate from the store, select the filename and click X.

4. When certificate management tasks are complete, click OK.

Setting Up RSOE
Set up one or more RSOEs for each Unwired Server identified in a Relay Server configuration.
The configured values are saved in the cluster database.

Configuring RSOE General Properties
Set general RSOE configuration properties to define the context in which the RSOE process
operates.

1. In the navigation pane, click Servers > <ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, then click New.

3. Specify these property values:

• Farm type – select the type of request managed by the Relay Server, Replication or
Messaging protocol.

• Unwired sever port – select the port on which RSOE will manage requests.
• Relay server host – select either the host name of the Relay Server, or the host name of

the load balancer (if any).
• Relay server port – select the Relay Server HTTPS port.
• Unwired server farm – select the string that identifies the Unwired Server cluster, for

which the Relay Server manages requests. This property is case-sensitive, and it must
match the value in the Relay Server configuration.

• Server node ID – select the string that identifies the Unwired Server in the cluster. This
property is case-sensitive, and it must match the value in the Relay Server
configuration.

4. Click Next.

Configuring RSOE Connection Settings
Set connection configuration properties for an RSOE. These properties define the RSOE
connection to the Relay Server.

1. Specify these property values:
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• Http user name – select the user name for RSOE authentication on the Web server
(Relay Server host).

• Http password – enter the password for RSOE authentication on the Web server.

2. If RSOE connections to the Relay Server must pass through an Internet proxy server,
specify these property values:

• Proxy server – select the Internet proxy server.
• Http proxy user – select the user name for RSOE authentication on the proxy server.
• Http proxy password – type the password for RSOE authentication on the proxy

server.

3. Specify these property values:

• Certificate file – select this option and choose the .CRT file used to authenticate the
RSOE to relay server. You can only choose this file if you have already loaded it into the
Unwired Server certificate store.

• Trusted certificate – if the certificate file includes multiple certificates, choose
whether to trust a single certificate or all of them.

Configuring RSOE Start Options
Configure start options for RSOE.

1. Enable an option:

a) Check the box that corresponds to each name.
b) Set a value. If you check the box but set no value for the option, the default is used.

2. Click OK.

3. Ensure the process starts by checking the Status column of the Outbound Enablers tab.
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RSOE Start Options Reference
Review available RSOE start options. These options affect RSOE logging.

Option Default Description

Verbosity level 0 Sets log file verbosity values:

• 0 – Log errors only. Use this
logging level for deploy-
ment.

• 1 – Session level logging.
This is a higher level view of
a session.

• 2 – Request level logging.
Provides a more detailed
view of HTTP requests
within a session.

• 3 - 5 – Detailed logging,
used primarily for technical
support.

Reconnect delay 5 Delay before retry after connec-
tion fails.

Maximum output file size 10KB Maximum log file size.

Truncate log file None Option to delete the log file at
RSOE startup.

Generating the Relay Server Outbound Enabler Configuration File
To quickly and easily replicate a common Outbound Enabler (RSOE) configuration to
multiple hosts, generate an RSOE configuration file.

Administrators can use Sybase Control Center to configure an initial RSOE for development.
Once a configuration proves valid and stable, the administrator can generate the RSOE
configuration file, then use regRelayServer.bat to apply it to Unwired Server hosts.

1. In the navigation pane, click the Unwired Server cluster name.

2. In the administration pane, click the Relay Servers tab.

3. Click Generate.

4. Choose Relay server outbound enabler configuration XML file, then click Next.

5. Select an output target for the file.

6. Click Finish.
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Managing Configured RSOEs
Manage RSOE instances you have configured.

Retrieving RSOE Logs
You can retrieve one RSOE log at a time, from the Unwired Server host, and copy it to another
location. You cannot retrieve an empty RSOE log file.

1. In the navigation pane, click Servers > <ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, and select the RSOE instance.

3. Click Retrieve Log, then Next, then Finish to save the log and choose the target location
for the file.

Viewing or Editing RSOE Properties
View or edit configuration properties for a selected RSOE instance.

Relaunching the RSOE Configuration Wizard
Relaunch the Outbound Enabler Configuration wizard to create a new RSOE configuration.

1. In the navigation pane, click Servers > <ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab.

3. Select the RSOE instance, then click Properties.

Configuring RSOE General Properties
Set general RSOE configuration properties to define the context in which the RSOE process
operates.

1. In the navigation pane, click Servers > <ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, then click New.

3. Specify these property values:

• Farm type – select the type of request managed by the Relay Server, Replication or
Messaging protocol.

• Unwired sever port – select the port on which RSOE will manage requests.
• Relay server host – select either the host name of the Relay Server, or the host name of

the load balancer (if any).
• Relay server port – select the Relay Server HTTPS port.
• Unwired server farm – select the string that identifies the Unwired Server cluster, for

which the Relay Server manages requests. This property is case-sensitive, and it must
match the value in the Relay Server configuration.

• Server node ID – select the string that identifies the Unwired Server in the cluster. This
property is case-sensitive, and it must match the value in the Relay Server
configuration.
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4. Click Next.

Configuring RSOE Connection Settings
Set connection configuration properties for an RSOE. These properties define the RSOE
connection to the Relay Server.

1. Specify these property values:

• Http user name – select the user name for RSOE authentication on the Web server
(Relay Server host).

• Http password – enter the password for RSOE authentication on the Web server.

2. If RSOE connections to the Relay Server must pass through an Internet proxy server,
specify these property values:

• Proxy server – select the Internet proxy server.
• Http proxy user – select the user name for RSOE authentication on the proxy server.
• Http proxy password – type the password for RSOE authentication on the proxy

server.

3. Specify these property values:

• Certificate file – select this option and choose the .CRT file used to authenticate the
RSOE to relay server. You can only choose this file if you have already loaded it into the
Unwired Server certificate store.

• Trusted certificate – if the certificate file includes multiple certificates, choose
whether to trust a single certificate or all of them.

Configuring RSOE Start Options
Configure start options for RSOE.

1. Enable an option:

a) Check the box that corresponds to each name.
b) Set a value. If you check the box but set no value for the option, the default is used.

2. Click OK.

3. Ensure the process starts by checking the Status column of the Outbound Enablers tab.

Deleting RSOE Configurations
Delete an RSOE configuration to remove the configuration properties from the cluster
database.

1. In the navigation pane, click Servers > <ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, and select the RSOE
instances.

3. Stop the RSOE instances and click Delete.
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4. Click OK.

Refreshing the RSOE List
Refresh the RSOE list to display current information about deployed and configured RSOE
instances.

1. In the navigation pane, click Servers > <ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, and click Refresh.

Starting and Stopping RSOE
Start and stop an RSOE process as needed. All configured RSOEs are started by default when
the Unwired Server starts.

1. In the navigation pane, click Servers > ServerNode > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab, select the RSOE instances,
and click Start or Stop.

Configuring Proxy Server Settings for an Outbound Enabler
(Applies only to Online Data Proxy) Configure an Outbound Enabler to work with an Internet
proxy server, when connections to the Relay Server must pass through a proxy server.

1. In the navigation pane, click Servers><ServerNode> > Server Configuration.

2. In the administration pane, select the Outbound Enabler tab.

3. Click Proxy.

a) In the Proxy Server Settings dialog, click New.

1. In the Add Proxy Server dialog, add the Host and Port details.
b) Select the proxy server.
c) Click New to configure the user for RSOE authentication on the proxy server.

1. In the Add Proxy User dialog, add the User name and Password.
d) Click OK.

Outbound Enabler Tab Reference
Understand the columns of data displayed in the Outbound Enabler tab for an Unwired Server
node.

Column Name Displays

Server Node ID the string that identifies the Unwired Server in the cluster. This property is
case-sensitive, and it must match the value in the Relay Server configuration.

Unwired Server Port the port on which RSOE manages requests.
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Column Name Displays

Farm Type the type of request managed by the Relay Server, Replication or Messaging
protocol.

Unwired Server
Farm

the string that identifies the Unwired Server cluster, for which the Relay Server
manages requests. This property is case-sensitive, and it must match the value
in the Relay Server configuration.

Relay Server Host either the host name of the Relay Server, or the host name of the load balancer
(if any).

Status current state of the RSOE process: stopped, running, or error.

Status Description additional details on the state of the RSOE. If you receive one of these mes-
sages, follow the documented recommendation:

• Unknown error state – Check the log for additional details.

• Failed to connect Unwired Server, retrying... – Check the Unwired
Server port managed by the RSOE.

• Unauthorized. – Check the security token of RSOE.

• Unrecognized farm or server node ID. – The string that identifies the
Unwired Server cluster or server node in the RSOE configuration does not
match the Relay Server configuration.

• Please check the relay server host and port or Failed to create I/O
stream to the relay server – If you use HTTPS port, check to see if the
certificate file is valid.

• Relay server service unavailable. – Check if the Relay Server is properly
configured, or if any internal errors are logged.

• Relay server not found. – Either the Relay Server is not yet deployed, or
the URL suffix is wrong.

• Bad request. – Check the syntax of the URL suffix.

• Error writing HTTP headers – Check if the trusted certificate is valid,
and verify the URL suffix syntax. Something may be misformatted.

Certificate File the certificate file uploaded to the Unwired Server certificate store.

Log File name and location of the RSOE log file.

Server Log
Server logs enable you to monitor system health at a highlevel, or focus in on specific issues by
setting up filtering criteria. You can save and archive system logs, and manage log file size and
rollover behavior.
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Note: Properties you configure for an Unwired Server are cluster-affecting. Therefore, to
make sure they are propagated correctly, Sybase recommends that you set them only on a
primary cluster server.

Default Unwired Server Runtime Logging
Unwired Server logs collect runtime information from various embedded runtime
components.

By default, all the components of the server log are set at the INFO level, except the Other
components, which are set at the WARN level. However, you can change this level as required.
You should only use Sybase Control Center to set these logging values to ensure they are
configured correctly. These values will be correctly transcribed to an internal file (that is,
<UnwiredPlatform_InstallDir>\Servers\UnwiredServer
\Repository\logging-configuration.xml).

You can view these Unwired Server logs in two ways:

• From Sybase Control Center – click Servers > <ServerName> > Log in the left pane. The
first 150 entries initially appear in the console area, so you may need to incrementally
retrieve more of the log as required, by scrolling down through the log events.

• From a text editor – browse to and open one or more of the
<UnwiredPlatform_InstallDir>\Servers\UnwiredServer\logs
\<hostname>-server.log files. These files may be indexed, depending on how
you configure the life cycle for the servers's log file.

Configuring Server Log Settings
Configure server log properties to specify the amount of detail that is written to the log, as well
as the duration of the server log life cycle. Server log properties are only set on the primary
node; property settings on secondary nodes are read-only.

How changes are applied in a cluster depends on whether you are configuring a primary or
secondary server. Sybase recommends you only configure log settings on the primary server.
If you change the setting on a secondary server, the configuration is updated only for that
server and is temporary (eventually the primary settings are propagated to all servers in the
cluster).

Additionally, you should always use Sybase Control Center to configure server logs. If you
manually edit the configuration file, especially on secondary servers in a cluster, the servers
may not restart correctly once shut down.

1. In the left navigation pane, expand the Servers folder and select the server to configure.

2. Select Log.

3. In the right administration pane, click the Settings tab.
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4. The option "Rollover server log on server restart" is set by default. When selected, this
option means a new version of the log file is created after server restart, and the old one is
archived.

5. Set the server log size and backup behavior that jointly determine the server log life cycle.

a) Set the Maximum file size, in kilobytes, megabytes, or gigabytes, to specify the
maximum size that a file can reach before a new one is created. The default is 10MB.

Alternatively, select No limit to log all events in the same file, with no maximum size.
b) Set the Maximum backup index to determine how many log files are backed up

before the oldest file is deleted. The index number you choose must be a positive
integer between 1 and 65535. The default is 10 files.

Alternatively, select No limit to retain all log files.

6. For each components, choose a log level:

Component Default Log Level

MMS Info

PROXY Info

MSG Info

Security Info

Mobilink Info

DataServices Info

Other Warn

DOEC Info

Note: DOEC only appears if you run the DOEC installer after installing SUP cluster.

Log level Messages logged

All Complete system information

Trace Finer-grained informational events than debug

Debug Very fine-grained system information, warnings, and all errors

Info General system information, warnings, and all errors

Warn Warnings and all errors

Error Errors only

Console Messages that appear in the administration console only (when Unwired Server is
running in non-service mode)

Off Do not record any messages
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7. Click Save.
Log messages are recorded as specified by the settings you choose. The log file is located
in:  <UnwiredPlatform_InstallDir>\<UnwiredPlatform>\Servers
\UnwiredServer\logs\<hostname>-server.log.

Log life cycle default example

If you keep the default maximum file size and default index, an Unwired Server writes to the
log file until 10MB of data has been recorded. As soon as the file exceeds this value, a new
version of the log file is created (for example, the first one is <hostname>-server.log.
1). The contents of the original log are backed up into this new file. When the <hostname>-
server.log file again reaches its limit:

1. The contents of <hostname>-server.log.1 are copied to <hostname>-
server.log.2.

2. The contents of <hostname>-server.log are copied to <hostname>-
server.log.1.

3. A new copy of <hostname>-server.log is created.

This rollover pattern continues until the backup index value is reached, with the oldest log
being deleted. If the backup index is 10, then <hostname>-server.log.10 is the file
removed, and all other logs roll up to create room for the new file.

Viewing the Server Log
In text view, use the vertical scroll bar to retrieve additional segments of the log file in 150 line
increments. In grid view, up to 10 pages of the server log data is loaded in one request.

You can navigate to any page by using the First, Prev, Next, Last, and Go to controls. Use
View Details open the actual log file and find the corresponding line.

There are also two search options you can use:

• Basic search – allows you to search by keyword, log level, first/last X number of lines in
the log file.

• Advanced search – allows you to search by specific subcomponents, log level, exception,
time range, and so on.

You can include backup logs in your search or retrieval. The option is not selected by default.

Searching Server Log Data
Filter server log data according to the criteria you specify.

1. In the left navigation pane, expand the Servers folder and select the server for which you
want to review log data.

2. Select Log.

3. In the right administration pane, click the General tab.
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4. Select Show filter criteria to display the search pane.

5. Select Include backup logs to display backup logs.

6. Select Text view or Grid view to specify how to display the logs.

7. Select Basic search to filter your search according to the specific string you enter in the
search field. (Optional) You may also specify:

• Show – specify first lines, last lines, or a keyword. If you are searching by first or last
lines, you can enter any value up to a maximum of 1000 lines in the log. However,
Sybase recommends that you provide a more manageable value to avoid severe
performance degradation associated with this upper limit.

• Log level – search only messages logged by the particular log level you select.

8. Select Advanced search to enter more specific search criteria, including:

• Component – identify which component the log data belongs to: MMS, Proxy, MSG,
Security, MobiLink™, DataServices, or Other.

Note: Set the log level for each component in the Setting tab. See Configuring Server
Log Settings in Sybase Control Center online help.

• Log level – search only messages logged by the particular log level you select.
• Thread ID – specify the ID name of the thread that logs the message you are searching.
• Logger name – indicate the class name and instance of the logged component.
• Keyword – indicate a value, file name, or other keyword by which to filter your search.
• Time period – specify a start date, start time, end date, and end time.

9. Click Retrieve.
The search results appear in the right log pane.

10. To begin a new query, click Reset in the search panel and enter new search criteria.

Retrieving the Server Log
Update the information in the log console window.

1. In the left navigation pane, expand the Servers folder and select a server name.

2. Select Log.
The information collected in the current log appears in the console window of the General
tab.

3. To display the latest log data collected in the log file if time has elapsed since you last
opened the log, click Retrieve.

Deleting the Server Log
Clear old or unrequired server log data from the log file.

1. In the left navigation pane, expand the Servers folder and select the server you want to
configure.
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2. Select Log.
The information collected in the current log appears in the console window of the General
tab.

3. To delete all data from the log file and all backup log files, click Delete.

4. In the confirmation dialog, click OK.

Domains
Domains provide a logical partitioning of a hosting organization's environment that achieves
increased flexibility and granularity of control in multitenant environments. By default, the
installer creates a single domain named "default."

Administrators use different domains within the same Unwired Platform installation.
Domains enable the management of application metadata within a partition, including server
connections, packages, role mappings, domain logs, and security, so that changes are visible
only in the specific domain.

Considerations when implementing domains in a multitenant environment include:

• Create and manage domains using Sybase Control Center from the Unwired Platform
administration perspective of Sybase Control Center.

• You can support multiple customers inside the same Unwired Platform cluster.
• You can configure security specifically for individual domains by creating one or more

security configurations in the cluster, and then assigning those security configurations to a
domain. You can then map the security configurations to one or more packages. A user
accessing the package from a device application is authenticated and authorized by the
security provider associated with the package.

• Customers may require their own administrative view on their portion of the Unwired
Platform-enabled mobility system. By granting domain administration access to your
customers, you can allow customers to customize their deployed applications packages
and perform self-administration tasks as needed.

The "default" domain
The "default" domain is a special domain where critical runtime configuration artifacts exist.
These artifacts include:

• An "admin" security configuration – this security configuration is mapped to the "default"
domain and is used to authenticate and authorize administrative users. For this reason,
administrators are not allowed to unassign the "admin" security configuration from the
"default" domain.

• Cache database (CDB) data source connections – for the "default" CDB data source, users
can configure the Pool Size property in the "default" domain according to their
requirements. This setting allows the maximum number of open connections to the SQL
Anywhere database server hosting the CDB.
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• Monitor database data source connections – the customer can modify the existing
monitoring data source properties according to their configuration requirements, or create
a new monitoring datasource in the "default" domain.

• Domain log database data source connections – the customer can modify the existing
domain log data source properties according to their configuration requirement, or create a
new domain log data source in the "default" domain. By default, the name of domain log
data source is "domainlogdb".

Since these critical runtime-related artifacts are located in the "default" domain,
administrators are not allowed to delete this domain. Sybase recommends creating new
domains to facilitate tenants according to their application requirements.

Creating and Enabling a New Domain
Create and configure multiple domains within a single Unwired Platform installation. A
domain must be enabled for application users to access the packages deployed in the domain.
Enabling a domain also triggers synchronization of the domain changes to the secondary
nodes in the cluster. Application users who attempt to access a disabled domain receive an
error message.

Prerequisites
Create a security configuration for the domain and register the domain administrator.

Task

1. In the left navigation pane, expand the Domains folder.

2. In the right administration pane, select the General tab, and click New.

3. In the Create Domain dialog, enter a name for the domain and click Next.
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4. Optional. Select a security configuration for the domain by checking an option from the
list of available configurations. These security configurations are then available for use in
validating users accessing the packages.

5. Click Next.

6. Optional. Select one or more domain administrators for the domain.

7. Click Finish.
The new domain appears in the General tab.

8. Click the box adjacent to the domain name, click Enable, then click Yes to confirm.

Deleting a Domain
Remove a domain and its contents from the cluster when you no longer require the partition.

When a domain is deleted, all referenced artifacts, such as domain administrators and security
configurations, are retained. However, all contained artifacts, including packages,
subscription templates, device subscriptions, MBO and operation historical data, package-
level role mapping, cache group settings, server connections, and domain-level role mappings
for security configurations independent of any other domain, are also deleted.

To preserve a deployed package before deleting a domain, export the package to an archive
file.

Note: You cannot delete the "default" domain since it contains critical runtime-related
artifacts.

1. In the left navigation pane, select Domains.

2. In the right administration pane, click the General tab and select the domain you want to
delete.

3. Click Delete.

4. In the confirmation dialog, click Yes.

Registering a Domain Administrator User
A platform administrator can add domain administrators, so these users can administer
domains to which they are assigned. This process registers an administrator with the cluster, so
the user can be assigned as an administrator for a domain.

Prerequisites
Create the user entry and map the physical role to the SUP Domain Administrator logical role
in the security provider repository used to authenticate administrators in Sybase Control
Center (SCC).

Task

1. In the left navigation pane, click the Security node.
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2. In the right administration pane, click the Domain Administrators tab and click New.

3. To configure user properties for the administrator, enter:

• Login name – the user name assigned to the administrator. For example, if you are
using LDAP to authenticate administrators, the UID is typically used as the login
name.

• (Optional) Company name – the name of the organization the administrator belongs
to. Sybase recommends you supply this information if you are setting up Unwired
Platform in a hosted environment and using domains to distinguish between different
hosted solutions for different organizations.

• (Optional) First name – the administrator's first name. The first name must match the
one assigned to the login name in the security repository.

• (Optional) Last name – the administrator's last name. The last name must match the
one assigned to the login name in the security repository.

4. Click OK to register the administrator.
The domain administrator can now log in with his or her user login credentials (user name
and password).

Next
Assign the domain administrator role to this user.

Assigning Domain Administrators to a Domain
Assign domain administration privileges to a domain administrator. You must be a platform
administrator to assign and unassign domain administrators.

Prerequisites
Ensure the user is already registered as a domain administrator in the Domain Administrators
tab.

Task

1. In the left navigation pane, expand the Domains folder, and select the domain for which to
assign domain administration privileges.

2. Select the domain-level Security folder.

3. In the right administration pane, select the Domain Administrators tab, and click
Assign.

4. Select one or more administrator users to assign to the domain by checking the box
adjacent to the user name.

5. Click OK.
A message appears above the right administration pane menu indicating the success or
failure of the assignment. If successful, the new domain administrator appears in the list of
users.
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Viewing Applications for a Domain
View applications registered for a specific domain.

1. In the left navigation pane, expand the Domains folder, and select a domain.

2. Within the domain, select Applications.

3. In the right pane, select the domain-level Applications folder.

4. Click Refresh to view a list of Applications IDs, and their display names and
descriptions.

5. Alternatively, search for one or more application IDs.

a) Provide the search criteria for Application ID by adding a search string.
b) Click Go.

All the applications that match the search criteria provided for the selected domain are
populated in the table.

Viewing Application Connections for a Domain
View application connection information for a specific domain. Optionally select the relevant
columns of information to display.

1. In the left navigation pane, expand the Domains folder, and select a domain.

2. Within the domain, select Applications.

3. In the right pane, select the domain-level Application Connections folder.

4. Click Refresh to view a list of Users.

5. Alternatively, search for one or more users.

a) Provide the search criteria for Users by adding a search string.
b) Click Go.

All the users that match the search criteria provided for the selected domain are
populated in the table.

6. (Optional) Select the columns to display (all columns, or specific columns) from the drop-
down list.

Scheduling Domain-Level Cleanup
Periodically clean up accumulated data maintenance items in cache that are no longer needed.

You can automate domain-level cleanup based on a configured schedule for specific cleanup
categories.

Running the cleanup options uses system resources, so Sybase recommends that you schedule
these tasks when system load is lightest. Optionally you can run the cleanup tasks manually.
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1. In the Sybase Control Center left navigation pane, expand the Domains tab and select a
domain.

2. In the right pane, select the Scheduled Task tab.

3. Under Task, select one of the options you want to schedule, and then select Properties to
set up its automatic schedule:

Option Description

Subscription Cleanup Removes subscriptions that are no longer referenced by
any active users.
• Replication-based synchronization – removes sub-

scriptions not used since the last synchronization.
• Message-based synchronization – removes subscrip-

tions if Unwired Server has not received a synchro-
nization message since the given date.

Error History Cleanup Removes historical data on MBO data refresh and oper-
ation replay failures, which result from system or appli-
cation failures. System failures may include network
problems, credential issues, and back-end system failure.
Application failures may include invalid values, and non-
unique data.

Note: Only error messages are removed.

Client Log Cleanup Removes client log records that have already been
synchronized to the device, or are no longer associated
with active users.

Synchronization Cache Cleanup Removes logically deleted rows in the cache that are older
than the oldest synchronization time on record in the sys-
tem. Synchronization activity for all clients establish the
oldest synchronization time. This cleanup task also re-
moves unused or stale partitions.

4. Select Enable. Schedules run until you disable them, or they expire.

Scheduling Cleanup Options
The SUP Administrator or SUP Domain Administrator schedules domain-level data
maintenance cleanup.

Set up an automatic schedule for database cleanup:

1. In the left pane, select the cluster, then the domain.

2. In the right pane, select the Scheduled Tasks tab.

3. Select one of the cleanup options:
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Option Description

Subscription Cleanup Removes subscriptions that are no longer referenced by
any active users.
• Replication-based synchronization – removes sub-

scriptions not used since the last synchronization.
• Message-based synchronization – removes subscrip-

tions if Unwired Server has not received a synchro-
nization message since the given date.

Error History Cleanup Removes historical data on MBO data refresh and oper-
ation replay failures, which result from system or appli-
cation failures. System failures may include network
problems, credential issues, and back-end system failure.
Application failures may include invalid values, and non-
unique data.

Note: Only error messages are removed.

Client Log Cleanup Removes client log records that have already been
synchronized to the device, or are no longer associated
with active users.

Synchronization Cache Cleanup Removes logically deleted rows in the cache that are older
than the oldest synchronization time on record in the sys-
tem. Synchronization activity for all clients establish the
oldest synchronization time. This cleanup task also re-
moves unused or stale partitions.

4. Click Properties.

5. In the Task Properties dialog, select the Schedule tab, and set the appropriate options:

• Schedule repeat – select how often the schedule should run. Options are hourly,
daily, custom, and never.
• If you select hourly or daily, specify:

• Start date – select the date and time the automated cleanup should begin. Use
the calender picker, and 24-hour time selector.

• End date – select the date and time the automated cleanup should end.
• Days of the week – select each day the automated cleanup schedule should

run.
• If you select custom, you can specify the interval granularity by seconds, minutes,

or hours, as well as other date and time parameters.
• If you select never, no scheduling options are available.

6. In the Task Properties dialog, select the Options tab, set the number of inactive days for
which to purge.

Note: This step is unnecessary for Synchronization Cache Cleanup.
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7. Click OK to save the schedule properties and purge options.

Enabling Domain Cleanup
The SUP Administrator or SUP Domain Administrator must enable the schedule as a separate
task.

You can set up the schedule, and enable it at a later time. Once enabled, the cleanup runs
automatically until is changed, disabled, or expires. You can check the current enabled or
disabled status on the Scheduled Tasks tab.

1. In the left pane, select the cluster, then the domain.

2. In the right pane, select the Scheduled Task tab.

3. Select one of the cleanup options, and verify the value in the Status column is set to
disabled.

4. On the Scheduled Task tab, click Enable.

5. Click OK to confirm. The value in the Status column changes to enabled. The cleanup
schedule runs automatically for the selected option.

Disabling Domain Cleanup
The SUP Administrator or SUP Domain Administrator can disable, or reenable, a scheduled
cleanup option at any time.

If you disable the cleanup option while it is running, the current process continues. Future
action is disabled, unless you reenable the option.

1. In the left pane, select the cluster, then the domain.

2. In the right pane, select the Scheduled Task tab.

3. Select one of the cleanup options, and verify the value in the Status column is set to
enabled.

4. On the Schedule tab, click Disable.

5. Click OK to confirm. The value in the Status column changes to disabled.

Running Manual Purge by Domain
At any time the SUP Administrator or SUP Domain Administrator can manually run cleanup
options. The processes run asynchronously on Unwired Server using the current settings.

As much as reasonable, use manual purge when system load is light.

1. In the left pane, select the cluster, then the domain.

2. In the right pane, select the Scheduled Tasks tab.

3. Select one of the cleanup options.

4. Click Run Now, then optionally specify the number of days for which to preserve data.
Artifacts that fall outside of the time period are purged.
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5. Click OK to confirm. The request is sent immediately, and the task runs asynchronously
on Unwired Server.

Domain Log
The domain log enables an administrator to monitor application activities throughout the
system. Detailed views of application activities are available by subsystem. The administrator
can review activities in a specific subsystem log view, view correlated data in multiple
subsystems, or view a unified log across all subsystems. The administrator must enable
logging, and then use log filters to view data of interest.

By default, only error messages are recorded in each domain's log. To enable domain logging,
you must create a log profile. See Creating and Enabling Log Profiles in Sybase Control
Center online help.

Enabling Application Logging
Enable domain-level logging to help you trace and monitor application activities, and review
the resulting logs for troubleshooting.

Creating and Enabling Domain Logging
Create logging profile definitions and enable the log profile.

1. In the left navigation pane of Sybase Control Center, select Domains.

2. Under the default domain node, select Log.

3. In the right administration pane, select the Settings tab.

4. Click New.

5. In the Profile Definition dialog, enter a Name and Description for the log profile.

6. Add the necessary profile definitions.

7. Select Enable after creation.

8. Click OK.

Note: To ensure the domain logs are populated immediately after enabling the log profile,
do the following:
1. Under the Settings tab, click Configuration.
2. Check Enable flush threshold.

Creating the Profile Definition
Create profile definitions belonging to multiple categories.

You can add profile definitions by selecting applications, security configurations, users,
connections, applications connections or payloads of your choice.
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Adding or Removing Applications to the Profile
Add applications to the log profile that are currently deployed in the selected domain.

1. In the Profile Definition dialog, select Package related.

2. Select Applications, then click the button to add application to the profile.
The Applications dialog is displayed with the list of applications currently deployed in this
domain.

3. To search for the application you want to add to the profile, select the search criteria from
the Search drop-down list and enter a value for this criteria.

4. Click Go.

5. You can do any of the following:

• To add an application to a new or existing profile, select the check-box adjacent to the
application entry in the list.

• To remove an application from the profile, uncheck the check-box adjacent to the
application entry in the list.

6. Click OK.

Adding or Removing Packages to the Profile
Add one or more packages to the profile.

1. In the Profile Definition dialog, select Package related.

2. Select Packages, then click the button to add packages to the profile.

3. Select one or more packages to include.

4. Click OK.

Note: To remove a selection, click View selection, select the item, then click Remove.

Adding or Removing MBOs to the Profile
Add MBOs from one or more packages to the profile.

1. In the Profile Definition dialog, select Package related.

2. Select MBOs, then click the button to add MBOs to the profile.

3. Navigate to a package in the left pane.

4. Select the MBO in the right pane.

5. Identify another MBO, or click OK.

Note: To remove a selection, click View selection, select the item, then click Remove.

Administer

Sybase Control Center for Sybase Unwired Platform 89



Adding or Removing Operations to the Profile
Add operations to the log profile for MBOs that are currently deployed in the selected domain.
You can select operations for one or more MBOs.

1. In the Profile Definition dialog, select Package related.

2. Select Operations, then click the button to add operations to the profile.

3. Navigate to a package in the left pane, and select an MBO.

4. Identify the create, delete, or update operations to include for the MBO in the right pane.

5. Select another MBO and its operations, or click OK.

Note: To remove a selection, click View selection, select the item, then click Remove.

Adding or Removing Security Configurations or Users to the Profile
Add one or more domain security configurations to the profile.

1. In the Profile Definition dialog, select Security related.

2. Select Security configuration, then click the button to add packages to the profile.

3. Select one or more security configuration to include.

4. Click OK.

Note: To remove a selection, click View selection, select the item, then click Remove.

Adding or Removing Package Users to the Profile
Add one or more domain package users to the profile to include security configurations.

1. In the Profile Definition dialog, select Security related.

2. Select Users, then click the button to add packages to the profile.

3. Select one or more user name to include.

4. Click OK.

Note: To remove a selection, click View selection, select the item, then click Remove.

Adding or Removing Connections to the Profile
Add connections of a particular connection type to the profile.

1. In the Profile Definition dialog, select Connections.

2. Click the button to add connections to the profile.
The Connections dialog is displayed with the list of applications currently deployed in this
domain.

3. You can do any of the following:
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• To add a connection to a new or existing profile, select the check-box adjacent to the
Connection Type entry in the list and select the connection names.

Note: To add connections for proxy services, select the Proxy connection type.

• To remove an application from the profile, select the View selection check-box. Select
the connection type and click Remove.

4. Click OK.

Adding or Removing Application Connections to the Profile
Add application connections to the profile. This enables you to list current application
connections to Unwired Server.

1. In Profile Definition, select Application connections.

2. Click the button to add application connections to the profile.

3. In Application Connections, select Application Connections, and the data columns to
include

4. Click OK.

Adding or Removing Payloads to the Profile
Add a subsystem to the profile for payload logging. This enables you to identify one or more
specific subsystems where payload data will also be included with the logged activity. If
specified, payload is enabled for the selected subsystems.

The payload corresponds to the information of one request serviced by the SUP Server.
Example: For an administrator to keep track of granular details such as request headers sent to
Gateway through the proxy server, payload is enabled for a profile.

1. In the Profile Definition dialog, select Payloads.

2. Click the button to add payloads to the profile.
The Payloads dialog is displayed.

3. You can do any of the following:

• Select the check-box adjacent to the subsystem you want to add to the profile.
• Uncheck the check-box that you want to remove from the profile.

4. Click OK.

Enabling the Created Profile
Enable the profile you have created to monitor the log profile definitions.

1. In the Profile Definition dialog, select Enable after creation to enable the logging profile
once you have created it.

2. Click OK.

You can alternatively enable the log profile by doing the following:
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1. In the Settings tab, select the log profile you have created.
2. Click Enable.
3. Click OK on the confirmation dialog.

Correlating Log Data Across Subsystems
Correlation mode enables you to retrieve domain log data in multiple subsystems, using the
same search condition. The same condition is combined by common type filters and time
range. This provides a tool for correlating activity across subsystems, useful for analyzing and
troubleshooting.

For example, you could create a common filter for Application ID (such as Application ID =
appid); select the ProxyRequestResponse tab and enter the filter information; retrieve the
data; then select Correlated mode, and switch to another tab such as ProxyPush.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the subsystem tab, such as Synchronization.

5. To select or set up a special filter, select Show filter.

6. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

7. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, User, and Thread.

8. Click Retrieve to retrieve the logs.
The table is populated with log data.

9. Select Correlated mode and select the common type of log filters to use.

10. Switch to another subsystem tabs. The data is refreshed using the same criteria from the
common type of log filters and time range specified.

11. Use the data to trace application activity across subsystems.

Exporting Log Data
Export data in CSV or XML format, to archive, analyze, or use to troubleshoot problems.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the subsystem tab, such as Synchronization.

5. To select or set up a special filter, select Show filter.

6. To filter based on the date and time, enter a Start date, End date, Start time, End
time.
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7. Click Retrieve to retrieve the logs.
The table is populated with log data.

8. Click Export .

a) In Export Domain Log, select xml or csv.
b) Click Finish.
c) Specify the file name and location, and save.

Purging Domain Logs
You can manually purge the domain log.

1. In the left navigation pane of Sybase Control Center, select Domains.

2. Under the default domain node, select Log.

3. In the right administration pane, select the Settings tab.

4. Click Purge.

5. Enter the date and time within which you want the data to be purged.

6. Click OK.

Configuring Domain Log Settings
Configure auto-purge, flush threshold, and flush batch size settings to determine how long
domain log data is retained, how frequently it is written to database from server nodes, and set
a domain log database connection to configure where domain log data is stored.

1. In the left navigation pane of Sybase Control Center, select Domains.

2. Under the default domain node, select Log.

3. In the right administration pane, select the Settings tab. These settings are used for all
domains.

4. Click Configuration.

5. Configure auto purge settings.

Auto purge clears obsolete data from the database once it reaches the specified threshold.

a) Select Enable auto purge configuration to activate auto purge functionality.
b) Enter the length of time (in days) to retain monitoring data before it is purged.

6. Configure flush threshold settings:

The flush threshold indicates how often data is flushed from memory to the database. This
allows you to specify the size of the data saved in memory before it is cleared. Alternately,
if you do not enable a flush threshold, data is immediately written to the domain log
database as it is captured.

a) Select Enable flush threshold configuration to activate flush threshold functionality.
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Note: Enabling flush configuration is a good practice for performance considerations.
Be aware there may be a consequent delay in viewing data, until data is stored in the
database.

b) Select one of:

• Number of rows – domain log data that surpasses the specified number of rows is
flushed from memory. Enter the desired number of rows adjacent to Rows.
Disabled by default.

• Time interval – domain log data older than the specified time interval is flushed
from memory. Enter the desired duration adjacent to Minutes. The default is 5.

• Either rows or time interval – domain log data is flushed from memory according
to whichever value is reached first: either the specified number of rows or the
specified time interval. Enter the desired rows and duration adjacent to Rows and
Minutes, respectively.

7. If you enabled a flush threshold, enter a Flush batch row size by specifying the size of
each batch of data sent to the domain log database. The row size must be a positive integer.

The batch size divides flushed data into smaller segments, rather than saving all data
together according to the flush threshold parameters. For example, if you set the flush
threshold to 100 rows and the flush batch row size to 50, once 100 rows are collected in the
console, the save process executes twice; data is flushed into the database in two batches of
50 rows. If the flush threshold is not enabled, the flush batch row size is implicitly 1.

Note: By default, the domain log database flushes data every 5 minutes. Alternatively, you
can flush data immediately by removing or decreasing the default values, but doing so
impacts performance.

8. Optional. To change the data source, select an available database from the Domain log
database endpoint drop down list.

Available databases are those with a JDBC server connection type (SQL Anywhere)
created in the default domain. To create a new database, a platform administrator must set
up a database by running the appropriate configuration scripts and creating a server
connection for the database in the default domain. The database server connection then
appears as an option in the Domain Log Database Endpoint drop down list.

9. Click OK.

Reviewing Domain Log Data
An administrator reviews logged data by creating log filters. The filters enable you to retrieve
data logged for a specific thread, application, user, connection, among other options.

You can retrieve log data without using any filters, however, when there is large number of
activities being logged, it may be advisable to filter the results to a more manageable size by
specifying search conditions in the log filter (user, application, or thread-id).

You can combine multiple log filters that are common with sub-system specific filters when
viewing in a sub-system view, and combine multiple sub-system filters in the ALL tab to
retrieve the data of interest.
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Supported Log Subsystems
Log subsystems provide categories that enable you to filter and correlate application data at a
more granular level. Understanding these subsystems enables you to formulate more specific
filters for tracking application activities throughout the system.

Subsystem Description

All Provides a unified view of all subsystems, enabling you to look for activities,
trends, and symptoms across multiple subsystems.

Synchronization Provides a view of synchronization activities. Within this subsystem, addi-
tional categories include data synchronization, operation replay, subscription,
result checker, cache refresh, and data services (DS) interface.

Device Notifica-
tion

Provides a view of device notification activities.

DCN Provides a view of data change notification (DCN) activities. Within this sub-
system, additional categories include general DCN, and workflow DCN.

Security Provides a view of security-related activities.

Error Provides a view of errors.

Connection Provides a view of connection activities. Within this subsystem, additional
categories include DOE, JDBC, RES, SAP®, and SOAP connections.

Proxy Provides a view of Online Data Proxy connection-related activities. Within this
subsystem, categories include request response, and push.

Setting Up a Pool of Log Filters
Set up a pool of log filters to filter out unwanted application activities, and provide a view of
specific activities. Use Sybase Control Center to create and manage your filters.

Reusable Log Filters
Create reusable log filters that you can use as a base. One strategy is to create a base log filter
for each of the supported log subsystems, and for significant categories within subsystems.
Another strategy is to create common log filters (useful across subsystems) on specific
criteria, such as thread ID, user, package, and so forth.

You can modify these base log filters as needed for more specific searches, or clone the log
filter and modify it for a specific search.
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Creating Log Filters
Filter the log data by creating filters across subsystems that define the appropriate search
criteria.

1. In the left navigation pane of the Sybase Control Center, select theDomains node.

2. Select the default node and select the Log node.

3. In the right administration pane, select the General tab.

4. Select + to add a filter definition to a subsystem.

5. In the Filter Definition dialog, enter the Name and Description of the filter.

6. Select the Sub System.

7. Select the filter criteria and assign values to the criteria selected. You can use the logical
operations to compose the criteria.

Note: You use the 'AND' logical operator to highlight filter relations belonging to the same
subsystem. Filter definitions among multiple subsystems use the 'OR' logical operator.

8. Click OK.

Deleting Filters
Delete the filters created for sub systems

1. In the left navigation pane of the Sybase Control Center, select theDomains node.

2. Select the default node and select the Log node.

3. In the right administration pane, select the General tab.

4. Select the filter from the list.

5. Click Delete.

Updating Filters
Update filters as needed to fine tune log file filtering.

1. In the left navigation pane of the Sybase Control Center, select theDomains node.

2. Select the default node and select the Log node.

3. In the right administration pane, select the General tab.

4. Select the filter from the list.

5. Click the properties icon to review or modify the filter.

Note: Alternatively, click the clone icon to clone the filter, then proceed to modify it.

6. In Filter Definition, modify the description, and set up the filter criteria.

7. Click OK.
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Retrieving Unified View Logs
Retrieves logging data across the domain to provide a unified view.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the All tab.

5. To select or set up a special filter, select Show filter.

6. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

7. Click Retrieve to retrieve the logs.
The table is populated with the list of logs.

Retrieving Synchronization Logs
Retrieves logging data related to different aspects of data synchronization, including data,
subscriptions, operations, result checker, cache refresh and the data service and Unwired
Server interface. Using data in these logs and the correlation tool, you can follow the data path
between the enterprise information system (EIS), Unwired Server, cache database, and user
application connection.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the Synchronization tab.

5. Select a synchronization subsystem:

• Data Sync – view data synchronization details.
• Operation Replay – view MBO operational replay details.
• Subscription – view subscription details.
• Result Checker – view result checker details.
• Cache Refresh – view cache database interaction details.
• DS Interface – view requests entering data services that result in interaction with cache

database and EIS.

6. To select or set up a special filter, select Show filter.

7. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

8. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

9. Click Retrieve to retrieve the logs.
The table is populated with the log data.
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For Data Sync:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Sync Group – the synchronization group associated with the request.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

For Operation Replay:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Operation – the MBO operation.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

For Subscription:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• Subscription Type – the type of subscription used, including SUBSCRIBE,

UNSUBSCRIBE, RECOVER, SUSPEND, and RESUME.
• Subscription ID – the identifier associated with the subscription.
• Sync Group – the synchronization group associated with the request.
• Thread ID – the identifier for the thread used to process the request.
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• Node ID – the server node on which the request is received.
• Error – the error message if any.

For Result Checker:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• Class – the class used for the result checker.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

For Cache Refresh:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Cache Group – the cache group name.
• CacheRow Count – the number of rows in the cache count.
• EIS Row Count – the enterprise information system (EIS) row count.
• Insert Count – the insert operation count.
• Update Count – the update operation count.
• Delete Count – the delete operation count.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

For DS Interface:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
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• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Operation – the MBO operation.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

Retrieving Device Notification Logs
Retrieves logging data for server-initiated synchronization notifications between Unwired
Server and devices.

1. In the left navigation pane of Sybase Control Center, select Domains.

2. Select the default node or another domain, then select Log.

3. In the right administration pane, select the General tab.

4. Select the Device Notification tab.

5. To select or set up a special filter, select Show filter.

6. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

7. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

8. Click Retrieve to retrieve the log.
The table is populated with the log data.
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Sync Group – the synchronization group associated with the request.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

Retrieving DCN Logs
Retrieves logging data for data change notifications between an enterprise information system
(EIS) and an MBO package, for general and workflow DCN.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.
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3. In the right administration pane, select the General tab.

4. Select the DCN tab.

5. Select the DCN type:

• General DCN
• Workflow DCN

6. To select or set up a special filter, select Show filter.

7. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

8. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

9. Click Retrieve to retrieve the logs.
The table is populated with the log data.

For general DCN:
• Time – the time and date stamp for the log entry.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

For workflow DCN:
• Time – the time and date stamp for the log entry.
• Workflow ID – the unique identifier associated with a workflow.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Package – the name of the package to which the subscription belongs.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Operation – the MBO operation.
• Subject – the workflow DCN request subject line.
• From – the "From" value for the workflow DCN request.
• To – the "To" value for the workflow DCN request.
• Body – the message body for the workflow DCN request.
• Error – the error message if any.

Retrieving Security Logs
Retrieves security details for specific applications.
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1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the Security tab.

5. To select or set up a special filter, select Show filter.

6. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

7. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

8. Click Retrieve to retrieve the logs.
The table is populated with the log data.
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Security Configuration – the associated security configuration.
• Method – the MBO operation used.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Outcome – the authentication outcome for the security check.
• Reason – the reason for authentication failure.
• Error – the error message if any.

Retrieving Errors Logs
Retrieves logging data for domain errors.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the Error tab.

5. To select or set up a special filter, select Show filter.

6. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

7. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.
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8. Click Retrieve to retrieve the logs.
The table is populated with the error log data.
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Operation – the MBO operation.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

Retrieving Logs for Connections
Retrieves logging data for domain connections for specific connection types to backend data
sources, including DOE, JDBC, REST, SAP, and SOAP if enabled.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the Connection tab.

5. Select a connection type, such as DOE, JDBC, REST, SAP, or SOAP.

6. To select or set up a special filter, select Show filter.

7. To filter based on the date and time, enter a Start date, End date, Start time, End
time.

8. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

9. Click Retrieve to retrieve the data.
The table is populated with the log data.

DOE connection:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Event Type – the DOE-C event type, such as Acknowledged, Ignored, Exclude,

Resend (from client), and Status.
• Package – the name of the package to which the subscription belongs.
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• Client ID – the identifier for the DOE-C client.
• Physical ID – the DOE-C generated physical identifier registered with DOE at

subscription.
• Subscription ID – the DOE-C generated subscription identifier registered with DOE at

subscription.
• Logical Device ID – the DOE-C logical device identifier, generated by DOE and

provided to DOE-C upon successful subscription.
• Message Direction – the DOE-C message direction, either client to Unwired Server, or

Unwired Server to client.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

JDBC connection:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Operation – the MBO operation.
• Query – the database or data source query used.
• Connection – the managed connection used.
• Connection ID – the managed connection identifier.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

REST connection:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• BAPI – the SAP BAPI used as the data source.
• Operation – the MBO operation.
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• Connection – the managed connection used.
• URL – the URL associated with the managed connection.
• Action – the GET, POST, PUT, or DELETE action.
• Response Status – the response status code for the invocation.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

SAP connection:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Operation – the MBO operation.
• BAPI – the SAP BAPI used as the data source.
• Connection – the managed connection used.
• Connection ID – the managed connection identifier.
• Properties – the list of name:value pairs.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

SOAP connection:
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Stage – the current stage of processing - START or FINISH.
• Package – the name of the package to which the subscription belongs.
• MBO – the mobile business object used.
• Operation – the MBO operation.
• Connection – the managed connection used.
• Service Address – the service address URL.
• Action – the SOAP action.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.

Administer

Sybase Control Center for Sybase Unwired Platform 105



• Error – the error message if any.

Retrieving Proxy Request-Response Logs
Retrieves the log data for all requests and responses made from the Proxy server.

Once you have traced a connection under the Applications node, you can retrieve the logs
under the Domains node.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.

3. In the right administration pane, select the General tab.

4. Select the Proxy tab and then select Request Response.

5. To select or set up a special filter, select Show filter.

6. To filter logs based on the date and time, enter a Start date, End date, Start time, End
time.

7. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

8. Click Retrieve to retrieve the log data.
The table is populated with the log data.
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Source - the source of the log if its from the server or client.
• Correlation ID - the unique id associated with every request-response message pair.
• Request Type - the request type of the message.
• Request URL - the Gateway URL.
• HTTP Endpoint - the Gateway URL.
• Log Level - not relevant.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

Retrieving Proxy Push Logs
Retrieves the log data for all push notifications from the Proxy server.

Once you have traced a connection under the Applications node, you can retrieve the logs
under the Domains node.

1. In the left navigation pane of Sybase Control Center, select Domain.

2. Under the default node, select Log.
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3. In the right administration pane, select the General tab.

4. Select the Proxy tab and then select Push.

5. To select or set up a special filter, select Show filter.

6. To filter logs based on the date and time, enter a Start date, End date, Start time, End
time.

7. (Optional) Select the columns to display from the drop down list, such as Application ID,
Application Connection Id, and User.

8. Click Retrieve to retrieve the data.
The table is populated with the log data.
• Time – the time and date stamp for the log entry.
• Application ID – the unique identifier assigned to the registered application. Values

may include a number, blank, or HWC, depending on the client type.
• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Source - the source of the log if its from the server or client.
• Correlation ID - the unique id associated with every request-response message pair.
• URN - not relevant.
• Log Level - not relevant.
• Thread ID – the identifier for the thread used to process the request.
• Node ID – the server node on which the request is received.
• Error – the error message if any.

Checking Client Application Logs
Review data about client application operations for all devices subscribed to a package in
order to track errors and identify performance issues.

1. In the left navigation pane, expand the Packages folder and select the package you want to
manage.

2. In the right administration pane, select the Client Log tab.

3. Review this information to monitor client application activity:

• User – the name of the user that activates the device.
• Application Connection ID – the unique identifier for a user application connection.
• MBO – the mobile business object that the client is synchronizing with.
• Operation – the operation that the client is performing.
• Code – the result of server-side operations; either 200 (successful) or 500 (failed).
• Level – the log level for the application; either FATAL, ERROR, WARN, INFO,

DEBUG, or TRACE.
• Timestamp – the date and time at which the operation took place.
• Message – the log message associated with the operation.
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4. Select a row from the table and click Details to see a detailed view of data for the selected
client log event.

5. Click Close to return to the Client Log summary view.

Cleaning the Client Log
Clears client application log data from the SCC administration page.

1. In the left navigation pane, expand the Packages folder and select the package you want to
manage.

2. In the right administration pane, select the Client Log tab.

3. Click Clean.

4. Enter a time frame to indicate which client log data you want to erase, and click OK.
The data is removed from the Client Log tab.

Connections
Connections allow Unwired Server to communicate with data sources. To facilitate the
connection process, define a set of properties for each data source. Establish connections and
connection pools for each domain.

A connection is required to send queries to mobile business objects, and to receive answers.
The format in which data is communicated depends on the type of data source; for example,
database data sources use a result set, while Web services data sources provide XML files, and
SAP data sources use tables.

Establish connections by supplying an underlying driver and a connection string. Together,
the driver and string allow you to address the data source, and provide you a mechanism by
which to set the appropriate user authentication credentials and connection properties that
describe the connection instance. Once a connection is establish, Unwired Server can open
and close it as required.

Connection Pools
Unwired Server maintains database connections in a connection pool, which is a cache
database connections for the cache database or any other database data source.

A connection can be reused when the database receives future requests for data, thereby
improving Unwired Server performance. If all the connections are being used, and the
maxPoolSize value you configured for a connection pool has been reached, a new connection
is added to the pool. For Unwired Server, connection pools are based on an existing template
created for a specific data source type.
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Connection Templates
A connection template is a model or pattern used to standardize connection properties and
values for a specific connection pool type so that they can be reused. A template allows you to
quickly create actual connections.

Often, setting up a connection for various enterprise data sources requires each administrator
to be aware of the mandatory property names and values for connecting to data sources. Once
you create a template and add appropriate property names and corresponding values (for
example user, password, database name, server name, and so on), you can use the template to
instantiate actual connection pools with predefined property name and value pairs.

Creating Connections and Connection Templates
Create a new connection or connection template that defines the properties needed to connect
to a new data source.

1. In the left navigation pane, expand the Domains folder, and select the domain for which
you want to create a new connection.

2. Select Connections.

3. In the right administration pane:

• To create a new connection – select the Connections tab, and click New.
• To create a new connection template – select the Templates tab, and click New.

4. Enter a unique Connection pool name or template name.

5. Select the Connection pool type or template type:

• JDBC – choose this for most database connections.
• Proxy - choose this if you care connecting to the Online Data Proxy.
• WS – choose this if you are connecting to a Web Services (SOAP or REST) data

source.
• SAP – choose this if you are connecting to an SAP (JCO) datasource.

6. Select the appropriate template for the data source target from the Use template menu. By
default, several templates are installed with Unwired Platform; however, a production
version of Unwired Server may have a different default template list.

7. Template default properties appear, along with any predefined values. You can customize
the template, if required, by performing one of:

• Editing existing property values – click the corresponding cell and change the value
that appears.

• Adding new properties – click the <ADD NEW PROPERTY> cell in the Property
column and select the required property name. You can then set values for any new
properties you add.
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Note: In a remote server environment, if you edit the sambledb Server Name property, you
must specify the remote IP number or server name. Using the value "localhost" causes
cluster synchronization to fail.

8. Test the values you have configured by clicking Test Connection. If the test fails, either
values you have configured are incorrect, or the data source target is unavailable. Evaluate
both possibilities and try again.

9. Click OK to register the connection pool.
The name appears in the available connection pools table on the Connections tab.
Administrators can now use the connection pool to deploy packages.

Editing Connection Pools and Templates
Edit the properties and values assigned to connection pools and templates.

1. In the left navigation pane, expand the Domains folder, and select the domain for which
you want to create a new connection.

2. Select Connections.

3. In the right administration pane:

• To edit the properties of a connection pool, click theConnections tab.
• To edit the properties of a connection pool template, click theTemplates tab.

4. Select a connection pool or template from the list.

5. Click Properties.

a) Edit the property and value.

a) Click Save to save the changes.

Testing a Connection
Test connection properties of a data source to validate the connection values.

1. In the left navigation pane, click the Connections icon.

2. Select the Connection Pool Name you want to validate.

3. Click Properties.

4. Click Test Connection.

If the connection test is not successful, see Connection Test Errors in theTroubleshooting
guide.

Deleting a Connection Pool and Template
Delete a connection pool or template.

1. In the left navigation pane, expand the Domains folder, and select the domain for which
you want to create a new connection.
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2. Select Connections.

3. In the right administration pane:

• To delete a connection pool, click theConnections tab.
• To delete a connection pool template, click theTemplates tab.

4. Select the connection pool or template you want to delete.

5. Click Delete.

EIS Data Source Connection Properties Reference
Name and configure connection properties when you create connection pools in Sybase
Control Center to enterprise information systems (EIS) .

JDBC Properties
Configure Java Database Connectivity (JDBC) connection properties.

This list of properties can be used by all datasource types. Sybase does not document native
properties used only by a single driver. However, you can also use native driver properties,
naming them using this syntax:

<driver_type>:<NativeConnPropName>=<SupportedValue>

Note: If Unwired Server is connecting to a database with a JDBC driver, ensure you have
copied required JAR files to correct locations. See the Installation for Runtime guide.

Name Description Supported values

After Insert Changes the value to into if a da-

tabase requires insert into
rather than the abbreviated into.

into

Batch Delimiter Sets a delimiter, for example, a sem-
icolon, that can be used to separate
multiple SQL statements within a
statement batch.

<delimiter>

Blob Updater Specifies the name of a class that can
be used to update database BLOB
(long binary) objects when the
BLOB size is greater than psMaxi-
mumBlobLength.

<class name>

The class must implement the
com.sybase.djc.sql.Blo-
bUpdater interface.

Clob Updater Specifies the name of a class that can
be used to update database CLOB
(long string) objects when the
CLOB size is greater than psMaxi-
mumClobLength.

<class name>

The class must implement the
com.sybase.djc.sql.Clo-
bUpdater interface.
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Name Description Supported values

Code Set Specifies how to represent a reper-
toire of characters by setting the val-
ue of CS_SYB_CHARSET for this
datasource. Used when the data in
the datasource is localized. If you do
not specify the correct code set,
characters may be rendered incor-
rectly.

[server]

If the value is server, the value of the
current application server’s defaultCo-
deSet property is used.

Commit Protocol Specifies how Unwired Server han-
dles connections for a datasource at
commit time, specifically when a
single transaction requires data from
multiple endpoints.

If you use XA, the recovery log is
stored in the tx_manager data-
source, and its commit protocol
must be optimistic. If tx_manager is
aliased to another datasource (that
is, one that is defined with the alias-
For property), the commit protocol
for that datasource must be optimis-
tic. A last-resource optimization en-
sures full conformance with the XA
specification. The commit protocol
for all other datasources should be
XA_2PC. Alternately, a transaction
that accesses multiple datasources
for which the commit protocols are
optimistic is permitted.

[optimistic| pessimis-
tic | XA_2PC]

Choose only one of these protocols:

• Optimistic – enables connections to
be committed without regard for
other connections enlisted in the
transaction, assuming that the trans-
action is not marked for rollback and
will successfully commit on all re-
sources. Note: if a transaction ac-
cesses multiple data sources with
commit protocol of "optimistic",
atomicity is not guaranteed.

• Pessimistic – specifies that you do
not expect any multi-resource trans-
actions. An exception will be thrown
(and transaction rolled back) if any
attempt is made to use more than one
"pessimistic" data source in the
same transaction.

• XA_2PC – specifies use of the XA
two phase commit protocol. If you
are using two phase commit, then
the recovery log is stored in the
"tx_manager" data source, and that
data source (or the one it is aliased
to) must have the commit protocol of
"optimistic" or "pessimistic". All
other data sources for which atom-
icity must be ensured should have
the "XA_2PC" commit protocol.
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Name Description Supported values

Datasource Class Sets the class that implements the
JDBC datasource.

Use this property (along with the
driverClass property) only if you do
not have a predefined database-type
entry in Unwired Server for the kind
of SQL database you are connecting
to. For example, you must use this
property for MySQL database con-
nections.

You can implement a datasource
class to work with a distributed
transaction environment. Because
Unwired Server supports distributed
transactions, some datasources may
require that a datasource class be
implemented for Unwired Server to
interact with it.

For two-phase transactions, use the
xaDataSourceClass connection
property instead.

<com.mydata-
source.jdbc.Driver>

Database Command Echo Echoes a database command to both
the console window and the server
log file.

Use this property to immediately see
and record the status or outcome of
database commands.

When you enable this property, Un-
wired Server echoes every SQL
query to ml.log, which may help

you debug your application.

[true|false]

Set a value of 1 to echo the database
commands like databaseStart-
Command, and databaseStop-
Command.

Otherwise, do not set this property, or
use a value of 0 to disable the echo.
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Name Description Supported values

Database Create Com-
mand

Specifies the operating system com-
mand used to create the database for
this datasource. If this command is
defined and the file referenced by $
{databaseFile} does not exist, the
command is run to create the data-
base when an application compo-
nent attempts to obtain the first con-
nection from the connection pool for
this datasource.

<command>

Example: <UnwiredPlat-
form_InstallDir>\Serv-
ers\SQLAny-
where11\BIN32\dbinit -q
${databaseFile}

Database File Indicates the database file to load
when connecting to a datasource.

Use this property when the path to
the database file differs from the one
normally used by the database serv-
er.

If the database you want to connect
to is already running, use the data-
baseName connection parameter.

<string>

Supply a complete path and file name.
The database file you specify must be on
the same host as the server.
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Name Description Supported values

Database Name Identifies a loaded database with
which to establish a connection,
when connecting to a datasource.

Set a database name, so you can re-
fer to the database by name in other
property definitions for a data-
source.

If the database to connect to is not
already running, use the database-
File connection parameter so the da-
tabase can be started.

Note: For Unwired Server, you typ-
ically do not need to use this prop-
erty. Usually, when you start a data-
base on a server, the database is as-
signed a name. The mechanism by
which this occurs varies. An admin-
istrator can use the DBN option to
set a unique name, or the server may
use the base of the file name with the
extension and path removed.

[DBN|default]

If you set this property to default, the
name is obtained from the DBN option
set by the database administrator.

If no value is used, the database name is
inherited from the database type.

Database Start Command Specifies the operating system com-
mand used to start the database for
this datasource. If this command is
defined and the database is not run-
ning, the command is run to start the
database when the datasource is ac-
tivated.

<command>

Example: <UnwiredPlat-
form_InstallDir>\Serv-
ers\SQLAny-
where11\BIN32\dbsrvXX.e
xe

Database Stop Command Specifies the operating system com-
mand used to stop the database for
this datasource. If this property is
defined and the database is running,
this command executes during shut-
down.

<command>

For a Adaptive Server® Anywhere da-
tabase, where the user name and pass-
word are the defaults (dba and sql), en-
ter:

<UnwiredPlatform_In-
stallDir>\Servers\SQLA-
ny-
where11\BIN32\dbsrvXX.e
xe
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Name Description Supported values

Database Type Specifies the database type. <database type>

Database URL Sets the JDBC URL for connecting
to the database if the datasource re-
quires an Internet connection.

Typically, the server attempts to
construct the database URL from
the various connection properties
you specify (for example, portNum-
ber, databaseName). However, be-
cause some drivers require a special
or unique URL syntax, this property
allows you to override the server de-
faults and instead provide explicit
values for this URL.

<JDBCurl>

The database URL is JDBC driver ven-
dor-specific. For details, refer to the
driver vendor's JDBC documentation.

Driver Class Sets the name of the class that im-
plements the JDBC driver.

Use this property (along with the
dataSourceClass property) only if
you do not have a predefined data-
base-type entry in Unwired Server
for the kind of SQL database you are
connecting to. For example,
MySQL database connections re-
quire you to use this connection
property.

To create a connection to a database
system, you must use the compatible
JDBC driver classes. Sybase does
not provide these classes; you must
obtain them from the database man-
ufacturer.

<Class.for-
Name("foo.bar.Driver")>

Replace <Class.forName("foo.bar.Driv-
er")> with the name of your driver.

Driver Debug Enables debugging for the driver. [true|false]

Set to true to enable debugging, or false
to disable.

Driver Debug Settings Configures debug settings for the
driver debugger.

[default|<setting>]

The default is STATIC:ALL.
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Name Description Supported values

Initial Pool Size Sets the initial number of connec-
tions in the pool for a datasource.

In general, holding a connection
causes a less dramatic performance
impact than creating a new connec-
tion. Keep your pool size large
enough for the number of concurrent
requests you have; ideally, your con-
nection pool size should ensure that
you never run out of available con-
nections.

The initialPoolSize value is applied
to the next time you start Unwired
Server.

<int>

Replace <int> with an integer to preal-
locate and open the specified number of
connections at start-up. The default is 0.

Sybase suggests that you start with 0,
and create additional connections as
necessary. The value you choose allows
you to create additional connections be-
fore client synchronization requires the
server to create them.

Is Download Zipped Specifies whether the driver file
downloaded from jdbcDriverDown-
loadURL is in .ZIP format.

This property is ignored if the value
of jdbcDriverDownloadURL con-
nection is an empty string.

[True|False]

The default is false. The file is copied,
but not zipped to <UnwiredPlat-
form-install>\lib\jdbc.

Set isDownloadZipped to true to save
the file to <UnwiredPlatform-
install>\lib\jdbc and unzip

the archived copy.

JDBC Driver Download
URL

Specifies the URL from which you
can download a database driver.

Use this property with isDownload-
Zipped to put the driver in an archive
file before the download starts.

<URL>

Replace <URL> with the URL from
which the driver can be downloaded.
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Name Description Supported values

Language For those interfaces that support lo-
calization, this property specifies
the language to use when connect-
ing to your target database. When
you specify a value for this property,
Unwired Server:

• Allocates a CS_LOCALE struc-
ture for this connection

• Sets the CS_SYB_LANG value
to the language you specify

• Sets the Microsoft SQL Server
CS_LOC_PROP connection
property with the new locale in-
formation

Unwired Server can access Unicode
data in an Adaptive Server® 12.5 or
later, or in Unicode columns in
Adaptive Server 12.5 or later. Un-
wired Server automatically converts
between double-byte character set
(DBCS) data and Unicode, provided
that the Language and CodeSet pa-
rameters are set with DBCS values.

<language>

Replace <language> with the language
being used.

Max Idle Time Specifies the number of seconds an
idle connection remains in the pool
before it is dropped.

<int>

If the value is 0, idle connections remain
in the pool until the server shuts down.
The default is 60.
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Name Description Supported values

Max Pool Size Sets the maximum number of con-
nections allocated to the pool for this
datasource.

Increase the maxPoolSize property
value when you have a large user
base. To determine whether a value
is high enough, look for Resource-
MonitorTimeoutException excep-
tions in <hostname>-serv-
er.log. Continue increasing the

value, until this exception no longer
occurs.

To further reduce the likelihood of
deadlocks, configure a higher value
for maxWaitTime.

To control the range of the pool size,
use this property with minPoolSize.

<int>

A value of 0 sets no limit to the maxi-
mum connection pool size.

Max Wait Time Sets the maximum number of sec-
onds to wait for a connection before
the request is cancelled.

<int>

The default is 60.

Max Statements Specifies the maximum number of
JDBC prepared statements that can
be cached for each connection by the
JDBC driver. The value of this prop-
erty is specific to each JDBC driver.

<int>

A value of 0 (default) sets no limit to the
maximum statements.

Min Pool Size Sets the minimum number of con-
nections allocated to the pool for this
datasource.

<int>

A value of 0 (default) sets no limit to the
minimum connection pool size.
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Name Description Supported values

Network Protocol Sets the protocol used for network
communication with the datasource.

Use this property (along with the
driverClass, and dataSourceClass
properties) only if you do not have a
predefined database-type entry in
Unwired Server for the kind of SQL
database you are connecting to. For
example, you may be required to use
this property for MySQL database
connections.

The network protocol is JDBC driver
vendor-specific. There are no predefined
values.

See the driver vendor's JDBC documen-
tation.

Password Specifies the password for connect-
ing to the database.

[default|<password>]

Ping and Set Session Auth Runs the ping and session-authori-
zation commands in a single com-
mand batch; may improve perform-
ance. You can only enable the Ping
and Set Session Auth property if you
have enabled the Set Session Auth
property so database work runs un-
der the effective user ID of the client.

[True|False]

Set to true to enable, or false to disable.

Ping Connections Pings connections before attempt-
ing to reuse them from the connec-
tion pool.

[True|False]

Set to true to enable ping connections, or
false to disable.

Ping SQL Specify the SQL statement to use
when testing the database connec-
tion with ping.

[default|<statement>]

Replace <statement> with the SQL
statement identifier. The default is "se-
lect 1".

Port Number Sets the server port number where
the database server listens for con-
nection requests.

[default|<port>]

Replace <port> with the TCP/IP port
number to use (that is, 1 – 65535).

If you set the value as default, the default
protocol of the datasource is used.
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Name Description Supported values

PS Maximum Blob
Length

Indicates the maximum number of
bytes allowed when updating a
BLOB datatype using Prepared-
Statement.setBytes.

[default|<int>]

Replace <int> with the number of bytes
allowed during an update. The default is
16384.

PS Maximum Clob
Length

Indicates the maximum number of
characters allowed when updating a
CLOB datatype using Prepared-
Statement.setString.

[default|<int>]

Replace <int> with the number of bytes
allowed during an update. The default is
16384.

Role Name Sets the database role that the user
must have to log in to the database.

[default|<name>]

If you set this value to default, the de-
fault database role name of the data-
source is used.

Server Name Defines the host where the database
server is running.

<name>

Replace <name> with an appropriate
name for the server.

Service Name Defines the service name for the da-
tasource.

For SQL Anywhere servers, use this
property to specify the database you
are attaching to.

<name>

Replace <name> with an appropriate
name for the service.

Set Session Auth Establishes an effective database
identity that matches the current
mobile application user.

If you use this property, you must
also use setSessionAuthSystemID
to set the session ID.

Alternately you can pingAndSet-
SessionAuth if you are using this
property with pingConnection. The
pingAndSetSessionAuth property
runs the ping and session-authoriza-
tion commands in a single command
batch, which may improve perform-
ance.

[true|false]

Choose a value of 1 to use an ANSI SQL
set session authorization command at
the start of each database transaction.
Set to 0 to use session-based authoriza-
tions.
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Name Description Supported values

Set Session Auth System
ID

If Set Session Authorization is ena-
bled, specifies the database identity
to use when the application server
accesses the database from a trans-
action that runs with "system" iden-
tity.

<database identity>

Replace <database identity> with the
database identifier.

Start Wait Sets the wait time (in seconds) be-
fore a connection problem is repor-
ted. If the start command completes
successfully within this time period,
no exceptions are reported in the
server log.

startWait time is used only with the
databaseStartCommand property.

<int>

Replace <int> with the number of sec-
onds Unwired Server waits before re-
porting an error.

Truncate Nanoseconds Sets a divisor/multiplier that is used
to round the nanoseconds value in a
java.sql.Timestamp to a granularity
that the DBMS supports.

[default|<int>]

The default is 10 000 000.

Use Quoted Identifiers Specifies whether or not SQL iden-
tifiers are quoted.

[True|False]

Set to true to enable use of quoted iden-
tifiers, or false to disable.

User Identifies the user who is connecting
to the database.

[default|<user name>]

Replace <user name> with the database
user name.

XA Datasource Class Specifies the class name or library
name used to support two-phase
commit transactions, and the name
of the XA resource library.

<class name>

Replace <class name> with the class or
library name.

• SQL Anywhere database:
com.syb-
ase.jdbc3.jdbc.SybXA-
DataSource

• Oracle database: ora-
cle.jdbc.xa.client.Or-
acleXADataSource
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SAP Java Connector Properties
Configure SAP Java Connector (JCo) connection properties.

For a comprehensive list of SAP JCo properties you can use to create an instance of a client
connection to a remote SAP system, see http://help.sap.com/javadocs/NW04/current/jc/com/
sap/mw/jco/JCO.html#createClient(java.util.Properties).

Table 8. General connection parameters

Name Description Supported values

Client Number Specifies the SAP client. Three-digit client number; preserve
leading zeros if they appear in the num-
ber

Logon User Specifies the login user ID. User name for logging in to the SAP
system

If using X.509 certificate authentica-
tion, remove the JCo properties
jco.client.passwd and

jco.client.user  defined for

the SAP connection profile in Sybase
Control Center (SCC).

Password Specifies the login password. Password for logging in to the SAP sys-
tem

Language Specifies a login language. ISO two-character language code (for
example, EN, DE, FR), or SAP-specific
single-character language code. As a
result, only the first two characters are
ever used, even if a longer string is en-
tered. The default is EN.

System Number Indicates the SAP system number. SAP system number

Host Name Identifies the SAP application server. Host name of a specific SAP application
server

Message Server Identifies the SAP message server. Host name of the message server

Gateway Host Identifies the SAP gateway host. Host name of the SAP gateway

Example: GWHOST=hs0311
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Name Description Supported values

Gateway Service Identifies the SAP gateway service. Service name of the SAP gateway

Example: GWSERV=sapgw53

R/3 Name Specifies R/3 name. Name of the SAP system

Server Group Identifies the group of SAP applica-
tion servers.

Group name of the application servers

External Server Program Identifies the program ID of the ex-
ternal server program.

Path and name of the external RFC
server program, or program ID of a reg-
istered RFC server program

Example: TPNAME=/sap/
srfcserv

External Server Program
Host

Identifies the host of the external
server program. This information de-
termines whether the RFC client con-
nects to an RFC server started by the
SAP gateway or to an already regis-
tered RFC server.

Note: If the gateway host and external
server program host are different,
make sure that the SAP gateway has
access to start the server program
through a remote shell.

Host name of the external RFC server
program

Example: TPHOST=hs0311

Remote Host Type Identifies the type of remote host. 2: R/2

3: R/3

E: external

RFC Trace Specifies whether or not to enable
RFC trace.

0: disable

1: enable

Initial Codepage Identifies the initial code page in SAP
notation.

A code page is used whenever char-
acter data is processed on the appli-
cation server, appears on the front
end, or is rendered by a printer.

Four-digit SAP code page number
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Name Description Supported values

Enable ABAP Debugging Enables or disables ABAP debug-
ging. If enabled, the connection is
opened in debug mode and the in-
voked function module can be step-
ped through in the debugger.

For debugging, an SAP graphical user
interface (SAPGUI) must be installed
on the same machine the client pro-
gram is running on. This can be either
a normal Windows SAPGUI or a Java
GUI on Linux/UNIX systems.

0: no debugging

1: attach a visible SAPGUI and break at
the first ABAP statement of the invoked
function module

Remote GUI Specifies whether a remote SAP
graphical user interface (SAPGUI)
should be attached to the connection.
Some older BAPIs need an SAPGUI
because they try to send screen output
to the client while executing.

0: no SAPGUI

1: attach an "invisible" SAPGUI, which
receives and ignores the screen output

2: attach a visible SAPGUI

For values other than 0 a SAPGUI needs
to be installed on the machine, where
the client program is running. This can
be either a Windows SAPGUI or a Java
GUI on Linux/Unix systems.

Get SSO Ticket Generates an SSO2 ticket for the user
after login to allow single sign-on. If
RfcOpenConnection() succeeds, you
can retrieve the ticket with RfcGet-
PartnerSSOTicket() and use it for ad-
ditional logins to systems supporting
the same user base.

0: do not generate SSO2 ticket

1: generate SSO2 ticket

Use Cookie Version 2 Indicates whether or not to use the
specified SAP Cookie Version 2
(SSO2) as the login ticket instead of
user ID and password.

User: $MYSAPSSO2$

Password: Base64-encoded ticket

Login with single sign-on is based on
secure network connection (SNC) en-
cryption and can only be used in com-
bination with an SNC.
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Name Description Supported values

Use X509 Indicates whether or not to use the
specified X509 certificate as the login
certificate instead of user ID and
password.

User: $X509CERT$

Password: Base64-encoded ticket

Login with X509 is based on secure
network connection (SNC) encryption
and can only be used in combination
with an SNC.

Logon Check Enables or disables login check at
open time.

0: disable

1: enable

If you set this to 0, RfcOpenConnec-
tion() opens a network connection, but
does not perform the login procedure.
Therefore, no user session is created in-
side the back-end system. This param-
eter is intended only for executing the
function module RFC_PING.

Additional GUI Data Provides additional data for graphical
user interface (GUI) to specify the
SAProuter connection data for the
SAPGUI when it is used with RFC.

/H/ router string : the entire

router string for the SAPGUI

/P/ password : specify this value if

the password for the SAPGUI connec-
tion is not the same as the password for
the RFC connection.

GUI Redirect Host Identifies which host to redirect the
remote graphical user interface to.

Host name

GUI Redirect Service Identifies which service to redirect
the remote graphical user interface to.

Name of the service

Remote GUI Start Pro-
gram

Indicates the program ID of the server
that starts the remote graphical user
interface.

Program ID of the server

SNC Mode Enables or disables secure network
connection mode.

0: off

1: on

SNC Partner Identifies the secure network connec-
tion partner.

Secure network connection name of the
application server (for example,
p:CN=R3, O=XYZ-INC, C=EN)
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Name Description Supported values

SNC Level Specifies the secure network connec-
tion security level.

1: digital signature

2: digital signature and encryption

3: digital signature, encryption, and user
authentication

8: default value defined by backend
system

9: maximum value that the current se-
curity product supports

SNC Name Indicates the secure network connec-
tion name. This property overrides
the default secure network connec-
tion partner.

Token or identifier representing the ex-
ternal RFC program

SNC Service Lib Path Identifies the path to the SAP crytpo-
graphic library that provides secure
network connection service.

Full path and name of third-party secur-
ity library. You must download and in-
stall the library from the SAP Service
Marketplace.

R/2 Destination Identifies a configured R/2 system
defined in the sideinfo configuration.

Logon ID Defines the string for SAPLOGON
on 32-bit Windows.

String key to read parameters from the
saplogon.ini file created by the SAPLo-
gon GUI program on Windows

External Authentication
Data

Provides data for external authentica-
tion (PAS). This is an old login mech-
anism similar to SSO; Sybase recom-
mends that you do not use this ap-
proach.

External Authentication Specifies type of external authentica-
tion (PAS). See External Authentica-
tion Data property.

SAP DOE-C Properties
Configure SAP Data Orchestration Engine Connector (DOE-C) properties. This type of
connection is available in the list of connection templates only when you deploy a DOE-C
package. No template exists for these types of connections.

Note: If you change the username or password property of a DOE-C connection, you must
reopen the same dialog and click Test Connection after saving. Otherwise the error state
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of this DOE-C package is not set properly, and an error message is displayed. This will not
work if you click Test Connection before saving the properties.

Name Description Supported values

Username Specifies the SAP user account ID. The
SAP user account is used during inter-
action between the connected SAP sys-
tem and client for certain administra-
tive activities, such as sending ac-
knowledgment messages during day-
to-day operations or "unsubscribe"
messages if a subscription for this con-
nection is removed.

This account is not used for messages
containing business data; those types
of messages are always sent within the
context of a session authenticated with
credentials provided by the mobile cli-
ent.

The technical user name and password
or certificateAlias must be set to per-
form actions on subscriptions. The cer-
tificateAlias is mutually exclusive with
and overrides the technical user name
and password fields if set. The techni-
cal user name and password fields can
be empty, but only if certifica-
teAlias is set.

Valid SAP login name for the DOE
host system.

Password Specifies the password for the SAP
user account.

Valid password.

DOE SOAP
Timeout

Specifies a timeout window during
which unresponsive DOE requests are
aborted.

Positive value (in seconds).

The default is 420 (7 minutes).
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Name Description Supported values

DOE Extract
Window

Specifies the number of messages al-
lowed in the DOE extract window.

Positive value (in messages).

The default is 50.

When the number of messages in the
DOE extract window reaches 50% of
this value, DOE-C sends a Status-
ReqFromClient message, to ad-

vise the SAP DOE system of the cli-
ent's messaging status and acknowl-
edge the server's state. The default val-
ue is 50.

Packet Drop Size Specifies the size, in bytes, of the larg-
est JavaScript Object Notation (JSON)
message that the DOE connector pro-
cesses on behalf of a JSON client.

The packet drop threshold size should
be carefully chosen, so that it is larger
than the largest message sent from the
DOE to the client, but smaller than the
maximum message size which may be
processed by the client.

Positive value (in bytes).

The default is 1048576 bytes (1MB).

Do not set lower than 4096 bytes; there
is no maximum limitation.

Service Address Specifies the DOE URL. Valid DOE URL.

If you are using DOE-C with SSO:

• Modify the port from the standard
http://host:8000 to

https://host:8001/.

• Add the certificate being used as
the technical user and DOE-C end-
point security profile certificate to
the SAP DOE system's SSL Server
certificate list by using the
STRUST transaction. See your
SAP documentation for details.

Listener URL Specifies the DOE-C server listener
URL.

Valid DOE-C listener URL, for exam-
ple http://<sup_host-
name>:8000/doe/publish.

Administer

Sybase Control Center for Sybase Unwired Platform 129



Name Description Supported values

SAP Technical
User Certificate
Alias

Sets the alias for the Unwired Platform
keystore entry that contains the X.509
certificate for Unwired Server's SSL
peer identity.

If you do not set a value, mutual au-
thentication for SSL is not used when
connecting to the Web service.

If you are using DOE-C with SSO use
the "SAP Technical User Certificate
Alias" only for configurations which
require the technical user to identify
itself using an X.509 certificate; it
specifies the Certificate Alias to be
used as the technical user. This over-
rides the "Username" and "Password"
settings normally used.

Valid certificate alias.

Login Required Indicates whether authentication cre-
dentials are required to login. The de-
fault value is true.

For upgraded packages, "login-re-
quired=false" gets converted to "login-
required=true" and a No-Auth security
configuration "DOECNoAuth" is as-
signed to the upgraded package.

A read-only property with a value of
true.

Web Services Properties
Configure connection properties for the Simple Object Access Protocol (SOAP) and
Representational State Transfer (REST) architectures.

Name Description Supported values

Password Specifies the password for HTTP basic
authentication, if applicable.

Password

Address Specifies a different URL than the port
address indicated in the WSDL docu-
ment at design time.

HTTP URL address of the Web service

User Specifies the user name for HTTP ba-
sic authentication, if applicable.

User name
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Name Description Supported values

Certificate Alias Sets the alias for the Unwired Platform
keystore entry that contains the X.509
certificate for Unwired Server's SSL
peer identity.

If you do not set a value, mutual au-
thentication for SSL is not used when
connecting to the Web service.

Use the alias of a certificate stored in
the Unwired Server certificate key-
store.

Proxy Properties
(Applies only to Online Data Proxy) Proxy properties identify the application endpoint and
the pool size.

Name Description Supported values

User Not currently used

Certificate Alias Not currently used

Address Corresponds to the Application end-
point provided at the time of register-
ing an application.

Must be a valid application end-point.

Pool Size Determines the maximum number of
connections allocated to the pool for
this datasource.

The default value set for the pool size is
25.

Password Not currently used

Note: When the application end-point for a registered application is modified under the
Applications node, you have to manually update the Address in the proxy properties of the
connection pool.

Configuring Domain Security
Configure security for an individual domain to meet the customer's security requirements.

Prerequisites
Before mapping and assigning administrator roles, ensure that you have set the Unwired
Platform administration and user roles and passwords required for Sybase Control Center
administrator login. See Enabling Authentication and RBAC for Administrator Logins.

Task

Perform steps to appropriately configure domain security settings.
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Choosing a Security Configuration
Select a security configuration that designates authentication, authorization, attribution, and
audit security providers for the packages in the domain. You can assign as many security
configurations as needed to a domain.

Only super administrators have privileges to create security configurations. Domain
administrators can view a security configuration only after a super administrator has assigned
it to the domain.

1. In the left navigation pane, navigate to Cluster > Domains > <DomainName> >
Security.

2. In the right administration pane, select the Security Configurations tab and click
Assign.
The Assign Security Configurations dialog appears.

3. Select one or more security configurations to assign to the domain by checking the box
adjacent to the configuration name.

4. Click OK.
A message appears above the right administration pane menu indicating the success or
failure of the assignment. If successful, the new security configuration appears in the list of
security configurations.

5. To remove a security configuration, check the box adjacent to the configuration name and
click Unassign. If a security configuration is mapped to one or more MBO packages, it can
not be removed.

Assigning Domain Administrators to a Domain
Assign domain administration privileges to a domain administrator. You must be a platform
administrator to assign and unassign domain administrators.

Prerequisites
Ensure the user is already registered as a domain administrator in the Domain Administrators
tab.

Task

1. In the left navigation pane, expand the Domains folder, and select the domain for which to
assign domain administration privileges.

2. Select the domain-level Security folder.

3. In the right administration pane, select the Domain Administrators tab, and click
Assign.

4. Select one or more administrator users to assign to the domain by checking the box
adjacent to the user name.
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5. Click OK.
A message appears above the right administration pane menu indicating the success or
failure of the assignment. If successful, the new domain administrator appears in the list of
users.

Mapping Roles
Configure role mapping to authorize client requests to access MBOs and operations. For each
security configuration, platform and domain administrators can manage logical role mappings
at the package level or at a domain level. Use the corresponding domain or package node in the
left navigation pane to configure role mappings accordingly.

Set an appropriate mapping state for each logical role. The state you choose allows you to
disable logical roles, allow logical roles to be automatically mapped, or manually define
which logical roles are mapped to one or more physical roles. The states of AUTO or NONE
require the least administration.

If a developer has defined a logical role, mapping is not required; the logical role is matched to
the physical role of the same name and is therefore automatically mapped.

Note: Changes to domain-level role mapping are applied to all domains that share the same
security configuration. Likewise, changes to package-level role mapping apply to all instances
of the affected package that use the same security configuration, even if the package is
deployed in multiple domains.

Setting the Mapping State
Map roles for a package by setting the mapping state. Mapping behavior is determined by the
state that exists for the logical role. You can select AUTO or NONE; a third state, MAPPED, is
set automatically after you manually map a physical role to the selected logical role.

You can set the mapping state either when managing roles, or earlier, during package
deployment. If your logical roles for a package do not automatically match the role names
registered in the back-end security system, map corresponding logical and physical names to
ensure that users can be authorized correctly.

1. For package-specific role mapping, select and deploy an available package. Follow the
wizard prompts until you reach the Configure Role Mapping page for the target package.

2. Change the mapping for a logical role, if required:

• To change the state to either NONE or AUTO, click the list adjacent to the logical role
and click the appropriate option.

• To change the role mapping itself, click the drop-down list adjacent to the logical role
and choose Map Role. This command displays the Role Mappings dialog that allows
you to manually set the physical role mappings. The Role Mappings dialog displays
the name of the logical role you are mapping in the text area of the dialog. Once saved,
the state automatically changes to MAPPED.

3. Click Next.
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The Server Connection page appears.

Deployment-time role mapping is done at the package level. Once the package is deployed,
you can change the role mapping by going to the Role Mapping tab for the desired package.
You can also set the role mapping for each security configuration at the domain level. This
allows the role mapping to be shared across packages for the common logical roles. Changing
role mapping at the domain level will result in role mapping changes in other domains where
the same security configuration is referenced.

Mapping a Physical Role Manually
Use the Role Mappings dialog to manually map required physical roles for a logical role when
physical and logical role names do not match. If names do not match, the AUTO mapping state
does not work.

Prerequisites
Unwired Platform cannot query all supported enterprise security servers directly; for
successful authentication, you must know the physical roles your back-end systems require.

Task

You can map a logical role to one or more physical roles. You can also map multiple logical
roles to the same physical role. If a role does not exist, you can also add or delete names as
needed.

1. Review the list of existing physical role names that you can map to the logical role you
have selected.

2. If a role that you require does not appear, enter the Role name and click the +  button.
The role name appears in the Available roles list with an asterisk (*). This asterisk
indicates that an available role was added by an administrator, not a developer.

3. To remove a role you no longer require from the Available roles list, select the name and
click the x button adjacent to the Role name field.
The role is removed and can no longer be mapped to a logical role.

4. To map a logical role that appears in the text area of the Role Mappings dialog to a physical
role:

a) Select one or more Available roles.
b) Click Add.

5. To unmap a role:

a) Select one or more Mapped roles.
b) Click Remove.

The roles are returned to the Available roles list.

6. Click OK to save these changes.
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Once a logical role has been manually mapped, the mapping state changes to MAPPED. The
roles you have mapped appear in the active Physical Roles cell for either a package-specific or
server-wide role mappings table.

Mapping State Reference
The mapping state determines the authorization behavior for a logical name instance.

State Description

AUTO Map the logical role to a physical role of the same name. The logical
role and the physical role must match, otherwise, authorization fails.

NONE Disable the logical role, which means that the logical role is not au-
thorized. This mapping state prohibits anyone from accessing the
resource (MBO or Operation). Carefully consider potential conse-
quences before using this option.

MAPPED A state that is applied after you have actively mapped the logical role
to one or more physical roles. Click the cell adjacent to the logical role
name and scroll to the bottom of the list to see the list of mapped
physical roles.

Security Configurations
Sybase Unwired Platform does not provide proprietary security systems for storing and
maintaining users and access control rules, but delegates these functions to the enterprise’s
existing security solutions.

A security configuration determines the scope of user identity, performs authentication and
authorization checks, and can be assigned multiple levels (domain or package). Applications
inherit a security configuration when the administrator assigns the application to a domain via
a connection template.

Users can be authenticated differently, depending on which security configuration is used. For
example, a user identified as "John" may be authenticated different ways, depending on the
named security configuration protecting the resource he is accessing: it could be an MBO
package, a DCN request, use of Sybase Control Center .

Security configurations aggregate various security mechanisms for protecting Unwired
Platform resources under a specific name, which administrators can then assign. Each security
configuration consists of:

• A set of configured security providers. Security provider plug-ins for many common
security solutions are included with the Sybase Unwired Platform.

• Role mappings (which are set at the domain and package level) that map logical roles to
back end physical roles.

A user entry must be stored in the security repository used by the configured security provider
to access any resources (that is, either a Sybase Control Center administration feature or an
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application package that accesses data sets from a back-end data source). When a user
attempts to access a particular resource, Unwired Server tries to authenticate and authorize the
user, by checking the security repository for:

• Security access policies on the requested resource
• Role memberships

Creating a Security Configuration
Create and name a set of security providers and physical security roles to protect Unwired
Platform resources.

Only platform administrators can create security configurations. Domain administrators can
only view after the platform administrator creates and assigns them to a domain.

1. In the left navigation pane, expand the Security folder.

2. In the right administration pane, click New.

3. Enter a name for the security configuration and click OK.

4. In the left navigation pane, under Security, select the new security configuration.

5. In the right administration pane, select the Settings tab.

The Authentication cache timeout determines how long authentication results should be
cached before a user is required to reauthenticate. For details, see Authentication Cache
Timeouts in Security. To configure this value:

a) Set the cache timeout value in seconds. The default is 3600.

The Maximum allowed authentication failure determines the maximum number of
login attempts after which the user is locked. To configure this value:

a) Set the maximum count for authentication failure.

The Authentication lock duration determines how long the user is locked after the
maximum login attempts is reached . To configure this value:

a) Set the authentication lock duration in seconds.

6. Click Save.

7. Select the tab corresponding to the type of security provider you want to configure:
Authentication, Authorization, or Audit.

8. To edit the properties of a preexisting security provider in the configuration:

a) Select the provider, and click Properties.
b) Configure the properties associated with the provider by setting values according to

your security requirements. Add properties as required. For more information about
configuring security provider properties, see the individual reference topics for each
provider.

c) Click Save.

9. To add a new security provider to the configuration:
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a) Click New.
b) Select the provider you want to add.
c) Configure the properties associated with the provider by setting values according to

your security requirements. Add properties as required. For more information about
configuring security provider properties, see the individual reference topics for each
provider.

d) Click OK.
The configuration is saved locally, but not yet committed to the server.

10. Select the General tab, and click Validate to confirm that Unwired Server accepts the new
security configuration.
A message indicating the success of the validation appears above the menu bar.

11. Click Apply to save changes to the security configuration, and apply them across Unwired
Server.
A message indicating the success of the application appears above the menu bar.

Security Providers
Different security providers give Unwired Server security features that include authentication,
and authorization capabilities.

Configure security providers for Unwired Server by logging in to the server in Sybase Control
Center and clicking Security > Configuration. Configuring these providers writes changes to
the Unwired Server configuration properties file.

For third-party providers, save related JAR files or DLLs in the
<UnwiredPlatform_InstallDir>\UnwiredPlatform\Servers
\UnwiredServer\lib\ext folder.

• Authentication modules – verify the identity of a user accessing a network with the mobile
application, typically via a login form or some other login or validation mechanism.
Authentication in Unwired Server is distinct from authorization. You must have at least
one authentication module configured in a production deployment of Unwired Server. You
can stack multiple providers so users are authenticated in a particular sequence.

• Authorization modules – check the access privileges for an authenticated identity. Sybase
recommends that you have at least one authorization module configured in a production
deployment of Unwired Server.

• Auditing modules – report all audit events to allow you to evaluate the security system
implementation for Unwired Server. Auditing provides you a record of all the security
decisions that have been made. Each successful authentication creates a session key that
shows up in subsequent security checks for that user. Unsuccessful authentications are also
logged. Each authorization records what roles were checked, or what resource was
accessed. Audit filters determine what events get recorded, the audit format determines
what the audit records look like, and the audit destination specifies where audit records are
sent. Use the audit trail to identify who did what and when, with respect to objects secured
by your providers. Auditing modules are optional.
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In most cases, each security module requires a unique set of configuration properties.
However, there are some cases when modules require a common set of properties, and these
properties are configured once for each module on a tab created for that purpose.

You can configure different security providers for administrator authenticaton and device user
authentication. For more information on configuring security providers depending on the type
of user, see either Enabling Authentication and RBAC for User Logins or Enabling
Authentication and RBAC for Administrator Logins in the Security guide.

Stacking Providers and Combining Authentication Results
(Not applicable to Online Data Proxy) Implement multiple LoginModule to provide a security
solution that meets complex security requirements.

Each provider has a controlFlag attribute that controls overall behavior when you enable
multiple providers. Set the controlFlag to refine how results are processed.

1. Use Sybase Control Center to create a security configuration and add multiple providers as
required for authentication.

2. Order multiple providers by selecting a LoginModule and using the up or down arrows at
to place the provider correctly in the list.

The order of the list determines the order in which authentication results are evaluated.

3. For each provider:

a) Select the provider name.
b) Click Properties.
c) Configure the controlFlag property with one of the available values: required,

requisite, sufficient, optional.

See controlFlag Attribute Values for descriptions of each available value.
d) Configure any other common security properties as required.

4. Click Save.

5. Select the General tab, and click Apply.

For example, say you have sorted these login modules in this order and used these controlFlag
values:

• LDAP (required)
• NT Login (sufficient)
• SSO Token (requisite)
• Certificate (optional)

The results are processed as indicated in this table:
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Pro-
vider

Authentication Status

LDAP pass pass pass pass fail fail fail fail

NT Log-
in

pass fail fail fail pass fail fail fail

SSO To-
ken

* pass pass fail * pass pass fail

Certifi-
cate

* pass fail * * pass fail *

Overall
result

pass pass pass fail fail fail fail fail

Stacking LoginModules in SSO Configurations
(Not applicable to Online Data Proxy) Use LoginModule stacking to enable role-based
authorization for MBOs and data change notifications (DCNs).

controlFlag Attribute Values
(Not applicable to Online Data Proxy) The Sybase implementation uses the same controlFlag
values and definitions as those defined in the JAAS specification.

If you stack multiple providers, you must set the controlFlag attribute for each enabled
provider.

Control Flag Value Description

(Default) required The LoginModule is required. Authentication proceeds down the Log-
inModule list.

requisite The LoginModule is required. Subsequent behavior depends on the
authentication result:

• If authentication succeeds, authentication continues down the
LoginModule list.

• If authentication fails, control returns immediately to the applica-
tion (authentication does not proceed down the LoginModule list).
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Control Flag Value Description

sufficient The LoginModule is not required. Subsequent behavior depends on the
authentication result:

• If authentication succeeds, control returns immediately to the ap-
plication (authentication does not proceed down the LoginModule
list).

• If authentication fails, authentication continues down the Logi-
nModule list.

optional The LoginModule is not required. Irrespective of success or failure,
authentication proceeds down the LoginModule list.

Example

Providers are listed in this order and with these controlFlag:

1. CertificateAuthenticationLoginModule (sufficient)
2. LDAP (optional)
3. NativeOS (sufficient)

A client doing certificate authentication (for example, X.509 SSO to SAP) can authenticate
immediately. Subsequent modules are not called, because they are not required. If there are
regular username/password credentials, they go to LDAP, which may authenticate them, and
set them up with roles from the LDAP groups they belong to. Then NativeOS is invoked, and if
that also succeeds, Unwired Platform picks up roles based on the Windows groups they are
in.

LDAP Login and Authorization Modules
LDAP login and authorization modules can sometimes share a common configuration.
However, authorizers do not inherit configuration from login modules you configure.
Configurations must be explicit.

In the case where both LDAPLoginModule and LDAPAuthorizer are configured:

• Matching configuration – LDAPAuthorizer simply skips the role retrieval.
• Differing configuration – LDAPAuthorizer proceeds with the role retrieval from the

configured backend, and performs the authorization checks using the complete list of roles
(from both the login module and itself). Even in the case where multiple
LDAPLoginModules are configured, only one LDAPAuthorizer is required as it compares
its configuration with the configuration used for the successful authentication of the user.
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Reordering Configured Providers
List stacked security providers for a security configuration to identify them as primary or
auxiliary providers. Authentication, authorization, or attribution by provider take place in the
order in which the providers are listed.

1. In the left navigation pane, expand the Security folder.

2. Select the security configuration you want to administer.

3. In the right administration pane, select the tab corresponding to the type of security
provider you want to configure: Authentication, Authorization, Attribution, or Audit.

4. Select a provider from the list, then use the up and down arrows to the right of the table to
achieve the desired placement.

5. Click Save.

6. Select the General tab, and click Apply.
A notification message appears if a server restart is required for changes to take effect.

Security Provider Configuration Properties
Security providers implement different properties, depending on whether or not they support
authentication, authorization, audit, or attribution.

Platform administrators can configure application security properties in the Sybase Control
Center for Unwired Platform console. These properties are then transcribed to an XML file in
the <UnwiredPlatform_InstallDir>\Servers\UnwiredServer
\Repository\CSI\ directory. A new section is created for each provider you add.

NoSec Configuration Properties
A NoSec provider offers pass-through security for Unwired Server. In development
environments, you can apply a NoSec security provider for authentication, authorization, and
attribution modules. However, never use this provider in production environments — either
for administration, or device user authentication.

The NoSecLoginModule class provides open authentication services, the NoSecAuthorizer
class provides authorization services, and the NoSecAttributer provides attribution services.
However, you need to configure only authentication properties for a NoSec provider.

Table 9. Authentication properties

Property Default Value Description

useUsernameAsIdentity true If this option is set to true, the
user name supplied in the call-
back is set as the name of the
principal added to the subject.
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Property Default Value Description

identity nosec_identity The value of this configuration
option is used as the identity of
the user if either of these condi-
tions is met:

• No credentials were sup-
plied.

• The useUsernameAsIdenti-
ty option is set to false.

useFirstPass false If set to true, the login module
attempts to retrieve only the user
name and password from the
shared context. It never calls the
callback handler.

tryFirstPass false If set to true, the login module
first attempts to retrieve the user
name and password from the
shared context before attempt-
ing the callback handler.

clearPass false If set to true, the login module
clears the user name and pass-
word in the shared context when
calling either commit or abort.

storePass false If set to true, the login module
stores the user name and pass-
word in the shared context after
successfully authenticating.

No Security Provider
A NoSec provider offers pass-through security for Unwired Server, and is intended for use in
development environments or for deployments that require no security control. Do not use this
provider in production environments— either for administration, or device user
authentication.

If you use NoSec providers, all login attempts succeed, no matter what values are used for the
user name and password. Additionally, all role and control checks based on attributes also
succeed.

Sybase provides these classes to implement the NoSec provider:

• NoSecLoginModule – provides pass-through authentication services.
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• NoSecAttributer – provides pass-through attribution services.
• NoSecAuthorizer – provides pass-through authorization services.

Disabling Security with the NoSec Provider
Disable security using the NoSec provider.

1. In the left navigation pane, expand the Security folder.

2. In the right administration pane, click New.

3. Enter a name for the No Security configuration and click OK.

4. In the left navigation pane, under Security, select the new security configuration.

5. In the right administration pane, select com.sybase.security.core.NoSec<ModuleType>
as the security provider for authentication and attribution. Leave both the authorization
and audit security providers empty.

a) Select the tab corresponding to the appropriate security type.
b) Click New.
c) From the menu, select com.sybase.security.core.NoSec<ModuleType> .
d) Configure the properties associated with the provider by setting values according to

your requirements. Add properties as required. For more information about
configuring NoSec security provider properties, see the individual reference topic.

e) Click OK.

6. Select the General tab, and click Validate to confirm that Unwired Server accepts the new
security configuration.
A message indicating the success of the validation appears above the menu bar.

7. Click Apply to save changes to the security configuration, and apply them across Unwired
Server.
A message indicating the success of the application appears above the menu bar.

Next
Assign the newly created security configuration to the domain where the package that requires
no security is deployed.

LDAP Configuration Properties
(Not applicable to Online Data Proxy) Use these properties to configure the LDAP provider
used to authenticate SCC administration logins or to configure the LDAP provider used to
authenticate device application logins. If you are creating a provider for device application
logins, then Unwired Platform administrators use Sybase Control Center to write these
properties to the <UnwiredPlatform_InstallDir>\Servers\UnwiredServer
\Repository\CSI\default.xml file.

Unwired Server implements a Java LDAP provider through a common security interface used
by other Sybase products like Sybase Control Center.
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The Java LDAP provider consists of three provider modules, each of which is in the
com.sybase.security.ldap Java package. This is why the syntax used between
Sybase Control Center provider and Unwired Server varies.

• LDAPLoginModule– provides authentication services. Through appropriate
configuration, you can enable certificate authentication in LDAPLoginModule.

• (Optional)LDAPAuthorizer or RoleCheckAuthorizer – provide authorization services for
LDAPLoginModule. LDAPLoginModule works with either authorizer. In most production
deployments, you must always configure your own authorizer. However, if you are
authenticating against a service other than LDAP, but want to perform authorization
against LDAP, you can use the LDAPAuthorizer.
The RoleCheckAuthorizer is used with every security configuration but does not appear in
Sybase Control Center.
Use LDAPAuthorizer only when LDAPLoginModule is not used to perform authentication,
but roles are still required to perform authorization checks against the LDAP data store. If
you use LDAPAuthorizer, always explicitly configure properties; for it cannot share the
configuration options specified for the LDAPLoginModule.

Use this table to help you configure properties for one or more of the supported LDAP
providers. When configuring modules or general server properties in Sybase Control Center,
note that properties and values can vary, depending on which module or server type you
configure.

Property Default Value Description

ServerType None Optional. The type of LDAP server you are con-
necting to:

• sunone5 -- SunOne 5.x OR iPlanet 5.x

• msad2k -- Microsoft ActiveDirectory, Win-

dows 2000

• nsds4 -- Netscape Directory Server 4.x

• openldap -- OpenLDAP Directory Server

2.x

The value you choose establishes default values
for these other authentication properties:

• RoleFilter

• UserRoleMembership

• RoleMemberAttributes

• AuthenticationFilter

• DigestMD5Authentication

• UseUserAccountControl
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Property Default Value Description

ProviderURL ldap://local-
host:389

The URL used to connect to the LDAP server.
Without this URL configured, Unwired Server
cannot contact your server. Use the default value if
the server is:

• Located on the same machine as your product
that is enabled with the common security in-
frastructure.

• Configured to use the default port (389).

Otherwise, use this syntax for setting the value:

ldap://<hostname>:<port>

DefaultSearchBase None The LDAP search base that is used if no other
search base is specified for authentication, roles,
attribution and self registration:

1. dc=<domainname>,dc=<tld>

For example, a machine in sybase.com do-
main would have a search base of dc=syb-
ase,dc=com.

2. o=<company name>,c=<country
code>

For example, this might be o=Sybase,c=us for
a machine within the Sybase organization.

SecurityProtocol None The protocol to be used when connecting to the
LDAP server.

To use an encrypted protocol, use "ssl" instead
"ldaps" in the url.

Note: ActiveDirectory requires the SSL protocol
when setting the value for the password attribute.
This occurs when creating a user or updating the
password of an existing user.
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Property Default Value Description

AuthenticationMethod simple The authentication method to use for all authen-
tication requests into LDAP. Legal values are
generally the same as those of the java.naming.se-
curity.authentication JNDI property. Choose one
of:

• simple — For clear-text password authenti-
cation.

• DIGEST-MD5 — For more secure hashed
password authentication. This method re-
quires that the server use plain text password
storage and only works with JRE 1.4 or later.

AuthenticationFilter For most LDAP servers:
(&(uid={uid})
(object-
class=person))

or

For Active Directory
email lookups:
(&(userPrinci-
palName={uid})
(object-
class=user))
[ActiveDirec-
tory]

For Active Directory
Windows username
lookups: (&(sAMAc-
count-
Name={uid})
(object-
class=user))

The filter to use when looking up the user.

When performing a username based lookup, this
filter is used to determine the LDAP entry that
matches the supplied username.

The string "{uid}" in the filter is replaced with the
supplied username.
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Property Default Value Description

AuthenticationScope onelevel The authentication search scope. The supported
values for this are:

• onelevel

• subtree

If you do not specify a value or if you specify an
invalid value, the default value is used.

AuthenticationSearchBase none The search base used to authenticate users. If this
value is not specified, the LDAP DefaultSearch-
Base is used.

BindDN none The user DN to bind against when building the
initial LDAP connection.

In many cases, this user may need read permis-
sions on all user records. If you do not set a value,
anonymous binding is used. Anonymous binding
works on most servers without additional config-
uration.

However, the LDAP attributer may also use this
DN to create the users in the LDAP server. When
the self-registration feature is used, this user may
also need the requisite permissions to create a user
record. This behavior can occur if you do not set
useUserCredentialsToBind to true. In this case,

the LDAP attributer uses this DN to update the
user attributes.
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Property Default Value Description

BindPassword none BindPassword is the password for BindDN,
which is used to authenticate any user. BindDN
and BindPassword are used to separate the LDAP
connection into units.

The AuthenticationMethod property determines
the bind method used for this initial connection.

If you use an encrypted the password using the
CSI encryption utility, append .e to the property
name. For example:

CSI.loginModule.7.options.
BindPassword.e=1-AAAAEgQQOLL+LpX
JO8fO9T4SrQYRC9lRT1w5ePfdczQTDs
P8iACk9mDAbm3F3p5a1wXWKK8+NdJuk
nc7w2nw5aGJlyG3xQ==

RoleSearchBase none The search base used to retrieve lists of roles. If
this value is not specified, the LDAP Default-
SearchBase is used.

RoleFilter For SunONE/iPlanet:
(&(object-
class=ldapsu-
bentry) (ob-
jectclass=nsro-
ledefinition))

For Netscape Directory
Server: (object-
class=groupof-
names) (object-
class=groupofu-
niquenames))

For ActiveDirectory:
(object-
class=groupof-
names) (object-
class=group))

The role search filter. This filter should, when
combined with the role search base and role scope,
return a complete list of roles within the LDAP
server. There are several default values depending
on the chosen server type. If the server type is not
chosen or this property is not initialized, no roles
are available.
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Property Default Value Description

RoleMemberAttributes For Netscape Directory
Server: member,unique-
member

The role's member attributes defines a comma-
delimited list of attributes that roles may have that
define a list of DN's of people who are in the role.

These values are cross referenced with the active
user to determine the user's role list. One example
of the use of this property is when using LDAP
groups as placeholders for roles. This property
only has a default value when the Netscape server
type is chosen.

RoleNameAttribute cn The attribute for retrieved roles that is the com-
mon name of the role. If this value is "dn" it is
interpreted specially as the entire dn of the role as
the role name.

RoleScope onelevel The role search scope. The supported values for
this are:

• onelevel

• subtree

If you do not specify a value or if you specify an
invalid value, the default value is used.

UserRoleMembershipAt-
tributes

For iPlanet/SunONE:
nsRoleDN

For ActiveDirectory:
memberOf

For all others: none

The user's role membership attributes property is
used to define an attribute that a user has that
contains the DN's of all of the roles as user is a
member of.

These comma-delimited values are then cross-
referenced with the roles retrieved in the role
search base and search filter to come up with a list
of user's roles.

UserFreeformRoleMem-
bershipAttributes

None The "freeform" role membership attribute list.
Users who have attributes in this comma-delimi-
ted list are automatically granted access to roles
whose names are equal to the attribute value. For
example, if the value of this property is "depart-
ment" and user's LDAP record has the following
values for the department attribute, { "sales",
"consulting" }, then the user will be granted roles
whose names are "sales" and "consulting".
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Property Default Value Description

Referral ignore The behavior when a referral is encountered. The
valid values are those dictated by LdapContext,
for example, "follow", "ignore", "throw".

DigestMD5Authentication-
Format

DN

For OpenLDAP: User-
name

The DIGEST-MD5 bind authentication identity
format.

UseUserAccountContro-
lAttribute

For most LDAP servers:
false

For ActiveDirectory:
true

The UserAccountControl attribute to be used for
detecting disabled user accounts, account expira-
tions, password expirations and so on. ActiveDir-
ectory also uses this attribute to store the above
information.

controlFlag optional Indicates whether authentication with this login
module is sufficient to allow the user to log in, or
whether the user must also be authenticated with
another login module. Rarely set to anything other
than "sufficient" for any login module.

Note: controlFlag is a generic login module op-
tion rather than an LDAP configuration property.

LDAP Security Provider
(Not applicable to Online Data Proxy) The LDAP security provider includes authentication,
attribution, and authorization providers.

You can configure these providers:

• LDAPLoginModule– provides authentication services. Through appropriate
configuration, you can enable certificate authentication in LDAPLoginModule.

• (Optional)LDAPAuthorizer or RoleCheckAuthorizer – provide authorization services for
LDAPLoginModule. LDAPLoginModule works with either authorizer. In most production
deployments, you must always configure your own authorizer. However, if you are
authenticating against a service other than LDAP, but want to perform authorization
against LDAP, you can use the LDAPAuthorizer.
The RoleCheckAuthorizer is used with every security configuration but does not appear in
Sybase Control Center.
Use LDAPAuthorizer only when LDAPLoginModule is not used to perform authentication,
but roles are still required to perform authorization checks against the LDAP data store. If
you use LDAPAuthorizer, always explicitly configure properties; for it cannot share the
configuration options specified for the LDAPLoginModule.
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You need not enable all LDAP providers. You can also implement some LDAP providers with
providers of other types. If you are stacking multiple LDAP providers, be aware of, and
understand the configuration implications.

Active Directory Considerations
If you are using Active Directory as a security provider, ensure you understand the
implications of using this LDAP directory in a production environment of Unwired Platform.

Consider these design implications when you extend Active Directory security to Unwired
Platform production environments:

• Shared identities among Sybase components – if you are using Active Directory for all
authentication requests (that is, administration logins to access Sybase Control Center and
application logins to access data), you can also set up Sybase Control Center to use this
Active Directory repository. This allows users to have a shared user identity in both
components, but Sybase cautions users that this can complicate deployment of the
patform. For example, the user identity must be already configured both as an Unwired
Platform user as well as an administrator.

• LDAP data structure and administrative control – Unwired Platform requires that roles be
added to the repository in specific locations, and therefore, that security configurations
also correctly point to the location of the roles. Otherwise, authentication may be
problematic. Coordinate the implementation of these roles with the LDAP administrator.

Configuration Best Practices for Multiple LDAP Trees
Use the Unwired Platform administration perspective to configure LDAP authentication and
authorization security providers, which are used to locate LDAP user information when
organizational user groups exist within multiple LDAP trees.

To accommodate an LDAP tree structure that cannot be directly accessed using one search
base:

• Create an LDAP authentication module for each level in the hierarchy – during the
authentication process, Unwired Platform tries to authenticate against every login module
in the ordered list until authentication succeeds or until it reaches the end of the list.
Depending on the number of login modules you configure, this approach may have some
performance issues.

• Use different AuthenticationScopes for performing user searches – specify the root node
of a particular LDAP tree, by entering
AuthenticationSearchBase=”dc=sybase, dc=com” and set
Scope=subtree. Unwired Platform performs an LDAP query against the entire
subtree for authentication and authorization information. Depending on the number of
AuthenticationScope within the LDAP tree structure, this approach can have performance
implications.

• If multiple servers are clustered together to form a large logical directory tree, configure
the LDAPLoginModule by setting the Referral property to follow.
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• If subjects have been made members of too many LDAP groups and the search for physical
roles results in too many results, the maximum result limit may be reached and
authentication fails. To avoid this, narrow the RoleSearchBase to LDAP groups that
are relevant only to Unwired Platform.

LDAP Role Computation
Role checks are the primary means of performing access control when using LDAP
authentication. Authentication and attribution capabilities both utilize role computation
techniques to enumerate roles that both authenticated users have.

There are three distinct types of role constructs supported by LDAP providers; each may be
used independently, or all three may be configured to be used at the same time.

• User-level role attributes, specified by the UserRoleMembershipAttributes configuration
property, are the most efficient role definition format. A user's roles are enumerated by a
read-only directory server-managed attribute on the user's LDAP record. The advantage to
this technique is the efficiency with which role memberships can be queried, and the ease
of management using the native LDAP server's management tools. These constructs are
supported directly by ActiveDirectory products, and use these configuration options:
• UserRoleMembershipAttributes – the multivalued attribute on the user's LDAP record

that lists the role DNs that the user is a member of. An example value for this property is
"memberOf" on ActiveDirectory.

• RoleSearchBase – the search base under which all user roles are found, for example,
"ou=Roles,dc=sybase,dc=com". This value may also be the root search base of the
directory server.

• RoleFilter – the search filter that, coupled with the search base, retrieves all roles on the
server.

• (Optional) RoleScope – enables role retrieval from subcontexts under the search base.
• (Optional) RoleNameAttribute –choose an attribute other than "cn" to define the name

of roles.
These properties retrieve correct values automatically based on the type of server you
configure.

• LDAP group role definitions may be used as role definitions. This is a common construct
among older LDAP servers, but is supported by nearly all LDAP servers. You may select
this approach to use the same LDAP schema across multiple LDAP server types. Unlike
the user-level role attributes, LDAP group memberships are stored and checked on a
group-by-group basis. Each defined group, typically of objectclass "groupofnames" or
"groupofuniquenames," has an attribute listing all of the members of the group. The
configuration settings used are the same as for user-level role attributes, except for the
RoleMemberAttributes property, which replaces the UserRoleMembershipAttributes
property. This property defines a comma-delimited list of attributes that contain the
members of the group. An example value for this property is "uniquemember,member,"
which represents the membership attributes in the above-mentioned LDAP objectclasses.

• Freeform role definitions are unique in that the role itself does not have an actual entry in
the LDAP database. A freeform role starts with the definition of one or more user-level
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attributes. When roles are calculated for a user, the collective values of the attributes (each
of which may can be multivalued) are added as roles to which the user belongs. This
technique is particularly useful when the overhead of managing roles uses are
administration-heavy. For example, assign a freeform role definition that is equivalent to
the department number of the user. A role check performed on a specific department
number is satisfied only by users who have the appropriate department number attribute
value. The only property that is required or used for this role mapping technique is the
comma-delimited UserFreeformRoleMembershipAttributes property.

LDAP Login and Authorization Modules
LDAP login and authorization modules can sometimes share a common configuration.
However, authorizers do not inherit configuration from login modules you configure.
Configurations must be explicit.

In the case where both LDAPLoginModule and LDAPAuthorizer are configured:

• Matching configuration – LDAPAuthorizer simply skips the role retrieval.
• Differing configuration – LDAPAuthorizer proceeds with the role retrieval from the

configured backend, and performs the authorization checks using the complete list of roles
(from both the login module and itself). Even in the case where multiple
LDAPLoginModules are configured, only one LDAPAuthorizer is required as it compares
its configuration with the configuration used for the successful authentication of the user.

Certificate Configuration Properties
The certificate validation provider contributes only authentication services. For Unwired
Server security, configure these properties from the corresponding tab in the Security node of
Sybase Control Center.

To configure certificate validation with another security provider, ensure you configure the
certificate validation properties before other login modules that will support this validation
service.

Note: This provider cannot be used for administrative security (in the "admin" security
configuration).

Table 10. Authentication properties

Property Default value Description

validatedCertificateIsIdentity false Specifies if the certificate should be set as the
ID for the authenticated subject. This option
should be set to false if the Certifica-
teValidationLoginModule is used

in conjunction with other login modules that
establish user identity based on the validated
certificate.
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NTProxy Configuration Properties
(Not applicable to Online Data Proxy) Configure these properties to allow the operating
system's security mechanisms to validate user credentials using NTProxy (Windows Native
OS). Access these properties from the Authentication tab of the Security node in Sybase
Control Center.

Table 11. Authentication properties

Properties Default Value Description

Extract Domain From User-
name

true If set to true, the user name can
contain the domain in the form
of <username>@<domain>. If
set to false, the default domain
(described below) is always
used, and the supplied user
name is sent to through SSPI
untouched.

Default Domain The domain for the host com-
puter of the Java Virtual Ma-
chine.

Specifies the default host name,
if not overridden by the a spe-
cific user name domain.

Default Authentication Server The authentication server for
the host computer of the Java
Virtual Machine.

The default authentication serv-
er from which group member-
ships are extracted. This can be
automatically determined from
the local machine environment,
but this property to bypass the
detection step.

useFirstPass false If set to true, the login module
attempts to retrieve only the user
name and password from the
shared context. It never calls the
callback handler.

tryFirstPass false If set to true, the login module
first attempts to retrieve the user
name and password from the
shared context before attempt-
ing the callback handler.

clearPass false If set to true, the login module
clears the user name and pass-
word in the shared context when
calling either commit or abort.
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Properties Default Value Description

storePass false If set to true, the login module
stores the user name and pass-
word in the shared context after
successfully authenticating.

NTProxy Security Provider
(Not applicable to Online Data Proxy) NTProxy (sometimes known as native Windows login)
integrates with existing Windows login security. Users can authenticate with their native
Windows user name and password, which gives them access to roles that are based on their
existing Windows memberships.

The NTProxy provider fulfills authentication services only with classes in csi-
nativeos.jar; role-based access control and attribution are not directly supported.
Groups are also not supported in NTProxy. Instead, group memberships are transformed into a
role of the same name and can be mapped in Sybase Control Center.

HTTP Basic Authentication Properties
The HttpAuthenticationLoginModule provider authenticates the user with given credentials
(user name and password) against a HTTP(S) enterprise information system (EIS) using a
GET against an URL that requires BASIC authentication, and can be configured to retrieve a
cookie with the configured name and add it to the JAAS subject to facilitate single sign-on.

Note: If you are using this provider for the "admin" security configuration, ensure you make
corresponding provider changes for Sybase Control Center logins. See Enabling
Authentication and RBAC for Administrators in the Security guide.

Table 12. HttpAuthenticationLoginModule properties

Property Description

URL The HTTP(S) URL that authenticates the user. For SSO, this
is the server URL from which Unwired Server acquires the
SSO cookie/token.

Disable certificate validation (Optional) – the default is False. If set to True, disables

certificate validation when establishing an HTTPS connec-
tion to the EIS using the configured URL. Set to True only

for configuration debugging.

SSO cookie name (Optional) – name of the cookie that is set in the session and
holds the SSO token for single sign-on.

The authentication provider ignores the status code when a
SSO cookie is found in the session. If the cookie is found,
authentication succeeds regardless of the return status code.
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Property Description

Roles HTTP header (Optional) – comma separated list of roles granted to the
authenticated user for role-based authorization.

Successful connection status code HTTP status code interpreted as success when connection is
established to the EIS. The default is 200.

HTTP connection timeout interval The value, in seconds, after which an HTTP(s) connection
request to the EIS times out. If the HTTP connection made in
this module (for either user authentication or configuration
validation) does not have a time out set, and attempts to con-
nect to an EIS that is unresponsive, the connection hangs,
which could potentially cause Unwired Server to hang. Set-
ting the timeout interval ensures authentication failure is re-
ported without waiting for ever for the server to respond.

HTTP Basic Security Provider
Use an HTTP Basic provider to enable automatic application registration. This provider is
required when registration is set to automatic, and will be used for integrating with third-party
security providers like SiteMinder.

A LoginModule validates standard username/password style credentials by passing them to a
Web server. Configure the URL property to point to a Web server that challenges for Basic
authentication.

Best practice guidelines include:

• Using an HTTPS URL to avoid exposing credentials.
• If the Web server's certificate is not signed by a well known CA, import the CA certificate

used to sign the Web server's certificate into the Unwired Server truststore.jks.
The truststore is prepopulated with CA certificates from reputable CAs.

• If this Web server returns a cookie as part of successful authentication, set the SSO
Cookie Name configuration property to the name of this cookie. Upon successful
authentication, this login module places the cookie value into an
HttpSSOTokenCredential object and attaches it to the
java.security.Subject as a public credential.

Note: The HTTP Basic login module is the module that can either be used for SSO tokens
or HTTP basic without SSO. The sole condition being that the backend support HTTP
Basic authentication.

• When using this module in lieu of the deprecated SAPSSOTokenLoginModule, the cookie
name is typically "MYSAPSSO2".

For example, SiteMinder is often used in mobile deployments to protect existing Web-based
applications. Existing users point their browser at a URL, and SiteMinder intercepts an
unauthenticated session to challenge for credentials (Basic). When the authentication
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succeeds, it returns a SMSESSION cookie with a Base64-encoded value that can be used for
SSO into other SiteMinder enabled systems.

SAP SSO Token Authentication Properties
The SAPSSOTokenLoginModule has been deprecated, Use the
HttpAuthenticationLoginModule when SAP SSO2 token authentication is required. This
authentication module will be removed in a future release.

Table 13. SAPSSOTokenLoginModule properties

Property Description

Implementation class (Required) – the fully qualified class that implements the
login module. com.sybase.securi-
ty.sap.SAPSSOTokenLoginModule is the de-

fault class.

Provider type (Required and read-only) – LoginModule is the only

supported value.

Control flag (Required) – optional is the default value. Determines

how success or failure of this module affects the overall au-
thentication decision.

SAP server URL (Required) – the SAP server URL that provides the SSO2
token. This may or may not be the same server that authen-
ticates the user. If providing and authenticating servers are
different, you must import the SAP Token provider server
certificate or one of its CA signers into the Unwired Server
truststore in addition to that of the authenticating server to
enable HTTPS communication. In environments where the
servers are different, the basic flow is:

1. Unwired Server passes credentials over HTTPS to the
token granting service.

2. An SSO2Token cookie is returned to Unwired Server.

3. The SSO2Token flows to the authenticating server, which
could be an SAP EIS or a server that hosts a Web service
bound to SAP function modules.

Note: The SAP Server URL must be configured to require
BASIC authentication, not just FORM based authentication.

Clear password (Optional) – if set to True, the login module clears the

username and password in the shared context.
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Property Description

Disable server certificate validation (Optional) – the default is False. If set to True, disables

certificate validation when establishing an HTTPS connec-
tion to the SAP server using the configured URL. Set to
True only for configuration debugging.

SAP server certificate (Optional) – name of the file containing the SAP certificate's
public key in .pse format. This is required only when token

caching is enabled by setting a SAP SSO token persistence
data store value.

SAP server certificate password (Optional) – password used to access the SAP server certif-
icate.

SAP SSO token persistence data store (Optional) – JNDI name used to look-up the data source to
persist the retrieved SSO2 tokens.

Set to "jdbc/default" to store tokens in the Unwired Server
CDB. If unconfigured, some caching is still done based on the
"Authentication cache timeout interval" property associated
with the security configuration setting.

If you use the default setting, you do not need to set SAP SSO
token persistence data store, SAP server certificate, SAP
server certificate password, or Token expiration interval
properties.

To enable token caching through the SAPSSOTokenLogin-
Module:

1. Set the SAP SSO token persistence data store value to
"jdbc/default."

2. Download and install the SAP SSO2 token files. See
Installing the SAP SSO2Token Files on Unwired Server
Hosts in the Security guide.

3. Specify the correct value for the SAP server certificate,
SAP server certificate, SAP server certificate password
and Token expiration interval properties.

Store password (Optional) – if set to true, the login module stores the user-
name/password in the shared context after successfully au-
thenticating the user.
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Property Description

Token expiration interval (Optional) – this property is ignored when the SAP SSO
token persistence data store property is not configured. It
specifies the token validity period, after which time a new
token is retrieved from the SAP EIS. The default value is 120
seconds.

Keep in mind that:

• The "Token expiration interval" cannot exceed the "To-
ken validity period", which is the amount of time defined
in the back-end SAP server for which the token is valid.

• The "Authentication cache timeout" property must be
less than the "Token expiration interval" property value.

Try first password (Optional) – if set to True, the login module attempts to

retrieve the username/password from the shared context, be-
fore calling the callback handler.

Use first password (Optional) – if set to True, the login module attempts to

retrieve the username/password only from the shared context,
and never calls the callback handler.

HTTP connection timeout interval The value, in seconds, after which an HTTP(s) connection
request to the EIS times out. If the HTTP connection made in
this module (for either user authentication or configuration
validation) does not have a time out set, and attempts to con-
nect to an EIS that is unresponsive, the connection hangs,
which could potentially cause Unwired Server to hang. Set-
ting the timeout interval ensures authentication failure is re-
ported without waiting for ever for the server to respond.

SAP SSO Token Security Provider
The SAPSSOTokenLoginModule has been deprecated and will be removed in a future release.
Use HttpAuthenticationLoginModule for SAP SSO2 token authentication.

Use HttpAuthenticationLoginModule for both JCo and DOE-C connections to the SAP
system. Unwired Server does not provide authorization control or role mappings for user
authorization; enforce any access control policies in the SAP system.
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Preconfigured User Authentication Properties
The PreConfiguredUserLoginModule authenticates the Unwired Platform Administrator
user whose credentials are specified during installations.

This login module is recommended only to give the Platform administrator access to Sybase
Control Center so it can be configured for production use. Administrators are expected to
replace this login module immediately upon logging in for the first time.For details on how to
setup administrator authentication in a production deployment, see Enabling Authentication
and RBAC for Administrator Logins in the Security guide.

The PreConfiguredUserLoginModule:

• Provides role based authorization by configuring the provider
com.sybase.security.core.RoleCheckAuthorizer in conjunction with this authentication
provider.

• Authenticates the user by comparing the specified username/password against the
configured user. Upon successful authentication, the configured roles are added as
Principals to the Subject.

Table 14. PreConfiguredUserLoginModule properties

Property Description

User name A valid user name.

Password The encoded password hash value.

Roles Comma separated list of roles granted to the authenticated
user for role-based authorization. Platform roles include
"SUP Administrator" and "SUP Domain Administrator".

Roles are mandatory for "admin" security configuration. For
example, if you define "SUP Administrator" to this property,
the login id in the created login module has Platform admin-
istrator privileges.

Note: If you use other values, ensure you map Unwired Plat-
form roles to the one you define here.

Preconfigured User Login Security Provider
If you are accessing Sybase Control Center for the first time you are authenticated as the
Unwired Platform administrator with the PreconfiguredLoginModule. You must supply the
password defined during the installation of Unwired Platform.

During installation,
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Note: Do not forget this installation password. The installer hashes the password with a
SHA-256 algorithm before it is saved as part of the PreconfiguredLoginModule
configuration. This value cannot be returned to cleartext once the installer hashes it.

Once logged in, the Unwired Platform administrator immediately reconfigures the "admin"
security configuration to replace this provider with an production-grade security provider like
LDAP. Once complete, the corresponding changes then need to be implemented in security
configuration files used by Sybase Control Center. Failure to coordinate these changes can
result in unpredictable behavior in Sybase Control Center. For complete procedural details on
how to setup administrator authentication for both components in a production environment
after installation, see Enabling Authentication and RBAC for Administrator Logins in the
Security guide. If you configure a new provider in Unwired Platform and Sybase Control
Center and login fails, review possible login failure solutions Troubleshooting guide.

Certificate Authentication Properties
Add and configure authentication provider properties for
CertificateAuthenticationLoginModule, or accept the default settings.

Note: This provider cannot be used for administrative security (in the "admin" security
configuration).

Table 15. CertificateAuthenticationLoginModule properties

Property Description

Implementation class The fully qualified class that implements the login module.
com.sybase.security.core.CertificateAu-
thenticationLoginModule is the default class.

Provider type LoginModule is the only supported value.

Control flag Determines how success or failure of this module affects the overall
authentication decision. optional is the default value.

Clear password (Optional) If true, the login module clears the user name and pass-
word from the shared context. The default is false.

Store password (Optional) If true, the login module stores the user name and pass-
word in the shared context. The default is false.

Try first password (Optional) If true, the login module attempts to retrieve user name
and password information from the shared context, before using the
callback handler. The default is false.

Use first password (Optional) If true, the login module attempts to retrieve the user
name and password only from the shared context. The default is
false.
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Property Description

Enable revocation checking (Optional) Enables online certificate status protocol (OCSP) certif-
icate checking for user authentication. If you enable this option, you
muse enable OCSP in Unwired Server. This provider uses the values
defined as part of the SSL security profile. Revoked certificates
result in authentication failure when both of these conditions are
met:

• revocation checking is enabled

• OCSP properties are configured correctly

Regex for username certificate
match

(Optional) By default, this value matches that of the certificates
common name (CN) property used to identify the user.

If a mobile application user supplies a user name that does not match
this value, authentication fails.

Trusted certificate store (Optional) The file containing the trusted CA certificates (import the
issuer certificate into this certificate store). Use this property and
Store Password property to keep the module out of the sys-

tem trust store.

The default Unwired Server system trust store is <Unwired-
Platform_InstallDir\Servers\Unwired-
Server\Repository\Securitytruststore
\truststore.jks.

Note: This property is required only if Validate certificate path is set
to true.

Trusted certificate store pass-
word

(Optional) The password required to access the trusted certificate
store. For example, import the issuer of the certificate you are trying
to authenticate into the shared JDK cacerts file and specify the
password using this property.

Note: This property is required only if Validate certificate path is set
to true.

Trusted certificate store pro-
vider

(Optional) The keystore provider. For example, "SunJCE."

Note: This property is required only if Validate certificate path is set
to true.
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Property Description

Trusted certificate store type (Optional) The type of certificate store. For example, "JKS."

Note: This property is required only if Validate certificate path is set
to true.

Validate certificate path If true (the default), performs certificate chain validation of the
certificate being authenticated, starting with the certificate being
validated. Verifies that the issuer of that certificate is valid and is
issued by a trusted certificate authority (CA), if not, it looks up the
issuer of that certificate in turn and verifies it is valid and is issued by
a trusted CA. In other words, it builds up the path to a CA that is in the
trusted certificate store. If the trusted store does not contain any of
the issuers in the certificate chain, then path validation fails. For
information about adding a certificate to the truststore, click Pre-
paring Certificates and Key Pairs.

Certificate Security Provider
Use the Unwired Server CertificateAuthenticationLoginModule authentication provider to
implement SSO with an SAP enterprise information system (EIS) with X.509 certificates.

Unwired Server does not provide authorization control or role mappings for user
authorization; enforce any access control policies in the EIS.

Roles and Mappings
Role mapping occurs when an administrator maps logical roles to physical roles using Sybase
Control Center as part of a security configuration or a deployment package. The physical roles
are the roles and groups in the underlying security repository. The mapped role determines the
security role requirement for a user at runtime to access a resource that is using the security
configuration on which the mapping is defined.

In Unwired Platform, the mapped role determines what security roles apply to users when they
attempt to perform an operation from the mobile application (device users) or Sybase Control
Center (administrators).

Role mappings are defined as part of a security configuration that you can assign to a particular
domain. Administrators can assign the same security configuration to multiple domains;
ensure that these mappings are suitable for all domains to which the security configuration is
assigned. Consider an example where security configuration is shared between domainA and
domainB.

1. The platform administrator (the administrator assigned the SUP administration role)
creates a security configuration called AllDomains.

2. The platform administrator assigns the AllDomain to the domain, and maps the EmpRole
role to SalesGroupRole in the security repository used by that configuration.
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This change that is specific to just domainA is also implemented in domainB even though the
domain administrator of domainB did not explicitly make, or require, the change. But the role
mapping is propagated to domainB as well. To avoid this, the Unwired Platform administrator
may want to create multiple security configurations so that underlying mechanisms can stay
the same, but specific role mappings can be made for each.

For device user security, there is an increased flexibility for packages as they are deployed. If a
security configuration is inappropriate, or if a role is not mapped at all that is used by the
package, the platform or domain administrator can override or extend the role mappings
defined for the security configuration. Package-level role mappings always take precedence in
such a scenario.

Assigning a Security Configuration to a Domain
Assign security configurations to one or more domains. This allows the supAdmin to offer a
security repository for application user authentication and authorization, as well as to share
security providers across domains in case one tenant uses mutiple domains.

Prerequisites
A supAdmin must already have created one or more security configurations in the Security
node of Sybase Control Center.

Task

1. In the left navigation pane, navigate to ClusterName > Domains > DomainName >
Security

2. In the right administration pane, select the Security Configurations tab and click
Assign.

3. From the list of available security configurations, select the appropriate configuration for
domain security, and click OK.
If successful, an Assigned successfully message appears, and the newly added security
configuration is listed in the domain-level Security node.

Applications
An Application in Unwired Server (visible in Sybase Control Center as such) is the runtime
entity that can be directly correlated to a native or mobile workflow application. The
application definition on the server establishes the relationship among packages used in the
application, domain that the application is deployed to, user activation method for the
application, and other application specific settings.

• For native replication/messaging applications, one or more MBO packages can be
assigned to an application. If the application developer uses the same package in a different
application, the MBO package must be assigned to that application.

Administer

164 Sybase Unwired Platform



• For the mobile workflow applications, all MBO packages are accessible in all domains, so
no MBO packages need to be assigned to the mobile workflow application (HWC).

• For Online Data Proxy applications, no MBO package assignments are needed as well.

Applications are managed and monitored by administrators on the Sybase Control Center.
They are created automatically or manually through Sybase Control Center.

An application ID uniquely identifies an application to Unwired Server. Application
connection templates enable administrator to manually register application connections in
Unwired Server with predefined settings. Templates also enable automatic activation of
devices (described later). Users are associated with one or more applications through
application connections. Administrators can view application users in Sybase Control Center
as soon as a user logs onto the application from a device.

Application ID Overview
Application can be directly correlated to a native application or mobile workflow container
instance on device. A native application is the single binary deployed to device which may use
one or more MBO packages. The mobile workflow application is a collection of workflow
packages and constitutes as one application. One or more MBO packages can be assigned to
an application. If application developer wants to use the same package in a different
application, they can do that by assigning the MBO package to that application using Sybase
Control Center.

An application Id uniquely identifies the application and must be used to register an
application connection and also used in the device application in case of Online Data Proxy
client for activation of its application connection.

Setting Up Application and User Connections
The basic step for setting up application and user connections involves creating an application,
and registering application connections to associate users to the application.

Application Creation
There are two ways an application gets created - automatic and manual.

Automatic Application Creation
Applications are created automatically, when the system administrator deploys a package.
The mobile workflow application (HWC) is created during Unwired Server installation.

An application is created automatically when an MBO package is deployed to the server. In
case of upgrade from a previous server version, an application is created for all deployed MBO
packages. The default name of an application is the same as the package name.
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Note: An application is primarily used for tracking purpose. At this point, an application
connection template is also created, but not used at this time since automatic registration is not
available for native applications (MBO package client applications).

For Online Data Proxy, there is no such automatic creation of applications. Applications must
be created manually.

Manually Creating Applications
Create an application manually by assigning a unique application ID and other key application
properties, such as domain, MBO package, security configuration, among others. At this time,
the manual process is only needed for Online Data Proxy applications or when using a Hybrid
Web Container built using the iOS sample, where developers can use their own application
IDs for workflow applications.

Launching the Application Creation Wizard
Use the Application Creation wizard to register an application.

1. In the left navigation pane of Sybase Control Center, click the Applications node and
select the Applications tab in the right administration pane.

2. To register an application, click New.
The Application Creation wizard is displayed.

Setting General Application Properties
Provide general application properties such as the application ID, description, security
configuration and domain details while registering the application. Optionally you can assign
an application connection template as well, or you can assign it later.

1. In the Application Creation Wizard, enter a unique Application ID, following application
ID guidelines.

2. Enter a Display name and Description for the application.

3. Select the appropriate security configuration from the Security Configuration drop-
down list.

4. Select the appropriate domain from the Domain drop-down list.

5. (Optional) Select a package from the list to assign an application connection template.

a) Select Configure additional settings, and click Next.
b) In the Application Creation wizard, enter a Template name and Description for the

application connection template.
c) To reuse the configuration of an existing template, select a Base template from the

drop-down list.
d) Configure the following property categories as required.

• Apple Push Notifications
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• Application Settings
• BlackBerry Push Notifications
• Connection
• Custom Settings
• Device Advanced
• Device Info
• Proxy
• Security Settings
• User Registration

6. Click Finish to register the application with the configured settings.

Modifying Application Properties
Associate the application with one or more domains and packages.

1. In the left navigation pane of Sybase Control Center, click the Applications node and
select the Applications tab in the right administration pane.

2. Select an application listed under Application ID.

3. Click Packages.

4. In Review packages, select the domains to associate with the Application.

a) To see more domains, click +.
b) In Available Domains, select one or more domain from the list .
c) Click OK.

5. Select the packages to associate with the Application.

a) To see more packages, click +.
b) In Available Packages, select one or more package from the list of available packages.
c) Click OK.

6. Click OK.

Deleting Applications
Delete an application to remove all the registered users, connections, and subscriptions
associated with those connections.

1. In the left navigation pane of Sybase Control Center, click the Applications node and
select the Applications tab in the right administration pane.

2. Select the user and click Delete.

Application Connection Activation Options
An application connection can be activated from the device by either providing valid
credentials, or an activation code for a pre-registered application connection. The credentials-
based approach, referred to from this point on as automatic registration, relies on application
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connection template properties (application ID, security configuration, automatic registration
enabled). The activation-based approach, referred to from this point as manual registration,
relies on matching user name and activation code sent from the device to an existing
application connection registered for the user.

Note: Application connection is not used for native replication applications at this time.

Information and guidelines:

• Native messaging applications can only be activated manually.
• Application template are used for automatic activation. Therefore, when setting up the

application template for automatic registration, be sure to set up the security configuration,
domain, the application ID, and automatic registration enabled properties in application
settings. Those are used for automatic application registration.
When a client application connects to the server with its application ID and credentials,
and requests automatic registration, the application ID is used to look up a matching
template. If that template allows automatic registration (the Automatic Registration
Enabled property is set to true),the security configuration in the template is used to validate
the credentials. Upon successful validation of those credentials, the user identity is
registered in the Unwired Server. The client application may also include the security
configuration as part of the username (user@securityconfiguration) and in that case, the
security configuration (in addition to application ID) is used to look up a matching
template. If no or multiple templates are detected, the registration request fails.

• Supported device client activation options:

Device Client Type Automatic Registration Manual Registration

Workflow messaging X X

Native messaging X

Online Data Proxy X X

Managing and Searching for Applications
You can view the applications registered through the Sybase Control Center

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application tab.
You can view the list of registered applications.

Viewing Assigned Connections
View the properties of the connections assigned to an application.

1. In the right administration pane, select the Applications tab.

2. Select the application from the list.
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3. Click Application Connections.

4. Click Refresh to refresh the list that displays the application connections.

5. Click Close to close the dialog.

Viewing Assigned Application Users
View the list of the users assigned to an application

1. In the right administration pane, select the Applications tab.

2. Select the application from the list.

3. Click Application Users.

4. Click Refresh to refresh the list that displays the application users.

5. Click Close to close the dialog.

Viewing Correlated Application Details
Select one or more applications, then view correlated application details in several categories,
including packages, application users, and application connections.

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application tab.
You can view the list of registered applications.

3. Select one or more applications from the list.

4. Select on of the buttons to view related packages, application users, or application
connections.

• Packages – view correlated domains and packages.
• Application Users – view correlated applications.
• Application Connections – view correlated applications.

5. In Review Assignment, check the information.

6. Click OK.

Refreshing the Application View
Refresh the list of all available applications registered through the Sybase Control Center.

1. In the right administration pane, select the Applications tab.

2. To view the list of registered applications, click Refresh.

Searching for Applications
Search for registered applications from the default view, or perform an advanced search. The
advanced search enables you to search through applications, users, application connections,
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packages, and subscriptions, filtering out results at each level until you obtain very specific
results.

Searching from the Default View
Search for applications that are registered in the Sybase Control Center.

1. In the right administrations pane, select the Applications node.

2. To set the search criteria, select the criteria from the Search drop-down list.

3. Add a search string.

4. Click Go.
All the applications that match the search criteria provided are populated in the table.

Performing an Advanced Search
search through applications, users, application connections, packages, and subscriptions,
filtering out results at each level until you obtain very specific results.

1. In the right administrations pane, select the Applications node.

2. Select Advanced Search.

3. In Advanced Search, enter an application ID, then click Go, or click Go to display a list of
applications.

4. Select an application, and click Search.
The Users, Application Connections, Packages, and Subscriptions tabs remain.

5. Select one of the remaining tabs, select the search criteria, and click Search.

6. Continue this process until you have the information you seek. Each time you search in a
one of the categories, the tab is removed. In this way you refine your search.

Application Users
In Unwired Platform, an application user is an identity registered as the user of one or more
versions of a device application. Application users are managed in Sybase Control Center.

For native replication applications, an application user is automatically registered upon first
successful authentication using the security configuration associated with the package that
user is trying to access. For native messaging applications, an application user is automatically
registered upon first successful synchronization after manual registration. For workflow and
Online Data proxy applications, the application user is registered upon successful registration
whether manual or automatic. A user can have multiple devices.

The platform administrator can view the user name and the security configuration that was
used to authenticate the user. In addition, the administrator can remove users that no longer
exist.

Note: SAP DOE-C package users are not registered in Unwired Server. Those users are
authenticated by their respective DOE back-end servers.
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Deleting Application Users
Delete a user to remove the entry as well as personalization data from the cache database.

1. In the left navigation pane of Sybase Control Center, click the Applications node and
select the Application Users tab in the right administration pane.

2. Select the user and click Delete.

The user entry and data are removed.

Checking Application User Assignments
Check which applications are used by registered users.

1. In the left navigation pane of Sybase Control Center, click the Applications node and
select the Application Users tab in the right administration pane.

2. Select an application user and click Applications.

All applications used by the user are listed in the dialog.

Searching for Application Users
Search for application users according to the criteria you specify.

1. In the right administration pane, select the Applications Users node.

2. Choose the criteria from the Search drop-down list for which you want to search for the
required user.

3. Click Go.
The user information is populated according to the criteria you have specified.

Refreshing the Application Users View
Refresh the application user list to display current information about registered users.

1. In the right administration pane, select theApplications node, then the Application Users
tab.

2. Click Refresh to view the current information of all users.

Application Connections
Application connections associate an application instance with a user. An application may be
used by many users, and a user may be associated with many applications.

Application ID Guidelines
Follow these guidelines for choosing an appropriate application ID while registering
application connection for use by native messaging, workflow client, or Online Data Proxy.
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Failure to specify the correct application ID would result in failure when the client tries to
activate itself even though the user name and activation code do match.

Registration Type Application ID Guidelines

Native messaging client The application ID should always be left empty. If using a
preexisting registration template (such as Default), then
the application id would be empty already.

Workflow client • 2.0.1 or earlier version – leave the application ID
empty.

• 2.1 version – use preexisting "HWC" template, or, if
using your own template, make sure that "HWC" is
set as the application ID in the template.

• iOS Sample container 2.1 version – use the template
you have created. The application ID used by the iOS
sample container should match the application ID
specified in registration.

Online Data Proxy client Register application connection using the template cre-
ated for the application. Existing templates can be found
in the Applications > Application Connection Tem-
plate tab.

Registering Application Connections
Use Sybase Control Center to trigger the registration of an application connection, or
reregister an application connection when the activation code has expired.

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application Connections tab.

3. Click Register to register a new application connection, or click Reregister to update an
existing application connection.

4. In the Register Application Connection or the Reregister Application Connection dialog.

a) For new device registration only, type the name of the user that will activate and
register the device. For reregistrations or clones, the same name is used and cannot be
changed.

b) Select the name of the template for initial application connection registration. The
template you use supplies initial values in the subsequent fields.

• Default – a default template that you can use as is, or customize.
• HWC – a default template for mobile workflows (containers). Use as is, or

customize. If you use the HWC template, Application ID must be set to HWC.
• Custom - customized templates are listed.
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5. Change the default field values for the template you have chosen. If you are using the
default template, you must provide the server name.

If you are using relay server, ensure the correct values are used.
• Server name- the DNS name or IP address of the primary Unwired Server, such as

"myserver.mycompany.com". If using relay server, the server name is the IP address or
fully qualified name of the relay server host.

• Port- the port used for messaging connections between the device and Unwired Server.
If using relay server, this is the relay server port. Default: 5001.

• Farm ID- a string associated with the relay server farm ID. Can contain only letter A-Z
(uppercase or lowercase), numbers 0-9, or a combination of both. Default: 0.

• Application ID- the application ID registered for the application. The value differs
according to application client type - native messaging, workflow, or Online Data
Proxy client. See Application ID Overview for guidelines.

• Security Configuration- select the security configuration relevant for the application
connection.

• Domain- select the domain for which you want to register the application connection
with.

• Activation code length - the number of characters in the activation code. If you are
reregistering or cloning a device, this value cannot be changed.

• Activation expiration- the number of hours the activation code is valid.

6. (Optional) Select the check box adjacent to Specify activation code to enter the code sent
to the user in the activation e-mail. This value can contain letter A - Z (uppercase or
lowercase), numbers 0 - 9, or a combination of both. Acceptable range: 1 to 10 characters.

7. Click OK

Searching for Application Connections
Set search criteria to filter connections viewed in the Application Connections tab

1. In the right navigation pane, click the Applications node.

2. In the right administration pane, click the Application Connections tab.

3. To set the search criteria, configure these search elements:

• Choose the connection information column name you want to enter a search value for.
• Type or choose the value for the column name you selected.

Deleting Application Connections
Delete an application connection to remove a user assignment to an application connection.

1. In the left navigation pane of Sybase Control Center, click the Applications node and
select the Application Connections tab in the right administration pane.

2. Select the application connection and click Delete.
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Editing the Application Connection Properties
Modify or update the properties of an application connections

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Applicaton Connections node.

3. Select an application connection from the list.

4. Click Properties.

a) In the Application Connection Properties dialog, select the category from the left pane.
b) Update or modify the property and its value.
c) Click OK.

Note: When the application end-point for a registered application is modified under
the Proxy property, you have to manually update the Address in the proxy properties
of the connection pool.

Cloning Application Connections
Create a duplicate copy of an application connection configuration settings. This allows you to
retain user information and pair it with a different device in the event that a user gets a new or
alternate device.

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application Connections node.

3. Check the box adjacent to the connection you want to clone and click Clone.

4. Edit the configuration settings associated with the application connection.

• Server name- the DNS name or IP address of the primary Unwired Server, such as
"myserver.mycompany.com". If using relay server, the server name is the IP address or
fully qualified name of the relay server host.

• Port- the port used for messaging connections between the device and Unwired Server.
If using relay server, this is the relay server port. Default: 5001.

• Farm ID- a string associated with the relay server farm ID. Can contain only letter A-Z
(uppercase or lowercase), numbers 0-9, or a combination of both. Default: 0.

• Application ID- the application ID registered for the application.
• Security Configuration- select the security configuration relevant for the application

connection.
• Domain- select the domain for which you want to register the application connection

with.
• Activation expiration- the number of hours the activation code is valid.
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5. (Optional) Select the check box adjacent to Specify activation code to enter the code sent
to the user in the activation e-mail. This value can contain letter A - Z (uppercase or
lowercase), numbers 0 - 9, or a combination of both. Acceptable range: 1 to 10 characters.

6. Click OK

Tracing Application Connections
Send a request to Unwired Server to retrieve log files for an application connection.

1. In the left navigation pane, select the Applications node.

2. In the right administration pane, click Application Connections tab.

3. Select an application connection, and click Get Trace.
The application connection status must be "online" to retrieve the logs.

4. Click OK.

5. When the application connection is online, check the application connection log. The
default location is <UnwiredPlatform_InstallDir>\UnwiredPlatform
\Data\Messaging\ClientTrace for cluster or
<UnwiredPlatform_InstallDir>\\UnwiredPlatform\Servers
\MessagingServer\Data\ClientTrace for single node.

Locking and Unlocking Application Connections
Lock or unlock connections to control which users are allowed to synchronize data. Locking
an application connection is an effective way to disable a specific user without making
changes to the security profile configuration to which he or she belongs.

1. In the left navigation pane, select theApplications node.

2. In the right administration pane, select the Application Connections tab.

3. Select the application connection you want to manage, and:

• If the connection is currently unlocked and you want to disable synchronization, click
Lock.

• If the connection is currently locked and you want to enable synchronization, click
Unlock.

4. In the confirmation dialog, click OK.

Application Connection Templates
An application connection template is a model or pattern used to standardize connection
properties and values for a specific application connections so that they can be reused. A
template allows you to quickly create actual application connections.

Two default templates are available: Default and HWC. The Default is for registering an
application connection without an application ID (backward compatibility scenario, as well as
for 2.1 native messaging clients). The HWC template is for registering application
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connections for 2.1 Hybrid Web Container clients. Native messaging applications can only be
activated manually.

Creating Application Connection Templates
Creating application connection templates by setting approiate properties and values.

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application Connection Templates tab.

3. Click New.

4. Enter the Template name and Description for the application connection template.

5. Select the Base template from the drop-down list.

6. You can configure any of the following profiles. See Appliation Settings:

• Apple Push Notifications
• Application Settings
• BlackBerry Push Notifications
• Connection
• Custom Settings
• Device Advanced
• Device Info
• Proxy
• Security Settings
• User Registration

7. Click OK.

Managing Properties of Application Connection Template
Manage the different categories of properties set for application connection templates.

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application Connection Templates tab.

3. Select the application connection template from the list and click Properties.

4. In the Template dialog, select the category you want to edit and modify the property and
value.

5. Click OK.

Deleting an Application Connection Template
Delete an application connection template.

1. In the left navigation pane, click the Applications node.

2. In the right administration pane, click the Application Connection Templates tab.
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3. Select the application connection template from the list and click Delete.

4. Click OK on the confirmation dialog.

Application Connection Properties
Application connection properties are used to create application connections and application
connection templates.

Apple Push Notification Properties
Apple push notification properties allow iOS users to install client software on their devices.
This process requires you to create a different e-mail activation message using the appropriate
push notification properties.

• APNS Device Token – the Apple push notification service token. An application must
register with Apple push notification service for the iOS to receive remote notifications
sent by the application’s provider. After the device is registered for push properly, this
should contain a valid device token. See the iOS developer documentation.

• Alert Message – the message that appears on the client device when alerts are enabled.
Default: New items available.

• Delivery Threshold – the frequency, in minutes, with which groupware notifications are
sent to the device. Valid values: 0 – 65535. Default: 1.

• Sounds –  indicates if a sound is a made when a notification is received. The sound files
must reside in the main bundle of the client application. Because custom alert sounds are
played by the iOS system-sound facility, they must be in one of the supported audio data
formats. See the iOS developer documentation.

Acceptable values: true and false.

Default: true
• Badges – the badge of the application icon.

Acceptable values: true and false

Default: true
• Alerts – the iOS standard alert. Acceptable values: true and false. Default: true.
• Enabled – indicates if push notification using APNs is enabled or not.

Acceptable values: true and false.

Default: true

Application Settings
Application settings display details that identify the Application Identifier, Domain, Security
Configuration of an application connection template

• Automatic Registration Enabled – the value is set to True when the application
connection registration is carried out automatically.
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• Application Identifier –  the application identifier registered on SCC.
• Domain –  the domain selected for the connection template.
• Security Configuration –  the security configuration defined for the connection template.

BlackBerry Push Notification Properties
BlackBerry push notification properties allow BlackBerry users to install messaging client
software on their devices.

Property Description

Enabled Enables notifications to the device if the device is offline. This feature sends a
push notification over an IP connection only long enough to complete the Send/
Receive data exchange. BlackBerry Push notifications overcome issues with
always-on connectivity and battery life consumption over wireless networks.
Acceptable values: true (enabled) and false (disabled). If this setting is false, all
other related settings are ignored. Default: true

Delivery threshold The minimum amount of time the server waits to perform a push notification to
the device since the previous push notification (in minutes). This controls the
maximum number of push notifications sent in a given time period. For example,
if three push notifications arrive 10 seconds apart, the server does not send three
different push notifications to the device. Instead they are sent as a batch with no
more than one push notification per X minutes (where X is the delivery thresh-
old). Acceptable values: 0 – 65535. Default: 1

Push listener port The push listener port reported by the device on which it listens for notifications.
This port is automatically assigned by the client. For example, if there is another
application already listening on this port, a free port is searched for. Default:
5011

Device PIN Every Blackberry device has a unique permanent PIN. During initial connection
and settings exchange, the device sends this information to the server. Unwired
Server uses this PIN to address the device when sending notifications, by sending
messages through the BES/MDS using an address such as: Device="Device
PIN" + Port="Push Listener port". Default: 0

Name The BES server to which this device's notifications are sent. In cases where there
are multiple BES servers in an organization, define all BES servers.
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Connection Properties
Connection properties define the connection information used by Unwired Server to relate a
user to a device.

• Activation Code – the original code sent to the user in the activation e-mail. Can contain
only letters A – Z (uppercase or lowercase), numbers 0 – 9, or a combination of both.
Acceptable range: 1 to 10 characters.

• Farm ID – a string associated with the Relay Server farm ID. Can contain only letters A –
Z (uppercase or lowercase), numbers 0 – 9, or a combination of both. Default: 0.

• Server Name – the DNS name or IP address of the Unwired Server, such as
"myserver.mycompany.com". If using Relay Server, the server name is the IP address or
fully qualified name of the Relay Server host.

• Server Port – the port used for messaging connections between the device and Unwired
Server. If using Relay Server, this is the Relay Server port. Default: 5001.

• Synchronization Server Host – the server host name used for synchronization.
• Synchronization Server Port – the port used for synchronization.
• Synchronization Server Protocol – the synchronization protocol - HTTP or HTTPS.
• Synchronization Server Stream Parameters – the server stream parameters.
• Synchronization Server URL Suffix – the server URL suffix.

Note: Some settings are visible but not in use by client (replication native application) at this
time.

Custom Settings
Define one of four available custom strings that are retained during reregistration and cloning.

Change the property name and value according to the custom setting you require. The custom
settings can be of variable length, with no practical limit imposed on the values. You can use
these properties to either manually control or automate how workflow-related messages are
processed:

• Manual control – an administrator can store an employee title in one of the custom fields.
This allows employees of a specific title to respond to a particular message.

• Automated – a developer stores the primary key of a back-end database using a custom
setting. This key allows the database to process messages based on messaging device ID.

Device Advanced Properties
Advanced properties set specific behavior for messaging devices.

• Relay Server URL Prefix – the URL prefix to be used when the device client is
connecting through Relay Server. The prefix you set depends on whether Relay Server is
installed on IIS or Apache. Acceptable values:

• For IIS – use/ias_relay_server/client/rs_client.dll.
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• For Apache – use /cli/iasrelayserver.

• Allow Roaming – the device is allowed to connect to server while roaming. Acceptable
values: true and false. Default: true.

• Debug Trace Size – the size of the trace log on the device (in KB). Acceptable values: 50 to
10,000. Default: 50.

• Debug Trace Level – the amount of detail to record to the device log. Acceptable values: 1
to 5, where 5 has the most level of detail and 1 the least. Default: 1.

• Device Log Items – the number of items persisted in the device status log. Acceptable
values: 5 to 100. Default: 50.

• Keep Alive (sec) – the Keep Alive frequency used to maintain the wireless connection, in
seconds. Acceptable values: 30 to 1800. Default: 240.

Device Info Properties
Information properties display details that identify the mobile device, including International
Mobile Subscriber identity (IMSI), phone number, device subtype, and device model.

• IMSI – the International Mobile Subscriber identity, which is a unique number associated
with all Global System for Mobile communication (GSM) and Universal Mobile
Telecommunications System (UMTS) network mobile phone users. To locate the IMSI,
check the value on the SIM inside the phone.

• Phone Number –  the phone number associated with the registered mobile device.
• Device Subtype – the device subtype of the messaging device. For example, if the device

model is a BlackBerry, the subtype is the form factor (for example, BlackBerry Bold).
• Model – the manufacturer of the registered mobile device.

Proxy Properties
(Applies only to Online Data Proxy) Proxy properties display details that identify the
application and push endpoints.

• Application Endpoint – the back-end URL where the application service document is
available

• Push Endpoint –  the server URL where all the notifications are forwarded to.

Security Settings
Security settings display the device security configuration.

• E2E Encryption Enabled – indicate whether end-to-end encryption is enabled.
• E2E Encryption Type – indicate the asymmetric cipher used for key exchange for end-to-

end encryption, either RSA or ECC.
• TLS Type – indicate the TLS type for device to Unwired Server communication, either

RSA or ECC.

Note: These settings are visible, but not in use by client (replication native application) at this
time.
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User Registration
User registration specifies details of the activation code that is sent to a user to manually
activate an application on the device.

• Activation Code Expiration (Hours) – indicates how long an activation code is valid. The
default is 72 hours.

• Activation Code Length – indicates the length of the activation code, as in number of
alphanumeric characters. The default is 3.
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Deploy

Deployment is a routine administration task that manages the life cycle of a mobile business
object (MBO) package on the Unwired Server. Deployment makes a package available to the
runtime environment, so that it can be administered or accessed by client devices. Deployment
is similar to, but not the same as, exporting and importing packages between multiple cluster
environments.

Unwired Platform supports the development and subsequent deployment of:

• Package archives
• Mobile Workflow archives

Depending on the package type, the deployment steps can vary.

Packages
Packages are collections of MBOs that are related by application use and authorship and
grouped according to maintenance or distribution. Packages are initially created by
developers, but are deployed and maintained on a production Unwired Server by
administrators.

Administrators cannot change the name of a package if one has been defined by the
development team. You can, however, create new package versions when you make an
upwardly incompatible change to an existing application. In this case, leave both versions of
the package running until every one of the remote client applications has been upgraded to the
latest version; only then should you delete the old package version.

Although each mobile business object (MBO) type has unique properties and data sources,
MBOs within a package used by an application may be of different types.

Note: You must deploy a package before you can configure or manage it. Package
administration tasks vary, depending on the type of package you deploy.

Deploying a Replication or Messaging Package
Use the Deploy wizard to make packages available on the Unwired Server.

Prerequisites
If your developers have created a custom filter for the mobile business object you are
deploying, you must copy class files to the primary server before you deploy the package that
uses those filters. If you copy the filters to a slave server by mistake, they are deleted when you
deploy the package to the primary server.
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To locate the name of the master, look at the server list in Sybase Control Center. If a particular
server is the master server of a cluster, it will be labeled as "primary" in the left navigation
pane.

Task

Deploying is the process whereby whole or part of a mobile application is loaded onto an
Unwired Server as one or more deployment units. Unwired Server can then make these units
accessible to users via a client application that is installed on a mobile device.

Because the deployment unit file contains package name and other information, you do not
need to select a package from the list of available packages; Unwired Server creates the
package automatically according to what has been defined in the deployment file.

Note: If the connection properties of an MBO or operation use credentials that have been
customized manually by a developer, the back-end data sources connection properties of these
MBOs and operations cannot be updated by an administrator when using the Deploy Wizard.

Instead, the adminstrator can update these properties after the MBO or operation is deployed
to an Unwired Server. When the server connection is created on Unwired Server, the
administrator can then change connection properties in Sybase Control Center by clicking on
the Connections node in the left navigation pane.

Launching the Deploy Wizard
Launch the Deploy wizard when the packages you require have already been created, or when
you want Unwired Server to create a package for you from a deployment unit file.

1. In the left navigation pane, expand the Domains folder.

2. Choose a domain name, then select Packages.

3. In the right administration pane, click the General tab.

4. Click Deploy.
Follow the instructions in the wizard to configure a package so it can be deployed.

Configuring Deployment Properties
Set the properties for packages being deployed on Unwired Server.

Prerequisites

Ensure that the deployment unit and the optional deployment descriptor exists and that you
can browse to the location of these files. Also, before you start the deploy wizard, ensure that
custom filter class files have been copied to the <UnwiredPlatform_InstallDir>
\<UnwiredPlatform>\Servers\UnwiredServer\lib\filters folder.
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Task

A deployment file and an optional deployment descriptor file are created by developers in
Unwired Workspace. These files are typically delivered for deployment to a production
version of the Unwired Server by an administrator.

Note: If the package is deployed to the primary server, it is cluster-level operation.

1. When the Deploy wizard loads, click Next.

2. Review the Deployment File name, or click Browse to navigate to the appropriate file.

You can select either a single deployment unit (.XML) or an archive file (.JAR).

The name of the Package Name appears. If this package does not already exist, the wizard
displays a message that indicates the new package will be created. The name cannot
exceed 64 characters or include any periods (".").

3. Select a Deployment Mode.

The deployment mode determines how the deployment process handles the objects in a
deployment unit and package. Which value you choose depends on whether or not a
package of the same name already exists on Unwired Server. Allowed values are:
• UPDATE – updates the target package with updated objects. After deployment, objects

in the server's package with the same name as those being deployed are updated. By
default, deploymentMode is UPDATE. If the deployment mode is specified both in the
descriptor file and the command-line, the command-line deploymentMode option will
override the deployment mode specified in the descriptor file.

• NOCLOBBER – deploys the package only if there are no objects in the target server's
package that have the same name as any of those objects being deployed.

• REPLACE – replaces any of the target objects with those in the package. After
deployment, the servers package contains only those objects being deployed.

• VERIFY – do not deploy package. Only return errors, if any. Used to determine the
results of the UPDATE deploy mode.

4. If you did not choose a deployment archive as your deployment file, you may browse and
select an optional deployment Descriptor File:

5. Click Next.

6. Select a Domain to deploy the package to.

7. Select a Security Configuration for the package.

8. Click Next.
The Configure Role Mapping page appears.

Deployment Archives
An archive is produced after a developer creates a package profile and executes a build on a
package. This archive can only be created in the Eclipse edition of Unwired WorkSpace.

In Unwired WorkSpace, a developer executes a build process so that it creates a .jar archive
file, which contains both a deployment unit and a corresponding descriptor file. A deployment
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archive can be delivered to an administrator for deployment to a production version of the
Unwired Server.

Deployment Descriptors
A deployment descriptor is an XML file that captures changes to the deployment unit during
deployment. Those changes are then used when a package is redeployed.

A deployment descriptor is not required to deploy the deployment unit.

A deployment descriptor is created either after a developer creates a package profile and
executes a build on a package, or when the developer deploys a package to a development
edition server from Unwired WorkSpace. The file contains this information:

• The deployment mode
• The target package that descriptor applies to
• The endpoint information that overrides specific endpoints defined for MBOs or

operations in the deployment unit
• The domain and named security that the package applied to
• Role mappings

This information is specific to each deployment unit; therefore, you cannot apply a descriptor
from another package to a deployment unit.

Setting the Mapping State
Map roles for a package by setting the mapping state. Mapping behavior is determined by the
state that exists for the logical role. You can select AUTO or NONE; a third state, MAPPED, is
set automatically after you manually map a physical role to the selected logical role.

You can set the mapping state either when managing roles, or earlier, during package
deployment. If your logical roles for a package do not automatically match the role names
registered in the back-end security system, map corresponding logical and physical names to
ensure that users can be authorized correctly.

1. For package-specific role mapping, select and deploy an available package. Follow the
wizard prompts until you reach the Configure Role Mapping page for the target package.

2. Change the mapping for a logical role, if required:

• To change the state to either NONE or AUTO, click the list adjacent to the logical role
and click the appropriate option.

• To change the role mapping itself, click the drop-down list adjacent to the logical role
and choose Map Role. This command displays the Role Mappings dialog that allows
you to manually set the physical role mappings. The Role Mappings dialog displays
the name of the logical role you are mapping in the text area of the dialog. Once saved,
the state automatically changes to MAPPED.

3. Click Next.
The Server Connection page appears.
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Deployment-time role mapping is done at the package level. Once the package is deployed,
you can change the role mapping by going to the Role Mapping tab for the desired package.
You can also set the role mapping for each security configuration at the domain level. This
allows the role mapping to be shared across packages for the common logical roles. Changing
role mapping at the domain level will result in role mapping changes in other domains where
the same security configuration is referenced.

Updating Server Connection Properties
Configure the production version of server connection properties. Typically, the endpoint and
role mapping a developer would use are not the same for a production system. Administrators
must reset these properties accordingly.

This step allows you to change connection profiles used for development (design time) to an
appropriate server-side connection. For example, your development environment might
permit access to certain systems that the Unwired Server prohibits.

Note: If the connection properties of an MBO or operation use credentials that have been
customized manually by a developer, the back-end data sources connection properties of these
MBOs and operations cannot be updated by an administrator when using the Deploy Wizard.

Instead, the adminstrator can update these properties after the MBO or operation is deployed
to an Unwired Server. When the server connection is created on Unwired Server, the
administrator can then change connection properties in Sybase Control Center by clicking on
the Connections node in the left navigation pane.

1. Review the connection properties.

2. Depending on how the properties are configured, choose an appropriate option:

• If the properties are configured by the developer as a set of connection properties, you
can edit properties as needed. To edit a property, click a field in the Value column and
change the value as required.

• If the properties are configured as an endpoint, choose the connection pool you want
Unwired Server to use. You cannot alter any of these properties.

3. If you want the changes to apply to operations only, click the corresponding check box at
the bottom of the table.

4. Click Next.

The connection properties are updated. The changes you make are displayed in the Summary
page in the Endpoint Updates section.
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Reviewing the Deployment Summary
Review the properties you have supplied before deploying the package to Unwired Server.
This allows you to change errors before making the deployment units available via the
package created for that purpose.

1. Review all three sections of the deployment summary. If anything is incorrect, click Back
and correct errors.

2. To create a deployment descriptor:

a) Click Create deployment descriptor.
b) Browse to the location you want to save the file and change the default name if

required.
c) Click OK.

You can use the deployment descriptor to redeploy the deployment unit without having to
repeat these steps in the deployment wizard.

3. Click Finish to deploy the file and create the package on Unwired Server.

Deploying to the server may take some time to complete. However, a status message
appears above the General tab indicating the success or failure of the attempt.

Replication-Based Synchronization Packages
Replication-based synchronization (RBS) packages are packaged mobile business objects
(MBOs) that use a replication paradigm to synchronize data and propagate transactions
between a device and Unwired Server. RBS package data can be synchronized through a
server-initiated push notification transmitted at defined intervals, or based upon the
occurrence of a synchronization event.

Administration for RBS packages involves configuring role mapping, setting required
properties for cache and synchronization groups, purging the cache, managing push
subscription templates and properties, and reviewing client activities.

Messaging-Based Synchronization Packages
Messaging-based synchronization (MBS) packages are packaged mobile business objects
(MBOs) that synchronize data through a messaging paradigm. Messaging-based
synchronization packages operate through device subscription to the package. Once
subscription is established, the server is responsible for maintaining the subscribed data set
through data pushes.

MBS package administration involves configuring role mapping, setting required properties
for cache and synchronization groups, purging the cache, managing messaging subscription
properties, registering user devices, modifying settings for registered user devices, and
reviewing client activities.

Note: Depending on the type of messaging package you are configuring (for example, one that
requires a SAP DOE connection, such as a Sybase Mobile Workflow package), not all
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configuration steps apply because some features are not supported for this package type. For
example, Sybase Mobile Workflow packages need not configure cache settings or sync
groups. Role mappings are also not required.

DOE-C Packages
Sybase Mobile Workflow for SAP Business Suite and Sybase Mobile Sales for SAP CRM
work with Unwired Platform to make parts of SAP Workflow available on your mobile device
using SAP Data Orchestration Engine connector (DOE-C) packages.

DOE-C packages implement messaging-based synchronization, which means that they
synchronize data through a messaging paradigm.

Setting the Bulk Load Timeout Property
The Subscribe bulk load timeout property is a package level property targeted to BlackBerry
clients for initial server-side subscription operations.

Server-side subscription improves performance and is enabled on the client if the device has a
secure digital (SD) memory card enabled. The timeout allows you to set an initial subscription
push timeout period. If the timeout period is reached, Unwired Server sends the database file
to the device, whether the initial subscribe is complete or not. The timeout window signals that
the device has received sufficient import messages to send the server-built database to the
client.

Note: This option is only available for Sybase SAP Data Orchestration Engine Connector
(DOE-C) packages.

1. In the left navigation pane of Sybase Control Center, expand the Packages folder and select
the package to configure.

2. In the right administration pane, select the Settings tab.

3. Set the timeout value. The default value is 3600 seconds.

In addition to the timeout value, you can define the Subscribe Bulk Load Thread Pool
Size – the maximum number of threads allocated to initial server-side subscription
operations. The default value is 5. Setting the thread pool size too high can impact
performance. This is a server-side setting that can be set:

a) In the left navigation pane, expand the Servers folder and select a server.
b) Select Server Configuration.
c) In the right administration pane, select the General tab.
d) From the menu bar, select Performance Configuration.
e) Expand Show Optional Properties.
f) Restart Unwired Server if you change the Subscribe Bulk Load Thread Pool Size

value for it to take effect.
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Importing Package Contents
Import package contents after they have been exported from another Unwired Server.

Note: A package can only be imported in the same domain as it was exported. Therefore it is
required that same domain exists in the server before the import. Also, it is required to create
domains in the same order in both export and import server environment to ensure that an
internal ID assigned to the domain in both environment matches. You can verify the internal
ID assigned to a domain by looking at the prefix used in the package folder in the exported
zip.

1. In the left navigation pane, expand the Packages folder.

2. In the right administration pane, click Import.

3. Enter a local file to import, or click Browse to navigate to the file.

4. Click OK.

Exporting Packages
Export a package to bundle one or more MBOs and package options in the selected package to
create a new instance of a deployment archive. Typically, export is used to move the package
contents onto another Unwired Server, however you can only import packages to the same
domain as it was exported from.

Note: It is a requirement to create domains in the same order in both the export and import
server environment to ensure that an internal ID assigned to the domain in both environment
matches. You can verify the internal ID assigned to a domain by looking at the prefix used in
the package folder in the exported zip.

1. In the left navigation pane, expand the Packages folder.

2. In the right administration pane, check the box adjacent to the name of the package and
click Export.
The Export Package dialog appears.

3. Check the appropriate export package options from the list: Include synchronization
tracing, Include package logging,,Include role mappings, and Include device
notification templates (for RBS packages only).

These selections determine which package settings are retained for the new instance of the
package. The current security configuration for the package is automatically applied to the
exported package.

4. Click Next.

5. Select the file system target for the exported contents and click OK.

Note: Ensure that you do not hide file type extension when you name the export package;
otherwise, when the *.zip extension becomes invisible, which adversely affects the
outcome of the export process.
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A status message on the General tab indicates the success or failure of the export
transaction. If successful a ZIP file is created in the location you specified. You can then
use this file to import the package.

Next

Deliver the file to the appropriate person or deploy the exported package on the appropriate
server.

Deleting a Package
Delete a package when you want to permanently remove all elements deployed on an Unwired
Server. If you do not want to permanently prohibit access by removing these files, consider
disabling the package instead.

1. In the left pane, click the Unwired Server you are currently logged in to.
This expands the list of Unwired Platform components you can manage, provided that you
have the correct permissions to do so.

2. Click Domains > DomainName > Packages.

3. To delete a package from the this list, select one or more packages and click Delete.
A confirm dialog box appears.

4. Click OK to confirm the deletion.

The package is removed from Unwired Server.

Enabling and Disabling a Package
Enable or disable a package to allow or prohibit device access to the package. Disabled
packages are still available to Sybase Control Center for Unwired Server. By default, all
packages are enabled.

When you disable a package, the server unloads all of its elements from memory. Disabling a
package prevents the Unwired Server from loading that package at start-up.

Note: You cannot disable a SAP Data Orchestration Engine Connector (DOE-C) package.

1. In the left navigation pane, click Packages.

2. In the right administration pane, select the General tab.

3. Select the box adjacent to the package you want to enable or disable.

You can select more than one package to apply the same change to multiple components.

4. Depending on the current status of the package, perform one of:

• Enable – if the package listed shows a status of disabled, click Enable.
• Disable – if the package listed shows a status of enabled, click Disable. The package

remains disabled until you or another administrator enables it; restarting Unwired
Server does not enable the package.
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Enabling Synchronization Tracing
Enable package execution tracing to collect detailed synchronization data in the server log.
This mechanism useful for debugging and diagnostics purposes only and has an adverse
impact on performance.

Tracing data consists of package synchronization data, such as data upload and download
sizes.

1. In the left navigation pane, expand the Packages folder and select the package you want to
configure.

2. In the right administration pane, click the Settings tab.

3. Select Enable synchronization tracing.

4. Click Save.

View synchronization tracing data from the server log.

Configuring a Cache Group
Select and configure a cache group. The cache is part of the Unwired Server cache database
(CDB) that is used to store data that is uploaded and downloaded from EIS servers and mobile
clients during synchronization.

Cache group configuration differs depending on whether the cache group is defined as "on
demand" or "scheduled" during development.

MBO Data in the CDB
A data cache is a copy of MBO data that is stored in a specific area of the cache database
(CDB). It is used as the data repository for replication and messaging MBOs that are deployed
to Unwired Server. "CDB" and "cache" and "MBO data" can sometimes used interchangeably,
even though the CDB includes runtime data as well.

When cache data is updated (either with an on-demand or scheduled cache refresh), the remote
client database eventually retrieves the updated data from the server's copy of MBO data in the
CDB by synchronization.

By giving applications a normalized and uniform view of corporate data, organizations can:

• Lower the barrier to data behind corporate firewalls
• Support development of mobile applications that interact with multiple enterprise back-

ends
• Reduce back-end load caused by device client requests
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Configuring On Demand Cache Group Properties
Specify the duration of cache data validity by configuring Unwired Server updates to mobile
business object (MBO) data for an on demand cache group.

Note: The developer configures a cache group as either on demand or scheduled. If the cache
group is "scheduled," the Cache tab is not configurable in the Cache Group Properties dialog.

1. In the left navigation pane, expand the Packages folder, and select the package for which
you want to configure cache settings.

2. In the right administration pane, click the Cache Group tab.

3. Select the cache group you want to configure and click Properties.

4. In the Cache Properties dialog, enter an expiry for the Cache Interval in seconds,
minutes, or hours.

The cache interval determines how frequently Unwired Server updates the cache database
with changes to enterprise data. See On Demand Cache Refreshes in the list of links below.

5. Click OK.

On Demand Cache Refreshes
Cache groups designated as "on demand" during development use cache intervals to balance
how frequently the object updates enterprise data with the amount of network traffic required
to maintain that data.

Unwired Server keeps a local copy of enterprise data in the cache database (CDB), and uses an
intricate mechanism to manage updates between the CDB and the EIS servers. When data is
updated, the remote client database eventually gets updated data from this local copy in the
CDB. The caching mechanism allows MBOs to retrieve updated data even if back-end servers
fail.

You must choose an appropriate cache interval for your system, since this value determines
how frequently the CDB is udpated with data from the EIS. The cache interval must be
configured according to business needs. A higher value for the cache may retain stale data,
however, a lower value increases the backend EIS load and may impede the client application's
performance, because Unwired Server queries the back-end information servers more
frequently to look for changes and possibly update the CDB copy.

Frequent queries typically put a higher load on the servers, as well as use more network
bandwidth on the server side. While the cache interval does not affect the bandwidth required
between the synchronization server and device client applications, nor the performance
characteristics of the client applications, the interval you choose can delay synchronization if
Unwired Server must first update many records in the CDB.

For example, if the cache interval is 0, each time a client application synchronizes, there is a
pause while the Unwired Server rereads data from the EIS and updates the CDB. If, however,
the cache interval is greater than 0, then the wait time depends on how long ago the data was
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refreshed. If the synchronization falls within a recent cache update, synchronization is almost
immediate.

Configuring Scheduled Cache Group Properties
Specify the duration of cache data validity by configuring Unwired Server updates to mobile
business object (MBO) data for a scheduled cache group.

Prerequisites
You can configure a schedule refresh for a cache only if the developer enables the cache group
as "scheduled" during development. Otherwise, the Schedule tab is not configurable in the
Cache Group Properties dialog.

Task

1. In the left navigation pane, expand the contents of the Packages folder and select the
package for which you want to display properties.

2. In the right administration pane, click the Cache Group tab.

3. Select the cache group you want to configure and click Properties.

4. In the Schedule tab of the Cache Properties dialog, set the frequency of the refresh by
selecting an appropriate Schedule Repeat: hourly, daily or custom.

This property determines what other schedule properties you must configure. Each option
is documented in a seperate topic which further discusses the details for each frequency
type. For more details, see the corresponding topic.

Scheduling an Hourly or Daily Refresh
Scheduling an hourly or daily cache refresh means that information is fetched from the
enterprise information server (EIS) and populated into the cache on either of these hourly or
daily frequencies according to the schedule and range of time you configure.

The Schedule tab in the Cache Property dialog displays options appropriate for configuring
this type of schedule.

1. Select either Hourly or Daily as the Schedule Repeat criteria.

2. (Optional) If you want to set a range to control which days the schedule refresh runs,
configure a start date and time, an end date and time, or day of week (if applicable).

• Select Start Date to set a date for which the first execution of the scheduled refresh is
performed. To be more specific, you can also select Start Time to specify a start time.
In this case, the refresh cannot begin until a given time on a given day has been reached.
A start date and time are inclusive.
If you do not set a start date and time, then, by default, the date and time that Unwired
Server starts is used.

• Select End Date to set a date that ends the repeating refresh transactions for a package.
To be more specific, you can also select End Time to specify an end time. An end date

Deploy

194 Sybase Unwired Platform



and time are exclusive. This means that a refresh transaction runs up to, but does not
include, the end time. For example, if a schedule has a start time of 13:00 and an end
time of 16:00 and repeats every hour, it runs at 13:00, 14:00, and 15:00, but not at
16:00.
If you do not set an end date and time, then, by default, the date and time that Unwired
Server stops is used.

• Select Specify Week Days to select the days of the week that the refresh transaction
runs. This means that for the days you select, the refresh runs every week on the day or
days you specify. A weekday is inclusive. This means that any day you choose is
included in the frequency. All others are excluded.

When the schedule expires, the automatic refresh you configured terminates, unless the
end user initiates a refresh.

3. Click Save.

Scheduling a Custom Refresh
Scheduling a custom cache refresh is the most flexible of all cache refresh schedules. This
means that information is fetched from the enterprise information system (EIS) according to
the schedule repeat interval you specify.

The Schedule tab in the Cache Property window displays options appropriate for configuring
this type of schedule.

1. Select Custom as the schedule repeat criteria.

2. Specify a repeat Interval, in minutes or seconds, to determine how often the cache refresh
occurs.

This interval determines how frequently Unwired Server updates the cache database with
changes to enterprise data. The default is 0 seconds, which means the mobile business
object retrieves the data from the enterprise information server (EIS) on every playback
request. If you choose something other than 0 seconds, the data is held by the cache for the
duration of the specified interval.

3. (Optional) To set a range to control which days the schedule refresh runs, configure a start
date and time, end date and time, or day of week (if applicable).

• Select Start Date to set a date for which the first execution of the scheduled refresh is
performed. To be more specific, you can also select Start Time to specify a start time.
In this case, the refresh cannot begin until a given time on a given day has been reached.
A start date and time are inclusive.
If you do not set a start date and time, then, by default, the date and time that Unwired
Server starts is used.

• Select End Date to set a date that ends the repeating refresh transactions for a package.
To be more specific, you can also select End Time to specify an end time. An end date
and time are exclusive. This means that a refresh transaction runs up to, but does not
include, the end time. For example, if a schedule has a start time of 13:00 and an end
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time of 16:00 and repeats every hour, it runs at 13:00, 14:00, and 15:00, but not at
16:00.
If you do not set an end date and time, then, by default, the date and time that Unwired
Server stops is used.

• Select Specify Week Days to select the days of the week that the refresh transaction
runs. This means that for the days you select, the refresh runs every week on the day or
days you specify. A weekday is inclusive. This means that any day you choose is
included in the frequency. All others are excluded.

When the schedule expires, the automatic refresh you configured terminates, unless the
end user initiates a refresh.

4. Click Save.

Scheduled Cache Refreshes
A schedule-driven cache refresh is a background task that runs between a configured start and
endpoint at scheduled intervals during normal server operation.

A schedule-driven cache refresh defines a contract between Unwired Server and back-end
information servers. Normally, data is retrieved from a server (for example, a database, and an
SAP repository, or a Web service) when a device user synchronizes. If the administrator wants
the data to be preloaded, he or she configures the Unwired Server repeat interval to expedite
data updates on the device.

Two properties configure the cache refresh schedule, which is used with a subscription to
synchronize data for mobile business objects (MBOs).

• Schedule repeat – determines the time frame when data is refreshed. If you set up a
schedule to repeatedly refresh data, information is always refreshed. Set the schedule to
meet business application requirements for data consistency.
As an administrator, you may also use a schedule repeat to look for data changes and alert
subscribed clients to synchronize when there are changes. Keep in mind, however, that the
actual detection of changes and sending of data (MBS) or notifications (RBS) depends on
the "change detection interval" property of the synchronization groups in the package, as
well as the notification threshold property of subscriptions of RBS package or push related
device settings for MBS package.

• Repeat interval – determines how often Unwired Server updates the cache with changes to
backend data.

Online Refresh Policy
MBOs that use an Online refresh policy indicates that the MBOs are to be used only in
Workflow applications where access to real-time enterprise information system (EIS) data is
required (cache validity is zero).

Data is valid in the Unwired Server cache only until delivery and immediately invalid. You
cannot modify the cache or schedule of the Online policy. Expired data is purged from the
cache based on a schedule at the domain level.
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DCN Refresh Policy
The cache refresh and schedule options are disabled for DCN (data change notification)
policy, since data never expires and is not refreshed based on client demand or a schedule.

Cache data does not expire until a cache invalidate operation is invoked or a data change
notification request is received from the enterprise information system (EIS).

Purging a Cache Group
Physically delete data that has been logically deleted from the cache. Cached data is marked as
logically deleted when certain activities occur in the client application or back end.

1. In the left navigation pane of Sybase Control Center, expand the Packages folder and
select the package to configure.

2. In the right administration pane, select the Cache Group tab.

3. Click OK.

Configuring a Synchronization Group for RBS Packages
Determine the frequency with which push notifications are generated by Unwired Server for
synchronization of mobile business objects (MBOs). The delivery time is determined by this
equation: delivery of push notification = schedule repeat value +
synchronization group change detection interval value +
notification threshold value. There may be an additional 10 second delay,
because the internal thread for a cache refresh from DCN or cache group that performs the
change detection runs every 10 seconds.

A synchronization group is a collection of MBOs that are synchronized together. For
replication-based synchronization packages (RBS), the synchronization group defines the
logical unit of synchronization and data notifications. The RBS client receives notifications
when data change is detected for any of the MBOs in a synchronization group, which
subsequently results in the client synchronization frequency of those MBOs.

1. In the left navigation pane, expand the Packages folder and select the package containing
the sync group you want to configure.

2. Select the desired sync group and click Properties.

3. Select a change detection interval. This value determines how frequently Unwired Server
looks for changes to MBOs, and generates push notifications. The default is 1 hour.

4. Click OK.

Configuring a Synchronization Group for MBS Packages
Determine the frequency with data changes are generated by Unwired Server for
synchronization of mobile business objects (MBOs). The delivery time is determined by this
equation: delivery of data change = schedule repeat value +
change detection interval value + + device push settings. There
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may be an additional 10 second delay, because the internal thread for performing the change
detection runs every 10 seconds.

A synchronization group is a collection of MBOs that are synchronized together. For
messaging-based synchronization (MBS) packages, the unit of changed data for MBOs
belonging to the synchronization group is sent directly to clients.

1. In the left navigation pane, expand the Packages folder and select the package containing
the sync group you want to configure.

2. Select the desired sync group and click Properties.

3. Select a change detection interval. This value determines how frequently Unwired Server
looks for changes to MBOs, and sends messages. The default is 1 hour.

4. Click OK.

Managing Deployed Package Subscriptions
Manage replication, messaging, and SAP Data Orchestration Engine connector (DOE-C)
package subscriptions that specify the synchronization messages mobile device users receive.

Subscription management tasks include pinging, unsubscribing, recovering, suspending,
resuming, resynchronizing, and logging subscriptions. Subscription tasks vary by the package
type.

These subscription management tasks apply only to the package types specified in the table
below. Perform each task in the Subscriptions tab of the deployed package you are managing.

Table 16. Subscription management tasks

Subscrip-
tion task

Description Summary Package
type

Ping Ensure that push information a
user provides for a device is
configured correctly.

If the ping is successful, notifi-
cations and subsequent data
synchronizations occur as de-
fined by each subscription. If
the ping fails, open the log and
check for an incorrect host
name or port number.

Select the box adjacent to the de-
vice ID, and click Ping.

Replication
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Subscrip-
tion task

Description Summary Package
type

Unsubscribe Remove a subscription from
Unwired Server.

Select the box adjacent to the de-
vice ID, and click Unsubscribe
for replication packages, messag-
ing packages, and DOE-C pack-
ages.

For Windows Mobile, the device
application must include the Da-
tabaseClass.CleanAllData();
method for data to be unsubscri-
bed correctly. If this method is not
used, Unsubscribe and Sub-
scribe could work unpredictably.

All

Recover Reestablish a relationship be-
tween the device and Unwired
Server. Perform recovery under
severe circumstances when a
device is unable to successfully
synchronize data.

During subscription recovery,
Unwired Server purges all en-
terprise data on the device. It
retains the device ID and sub-
scription information so that all
data can then be resynchronized
and loaded onto the device.

Check the box adjacent to the sub-
scription ID of the device, and
click Recover.

Messaging

Suspend/re-
sume

Control the deactivation and re-
activation of package subscrip-
tions:

• Suspend – temporarily
block data synchronization
for a device subscribed to a
particular package.

• Resume – reactivate a pack-
age subscription after it has
been suspended.

Select the box adjacent to the sub-
scription ID of the device, and
click either Suspend or Resume.

Messaging

DOE-C
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Subscrip-
tion task

Description Summary Package
type

Resynchron-
ize

Reactivate subscriptions to a
deployed package.

If a DOE-C subscription does
not respond to the SAP DOE
quickly enough, the DOE may
mark that subscription's queues
as "blocked" and stop sending
messages to the DOE-C. Re-
synchronize to resume commu-
nication from the DOE to the
DOE-C subscription.

Check the box adjacent to the sub-
scription ID of the device, and
click ReSync.

DOE-C

Purge Removes subscriptions that are
no longer referenced by any ac-
tive users.

Select the subscription, click
Purge, and then select the criteria.

Messaging

Replication

Configuring Replication Package Subscriptions
Configure subscriptions and subscription templates to allow the device user to be notified
when information is available, depending on the subscription properties configured for a
package. Subscription templates allow you to configure predefined properties for a
synchronization group. A client's first synchronization for a specified synchronization group
results in subscription creation using both the template and client-specified properties.

There are two main activities to set up a notification for a replication-based synchronization
package.

Creating Subscription Templates
Create a subscription template to specify synchronization targets and behavior for subscribed
users. A template is useful to create a set of predefined values that are used frequently.
Otherwise, a subscription is still automatically created for each client upon explicit indication
of interest for a device notification.

This is an optional step; it is only required if an administrator wants to establish preset
subscription properties. The subscription properties can be modified from device application,
but only if the Admin lock property is disabled.

1. In the left navigation pane, expand the Packages folder and select the replication based
sync package you want to configure.

2. In the right administration pane, click the Subscriptions tab.

3. From the menu bar, select Templates.
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4. Click New.

5. In the New Template dialog, select settings for these options:

• Synchronization Group – the group of MBOs that a client receives data change
notifications for when data changes occur.

• Notification Threshold – the length of time that must pass since a client's last
synchronization before another notification is sent.

• Admin Lock – (enable or disable) prevents device users from modifying the push
synchronization state or sync interval value configured in the subscription. If the admin
lock is disabled, the device client user can change these properties, and these changes
take effect the next time the client user synchronizes the package to which the
subscription applies.

• Push – (enable or disable) if enabled, automatic server-initiated notifications are
pushed to users when changes occur in the cache. If disabled, device users perform
client-initiated synchronizations when they receive an outbound notification.

Note: If you intend to use push synchronization with BlackBerry devices, enable push
synchronization in the BlackBerry server. See the BlackBerry server documentation for
details.

6. Click OK.
The new subscription template appears in the list of templates.

Notifications are delivered to BlackBerry device clients using push-based notification settings
and to Windows Mobile device clients using pull-based notification settings. The "poll every"
setting determines the notification delivery behavior. See in Sybase Control Center online
help.

Configuring Subscription Properties
View and configure subscription properties for device users subscribed to deployed
replication-based synchronization packages.

1. In the left navigation pane, expand the Packages folder and select the replication-based
synchronization package you want to configure.

2. In the right navigation pane, click the Subscriptions tab.

3. From the menu bar, select Devices.

4. Check the box adjacent to a device user and click Properties to view these subscription
properties:

• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Package Name – the name of the package to which the subscription belongs.
• Sync Counts – the total number of synchronizations for the subscription since the

synchronization history was last cleared.
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• Notification Threshold – the length of time that must pass since a client's last
synchronization before another notification is sent.

• Last Sync Time – the date and time that the last synchronization for the subscription
occurred.

• Synchronization Group – the group of MBOs that a client receives data change
notifications for when data changes occur.

• Admin Lock – (enable or disable) prevents device users from modifying the push
synchronization state or sync interval value configured in the subscription. If the admin
lock is disabled, the device client user can change these properties, and these changes
take effect the next time the client user synchronizes the package to which the
subscription applies.

• Push – (enable or disable) if enabled, automatic server-initiated notifications are
pushed to users when changes occur in the cache. If disabled, device users perform
client-initiated synchronizations when they receive an outbound notification.

5. Check the box adjacent to Clear sync history in order to erase stored synchronization
details for the subscription.

6. If you made changes to subsciption properties, click Save. Otherwise, click Cancel to
return to the Subscriptions tab.

Configuring Messaging and DOE-C Package Device Settings
View and edit device properties for messaging and SAP Data Orchestration Engine connector
(DOE-C) subscriptions that allow you to manage synchronization messages between
Unwired Server and mobile device users.

1. In the left navigation pane, expand the Packages folder, and select the package you want to
configure.

2. In the right navigation pane, click the Subscriptions tab.

3. Check the box adjacent to a device user and click Device Settings to view these
subscription properties:

• User – the name of the user associated with the application ID.
• Device Type – the type of the messaging device (for example, BlackBerry).
• Device Model – the manufacturer of the registered mobile device.
• Application Connection ID – the unique identifier for a user application connection.
• Status – the current status of a device. The possible values are: Online, Offline, and

Pending Activation.
• Pending Items – the pending items on the server side that needs to be sent to the device.
• Last Delivery – the date and time of last item delivered from Unwired Server to the

device.
• Client Version – the Sybase Unwired Platform client runtime version of the client.
• Node – the node of the cluster on which the device is registered.
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4. Click Next.

5. Configure these property categories, as required:

• Connection
• Custom Settings
• Device Advanced
• Device Info
• User Registration
• Apple Push Notifications (iPhone only)
• BlackBerry Push Notifications
• Proxy' 'Security Settings
• Application Setting

Checking and Resolving DOE-C User Failures
If the General tab of a DOE-C package displays an invalid user account error for the Error
State property, you must resolve the issue by reconfiguring the username and password in the
Connection Pool configured for the SAP package connection.

1. In the default domain, expand the Packages folder and click the DOE-C package name.

2. Check the Error State property in the General tab.

3. Validate the username and password configured, by clicking the Connection tab.

4. Correct the user credentials used by editing the corresponding connection pool properties:

a) In the navigation pane, click Connections.
b) In the administration pane, click the Connections tab.
c) Select the connection for the DOE-C package, then click Properties.
d) Set the username and password so that it matches the user account credentials.

Note: If you change the username or password property of a DOE-C connection, you
must reopen the same dialog and click Test Connection after saving. Otherwise
the error state of this DOE-C package cannot be cleaned up. If you do not click Test
Connection, the username or password is correct, but the error state of the DOE-C
package cannot be cleaned up.

Viewing and Changing Messaging and DOE-C Package Connection
Properties

View and edit connection properties for messaging and SAP Data Orchestration Engine
connector (DOE-C) packages.

1. In the left navigation pane, expand the Packages folder, and select the package whose
connection properties you want to view or change.

2. In the right navigation pane, click the Connection tab.
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3. If you wish to change any of the settings:

1. In the left navigation pane, click the Connections icon.
2. Select the checkbox for the Connection Pool Name that matches the name of the

package whose connection properties you were just viewing.
3. Click Properties.
4. Make desired changes and click Save.
5. In the left navigation pane, click the Connections icon.
6. Select the checkbox for the Connection Pool Name that matches the name of the

package whose connection properties you wish to test.
7. Click Properties.
8. Click Test Connection.

If the connection test is not successful, see Connection Test Errors in the
Troubleshooting guide

Managing Deployed Package Subscriptions
Manage replication, messaging, and SAP Data Orchestration Engine connector (DOE-C)
package subscriptions that specify the synchronization messages mobile device users receive.

Subscription management tasks include pinging, unsubscribing, recovering, suspending,
resuming, resynchronizing, and logging subscriptions. Subscription tasks vary by the package
type.

These subscription management tasks apply only to the package types specified in the table
below. Perform each task in the Subscriptions tab of the deployed package you are managing.

Table 17. Subscription management tasks

Subscrip-
tion task

Description Summary Package
type

Ping Ensure that push information a
user provides for a device is
configured correctly.

If the ping is successful, notifi-
cations and subsequent data
synchronizations occur as de-
fined by each subscription. If
the ping fails, open the log and
check for an incorrect host
name or port number.

Select the box adjacent to the de-
vice ID, and click Ping.

Replication
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Subscrip-
tion task

Description Summary Package
type

Unsubscribe Remove a subscription from
Unwired Server.

Select the box adjacent to the de-
vice ID, and click Unsubscribe
for replication packages, messag-
ing packages, and DOE-C pack-
ages.

For Windows Mobile, the device
application must include the Da-
tabaseClass.CleanAllData();
method for data to be unsubscri-
bed correctly. If this method is not
used, Unsubscribe and Sub-
scribe could work unpredictably.

All

Recover Reestablish a relationship be-
tween the device and Unwired
Server. Perform recovery under
severe circumstances when a
device is unable to successfully
synchronize data.

During subscription recovery,
Unwired Server purges all en-
terprise data on the device. It
retains the device ID and sub-
scription information so that all
data can then be resynchronized
and loaded onto the device.

Check the box adjacent to the sub-
scription ID of the device, and
click Recover.

Messaging

Suspend/re-
sume

Control the deactivation and re-
activation of package subscrip-
tions:

• Suspend – temporarily
block data synchronization
for a device subscribed to a
particular package.

• Resume – reactivate a pack-
age subscription after it has
been suspended.

Select the box adjacent to the sub-
scription ID of the device, and
click either Suspend or Resume.

Messaging

DOE-C
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Subscrip-
tion task

Description Summary Package
type

Resynchron-
ize

Reactivate subscriptions to a
deployed package.

If a DOE-C subscription does
not respond to the SAP DOE
quickly enough, the DOE may
mark that subscription's queues
as "blocked" and stop sending
messages to the DOE-C. Re-
synchronize to resume commu-
nication from the DOE to the
DOE-C subscription.

Check the box adjacent to the sub-
scription ID of the device, and
click ReSync.

DOE-C

Purge Removes subscriptions that are
no longer referenced by any ac-
tive users.

Select the subscription, click
Purge, and then select the criteria.

Messaging

Replication

Reviewing Replication Package Subscriptions
Review information on replication-based synchronization package subscriptions that allows
you to manage the notifications that are sent to device users, depending on the synchronization
group to which they belong.

In the left navigation pane, select a deployed package. In the administration console, click the
Subscriptions tab to review these properties:

• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Synchronization Group – the group of MBOs that a client receives data change

notifications for when data changes occur.

Reviewing Messaging Package Subscriptions
Review information on messaging-based synchronization package subscriptions in order to
manage the synchronization data that device users receive.

In the left navigation pane, select a deployed package. In the administration console, click the
Subscriptions tab to review these properties:

• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Status – the current status of a device. The possible values are: Running, Suspended,

Pending Activation, Online, Offline, and Expired.
• Last Server Response Time – the date and time that the last outbound response was sent

from Unwired Server to the client.
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• Client ID – the device application ID, which identifies the package database for the
application.

• Application Name – the name of the device application used by the subscription.

Reviewing DOE-C Package Subscriptions
Review information on SAP Data Orchestration Engine connector (DOE-C) package
subscriptions in order to manage the synchronization data that device users receive.

In the left navigation pane, select a deployed package. In the administration console, click the
Subscriptions tab to review these properties:

• Application Connection ID – the unique identifier for a user application connection.
• User – the name of the user associated with the application ID.
• Last Server Response Time – the date and time that the last outbound response was sent

from Unwired Server to the client.
• Client ID – the device application ID, which identifies the package database for the

application.
• Application Name – the name of the device application used by the subscription.
• Status – the current status of a device. The possible values are: Running, Suspended,

Pending Activation, Online, Offline, and Expired.
• Packet Dropped – the current packet dropped state of a device. The values are true or

false.

Select Advanced to view these properties:

• Subscription ID – the unique identifier of the subscription.
• Logical ID – the unique identifier of a registered device that is generated and maintained

by Unwired Server.

Reviewing MBO History
View or clear the error history of a mobile business object (MBO).

1. In the left navigation pane, expand the Packages folder and select the package that
contains the MBO you want to view.

2. Select the MBO.

3. In the right administration pane, click the History tab.

4. To view MBO data from a specific time period, select a Start date and End date and click
Go.

5. Review the following data for the MBO:

• Data refresh time – the time of this data refresh's failure.
• Failed data refresh counts – the number of failed data refreshes that occurred during the

specified time period.
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• Last successful data refresh – the date and time of the most recent successful data
refresh of this MBO before this refresh failure.

6. To clean MBO history data, click Clean.
Data is removed from the cache database.

Reviewing Operation History
View the error history of a mobile business object (MBO) create, delete, or update operation.

1. In the left navigation pane, expand the Packages folder and select the package that
contains the MBO operation you want to view.

2. Expand the desired MBO and select the operation for which you want to view the error
history: create, delete, or update.

3. In the right administration pane, click the History tab.

4. To view operation data from a specific time period, select a Start date and End date and
click Go.

5. Review the following data for the operation:

• Operation replay time – time of this operation replay's failure.
• Number of failed operation replays– the number of failed operation replays that

occurred during the specified time period.
• Last successful operation replay – the date and time of the most recent successful

replay of this operation before this operation replay failure.

6. Click Clean to remove operation history data.
The lines are removed from the cache database.

Purging the Synchronization Cache Manually
You can manually purge the synchronization at the package level. Mobile business objects
(MBOs) contained in a cache group using the online policy are deleted.

1. In the left navigation pane, expand the Domains folder and select a domain.

2. Navigate to the Packages folder, and select a package.

3. In the right pane, select the Cache Group tab.

4. On the Cache Group tab, click Purge.

5. Click OK to purge immediately based on your selections.

Purging RBS Package Subscriptions Manually
Periodically clean up replication-based synchronization subscriptions for a specific domain.

1. In the left navigation pane, expand the Domains folder and select a domain.

2. Navigate to the Packages folder, and select a replication-based subscription.
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3. In the right pane, select the Subscriptions tab.

4. On the Subscriptions tab, click Purge.

5. In the Purge Subscriptions dialog, enter the number of days to be purged. Any inactive
subscriptions that are older than this value are removed.

6. Click OK. The subscriptions that match the purging criteria are physically deleted from
cache database. Devices for which you have purged subscriptions cannot perform any
operations.

Searching for Inactive RBS Subscriptions
At any time you can search for inactive replication-based synchronization subscriptions. This
is useful for previewing subscription purge candidates.

1. In the left navigation pane, expand the Domains folder and select a domain.

2. Navigate to the Packages folder, and select a replication-based subscription.

3. In the right pane, select the Subscriptions tab.

4. Select Number of Inactive Days for the search.

5. Enter the number of inactive days, then click Go. The subscription candidates that would
be purged are retrieved.

Purging MBS Package Subscriptions Manually
Periodically clean up message-based synchronization subscriptions for a specific domain.
These are subscriptions that have been inactive, and fall outside of the number of days to
preserve.

1. In the left navigation pane, expand the Domains folder and select a domain.

2. Navigate to the Packages folder, and select a message-based subscription.

3. In the right pane, select the Subscriptions tab.

4. Click Purge.

5. Enter the number of inactive days to purge. Any inactive subscriptions that are older than
this value are removed.

6. Click OK.

Searching for Inactive MBS Subscriptions
At any time you can search for message-based synchronization subscriptions. This is useful
for previewing subscription purge candidates.

1. In the left navigation pane, expand the Domains folder and select a domain.

2. Navigate to the Packages folder, and select a message-based subscription.

3. In the right pane, select the Subscriptions tab.

4. Select the search criteria:
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• Select Number of Inactive Days, and enter the number of inactive days. This searches
for MBS subscriptions that have not been active for the number of days you specify.
For example, if you enter 90, and subscriptions that have not been active for the last 90
days are retrieved.

• Select Last Active Date, and enter a date. This searches for MBS subscriptions that
were active as of the date specified.

5. Click Go to retrieve the selection candidates that meet the criteria.

Assigning Package-Level Security
Assign security configurations at the package level to override those set at the domain-level.

Selecting a Security Configuration for a Package
Designate a security configuration for a package in Sybase Control Center. This is a required
step during package deployment, but you can later change the security configuration.

The administrator must create a security configuration in the cluster and assign it to the
domain where the package is deployed before the deployer can assign the security
configuration to the package.

1. In the left navigation pane, expand the Packages folder, and select the package to
configure.

2. In the right administration pane, click the Settings tab.

3. Select a security configuration.

The security profiles that appear in this list have been created by a platform administrator
and assigned to the domain.

4. Click Save.

Mapping Roles
Configure role mapping to authorize client requests to access MBOs and operations. For each
security configuration, platform and domain administrators can manage logical role mappings
at the package level or at a domain level. Use the corresponding domain or package node in the
left navigation pane to configure role mappings accordingly.

Set an appropriate mapping state for each logical role. The state you choose allows you to
disable logical roles, allow logical roles to be automatically mapped, or manually define
which logical roles are mapped to one or more physical roles. The states of AUTO or NONE
require the least administration.

If a developer has defined a logical role, mapping is not required; the logical role is matched to
the physical role of the same name and is therefore automatically mapped.

Note: Changes to domain-level role mapping are applied to all domains that share the same
security configuration. Likewise, changes to package-level role mapping apply to all instances
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of the affected package that use the same security configuration, even if the package is
deployed in multiple domains.

Setting the Mapping State
Map roles for a package by setting the mapping state. Mapping behavior is determined by the
state that exists for the logical role. You can select AUTO or NONE; a third state, MAPPED, is
set automatically after you manually map a physical role to the selected logical role.

You can set the mapping state either when managing roles, or earlier, during package
deployment. If your logical roles for a package do not automatically match the role names
registered in the back-end security system, map corresponding logical and physical names to
ensure that users can be authorized correctly.

1. For package-specific role mapping, select and deploy an available package. Follow the
wizard prompts until you reach the Configure Role Mapping page for the target package.

2. Change the mapping for a logical role, if required:

• To change the state to either NONE or AUTO, click the list adjacent to the logical role
and click the appropriate option.

• To change the role mapping itself, click the drop-down list adjacent to the logical role
and choose Map Role. This command displays the Role Mappings dialog that allows
you to manually set the physical role mappings. The Role Mappings dialog displays
the name of the logical role you are mapping in the text area of the dialog. Once saved,
the state automatically changes to MAPPED.

3. Click Next.
The Server Connection page appears.

Deployment-time role mapping is done at the package level. Once the package is deployed,
you can change the role mapping by going to the Role Mapping tab for the desired package.
You can also set the role mapping for each security configuration at the domain level. This
allows the role mapping to be shared across packages for the common logical roles. Changing
role mapping at the domain level will result in role mapping changes in other domains where
the same security configuration is referenced.

Mapping a Physical Role Manually
Use the Role Mappings dialog to manually map required physical roles for a logical role when
physical and logical role names do not match. If names do not match, the AUTO mapping state
does not work.

Prerequisites
Unwired Platform cannot query all supported enterprise security servers directly; for
successful authentication, you must know the physical roles your back-end systems require.
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Task

You can map a logical role to one or more physical roles. You can also map multiple logical
roles to the same physical role. If a role does not exist, you can also add or delete names as
needed.

1. Review the list of existing physical role names that you can map to the logical role you
have selected.

2. If a role that you require does not appear, enter the Role name and click the +  button.
The role name appears in the Available roles list with an asterisk (*). This asterisk
indicates that an available role was added by an administrator, not a developer.

3. To remove a role you no longer require from the Available roles list, select the name and
click the x button adjacent to the Role name field.
The role is removed and can no longer be mapped to a logical role.

4. To map a logical role that appears in the text area of the Role Mappings dialog to a physical
role:

a) Select one or more Available roles.
b) Click Add.

5. To unmap a role:

a) Select one or more Mapped roles.
b) Click Remove.

The roles are returned to the Available roles list.

6. Click OK to save these changes.

Once a logical role has been manually mapped, the mapping state changes to MAPPED. The
roles you have mapped appear in the active Physical Roles cell for either a package-specific or
server-wide role mappings table.

Mapping State Reference
The mapping state determines the authorization behavior for a logical name instance.

State Description

AUTO Map the logical role to a physical role of the same name. The logical
role and the physical role must match, otherwise, authorization fails.

NONE Disable the logical role, which means that the logical role is not au-
thorized. This mapping state prohibits anyone from accessing the
resource (MBO or Operation). Carefully consider potential conse-
quences before using this option.

MAPPED A state that is applied after you have actively mapped the logical role
to one or more physical roles. Click the cell adjacent to the logical role
name and scroll to the bottom of the list to see the list of mapped
physical roles.

Deploy

212 Sybase Unwired Platform



Logical Roles
Most logical roles are defined by MBO modelers or.

MBO modelers define logical roles in their models, either at the MBO or operation level:

• When logical roles are assigned to an MBO, that defines the role based access control
(RBAC) policy for who can read data from that MBO.

• When logical roles are assigned to an MBO operation, it defines the policy for who can
execute that operation.

After the MBO is deployed to a production Unwired Server, an Unwired Platform
administrator may create the logical and physical role mappings. This usually occurs after
consulting both:

• The MBO application developer to understand which logical roles are meant to protect
access.

• The backend security administrator to understand which physical roles are available.

After such consultation, the platform administrator may deem it appropriate to create new
backend roles and assign subjects to them to get appropriate groupings.

In the absence of explicit mapping, the default role mapping is set to AUTO, which is
equivalent of logical role mapping to a physical role of the same name, in the underlying
provider of that security configuration.

SUP DCN User Role
The SUP DCN User is a logical role that Unwired Platform uses to authorize any DCN event:
updating data in the cache, executing an operation, or triggering a workflow package.

Before any DCN event is submitted, the person or group mapped to this role must be
authenticated and authorized by the security configuration. By default, SUP DCN User is
automatically available to all new security configurations. However, the underlying default
varies depending on the environment in use.

Before this logical role can be used, SUP DCN User must be mapped to a physical role in the
enterprise security repository, and the user who performs DCN must be in that physical role.

• To map the SUP DCN User to a user in the underlying security repository, the user name
must be first defined in Sybase Control Center as a physical role that is mappable. Then,
SUP DCN User role can be mapped to a physical user or to a physical role from Sybase
Control Center. For example, to map SUP DCN User to a user that is not in the security
repository, use the format  user:User.

If you are supporting multiple domains, the user name must also include the named
security configuration for the package the DCN is targeted for, by appending
@DomainSecurityConfigName as a suffix to that name. Suppose you have two packages
(PKG_A, PKG_B) deployed to two domains (Domain_A, Domain_B) respectively.
Further, assume that PKG_A in Domain_A has been assigned to the "admin" security
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configuration, whereas PKG_B in Domain_B has been assigned to the
"alternateSecurityConfig" security configuration.
• A user doing DCN to PKG_A should identify him or herself as User@admin.
• A user doing DCN to PKG_B should identify him or herself as

User@alternateSecurityConfig.
If you are using ActiveDirectory, and are using e-mail addresses for user names,
definitions appear as username@myaddress@DomainSecurityConfigName.

The implementation varies, depending on the DCN service used:

• For workflows, because the resource the user is pushing data toward is a group of named
users (users authenticated previously successfully against a certain security
configuration), he or she must have the authorization to push to that particular security
configuration. The user must be mapped to SUP DCN User in the security configuration
for the workflow target.

• A user having SUP DCN User logical role in security configuration "mySecConfig1"'
must not have the right to push workflow DCN or regular DCN to a user or package
associated with "mySecConfig2".

Physical Roles
Physical roles are named references to roles or groups that an administrator has defined on a
back-end enterprise security provider. Mapping a logical role to a physical role allows
authorization control in the Unwired Server. Replicate these names exactly, so that logical
roles can be mapped correctly to the server role.

Physical roles are sourced from the enterprise security repositories. In some cases, the security
providers configured by the administrator in Sybase Control Center are not able to reliably
extract a list of physical roles from these repositories. In which case, Unwired Platform
administrator must collaborate with the security administrator to get a list of physical roles.
These must be manually entered in the role mapping stage when creating a security
configuration in Sybase Control Center.

Mobile Workflows
Mobile Workflow packages support occasionally connected users and solve the replication
and synchronization issues such users present with respect to data concurrency. Worfkflow
packages are similar to other package types in that an administrator must deploy the package
to Unwired Server so that it can be configured and made available to client devices.

Enabling and Configuring the Notification Mailbox
Configure the notification mailbox settings that allow Unwired Server to transform e-mail
messages into mobile workflows.

The notification mailbox configuration uses a listener to scan all incoming e-mail messages
delivered to the particular inbox specified during configuration. When the listener identifies
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an e-mail message that matches the rules specified by the administrator, it sends the message
as a mobile workflow to the device that matches the rule.

Note: Saving changes to the notification mailbox configuration deletes all e-mail messages
from the account. Before proceeding with configuration changes, consult your e-mail
administrator if you want to back up the existing messages in the configured account.

1. In the left navigation pane, click Workflows.

2. In the right administration pane, click Notification Mailbox.

3. Select Enable.

4. Configure these properties:

• Protocol – choose between POP3 or IMAP, depending on the e-mail server used.
• Use SSL – encrypt the connection between Unwired Server and the e-mail server in

your environment.
• Server and Port – configure these connection properties so Unwired Server can

connect to the e-mail server in your environment. The defaults are localhost and port
110 (unencrypted) or 995 (encrypted).

• User name and Password – configure these login properties so Unwired Server can
log in with a valid e-mail user identity.

• Truncation limit – specify the maximum number of characters taken from the body
text of the original e-mail message, and downloaded to the client during
synchronization. If the body exceeds this number of characters, the listener truncates
the body text to the number of specified characters before distributing it. The default is
5000 characters.

• Poll seconds – the number of seconds the listener sleeps between polls. During each
poll, the listener checks the master inbox for new e-mail messages to process. The
default is 60 seconds.

5. If you have added at least one distribution rule, you can click Test to test your
configuration. If the test is successful, click Save.

Configuring a Mobile Workflow Package
Configure mobile workflow properties for you production environment.

Prerequisites
You must deploy a package before you can configure properties for it.

Configuring General Mobile Workflow Properties
Configure general properties for a mobile workflow, including display name and icon. Alter
these settings to modify development environment values to production environment
equivalents.
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1. In the left navigation pane, click Workflows and select the mobile workflow for which to
configure the properties.

2. In the right administration tab, click General.

Only an administrator can change these properties. All others are configured by the mobile
workflow developer and cannot be modified.

• Display name – sets the name that appears for the mobile workflow package.
• Display icon – scroll and select the icon you want to use for the mobile workflow

package.

3. Click Lock/Unlock to lock or unlock a mobile workflow.

A locked mobile workflow cannot be modified or deployed.

4. Click Save.

Configuring Matching Rules
Define the parameters and matching rules that determine whether an e-mail message is a
regular e-mail, or a workflow e-mail at runtime.

Prerequisites
The developer must have created an object query and added an E-mail Subscription starting
point when the mobile workflow was designed.

Task

When a multiplexer, which a user configures for a Notification mailbox, retrieves e-mails
from the e-mail server, the "Matching rules" are used to determine if an e-mail is a regular e-
mail or a workflow e-mail. If the "matching rules" match, then the e-mail is processed as a
workflow e-mail. The e-mail is processed for "Extraction rules" (this processing is not visible
in SCC) to extract values from the e-mail. This determines further processing, such as calling
MBO object queries, and so forth. Then, a workflow message is constructed with the
necessary data of the object query result, and sent to device(s) according to the "Distribution
rules" (which determine the devices to which the message should be sent).

You can configure a matching rule at one of two levels:

• At the inbox level to route e-mails for all mobile workflows
• At the package level to route e-mails only for a specific mobile workflow

1. In the left navigation pane, click Workflows > WorkFlowName.

2. In the right administration pane, click the Matching Rules tab.

3. Configure matching rules by either:

• Clicking Add to create a new rule, or,
• Selecting an existing rule name and clicking Properties.

4. In the Matching Rules dialog:
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a) Select the field in the e-mail from which the parameter value is extracted. For example,
if you choose From, the parameter value is extracted from the line of the e-mail
message that indicates the name of the sender of the message.

You can also select one of the custom parameter values. When registering mobile
workflow devices, an administrator can choose one of four device settings. The
customer then populates the settings with whatever values they like. Custom
parameters can also be set programmatically through Web services.

Note: If you are editing properties of a rule created by a developer, you cannot modify
the matching rules.

b) Choose the type of search expression:

• Equals – the field must exactly match the text in the label.
• Begins with – the field must begin with the text in the label.
• Ends with – the field must end with the text in the label.
• Contains – the text in the label must exist somewhere in the field.
• Regular expression – search for text that matches the pattern defined by the regular

expression. You can create an expression with Boolean operators, groups, or
wildcards like "?" or "*". Unwired Platform uses the Boost regular expression
engine. See the Boost documentation on regular expression syntax at http://
www.boost.org/doc/libs/1_40_0/libs/regex/doc/html/boost_regex/syntax.html.

c) Configure the text to search against, or define a regular expression in the Value field.

Next
Test all new and changed rules to ensure they work as designed.

Testing Configured Matching Rules
Test a new or modified matching rule to ensure it is configured correctly.

1. In the Matching Rules tab for a selected mobile workflow package, click Test.

2. Populate the fields to create a sample e-mail message against which the rule configuration
is tested. Review the results:

• If a pattern for a corresponding field in the rule matches, the word Pass appears
adjacent to the field.

• If a pattern for a corresponding field in the rule does not match, the word Fail appears
adjacent to the field.

• Otherwise, No Rule appears, indicating that no rule was created for this
corresponding e-mail field.
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Configuring Context Variables for Mobile Workflow Packages
The administrator can change some of the values of a selected variable, should the design-time
value need to change for a production environment.

Which values are configurable depends on whether the developer hard-coded a set of user
credentials or used a certificate.

1. In the left navigation pane, click Workflows >
<Workflow_Package>:<Workflow_Version>.

2. In the right administration pane, click the Context Variables tab.

3. Select the context variable to configure, then click Modify.

Context Variable Description

SupUser The user name of the Platform administrator.

SupUnrecoverableErrorRetryTimeout After sending a JSON request to Unwired Serv-
er, if you receive an EIS code that indicates an
unrecoverable error in the response log, the
mobile workflow client throws an exception. A
retry attempt is made after a retry time interval,
which is set to three days by default. Select this
property to change the retry time interval.

SupThrowCredentialRequeston401Error The default is true, which means that an error
code 401 throws a CredentialReques-
tException, which sends a credential re-
quest notification to the user's inbox. If this
property is set to false, error code 401 is treated
as a normal recoverable exception.

SupRecoverableErrorRetryTimeout After sending a JSON request to Unwired Serv-
er, if you receive an EIS code that indicates a
recoverable error in the response log, the mo-
bile workflow client throws an exception. A
retry attempt is made after a retry time interval,
which is set to 15 minutes by default. Select this
property to change the retry time interval.

SupPassword The password of the Platform administrator.

SupPackages The name and version of the deployed Mobile
Workflow package. This cannot be changed.
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Context Variable Description

SupMaximumMessageLength Use this property to increase the allowed max-
imum Mobile Workflow message size. Limita-
tions vary depending on device platform:
• For BlackBerry 5, the limit is 512KB.
• For Windows Mobile the limit is 500KB.
• For BlackBerry 6 and Android, the limit

depends on the memory condition of the
device. Large message may result in an out
of memory error.

4. In the Context Variable dialog, change the value of the named variable and click OK.

Changing Hard Coded User Credentials
The administrator can change hard coded user credentials assigned at design time if the design
time value needs to change for a production environment.

1. In the left navigation pane, click Workflows >
<Workflow_Package>:<Workflow_Version>.

2. In the right administration pane, click the Context Variables tab.

3. Select one or both of the variables: SupUser or SupPassword, and click Modify.

4. Type the new value and click OK.

Adding a Certificate File to the Mobile Workflow Package
The administrator can change the credential certificate assigned at design time.

1. In the left navigation pane, click Workflows >
<Workflow_Package>:<Workflow_Version>.

2. In the right administration pane, click the Context Variables tab.

3. Select SupPassword and click Modify.

4. To select a new certificate file, click Browse to find and upload a production version of the
certificate.
The read-only values of SupUser, SupCertificateSubject, SupCertificateIssuer,
SupCertificateNotAfter, SupCertificateNotBefore change to reflect values of the new
certificate and password you set.

5. Click OK.

Assigning and Unassigning Mobile Workflows
Assign mobile workflow packages to make them available to a device user. Unassign them
when a package is no longer required.
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1. In the left navigation pane of Sybase Contorl Center, click Workflows >
<Mobile_WorkFlow_Package>.

2. In the right administration pane, click the Application Connections tab.

3. Locate the device to assign a mobile workflow package to, then:

a) Click Assign Workflow.
b) List the activation users to assign the mobile workflow package to.

By default, no users are listed in this window. Search for users by selecting the user
property you want to search on, then selecting the string to match against. Click Go to
display the users.

c) Select the user or users from the list to which to assign the mobile workflow package.
d) Click OK.

4. To unassign a mobile workflow package, select the User and click Unassign Workflow.

Checking Mobile Workflow Users and Queues
Check mobile workflow application users and review pending activities for a mobile
workflow application.

1. In the left navigation pane, expand the Workflows folder and select the mobile workflow
you want to administer.

2. To check mobile workflow users:

a) In the right administration pane, select the Application Connections tab.
b) Review data about mobile workflow device users:

• User – the name of the user that activates the device.
• Application Connection ID – the unique identifier for a user application

connection.
• Errors – the total number of errors on the device.
• Transform Items – the total number of items in the transform queue. The transform

queue contains items that Unwired Server has transformed from e-mail messages
into mobile workflow messages to be sent to clients.

• Response Items – the total number of items in the response queue. The response
queue contains mobile workflow messages that are sent from the device to Unwired
Server.

• Device Number – the unique identifier for a registered mobile device that is
generated and maintained by Unwired Server.

• Transform Queue Status – the current status of the transform queue: active,
awaiting credentials, or awaiting retry.

• Response Queue Status – the current status of the response queue: active, awaiting
credentials, or awaiting retry.

3. To view pending activities for a mobile workflow:

a) Select the Queue Items tab.
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b) Review data about pending mobile workflow activities:

• User – the name of the user that activates the device.
• Queue Type – the type of mobile workflow queue: response or transform.
• Application Connection ID – the unique identifier for a user application

connection.
• Device Number – the unique identifier for a registered mobile device that is

generated and maintained by Unwired Server.
• Queue ID – the unique identifier of the queued item.
• State – the status of the mobile workflow queue: active, awaiting credentials, or

awaiting retry.
• Creation Date – the date the queue item was created.
• Retry Date – the date that the processing of the queue item is scheduled to be retried

(if applicable).

4. To manage the mobile workflow queue in the event of non-recoverable errors:

a) Select the Queue Items tab.
b) Identify a workflow queue item that requires you to unblock it or delete it.

Errors affecting workflow queue items are either recoverable (where a retry is
applicable) or unrecoverable/unknown (where no automatic retry occurs, or there is
very long retry interval).

To recover from a long retry interval, an administrator can unblock a queue currently in
retry state, so the next work schedule can pick up the blocked item immediately, instead
of waiting for the retry timeout.

c) Select one of more of the queue items from the same queue type (the queue type for all
the selected items must be either Transform or Retry).

d) Select one of the following actions:

• Delete – deletes the selected workflow queue item(s).
• Unblock – unblocks the selected workflow queue item(s) that are currently in a

retry state.
e) Click OK to confirm the action.

Deploying a Mobile Workflow Package
Use the Deploy wizard to make mobile workflow packages available on the Unwired Server.

1. In the left navigation pane, click Workflows.

2. From the General tab, click Deploy.

3. Click Browse to locate the Mobile Workflow package.

4. Select the file to upload and click Open.

5. Select the deployment mode:

• New – generates and deploys the mobile workflow package and its files for the first
time.
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If the uploaded file does not contain a Mobile Workflow, or a Mobile Workflow with
the same name and version is already deployed to Unwired Server, you see an error
message.

• Update – updates the existing mobile workflow package with the newly generated
mobile workflow package and its files before deploying. The previous version of the
package remains on the server

• Replace – replaces any pre-existing mobile workflow packages while preserving any
user assignments.

The package is added to the list of deployed packages, which are sorted by Display Name.

Next
Configure the package if you want the deployed package to have a different set of properties in
a production environment.
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Monitor

Monitor availability status, view performance statistics, and review system data that allow
administrators to diagnose the health of the runtime.

Monitored operations include replication-based synchronization, messaging-based
synchronization, messaging queue, data change notification, device notification, package,
user, and cache activity. These aspects of monitoring are important to ensuring that the
required data is collected.

The critical aspects of monitoring include:

1. Setting up a monitoring configuration. A monitoring configuration sets the server
behavior for writing data to database, automatic purge, and data source where the
monitoring data is stored.

A default configuration is created for you, however you will likely want to customize this
configuration for your environment. By default, monitoring data is flushed every 5
minutes. In development and debugging scenarios, you may need to set the flush behavior
to be immediate. Set the Number of rows and Batch size properties to a low number. You
can also disable flush, which results in immediately persisting changes to monitoring
database. If you are setting up immediate persistence in a production environment, you
may experience degraded performance. Use persistence with caution.

2. Creating a monitoring profile. A monitoring profile defines one or more domains and
packages that need to be monitored.

You can either use the default profile to capture monitoring data for all packages in all
domains or create specific profiles as required. Otherwise, disable the default profile or
modify it as needed.

3. Reviewing the captured data. An administrator can review monitoring data (current,
historical, and performance statistics) from Sybase Control Center.

Use the monitoring tabs to filter the data by domain, package, and time range. You can also
export the data into a CSV or XML file and then use any available reporting or spreadsheet
tool to analyze the data.

Monitoring Usage
Monitoring information reflects current and historical activity, and general performance
during a specified time period.

Monitoring allows administrators to identify key areas of weakness or periods of high activity
in the particular area they are monitoring. Access to this data helps administrators make
decisions about how to better configure the application environment to achieve a higher level
of performance.
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The historical data is preserved in the monitor database. Performance data (KPIs for
Replication, Messaging, Package Statistics, User Statistics, and Cache Statistics) for the
specified time period is calculated upon request using the historical data available for that
period. If monitoring data is purged for that time period, the performance data calculations
will not factor in that data. It is recommended to purge monitoring data after putting in place
mechanisms to export the required historical and/or performance data as needed. By default,
monitoring data is automatically purged after seven days.

Also note that the processing times are calculated based on the time the request (or message)
arrives on the server, and the time it took to process the request (or message) on the server. The
client-side time (request origin time, and time taken to deliver to the server) are not factored
into that data.

System Monitoring Overview
The goal of monitoring is to provide a record of activities and performance statistics for
various elements of the application. Monitoring is an ongoing administration task.

Use monitoring information to identify errors in the system and resolve them appropriately.
This data can also be shared by platform and domain administrators by exporting and saving
the data to a .CSV or .XML file.

The platform administrator uses Sybase Control Center to monitor various aspects of Unwired
Platform. Monitoring information includes current activity, historical activity, and general
performance during a specified time period. You can monitor these components:

• Security log
• Replication-based synchronization
• Messaging-based synchronization
• System queue status
• Data change notifications
• Device notifications (replication)
• Package statistics
• Device users
• Cache activity

To enable monitoring, platform administrators must set up a monitoring database, configure a
monitoring data source or create a new one, and set up monitoring database flush and purge
options. By default the installer created a monitoring database, however you can use another
one if you choose.

To control monitoring, platform administrators create monitoring profiles and configurations,
which define the targets (domains and packages) to monitor for a configured length of time. A
default monitoring profile is created for you by the installer. Monitoring data can be deleted by
the platform administrator as needed.
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Table 18. System monitoring tasks

Task Frequency Accomplished by

Create and enable monitor-
ing profiles

One-time initial configuration with
infrequent tuning as required

Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Enable domain logging One-time setup with infrequent con-
figuration changes, usually as issues
arise

Sybase Control Center for Un-
wired Platform with the Do-
mains > <DomainName> >
Log node.

Review current/historical/
performance metrics

Routine Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Identify performance is-
sues

Active Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Monitor application and
user activity to check for
irregularities

Active Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Troubleshoot irregularities Infrequent Reviewing various platform
logs

Purge or export data On demand Sybase Control Center for Un-
wired Platform with the Moni-
toring node

Monitoring Configuration
The monitoring configuration identifies the monitoring database endpoint and determines
how long data is stored in the database.

The configurable monitoring properties are:

• Auto-purge – configures an automatic purge of the monitoring database to occur on a
regular basis.

• Flush threshold – determines how often monitoring data is flushed from the server
memory for storage in the monitoring database.

• Flush batch size – divides flushed data into smaller segments, rather than saving all data
together according to the flush threshold parameters.

• Monitor database endpoint – sets the database to be used for storage of monitoring data.
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Configuring Monitoring Performance Properties
Configure auto-purge, flush threshold, and flush batch size settings to determine how long
monitoring data is retained, and set a monitoring database to configure where data is stored.

Prerequisites

Depending on the expected level of monitoring activity, ensure that the monitoring database is
adequately prepared to store monitoring data.

Task

1. In the left navigation pane of Sybase Control Center, select Monitoring.

2. In the right administration pane, select the General tab.

3. Click Configuration.

4. Configure auto purge settings.

Auto purge clears obsolete data from the monitoring database once it reaches the specified
threshold.

a) Select Enable auto purge configuration to activate auto purge functionality.
b) Enter the length of time (in days) to retain monitoring data before it is purged.

5. Configure flush threshold settings.

The flush threshold indicates how often data is flushed from memory to the database. This
allows you to specify the size of the data saved in memory before it is cleared. Alternately,
if you do not enable a flush threshold, data is automatically written to the monitoring
database as it is captured.

a) Select Enable flush threshold configuration to activate flush threshold functionality.
b) Select one of:

• Number of rows – monitoring data that surpasses the specified number of rows is
flushed from memory. Enter the desired number of rows adjacent to Rows. The
default is 100.

• Time interval – monitoring data older than the specified time interval is flushed
from memory. Enter the desired duration adjacent to Minutes. The default is 5.

• Either rows or time interval – monitoring data is flushed from memory according
to whichever value is reached first: either the specified number of rows or the
specified time interval. Enter the desired rows and duration adjacent to Rows and
Minutes, respectively.

6. If you enabled a flush threshold, enter a Flush batch row size by specifying the size of
each batch of data sent to the monitoring database. The row size must be a positive integer.

The batch size divides flushed data into smaller segments, rather than saving all data
together according to the flush threshold parameters. For example, if you set the flush
threshold to 100 rows and the flush batch row size to 50, once 100 rows are collected in the
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monitoring console, the save process executes twice; data is flushed into the database in
two batches of 50 rows. If the flush threshold is not enabled, the flush batch row size is
implicitly 1.

Note: By default, the monitoring database flushes data every 5 minutes. Alternatively, you
can flush data immediately by removing or decreasing the default values, but doing so
impacts performance and prevents you from using captured data.

7. Optional. To change the data source, select an available database from the Monitor
database endpoint drop down list.

Available databases are those with a JDBC server connection type created in the "default"
domain. To create a new monitor database, a platform administrator must set up a database
by running the appropriate configuration scripts and creating a server connection for the
database in the default domain. The database server connection then appears as an option
in the Monitor Database Endpoint drop down list.

8. Click OK.

Monitoring Profiles
Monitoring profiles specify a monitoring schedule for a particular group of packages. These
profiles let administrators collect granular data on which to base domain maintenance and
configuration decisions.

A default monitoring profile is automatically created in disabled state on Unwired Server.
Administrators can enable or remove the default profile, and enable one or more new
monitoring profiles as required.

The same monitoring schedule can be applied to packages across different domains; similarly,
you can select individual packages for a monitoring profile.

Note: Properties you configure for an Unwired Server are cluster-affecting. Therefore, to
make sure they are propagated correctly, Sybase recommends that you set them only on a
primary cluster server.

Creating and Enabling a Monitoring Profile
Specify a monitoring schedule for a group of packages.

Prerequisites
Depending on the expected level of monitoring activity, ensure that the monitoring database is
adequately prepared to store monitoring data.

Task

1. In the left navigation pane, select Monitoring.
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2. In the right administration pane, select the General tab.

3. Click New to create a monitoring profile.

4. Enter a name for the new profile.

5. Select the Domains and Packages tab and choose packages to be monitored according to
these options:

• Monitor all domains and packages – select All Domains and Packages.
• Monitor all packages from one or more domains – select a domain, then click Select

All Packages. Perform this step for each domain you want to monitor.
• Monitor specific packages from one or more domains – select a domain, then select the

particular packages you want to monitor from that domain. Perform this step for each
domain you want to monitor.

6. Select View my selections to view the packages you selected for the monitoring profile.
Unselect this option to return to the package selection table.

7. Select Enable after creation to enable monitoring for the selected packages immediately
after you create the profile. By default, this option is selected. Unselect this option to
enable the monitoring profile later.

8. On the Schedule tab, select a schedule to specify when monitoring takes place:

• Always On – this schedule requires no settings. Package activity is continually
monitored.

• Run Once – specify a length of time during which monitoring occurs, in either minutes
or hours. Package activity is monitored for the duration specified for one time only.

• Custom – specify start and end dates, start and end times, and days of the week.
Package activity is monitored according to the time frame specified. See Setting a
Custom Monitoring Schedule.

9. Click OK.
A status message appears in the administration pane indicating the success or failure of
profile creation. If successful, the profile appears in the monitoring profiles table.

10. To enable a profile that you did not enable during creation, select the monitoring profile
and click Enable.

Setting a Custom Monitoring Schedule
Customize the monitoring schedule for packages within a monitoring profile. Setting a
custom schedule is the most flexible option; monitoring information is provided according to
the time frame you specify.

Prerequisites
Begin creating a monitoring profile in the New Monitor Profile dialog.
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Task

1. In the New Monitor Profile dialog, select the Schedule tab.

2. Select Custom as the monitoring schedule criteria.

3. To set a range to control which days the custom schedule runs, configure a start date and
time, end date and time, or day of week (if applicable).

• Select Start Date to set a date for when monitoring of package activity begins. To be
more specific, you can also enter a Start Time. In this case, monitoring cannot begin
until a given time on a given day has been reached.

• Select End Date to set a date that ends the monitoring of package activity. To be more
specific, you can also enter an End Time.

• Select the days of the week that package monitoring runs. This means that for the days
you select, the schedule runs every week on the day or days you specify.

If you do not indicate a time frame, Unwired Server uses the default custom schedule,
which is equivalent to Always On monitoring.

4. Click OK.

Monitoring Data
Monitoring data is aggregated in the Monitoring node of Unwired Server and organized by
activity, including replication-based synchronization, messaging-based synchronization,
messaging queue, data change notifications, device notifications, packages, users, and cache.
The data for each activity is further broken down into current, historical, and performance-
related information. View data for each monitored activity to track the performance and health
of the system.

You can selectively view data accrued during a specific time period to see a snapshot of system
performance during specific periods. The export function allows you to save data to a file
outside of Sybase Control Center for reference or logging purposes.

Reviewing System Monitoring Data
Review data for monitored activities. The monitoring data is retrieved according to the
specified time range. Key Performance Indicators (KPIs) are also calculated for the specified
time range.

1. In the left navigation pane, select Monitoring.

2. In the right administration pane, select one of the following tabs according to the type of
monitoring data you want to view:

• Security Log
• Replication
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• Messaging
• Queue
• Data Change Notifications
• Device Notifications
• Package Statistics
• User Statistics
• Cache Statistics

Purging Monitoring Data
Clear old data from the monitoring database.

Using the Purge function in Sybase Control Center allows you to perform an ad hoc purge of
monitoring data.

1. In the left navigation pane, select Monitoring.

2. In the right administration pane, select the General tab.

3. Click Purge.

4. Indicate the time period for which you want to delete data by specifying a Start Date,
Start Time, End Date, and End Time.

All monitoring data collected from the start time and date to the end time and date is
deleted from the database. If you do not specify a start date, all data acquired prior to the
end date and time is purged. Similarly, if you do not specify an end date, all data collected
from the start date until the present time is purged. To save the data to file before purging it,
see Exporting Monitoring Data.

5. Click OK.

A status message appears in the right administration pane indicating that the data purge was
successfully completed.

Exporting Monitoring Data
Save a segment of monitoring data to a location outside of the monitoring database. Export
data to back up information, particularly before purging it from the database, or to perform
closer analysis of the data in a spreadsheet application.

This option is especially useful when you need to share monitoring data with other
administrators and tenants. Since this task can be time-consuming, depending upon the size of
the data being exported, Sybase recommends that you export the data in segments or perform
the export at a time when Sybase Control Center is not in use.

1. In the left navigation pane, select Monitoring.

2. In the right administration pane, select the tab corresponding to the monitoring data you
want to view.
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3. Perform a search using the appropriate criteria to obtain the desired monitoring data.

4. Click Export.

5. Select a file type for the exported data (CSV or XML), and click Next.

6. Click Finish.

7. In the file browser dialog, select a save location and enter a unique file name.

8. Click OK.
All monitoring data retrieved by the search is saved to the file you specify in step 7.

Searching Monitoring Data
Filter monitoring data according to a specified date and time range.

Filter options vary depending upon the type of monitoring data you search.

1. In the left navigation pane, select Monitoring.

2. In the right administration pane, select the tab corresponding to the monitoring data you
want to view.

3. In the Search pane, indicate the time period for which you want to view data by specifying
a date range to search within (that is, Start Date, Start Time, End Date, and End Time) .

Note: You do not need to specify a time period if you are performing a search on Current
date.

4. Filter the system components to include in the search.

a) Select Show current filter.
b) Specify the components to include in your search.

If a domain or package does not appear in the search list (for example, if it has been
deleted), enterthe name and click Add.

5. From the Sort By drop-down list, select a category by which to sort search results.

Note: This field is disabled for some categories.

6. To view the domains and packages you included in the search, select View My
Selections.

7. Click Retrieve.

Monitoring data for the time period specified appears in the administration console.

Monitoring Data Categories
Monitoring data is organized according to object type, allowing administrators to perform
focused data analysis on specific activities and Unwired Platform components. Current,
historical, and performance-based statistics facilitate user support, troubleshooting, and
performance tracking for individual application environments.

The replication and messaging categories are the primary sources of data relating to
application environment performance. The remaining tabs present detailed monitoring data
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that focuses on various aspects of replication-based applications, messaging-based
applications, or both.

Replication Statistics
Replication statistics reflect replication synchronization activity for monitored packages.
Current statistics monitor the progress of real-time synchronizations, while historical
statistics present data from completed synchronizations on a per-package basis. Performance
monitoring uses key performance indicators to produce data about synchronization efficiency.

Through statistics that report on the duration and scope of synchronizations, as well as any
errors experienced during synchronization, replication monitoring allows you to identify the
rate at which synchronizations happen during specified time periods, which users synchronize
data, and which mobile business objects are affected.

Current Replication Statistics
Current statistics for replication synchronization provide real-time information about in-
progress synchronizations.

Unwired Server monitors replication requests using these statistical categories:

Category Description

Application ID The ID associated with the application.

Package The package name.

Phase The current synchronization activity: upload or download. During
the upload phase, a client initiates operation replays to execute
mobile business object (MBO) operations on the back-end system.
During the download phase, a client synchronizes with Unwired
Server to receive the latest changes to an MBO from the back-end
system.

Entity During the download phase, the name of the MBO with which the
client is synchronizing. During the upload phase, the name of the
operation that the client is performing.

Synchronization Start Time The date and time that the synchronization request was initiated.

Domain The domain to which the package involved in synchronization
belongs.

Application Connection ID The ID number of the connection participating in the synchroni-
zation.

User The name of the user associated with the device ID.
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Replication History Statistics
Historical data for replication-based synchronization consists of past synchronization details
for monitored packages.

The summary view provides general information, whereas the detail view presents a more
specific view of all request events during each synchronization; each row of data corresponds
to a synchronization request from the client in the time frame you define:

• Click either Details to see more granular information on each synchronization request, or
select the Detail option to see all synchronization request details. Detail view allows you to
look at the individual messages that make up the summary view.

• Select Summary to see aggregated details by domain, package, and user about past
synchronization events for the defined time frame.

Table 19. Detail view information

Synchronization ele-
ment

Description

Application ID The ID number associated with an application.

Package The package name.

Application Connection ID The ID number of the connection used in a synchronization re-
quest.

User The user associated with the device ID.

Phase The sync activity that occurred during this part of synchronization:
upload or download. During the upload phase, a client initiates
operation replays to change an MBO. During the download phase,
a client synchronizes with Unwired Server to receive the latest
changes to an MBO.

Entity During download, the name of the MBO that the client is synchro-
nizing with. During upload, the operation that the client is per-
forming: create, update, or delete.

Total Rows Sent The total number of rows sent during package synchronization.
This data type is not supported at the MBO level.

Bytes Transferred The amount of data transferred during the synchronization request.

Start Time The date and time that the synchronization request was initiated.

Finish Time The date and time that this part of synchronization completed.

Error The incidence of errors during this request: true or false.
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Synchronization ele-
ment

Description

Domain The domain to which the package involved in synchronization
belongs.

Table 20. Summary view information

Category Description

Application ID The ID number associated with an application.

User The name of the user associated with the device ID.

Package The package name.

Total Rows Sent The total number of rows sent during package synchronization.

Total Operation Replays The total number of operation replays performed by clients during
synchronization.

Total Bytes Sent The total amount of data (in bytes) downloaded by clients from
Unwired Server during synchronization.

Total Bytes Received The total amount of data (in bytes) uploaded to Unwired Server by
clients during synchronization.

Start Time The date and time that the synchronization request was initiated.

Total Synchronization Time The amount of time taken to complete the synchronization.

Total Errors The total number of errors that occurred for the package during
synchronization.

Domain The domain to which the package involved in synchronization
belongs.

Replication Performance Statistics
Replication performance statistics consist of key performance indicators (KPIs) that reflect
the overall functioning of the application environment.

Performance monitoring highlights key totals and identifies average, minimum, and
maximum values for primary activities. These calculations are dynamic, and are based on the
data currently available in monitoring database for the specified time period.

All values in this table (totals, averages, maximums, minimums) apply to the specific time
period you indicate:
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KPI Description

Total Distinct Package Syn-
chronization

The total number of packages subject to synchronization.

Total Distinct Users The total number of users who initiated synchronization requests.
This value comprises only individual users, and does not count
multiple synchronizations requested by the same user.

Average/Minimum/Maximum
Sync Time

The average, minimum, or maximum amount of time Unwired
Server took to finish a complete synchronization.

Time at Minimum/Maximum
Sync Time

The time of day at which the shortest or longest synchronization
completed.

Package with Minimum/Maxi-
mum Synchronization Time

The name of the package and associated MBO with the shortest or
longest synchronization time.

Average/Minimum/Maximum
MBO Rows Per Synchroniza-
tion

The average, minimum, or maximum number of MBO rows of data
that are downloaded when synchronization completes.

Average/Minimum/Maximum
Operation Replays per Sync
(records received)

The average, least, or greatest number of operation replays per
synchronization received by Unwired Server from a client.

Total Bytes Sent The total number of bytes downloaded by clients from Unwired
Server.

Total Bytes Received The total number of bytes uploaded from clients to Unwired Server.

Total Operation Replays The total number of operation replays performed on the EIS.

Total Errors The total number of errors that took place across all synchroniza-
tions.

Average/Minimum/Maximum
Concurrent Users

The average, least, or greatest number of users involved in con-
current synchronizations.

Time at Minimum/Maximum
Concurrent Users

The time at which the least or greatest number of users were in-
volved in concurrent synchronizations.

Messaging Statistics
Messaging statistics report on messaging synchronization activity for monitored packages.

• Current monitoring data tracks the progress of messages from device users presently
performing operation replays or synchronizing MBOs.

• Historical data reveals statistics indicating the efficiency of completed transactions.
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• Performance monitoring provides an overall view of MBS activity intended to highlight
areas of strength and weakness in the application environment.

Messaging historical data captures messages such as login, subscribe, import, suspend,
resume and so on. The Import type message is a data payload message from server to client
(outbound messages), while rest of the messages (login, subscribe, replay, suspend, resume)
are sent from the client to server (inbound messages).

Current Messaging Statistics
Current statistics for messaging synchronization provide real-time information about in-
progress synchronizations. Because messaging synchronizations progress rapidly, there is
typically little pending messaging data available at any given time.

Unwired Server monitors messagin requests using these categories:

Category Description

Application ID The ID associated with the application.

Package The package name.

Message Type The type of message sent by the client to Unwired Server, indicat-
ing the current sync activity; for example, import, replay, sub-
scribe, suspend, resume, and so on.

Entity During the import process, the name of the mobile business object
(MBO) with which the client is synchronizing. During replay, the
operation that the client is performing. For all other message types,
the cell is blank.

Start Time The date and time that the initial message requesting synchroni-
zation was sent by the client.

Domain The domain to which the package involved in synchronization
belongs.

Application Connection ID The ID number of the application participating in the synchroni-
zation.

User The name of the user associated with the device ID.

Messaging History Statistics
Historical data for messaging synchronization consists of past synchronization details for
monitored packages.

The summary view provides general information, whereas the detail view presents a more
specific view of all request events during each synchronization; each row of data corresponds
to a synchronization request from the client in the time frame you define:
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• Click either Details to see more granular information on each synchronization request, or
select the Detail option to see all synchronization request details. Detail view allows you to
look at the individual messages that make up the summary view.

• Select Summary to see aggregated details by domain, package, and user about past
synchronization events for the defined time frame.

Table 21. Detail view information

Data type Description

Application ID The ID number associated with an application.

Package The package name.

Application Connection ID The ID number of the connection that participated in the synchro-
nization request.

User The name of the user associated with the device ID.

Message Type The type of message sent by the client to Unwired Server, indicat-
ing the sync activity; for example, import, replay, subscribe, sus-
pend, resume, and so on.

Entity During the import process, the name of the mobile business object
(MBO) that the client is synchronizing with. During replay, the
operation that the client is performing. For all other message types,
the cell is blank.

Payload Size The size of the message (in bytes).

Start Time The date and time that the message for this sync request is received.

Finish Time The date and time that the message for this sync request is pro-
cessed.

Processing Time The total amount of time between the start time and the finish time.

Error The incidence of errors during this request; either true or false.

Domain The domain to which the package involved in synchronization
belongs.

Table 22. Summary view information

Category Description

Application ID The ID number associated with an application.

User The name of the user associated with the device ID

Package The package name
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Category Description

Total Messages Sent The total number of messages sent by Unwired Server to clients
during synchronization

Total Messages Received The total number of messages received by Unwired Server from
clients during synchronization

Total Payload Size Sent The total amount of data (in bytes) downloaded by clients from
Unwired Server during synchronization

Total Payload Size Received The total amount of data (in bytes) uploaded to Unwired Server by
clients during synchronization

Total Operation Replays The total number of operation replays performed by clients during
synchronization

Last Time In The date and time that the last inbound request was received

Last Time Out The date and time that the last outbound response was sent

Subscription Commands Count The total number of subscription commands sent during synchro-
nization; for example, subscribe, recover, suspend, and so on

Total Errors The number of errors that occurred for the package during syn-
chronization

Domain The domain to which the package involved in synchronization
belongs

Messaging Performance Statistics
Messaging performance statistics consist of key performance indicators (KPIs) that reflect the
overall functioning of the application environment.

Performance monitoring highlights key totals and identifies average, minimum, and
maximum values for primary activities. These calculations are dynamic, and are based on the
data currently available in monitoring database for the specified time period.

All values in this table (totals, averages, maximums, minimums) apply to the specific time
period you indicate:

KPI Description

Total Messages The total number of messages sent between the server and clients
during synchronization.
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KPI Description

Total Distinct Devices The total number of devices involved in synchronization. This
total includes the same user multiple times if he or she has multiple
devices. The value comprises individual devices, and does not
count multiple synchronizations requested by the same device.

Total Distinct Users The total number of users who initiated synchronization requests.
This value comprises individual users, and does not count multiple
synchronizations requested by the same user if he or she uses
multiple devices.

Average/Minimum/Maximum
Concurrent Users

The average, minimum, or maximum number of users involved in
simultaneous synchronizations.

Time at Minimum/Maximum
Concurrent Users

The time at which the greatest or least number of users were
involved in concurrent synchronizations.

Average/Minimum/Maximum
Processing Time

The average, minimum, or maximum amount of time Unwired
Server took to respond to a sync request message.

Time at Minimum/Maximum
Message Processing Time

The time of day at which the shortest or longest message pro-
cessing event completed.

MBO for Maximum/Minimum
Message Processing Time

The name of the package and associated mobile business object
(MBO) with the shortest or longest message processing time.

Average/Minimum/Maximum
Message Size

The average, smallest, or largest message sent during synchroni-
zation.

Total Inbound Messages The total number of messages sent from clients to Unwired Server.

Total Outbound Messages The total number of messages sent from Unwired Server to clients.

Total Operation Replays The total number of operation replays performed by clients on
MBOs.

Total Errors The total number of errors that took place across all synchroni-
zations.

Average/Minimum/Maximum
Concurrent Users

The average, least, or greatest number of users involved in con-
current synchronizations.

Messaging Queue Statistics
Messaging queue statistics reflect the status of various messaging queues. The data does not
reveal any application-specific information, but provides a historical view of messaging
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activities that communicates the efficiency of messaging-based synchronization, as well as
the demands of device client users on the system.

Based on this data, administrators can calculate the appropriate inbound and outbound
message queue counts for the system (configurable in the Server Configuration node of
Sybase Control Center).

Messaging Queue Status
Messaging queue status data provides historical information about the processing of
messaging-based synchronization requests by Unwired Server. The data indicates areas of
high load and times of greatest activity. This data can help administrators decide how to handle
queue congestion and other performance issues.

These key indicators monitor messaging queue status:

Statistic Description

Name The name of the messaging queue.

Current Queued Items The total number of pending messages waiting to be processed by
Unwired Server.

Average/Minimum/Maximum
Queue Depth

The average, minimum, or maximum number of queued messages.
For minimum and maximum queue depth, this value is calculated
from the last server restart.

Time at Minimum/Maximum
Queue Depth

The time and date at which the queue reached its minimum or
maximum depth.

Type The direction of message flow: inbound or outbound.

Total Messages The total number of messages in the queue at one point since the
last server reboot.

Bytes Received The total number of bytes processed by the queue since the last
server reboot.

Last Activity Time The time at which the most recent message was added to the queue
since the last server reboot.

Data Change Notification Statistics
Data change notification (DCN) statistics monitor notifications that are received by Unwired
Server from the enterprise information server. Specifically, DCN monitoring reports which
packages and sync groups are affected by notifications, and how quickly these are processed
by the server.

Monitoring DCN statistics allows you to troubleshoot and diagnose performance issues if, for
example, the cache is not being updated quickly enough. These statistics help to identify
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which packages took longest to process data changes, as well as times of peak performance or
strain on the system.

Data Change Notification History Statistics
Historical information for data change notifications (DCNs) consists of past notification
details for monitored packages. Detailed data provides specific information on past
notification activity for packages, and identifies which server data was affected.

Details about past notification events are organized into these categories:

Category Description

Domain The domain to which the package affected by the DCN belongs.

Package The name of the package containing data changes.

MBO The name of the MBO to which the notification applied.

Notification Time The date and time that Unwired Server received the DCN.

Processing Time The time that Unwired Server used to process the DCN.

Data Change Notification Performance Statistics
Data change notification (DCN) performance statistics consist of key performance indicators
that reflect the efficiency of notification processing by Unwired Server.

Performance monitoring highlights key totals and identifies average, minimum, and
maximum values for primary activities. These calculations are dynamic, and are based on the
data currently available in monitoring database for the specified time period.

All values in this table (totals, averages, maximums, minimums) apply to the specific time
period you indicate:

Key performance indica-
tor

Description

Total Notifications The total number of notifications sent by the enterprise information
system to Unwired Server.

Average/Minimum/Maximum
Processing Time

The average, minimum, or maximum amount of time Unwired
Server took to process a DCN.

Time at Minimum/Maximum
Message Processing Time

The time of day at which the shortest or longest DCN processing
event completed.

Time of Last Notification Re-
ceived

The time at which the most recent DCN was received by Unwired
Server.
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Key performance indica-
tor

Description

MBO with Minimum/Maxi-
mum Notification Processing
Time

The name of the package and associated mobile business object
(MBO) with the shortest or longest notification processing time.

Device Notification Statistics
Device notification statistics provide data about the occurrence and frequency of notifications
sent from Unwired Server to replication synchronization devices. Historical device
notification monitoring reports on the packages, synchronization groups, and devices affected
by RBS synchronization requests in a given time frame. Performance-related device
notification data provides a general indication of the efficiency of notification processing and
the total demand of synchronization requests on the system.

Device Notification History Statistics
Historical information for device notifications provides specific information on past device
notifications, indicating which packages, synchronization groups, and devices were involved
in synchronization requests.

Details about past device notification events fall into these categories:

Category Description

Application ID The ID associated with the application.

Domain The domain to which the package affected by the device notifica-
tion belongs.

Package The name of the package containing data changes.

Synchronization group The synchronization group that the package belongs to.

Application Connection ID The ID number of the connection participating in the synchroni-
zation request.

Generation time The date and time that Unwired Server generated the device noti-
fication.

User The name of the user associated with the device ID.

Device Notification Performance Statistics
Device notification performance statistics provide a general indication of the efficiency of
notification processing and the total demand of synchronization requests on the system.

Performance monitoring highlights key totals and identifies average, minimum, and
maximum values for primary activities. These calculations are dynamic, and are based on the
data currently available in monitoring database for the specified time period.
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All values in this table (totals, averages, maximums, minimums) apply to the specific time
period you indicate:

KPI Description

Synchronization Group for
Maximum Notifications

The synchronization group for which the maximum number of
notifications were sent.

Package for Maximum Notifi-
cations

The package for which the greatest number of device notifications
were sent.

Total Notifications The total number of device notifications sent from Unwired Server
to devices.

Total Distinct Users The total number of users that received device notifications. This
value comprises only individual users, and does not count multiple
synchronizations requested by the same user.

Total Distinct Devices The total number of devices that received device notifications. This
is distinct from Total Distinct Users, because a single user name
can be associated with multiple devices.

Enabled Subscriptions The total number of replication subscriptions for which notifica-
tions are generated.

Time at Last Notification The time at which the last device notification was sent by Unwired
Server.

Outstanding Subscriptions The total number of replication subscriptions, both enabled and
disabled.

Package Statistics
Package statistics reflect response times for replication-based and messaging-based
synchronization packages.

This type of monitoring uses key performance indicators to provide data on the efficiency of
response by Unwired Server to synchronization requests. These calculations are dynamic, and
are based on the data currently available in monitoring database for the specified time period.

Replication Package Statistics
Replication package statistics consist of key performance indicators (KPIs) that reflect the
overall function of the application environment at the cluster or domain level. The statistics
highlight key totals and identify average, minimum, and maximum values for primary
activities.

These key indicators monitor replication packages:

Note: These KPIs are not applicable at the MBO level.
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• Total Bytes Received
• Total Bytes Sent
• Total Operation Replays

KPI Description

Total Devices The total number of devices involved in synchronization.
This total includes the same user multiple times if he or she
has multiple devices. The value comprises individual devi-
ces, and does not count multiple synchronizations requested
by the same device.

Total Rows Sent The total number of rows sent during package synchroniza-
tion.

Total Rows Received The total number of rows received during package synchro-
nization.

Total Errors The total number of errors that took place across all syn-
chronizations.

Total Bytes Received The total number of bytes uploaded from clients to Unwired
Server.

Total Bytes Sent The total number of bytes downloaded by clients from Un-
wired Server.

Average/Minimum/Maximum Syn-
chronization Time

The average, minimum, or maximum amount of time Un-
wired Server took to finish a complete synchronization.

Time at Minimum/Maximum Syn-
chronization Time

The time at which the shortest or longest synchronization
completed.

Total Synchronization Requests The total number of sync requests initiated by a client.

Total Operation Replays The total number of operation replays performed by clients
on MBOs.

Messaging Package Statistics
Messaging package statistics consist of key performance indicators (KPIs) that reflect the
overall function of the application environment at the cluster or domain level. The statistics
highlight key totals and identify average, minimum, and maximum values for primary
activities.

Note: These KPIs are not applicable at the MBO level:

• Total Subscription Commands
• Total Devices
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These key indicators monitor messaging packages:

KPI Description

Total Subscription Commands The total number of subscription commands sent from clients to the
server.

Total Devices The total number of devices involved in synchronization. This total
includes the same user multiple times if he or she has multiple
devices. The value comprises individual devices, and does not
count multiple synchronizations requested by the same device.

Average/Minimum/Maximum
Message Processing Time

The average, minimum, or maximum amount of time Unwired
Server took to respond to a synchronization request message.

Time at Minimum/Maximum
Processing Time

The time at which the shortest or longest response time completed.

Total Inbound Messages The total number of messages sent from clients to Unwired Server.

Total Outbound Messages The total number of messages sent from Unwired Server to clients.

Total Operation Replays The total number of operation replays performed by clients on
mobile business objects (MBOs).

Total Errors The total number of errors that took place across all synchroniza-
tions.

Total Data Push The total amount of data transmitted from the server to clients.

User Statistics
User statistics consist of key performance indicators that reflect the overall activity of
application users.

User statistics can be filtered to include users who belong to a particular security
configuration. This type of monitoring highlights key totals and identifies average, minimum,
and maximum values for primary user activities. These calculations are dynamic, and are
based on the data currently available in monitoring database for the specified time period.

Note: These statistics are not supported for Sybase Mobile CRM and Sybase Mobile
Workflow for SAP application users.

Replication User Statistics
Replication user statistics reflect the synchronization activity of a group of replication-based
synchronization users belonging to a specified security configuration. These statistics include
general activity-related information on a per-user basis.

These key indicators monitor replication users:
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KPI Description

Total Synchronization Requests The total number of sync requests initiated by a client.

Total Rows Received The total number of rows received during package synchroniza-
tion.

Total Rows Sent The total number of rows sent during package synchronization.

Total Bytes Received The total number of bytes uploaded from clients to Unwired Server.

Total Bytes Sent The total number of bytes downloaded by clients from Unwired
Server.

Average/Minimum/Maximum
Synchronization Time

The average, minimum, or maximum amount of time Unwired
Server took to complete a synchronization request.

Time at Maximum/Minimum
Synchronization Time

The time at which the fastest or slowest synchronization is com-
pleted.

Total Operation Replays The total number of operation replays performed by user of mobile
business objects (MBOs).

Total Errors The total number of errors that took place across all synchroniza-
tions.

Total Devices The total number of devices involved in synchronization. This total
includes the same user multiple times if he or she has multiple
devices. The value comprises individual devices, and does not
count multiple synchronizations requested by the same device.

Messaging User Statistics
Messaging user statistics reflect the synchronization activity of a group of messaging-based
synchronization users belonging to a specified security configuration. These statistics include
general activity-related information on a per-user basis.

These key indicators monitor messaging users:

KPI Description

Total Devices The total number of devices involved in synchronization. This total
includes the same user multiple times if he or she has multiple
devices. The value comprises individual devices, and does not
count multiple synchronizations requested by the same device.

Average/Minimum/Maximum
Message Processing Time

The average, minimum, or maximum amount of time Unwired
Server took to respond to a sync request message.
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KPI Description

Time at Minimum/Maximum
Message Processing Time

The time of day at which the shortest or longest message process-
ing event completed.

Total Inbound Messages The total number of messages sent from clients to Unwired Server.

Total Outbound Messages The total number of messages sent from Unwired Server to clients.

Total Operation Replays The total number of operation replays performed by clients on
mobile business objects (MBOs).

Total Errors The total number of errors that took place across all synchroniza-
tions.

Total Subscription Commands The total number of subscription commands sent from clients to the
server.

Total Data Push The total number of import data messages.

Security Log Statistics
The security log reflects the authentication history of users either across the cluster, or filtered
according to domain, during a specified time period. These statistics allow you to diagnose
and troubleshoot connection or authentication problems on a per-user basis. Security log
monitoring is always enabled.

User security data falls into these categories:

Category Description

User The user name

Security Configuration The security configuration to which the device user belongs

Time The time at which the authentication request took place

Result The outcome of the authentication request: success or failure

Application Connection ID The application connection ID associated with the user

Package The package the user was attempting to access

Domain The domain the user was attempting to access
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Cache Statistics
Cache statistics provide a granular view of cache activity eithr at the domain or package level,
particularly in the areas of cache performance, mobile business object (MBO) status, and
cache group status.

Cache statistics report on performance at the domain, package, MBO, and cache group levels
to allow administrators to obtain different information according to the level of specificity
required. These calculations are dynamic, and are based on the data currently available in
monitoring database for the specified time period.

Note: These statistics are not supported for Sybase Mobile CRM and Sybase Mobile
Workflow for SAP application users.

Viewing Package-Level Cache Statistics
Use the package tree to view cache statistics at the package, cache group, or mobile business
object (MBO) level.

The package tree allows for a granular view of data in all cache statistic categories except for
domain-level data. Domain-level data instead uses the Filter by Domain search functionality.

1. In the left navigation pane, select Monitoring.

2. In the right administration pane, select Cache Statistics.

3. From the cache feature drop-down list, select one of the following, depending on the type
of data and level of granularity you require:

• Domain level
• Package level
• Package level cache group
• Package level MBO

4. Select Show Package Tree.
The tree view appears on the left side of the right administration pane.

5. In the tree view, click the package, cache group, or MBO for which you want to view
monitoring data.
The monitoring data displays in the monitoring console. You can further filter data by
specifying a time period in the search panel (for package-level cache performance and
package-level MBO status only).

Cache Performance Statistics
Cache performance statistics report on key totals and identify average, minimum, and
maximum values for primary cache activities. View cache performance data at the domain or
package level.

Select either Domain level or Package level to view the following key performance
indicators:
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Key performance in-
dicator

Description

Domain The domain to which the package affected by the cache activity be-
longs.

Package The name of the package associated with this cache activity.

Minimum/Maximum Cache
Misses

The minimum or maximum number cache misses and the MBO name
for which it was generated.

Minimum/Maximum Cache
Hits

The minimum or maximum number of scheduled cache queries for all
of the MBOs in the package in the specified date range.

Minimum/Maximum/Aver-
age % Cache Hits

The minimum or maximum percentage of scheduled cache queries for
the supplied date range and the MBO name for which it was generated.

Minimum/Maximum Aver-
age Wait Time

The minimum or maximum average wait time for a scheduled cache
query and the MBO name for which it was generated.

Minumum/Maximum Aver-
age Refresh Time

(Package-level only)The minimum or maximum average refresh time
for an on-demand or scheduled refresh.

MBO Statistics
Mobile business object (MBO) status monitoring reports on cache activity at the MBO level,
and thus, reflects activity for single mobile business objects.

Select Package level MBO to view the following key performance indicators:

Key performance indi-
cator

Description

Cache Group The name of the group of MBOs associated with this cache activity.

MBO The name of the single mobile business object associated with this
cache activity.

Number of Rows The number of rows affected by the cache refresh.

Cache Hits The number of scheduled cache queries that occurred in the supplied
date range.

Cache Misses The number of on-demand cache or cache partition refreshes that
occurred in the supplied date range.

Access Count The number of cache queries that occurred in the supplied date range.
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Key performance indi-
cator

Description

Minimum/Maximum/Aver-
age Wait Time

The minimum, maximum, or average duration of cache queries in the
supplied date range. This time does not include the time required to
refresh the cache in a cache “miss” scenario. Instead Minimum/
Maximum/Average Full Refresh Time exposes this data.

Minimum/Maximum/Aver-
age Full Refresh Time

The minimum, maximum, or average duration of on-demand and
scheduled full refresh activities in the supplied date range.

Cache Group Status Statistics
Cache group status statistics provide monitoring data about cache activity at the cache group
level. The data reflects activity for all mobile business objects (MBOs) belonging to a cache
group.

Select Package level cache group to view the following key performance indicators (KPIs):

KPI Description

Package The name of the package to which the associated cache group be-
longs

Cache Group The name of the group of MBOs associated with the cache activity

Number of Rows The number of rows in the cache table of the MBO

Last Full Refresh Time The last time the cache or cache partition was fully refreshed

Last Update Time The last time a row in the cache was updated for any reason (row-level
refresh, full refresh, partitioned refresh, alternate read, or data change
notification)

Last Invalidate Time The last time the cache was invalidated

Cache Coherency Window The data validity time period for the cache group, in seconds. Can
span any value in this range:

• 0 shows that data is always retrieved on-demand for each client.

• 2049840000 shows that the cache never expires. This occurs
when you set the on-demand cache group to NEVER expire or
scheduled cache group to NEVER repeat.
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Troubleshoot the Sybase Control Center

Troubleshoot issues that arrise in Sybase Control Center for Unwired Platform.

Using Sybase Control Center to Troubleshoot Unwired
Platform

Problem: Unwired Platform is not functioning properly or exhibits abnormal behaviour.

Consult these Sybase Control Center sources to find useful information to help you
troubleshoot Unwired Platform issues:

1. Review the server log – view server errors, warnings, and general information to identify
problems. Access the Server node in the left navigation tree of Sybase Control Center to
view server log data.

2. Review domain logs – if domain logging is enabled, view domain logs in each Domains >
<DomainName> > Log node of Sybase Control Center. Aggregated log data in the console
makes domain information readily accessible and actionable.

3. Review monitoring data – access the Monitoring node in the left navigation tree of Sybase
Control Center to view monitoring data on the following components of Unwired
Platform: replication-based synchronization, messaging-based synchronization,
messaging queue, data change notifications, device notifications, packages, users, and
cache. See System Diagnostics in System Administration .

4. Review Application Connection status – access the Applications node in the left
navigation pane of Sybase Control Center to view application connection information in
the right pane.

Note: You can also view domain-level Application Connection status – navigate to the
domain then select Applications in the left navigation pane, and view application
connection information in the right pane.

5. Review package client logs – access the Client Log tab of the Packages > <PackageName>
node in Sybase Control Center to view data about client application operations for all
devices subscribed to a package. This information allows you to track errors and identify
performance issues.

6. Review MBO and operation history – access the History tab for both the MBO and
operation nodes of a package in Sybase Control Center to review error history during
synchronizations and operation replays.
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Collecting Administration Performance Data for
Troubleshooting

Problem: You need to collect performance data to troubleshoot performance issues in Sybase
Control Center for Unwired Platform administrative options.

Solution: Set up the <UnwiredPlatform_InstallDir>\SCC-XX\log
\executionTime.log, which provides information on the length of time taken to
complete operations in Sybase Control Center. Sybase Product Support and Engineering
teams can use this information to diagnose the source of your performance issues. To set up
this log file:

1. Open <UnwiredPlatform_InstallDir>\SCC-XX\plugins
\com.sybase.supadminplugin\agent-plugin.xml.

2. Add the following line to the file under the <properties> element:

<set-property property="log_MO_method_execution_time" 
value="enable_log_mo_method_execution_time" />

3. Open <UnwiredPlatform_InstallDir>\SCC-XX\conf
\log4j.properties.

4. If you are experiencing log truncation issues, edit the following lines to change the default
values for maximum file size (default: 5MB) and maximum backup index (default: 10
files) to the values shown in this example:

## file appender (size-based rolling)
log4j.appender.executionTime=org.apache.log4j.RollingFileAppender
log4j.appender.executionTime.File=${com.sybase.ua.home}/log/
executionTime.log
log4j.appender.executionTime.layout=org.apache.log4j.PatternLayou
t
log4j.appender.executionTime.layout.ConversionPattern=%d [%-5p] 
[%t] %c.%M(%L) - %m%n
log4j.appender.executionTime.MaxFileSize=50MB
log4j.appender.executionTime.MaxBackupIndex=20
## log MO method execution time
log4j.logger.com.sybase.uep.sysadmin.management.aop=INFO,executio
nTime

5. Restart SCC.
The executionTime.log file now appears in the
<UnwiredPlatform_InstallDir>\SCC-XX\log folder.

Use this log file to diagnose and analyze performance problems. For more information on
configuring the agent-plugin.xml configuration file, search for Agent Plugin
Properties Reference in the System Administration guide.
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You can also use the Adobe Flex log to track performance in Sybase Control Center. To access
Flex-side logging, highlight the resource in the Perspective Resources view and select View
Log to show the user interface time for each activity. Alternately:

1. Modify the <UnwiredPlatform_InstallDir>\SCC-XX\plugins
\com.sybase.supadminplugin\agent-plugin.xml file as indicated in step
2, above.

2. Restart SCC.
3. Log in and perform your regular administrative tasks.
4. View the execution time indicators for these operations in the cookie file

supatcookie.sol. The location of this file varies depending on your operating
system:

Operating System Location

Windows XP C:\Documents and Settings\<username>
\Application Data\Macromedia\Flash
Player\#SharedObjects

Windows Vista C:\Users\<username>\AppData\Roaming
\Macromedia\Flash Player\#SharedOb-
jects

Macintosh OS X /Users/<username>/Library/Preferen-
ces/Macromedia/Flash Player/#Share-
dObjects

Linux /home/<username>/.macromedia/
Flash_Player/#SharedObjects

5. Analyze the log using your preferred method of data analysis.

Sybase Control Center Management Tier Issues
Review this list of documented general issues for Sybase Control Center and its server
management-related services.

Launching SCC Results in Rounded Rectangle Box or Empty Console
Screen

Problem: When you launch Sybase Control Center, a rounded rectangular box appears instead
of the administration console, or the console displays a gray or empty screen.

Explanation: The Adobe Flash Player version is older than the minimum version supported by
SCC.
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Solution: Upgrade your Flash Player version to the latest version. For more information on
software prerequisites, see Supported Hardware and Software.

Sybase Control Center Windows Service Fails to Start
Problem: When starting the Sybase Control Center X.Xservice, it takes a long time before
failing, and the service manager displays a message that the service startup has timed out.

The <UnwiredPlatform_InstallDir>\SCC_X-X\log\agent.log shows the
following message:

Explanation: This problem usually occurs when the Sybase Control Center repository
database log file is out of sync with the repository database. A related symptom is the message
SQL Login Failure in the Sybase Control Center repository log file.

Solution 1: Review <UnwiredPlatform_InstallDir>\SCC-X_X\services
\Repository\scc_repository.log log for any issues with the database transaction
log file during startup. If the transaction log could not be processed, the database cannot start,
and consequently nor can the Sybase Control Center service. Resolve this error by:

1. Creating a backup of <UnwiredPlatform_InstallDir>\SCC-X_X
\services\Repository\scc_repository.log.

2. Deleting the <UnwiredPlatform_InstallDir>\SCC-X_X\services
\Repository\scc_repository.log file and restarting the Sybase Control
Center service.

Solution 2: Review <UnwiredPlatform_InstallDir>\SCC-X_X\services
\Repository\scc_repository.log log for any failures in database transaction and/
or recovery. Resolve this error by temporarily configuring the repository database (-f) to start
without a transaction log:

1. Log out of Sybase Control Center and then shutdown Sybase Control Center service.
2. Open command prompt window, and run the following command:

C:\Sybase\SCC-3_2\services\SccSADataserver\sa
\bin_windows32\dbsrv11.exe -n scc_repository -o C:\Sybase
\SCC-3_2\services\Repository\scc_repository.slg -f -m -qi -
qw -sb 0 -gn 100 -gm 500 -zl -zp -x TCPIP{port=3638} C:
\Sybase\SCC-3_2\services\Repository\scc_repository.db

3. Delete the <UnwiredPlatform_InstallDir>\SCC-X_X\services
\Repository\scc_repository.log file using Windows Explorer.

4. Restart the Sybase Control Center service.
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Sybase Control Center Windows Service Deleted
Problem: the Sybase Control Center X.X windows service was inadvertently deleted, so
Sybase Control Center is unavailable.

Solution: Re-create the Windows service with the following command:
UnwiredPlatform_InstallDir\SCC-X_X\utility\ntautostart\release
\sccservice.exe -install

Sybase Control Center Fails to Start
Problem: The Sybase Control Center server does not start.

This problem occurs when the host name cannot be resolved or the IP address of the machine
has changed since the product installation. This troubleshooting topic applies only when
either of these scenarios is true.

Solution 1: Change the host name to its IP address in the Sybase Control Center service-
config.xml file:

1. From the command line, verify the host name by running nslookup<hostname >.
2. If the DNS server cannot resolve the host name, edit the colocated

<UnwiredPlatform_InstallDir>\SCC-XX\services\RMI\service-
config.xml file:
a. Log out of Sybase Control Center.
b. Stop the Sybase Control Center X.X service.
c. Open <UnwiredPlatform_InstallDir>\SCC-XX\services\RMI

\service-config.xml.
d. Locate this line: <set-property property="address"

value="<hostname>" />.
If the line does not exist, add it under the <properties></properties>
element in the file.

e. Change the value from the host name to the IP address of the host computer. If the IP
address is already used, ensure it is valid (especially if the IP address has recently been
changed).

f. Restart the Sybase Control Center X.X service.
g. Log in to Sybase Control Center and proceed with your administrative tasks.

Second Sybase Control Center Fails to Start
Problem: Cannot start a second co-existing Sybase Control Center in a deployment
environment.

Explanation: When multiple versions of Sybase Control Center co-exist on a single machine,
if the older version is already using the default port number, the new version of Sybase Control
Center uses another port number, such as 8285. If the configuration files have not been
updated, this may cause port conflicts.
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Solution: Check the port numbers, and check the configuration files to make sure the
configuration is correct. See the topic Port Number Reference in the System Administration
guide. If the configuration is correct, you may need to start the second version of Sybase
Control Center manually.

Login Invalid in Sybase Control Center
Problem: Logging in to Sybase Control Center generates an Invalid Login message.

Solution:

• Verify Sybase Control Center session validity – ensure that the current Sybase Control
Center session is active. If the session is frozen or expired, refresh the page or close the
browser and try again.

• Verify authentication configuration – ensure that the Sybase Control Center authentication
provider configuration is correct, and points to the correct server. See Enabling
Authentication and RBAC for Administration Logins in the Security guide.

• Verify LDAP consistency – if you are using LDAP security – ensure that the LDAP
configuration in Sybase Control Center CSI configuration is correct and matches with the
server-side LDAP configuration in the 'admin' security provider.
• For Sybase Control Center authentication:<UnwiredPlatform_InstallDir>

\SCC-XX\conf\csi.properties, and configuration should point to the
correct LDAP host and port with appropriate properties.

• Check <UnwiredPlatform_InstallDir>\SCC_XX\log\agent.log for any
issues with starting various services.

• If all services are running, check the <UnwiredPlatform_InstallDir>\SCC_XX
\log\agent.log for an error message containing text similar to the following:
Failed to authenticate user 'supAdmin' (Failed to connect
to service:jmx:rmi:///jndi/rmi://eas3w03.sybase.com:9999/
agent, probably because the agent is protected and requires
credentials.Security Service Error. Agent service
exception.)

• Ensure that the Sybase Control Center authentication provider configuration is correct,
and points to the correct server. See Enabling Authentication and RBAC for
Administration Logins in the Security guide.

Login Fails in Sybase Control Center
Problem: Removed the PreconfiguredUser login module from the "admin" security
configuration. Now, logins to Sybase Control Center fail.

Solution: You must make the corresponding provider changes to the csi.properties file
used to configure providers for Sybase Control Center. If changes are not coordinated, Sybase
Control Center logins fail. See Configuring a Provider to Authenticate Sybase Control Center
Logins in the Security guide for configuration details.
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You can verify server-side configuration by trying to connect to Unwired Server from
Unwired WorkSpace (requires creating Unwired Server Connection Profile with proper
username and password among other things). If that works but the SCC login still fails, make
sure the same configuration as in the 'admin' security configuration is also set in the Sybase
Control Center CSI.properties file. The messages in agent.log can offer further
clues on the issue.

Stale Version of Sybase Control Center After Upgrade
Problem: after upgrading Sybase Unwired Platform and relaunching Sybase Control Center
through a Web browser, a stale version of Sybase Control Center loads in the browser.

Explanation: Adobe® Flash® Player caches the earlier version of Sybase Control Center
locally, preventing you from logging in to the correct version of Sybase Control Center when
accessing the browser.

Solution 1: Clear the Adobe Flash Player cache:

1. In Windows Explorer, navigate to C:\Documents and Settings\<username>
\Application Data\Macromedia\Flash Player\#SharedObjects,
and delete all files in this folder.
As an alternative to manually deleting files, you can also access the Adobe Flash Player
Cache Cleanup URL: http://www.macromedia.com/support/documentation/en/
flashplayer/help/settings_manager07.html

Solution 2: Only perform this solution if Solution 1 does not solve the problem. Clear browser
history:

1. In Microsoft Internet Explorer, select Tools > Internet Options > General > Delete... and
delete all temporary files, history, cookies, saved passwords, and Web form information.

Sybase Control Center Reports Certificate Problem
When attempting to bring up Sybase Control Center by clicking the SCC link after
installation , this message appears: There is a problem with this website's
security certificate.

Explanation: This can occur when the browser session starts on the same computer as Sybase
Control Center. The installer automatically sets up a local security certificate, but the
certificate installed for HTTPS in the web container keystore is a self-signed root certificate,
which is not recognized b the client browser.

Solution: Follow browser-specific instructions to accept the certificate into the Windows
certificate store. Once the certificate is accepted, you may also need to change the SCC Web
URL to include the network domain name <yourco.com> in addition to the host name. That
host name in the Web URL must match with the "Issued To" property of the certificate.
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Previous Administrator Credentials Used
Problem: You cannot use new credentials to authenticate against a resource in Sybase Control
Center. When an administrator enters credentials with the Remember these credentials for
future sessions option, Sybase Control Center uses those credentials until they are cleared.

Solution: Clear credentials so that Sybase Control Center does not use them for future
sessions:

1. Open the Perspective Resources window.
2. Select the resource you want to log in to.
3. From the menu bar, select Resource > Clear Authentication Parameters and click

OK.

You can now authenticate against the resource using new administrator credentials.

Browser Refresh (F5) Causes Logout
Problem: Pressing the F5 key to refresh your browser logs you out of Sybase Control Center.

Solution: Do not use F5 when you are logged in to Sybase Control Center. Browser refresh
does not refresh data inside Sybase Control Center, but refreshes the loaded application or
pages in the browser—in this case, the Adobe Flash on which Sybase Control Center is built.
Consequently, pressing F5 logs you out of any servers you are currently logged in to, including
Sybase Control Center.

Security Error Triggered When Connecting to SCC from Remote
Browser

Problem: Connecting to Sybase Control Center from a browser that is remote triggers a
security exception.

Solution: Ensure you have a security certificate installed in the Windows security store. See
Setting Up Browser Certificates for Sybase Control Center Connections in Sybase Control
Center online help.

Administrator Login Passes When Provider Is Not Available
Problem: The configured authentication provider is unavailable but administration credentials
are still accepted.

Explanation: The administrator login credentials may be cached by Unwired Server.

Solution: If this behavior is undesired, reduce the cache timeout value used by the Unwired
Server security domain instance. For details, search for Authentication Cache Timeouts in the
Security guide.
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Host Name of Registered Resource Changed But Is Not Updated
Problem: An administrator changes the host name property of a registered resource; but in
Sybase Control Center, the old host name is still used and the management console for
Unwired Platform does not appear.

Description: If you modify the resource properties for an Unwired Server in Sybase Control
Center, the new host name or IP address is not used in establishing a connection to the server.

Solution: After changing the host name property of the resource, in the Perspective Resources
view, right-click the resource and select Authenticate to update resource connection
properties. You can then launch the management console successfully.

Management Issues with Clustered Data Tiers
Problem: if you install Unwired Platform and the cache database on Microsoft Cluster, you
will receive errors when trying to manage the cluster in Sybase Control Center. This is because
Microsoft Cluster uses node switches.

Solution: Replace the current entry for the cluster with a new entry that uses the computer
node's hostname or IP address, rather than Unwired Platform cluster's hostname (the default).

Poor Sybase Control Center Performance after Upgrade
Problem: After upgrading to the latest version of Sybase Unwired Platform, Sybase Control
Center performance is poor.

Explanation: This may indicate that Flash Player cache from the previous version of Sybase
Control Center is filled and slowing down performance.

1. Navigate to C:\Documents and Settings\username\Application Data
\Macromedia\Flash Player\#SharedObjects .

2. Delete all files under this folder.

Note: Alternatively, go to the following link from a browser: http://www.macromedia.com/
support/documentation/en/flashplayer/help/settings_manager07.html. Use the Website
Storage settings panel to change storage capacity, or delete Websites to clean up the cache.

Platform Component Monitoring Issues
Review this list of documented issues for platform components monitored by Sybase Control
Center.
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Monitoring Data Does Not Appear in History Tab
Problem: Monitoring data does not appear immediately in the History tab.

Explanation: The monitoring data is stored in memory to optimize database access, and
periodically flushed to the monitoring database.

Solution: Try either of these options:

• Wait for the data to be flushed. The default time period is five minutes.
• Change the flush interval to a smaller value in Sybase Control Center:

1. In the left navigation pane, select Monitoring.
2. In the right administration pane, select the General tab.
3. Click Configuration.
4. In the flush threshold section, ensure that Enable flush threshold configuration is

selected.
5. Select one of:

• Number of rows – monitoring data that surpasses the specified number of rows is
flushed from the console display. Enter the desired number of rows adjacent to
Rows. The default is 100.

• Time interval – monitoring data older than the specified time interval is flushed
from the console display. Enter the desired duration adjacent to Minutes. The
default is 5.

• Either rows or time interval – monitoring data is flushed from the console display
according to whichever value is reached first: either the specified number of rows
or the specified time interval. Enter the desired rows and duration adjacent to Rows
and Minutes, respectively.

6. Retrieve the results list using the Sybase Control Center monitoring node.

Domain Log Data Does Not Appear in History Tab
Problem: Domain log data does not appear immediately in the History tab.

Explanation: The domain log data is stored in memory to optimize database access, and
periodically flushed to the domain log database.

Solution: Try either of these options:

• Wait for the data to be flushed. The default time period is five minutes.
• Change the flush interval to a smaller value in Sybase Control Center:

1. In the left navigation pane, expand the Domains folder and select the default domain.
2. Select Log.
3. In the right administration pane, select the Settings tab.
4. Click Configuration.
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5. In the flush threshold section, ensure that Enable flush threshold configuration is
selected.

6. Select one of:
• Number of rows – domain log data that surpasses the specified number of rows is

flushed from the console display. Enter the desired number of rows adjacent to
Rows. The default is 100.

• Time interval – domain log data older than the specified time interval is flushed
from the console display. Enter the desired duration adjacent to Minutes. The
default is 5.

• Either rows or time interval – domain log data is flushed from the console display
according to whichever value is reached first: either the specified number of rows
or the specified time interval. Enter the desired rows and duration adjacent to Rows
and Minutes, respectively.

7. Retrieve the results list using the Sybase Control Center domain log node.

Previously Existing Monitoring Data No Longer Appears
Problem: Monitoring data that displayed previously no longer appears.

Explanation: By default, monitoring data is preserved in the database for seven days. After
that period, the data is removed.

Solution: Change the auto purge setting value in Sybase Control Center. Auto purge clears
obsolete data from the monitoring database once it reaches the specified threshold.

1. In the left navigation pane, select Monitoring.
2. In the right administration pane, select the General tab.
3. Click Configuration.
4. In the auto purge section, ensure that Enable auto purge configuration is selected.
5. Enter the length of time (in days) to retain monitoring data before it is purged.
6. Restart the server.
7. Retrieve the results list using the Sybase Control Center monitoring node.

Previously Existing Domain Log Data No Longer Appears
Problem: Domain log data that displayed previously no longer appears.

Explanation: By default, domain log data is preserved in the database for seven days. After
that period, the data is removed.

Solution: Change the auto purge setting value in Sybase Control Center. Auto purge clears
obsolete data from the domain log database once it reaches the specified threshold.

1. In the left navigation pane, expand the Domains folder and select the default domain.
2. Select Log.
3. In the right administration pane, select the Settings tab.
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4. Click Configuration.
5. In the auto purge section, ensure that Enable auto purge configuration is selected.
6. Enter the length of time (in days) to retain domain log data before it is purged.
7. Restart the server.
8. Retrieve the results list using the Sybase Control Center domain log node.

Server Tier Administration Issues
Review this list of documented issues for Unwired Server or its internal synchronization
services configured and administered by Sybase Control Center.

Server List Not Retrieved
Problem: No list of Unwired Servers displays in Sybase Control Center. Instead, an Error
Retrieving Server List message appears in the left navigation pane.

Scenario 1: No other error message appears.

If this is the case, one of the following explanations may apply:

• You are attempting to connect to a remote server that is not properly registered in Sybase
Control Center.
Solution: Manually register the remote server. By default, only Unwired Servers installed
to the same host computer are automatically registered with Sybase Control Center. See
Getting Started with Unwired Server Administration in the Sybase Control Center online
help. If you have recently made changes to the environment, for example, by modifying
server resource properties (login, password, host name, IP address, or port number),
ensure that you reauthenticate after making the changes.

• Jetty caching in Sybase Control Center prevents the console from displaying the server
tree. This is indicated by 404 errors in both the console URL and
<UnwiredPlatform_InstallDir>\SCC-X_X\services
\EmbeddedWebContainer\log\http-service.log (the HTTP access log).

Solution:
1. Close Sybase Control Center.
2. Stop Sybase Control Center X.X Service.
3. Delete the contents of: <UnwiredPlatform_InstallDir>\SCC-X_X

\services\EmbeddedWebContainer\container\Jetty-X.X.XX
\work.

4. Restart Sybase Control Center X.X service.

Scenario 2: The right administration pane shows an Authentication has failed
error message.

If this is the case, one of the following explanations may apply:
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• You have not performed the "Authenticate" step in Sybase Control Center after registering
the resource or changing their credentials.
Solution: In the Perspective Resources view, right click the server name and select
Authenticate. In the default configuration, if you have used "supAdmin" to log in to
Sybase Control Center, select Use my current SCC login.

• You do not have the required administration privileges.
Solution: Ensure that:
1. The administrator login is assigned one of the physical roles attached to the "SUP

Administrator" or "SUP Domain Administrator" logical roles in the "admin" security
configuration. To change the "admin" role mapping outside of Sybase Control Center,
manually edit <UnwiredPlatform_InstallDir>\UnwiredPlatform
\Servers\UnwiredServer\Repository\CSI\conf\role-
mapping.xml on all nodes in the cluster.

2. The <UnwiredPlatform_InstallDir>\SCC-X_X\conf\roles-
map.xml configuration for the "SUP LDAP Login Module" and your security
repository are being used to authenticate Sybase Control Center users. Ensure that the
administration roles configured for the "SUP LDAP Login Module" exist in the
security repository.

• The server IP may have changed.
Solution: Update server resource properties, and repeat the "Authenticate" step described
above. See the topic Sybase Control Center Fails to Start.

Scenario 3: The right administration pane shows a Connection unknown. Ensure
Server is running.... message.

If this is the case, one of the following explanations may apply:

• Unwired Server responded with an exception indicating a problem on the server.
Solution: Check <UnwiredPlatform_InstallDir>\UnwiredPlatform
\Servers\UnwiredServer\logs\<hostname>-server.log for details.

• The Sybase Control Center security provider is down or a system condition prevents
Sybase Control Center from authenticating the user for administration access.
Solution: Ensure that the security provider is running and that its host is reachable from the
Sybase Control Center host.

Scenario 4: In some rare cases, the connection between Sybase Control Center and Unwired
Server cannot be established after trying the previous recommendations.

Solution: You may need to stop and restart the Sybase Control Center X.X windows service.
After stopping the window service, make sure the process uaservices.exe is not running
(or stop it from Windows task manager). Then log in to Sybase Control Center again.

Scenario 5: This may happen if you upgraded Sybase Unwired Platform to a newer version,
and changed the server host name.

Solution: You need to complete some extra steps:
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1. Change the listener prefix of httpListeners and iiopListeners for the new hostname in the
new server's properties file:
Repository\Instance\com\sybase\djc\server\ApplicationServer
\default.properties,  <new_hostname>.properties

2. In Repository\Instance\com\sybase\djc\server\SocketListner
\*.properties, rename all the
<old_hostname>_<protocol>.properties into
<new_hostname>_<protocol>.properties.

3. Use dbisqlc to update the table: cluster_installation in clusterdb,
update cluster_installation set hostname='<new_hostname>'
where hostname='<old_hostname>'.

Unwired Server Fails to Start
Problem: Starting Unwired Server from Windows services or the desktop shortcut fails.

Solution:

1. Ensure that the server license is valid and has not expired.
2. Open Windows services to check that the services Unwired Server depends on for start-up

are running properly. Identify dependencies by right-clicking the service and selecting
Properties.

3. Check <UnwiredPlatform_InstallDir>\UnwiredPlatform\Servers
\UnwiredServer\log\<serverName>-server.log for error messages
indicating the nature of Unwired Server start-up issues.

4. Check <UnwiredPlatform_InstallDir>\UnwiredPlatform\Servers
\UnwiredServer\log\bootstrap**.log for possible license errors.

Error in Listing Application Connections and
ADMIN_WEBSERVICE_INVOCATION_ERROR in gateway.log

Problem: This message may indicate that an Unwired Server administrative component is not
running.

If users report a problem listing application connections in Sybase Control Center, check for
this error message in the Sybase Control Center gateway.log file:

com.sybase.uep.sysadmin.management.mbean.UEPAdminException: 
com.sybase.uep.admin.client.AdminException: 
ADMIN_WEBSERVICE_INVOCATION_ERROR:java.security.PrivilegedActionExc
eption: com.sun.xml.internal.messaging.saaj.SOAPExceptionImpl: 
Message send failed
javax.management.MBeanException:

Explanation: Usually this occurs when when there is a conflict on the currently configured
port for the administration web service or a component of Sybase Unwired Server service
went down for some reason.
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One way to verify availability of the Web service is by accessing the following URL from the
host where Sybase Unwired Platform is installed: http://localhost:5100/MobileOffice/
Admin.asmx. The default Messaging port is 5100, but this may vary depending on your
configuration.

Solution 1: Check Windows Application Event log for any error reported there. If the service
is configured to run with a domain account and the password has been changed, you will need
to update the password.

Solution 2: Make sure the administration Web service is up and running, and correctly
configured. Review Cannot Access Applications Tab and Web Service Error in
Troubleshooting to reconfigure the port in case of conflict with existing port.

Starting or Restarting a Remote Server from Sybase Control Center
Fails

Problem: After you have registered a remote server in Sybase Control Center, you cannot start
or restart the server.

If the DNS server cannot resolve the host name of the machine on which the remote Unwired
Server is installed, or if the host has no internal DNS server, you cannot start, stop, or restart
that Unwired Server using your local instance of Sybase Control Center. Because this network
communication relies on name resolution, you must ensure that DNS is set up properly to
successfully control a remote Unwired Server.

Before attempting the following solutions, verify that:

1. Sybase Control Center is running on the remote host.
2. A network connection can be established between your Sybase Control Center host and

the Sybase Control Center agent on the remote server's host.

If the DNS server cannot establish a connection, try the following:

Solution 1: Repair the network DNS server setup. If you or your network administrator cannot
modify the DNS, use solution 2.

Solution 2: Change the host name to its IP address in the Sybase Control Center service-
config.xml file:

• If you cannot resolve the local host name, modify the file on the local instance of Sybase
Control Center.

• If you cannot resolve the remote host name, modify the file on the remote instance of
Sybase Control Center.

• If you cannot resolve both the remote and local host names, modify both files.

1. From the command line, verify the host name by running nslookup<hostname >.

2. If the DNS server cannot resolve the host name, edit the colocated
<UnwiredPlatform_InstallDir>\SCC-XX\services\RMI\service-
config.xml file:
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a. Log out of Sybase Control Center.
b. Stop the Sybase Control Center X.X service.
c. Open <UnwiredPlatform_InstallDir>\SCC-XX\services\RMI

\service-config.xml.

d. Locate this line: <set-property property="address"
value="<hostname>" />.

If the line does not exist, add it under the <properties></properties>
element in the file.

e. Change the value from the host name to the IP address of the host computer. If the IP
address is already used, ensure it is valid (especially if the IP address has recently been
changed).

f. Restart the Sybase Control Center X.X service.
g. Log in to Sybase Control Center and proceed with your administrative tasks.

If the DNS server resolves the host name, but the problem persists, check that both:

• The remote host on which Unwired Platform and Sybase Control Center are installed can
receive UDP multicasts from the local host on which Sybase Control Center is installed,
and

• The remote instance of Sybase Control Center uses RMI port 9999.

Port Conflict Issues
Problem: You have identified a Sybase Control Center X.X service port conflict.

Solution:

1. Identify the service with the port conflict in <UnwiredPlatform_InstallDir>
\SCC-X_X\log\agent.log.

2. Use a text editor to open <UnwiredPlatform_InstallDir>\SCC-X_X
\Services\<Servicename>\service-config.xml.

3. Change the port to an available port number.
4. Save and close the file.

Search for Port Number Reference in System Administration for more information.

Unexpected Listener Startup or Connection Errors
Problem: You encounter unexpected listener startup or connection errors for Unwired
Platform components. This is usually seen when Sybase Unwired Server is installed on a host
in DMZ (De-Militarized Zone) within the internal and external firewalls.

Solution:

1. Verify that the TCP/IP filtering restriction is not in effect on the host machine.

Troubleshoot the Sybase Control Center

266 Sybase Unwired Platform



To do so on Windows XP, navigate to: Control Panel > Network Connections > Local
Area Connection 1 > Properties > General tab > Internet Protocol (TCP/IP) >
Properties > General tab > Advanced > Options tab > TCP/IP filtering > Properties

2. In TCP/IP Filtering, check to make sure the Enable TCP/IP Filtering (All Adopters)
checkbox is not selected. This enables all Sybase Unwired Platform infrastructure ports.

If you do choose to select it, be sure to select Permit All for TCP Ports to enable all Sybase
Unwired Platform infrastructure ports. These ports are documented in the Installation
Guide.

3. Click OK to close each window and save your changes.

4. You can change “Local Area Connection 1” to the network connection name being used on
the machine.

5. Make sure users are not using third party port blockers, like McAfee Antivirus.

Refreshing Server Configuration Displays Only Partial Updates
Problem: The Refresh button in the Server Configuration node does not display correct
properties or values, despite changes being made and saved. Updates consequently appear to
have been lost. In some scenarios, when you save the Server Configuration, it fails with the
message Save Failed.

Scenario 1: After restarting Unwired Server, refreshing the server configuration displays the
first saved change, but not subsequent saved updates. The message Save Failed appears in
the administration console after you attempt to save an update.

In this scenario, the second save was likely unsuccessful. The message Save Failed
indicates a conflict with the first set of updates.

Cumulative saved changes are applied successfully upon server restart only if these updates do
not conflict. Attempting to save two conflicting sets of changes fails.

Solution: Inject a server restart in between each saved change to ensure that the required
updates are propagated across the server.

Scenario 2: After restarting Unwired Server, refreshing the server configuration displays the
final saved update, but not previous ones.

The refresh action following saved configuration changes must be used in conjunction with an
Unwired Server restart. Refreshing the server configuration displays the latest successfully
saved configuration information.

If you click Refresh in between two sets of saved changes, only the most recent saved updates
are applied during a server restart, as in the following workflow:

1. Make the first change.
2. Save the configuration.
3. Refresh the configuration.
4. Make the second change.

Troubleshoot the Sybase Control Center

Sybase Control Center for Sybase Unwired Platform 267



5. Save the configuration.
6. Restart the server.
7. Refresh the configuration.

In this sequence, only the second set of changes in step 4 are committed and consequently
displayed as the current set of properties used by Unwired Server.

Solution: If you refresh the configuration after saving updates to it, restart Unwired Server
immediately to apply those changes before making another set of updates. Otherwise, the first
set of configuration changes will be lost. The Refresh button allows you to then validate that
those changes are applied and used by Unwired Server. For details on how to refresh the server
in the correct sequence, see Saving and Refreshing an Unwired Server Configuration in the
Sybase Control Center online help.

Users Connect with Old Credentials
Problem: A user changes password in the backend security system, but can still authenticate
with the previous password when connecting to Unwired Server.

Description: Unwired Server securely caches authenticated login credentials (1 hour by
default), so that subsequent connection requests using the same credentials are not sent to the
underlying security provider until the login cache timeout is reached. However, if the same
user uses changed credentials, the authentication request us sent to the underlying security
provider. The authorization outcome is not cached and always delegated to the security
provider in the security configuration.

Solution: To reduce the cache period, decrease the default authentication cache timeout for a
security configuration using Sybase Control Center (go to the Cluster > Security > <security
configurationname> > Settings tab). Setting the property to 0 results in disabling the
authentication caching (not recommended for performance reasons).

AuthorizationException Displays Instead of Status
The SCC administration console left-pane tree structure is not complete, and an
AuthorizationException is reported..

Explanation: This may happen if the SCC administration console internal network
communications are not working properly.

Solution:

1. Close the Internet Explorer session.

2. Relaunch the SCC administrative console.

3. Log in as usual.

The internal network connection is resumed by restarting, so the tree displays information
and status properly.
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Increasing Messaging Queue Counts Degrades Performance
Problem: Both inbound and outbound messaging queue counts were increased, however,
performance degraded as a result.

Description: After increasing inbound and outbound message queue count, the default
maxThreads of IIOP socket listener is insufficient.

Solution: Increase the maxThreads of IIOP socket listener by editing the
<hostname>_iiop1.properties file (located in
<UnwiredPlatform_InstallDir>\UnwiredPlatform\Servers
\UnwiredServer\Repository\Instance\com\sybase\djc\server
\SocketListener\), and restart Unwired Server. The maxThread of IIOP socket listener
must be larger than the sum of all nodes needed IIOP thread counts.

Saving Server Configuration Fails Due to Certificate Validation Error
Problem: Saving the server configuration after property updates yields this error:
"[com.sybase.sup.admin.server.configuration.RuntimeServerConfigurationHandler] Invalid
configuration object for: SyncServerConfiguration. Message : 'certificate validation failed.
Update did not happen.'"

Solution: The message suggests that the server certificate has expired. Update the certificate
file to a non-expired version, and try to save again.

Package Deployment and Management Issues
Review this list of documented issues for packages deployed or managed from Sybase Control
Center.

Exporting or Deploying Large Packages Fails
Problem: You used Sybase Control Center to export or deploy a large package, and it fails.

You can troubleshoot this error by opening the Sybase Control Center
<UnwiredPlatform_InstallDir>\SCCXX\log\agent.log file and checking
for a message that is similar to this one:

exception:java.lang.IllegalStateException: Form too large

Explanation: This message means that the package, and not the form, is too large. The Web
server that hosts Sybase Control Center cannot manage the data. A number like 273310
indicates the size of the package in kilobytes (that is, 273,310).

Solution 1: Use this solution if you run the Sybase Control Center XX as a service (default).
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1. Open <UnwiredPlatform_InstallDir>\SCC-X_X\bin
\scc.properties in a text editor

2. Set Set MAX_FORM_CONTENT_SIZE and jvmopt1. For example:

jvmopt=-Dorg.mortbay.jetty.Request.maxFormContentSize=2000000

3. Save the file.

Solution 2: Use this solution if you do not run the Sybase Control Center XX as a service.

1. Close Sybase Control Center, and stop Sybase Control Center XX using the Windows
Services dialog.

2. Open <UnwiredPlatform_InstallDir>\SCC_X-X\bin\scc.bat, in a text
editor.

3. Set the maxFormContentSize property to a value larger than the default, and save the file.
The default is 2000000. For example:
-Dorg.mortbay.jetty.Request.maxFormContentSize=2048000

4. Restart the Sybase Control Center XX (using the updated scc.bat file), and reopen
Sybase Control Center.

Invalid DOE-C User Error for an SAP Server Connection
Problem: The General tab of a DOE-C package displays an invalid user account error for the
Error State property.

Explanation: SAP servers could not authenticate this user with the Username and Password
configured for this package.

User names and passwords configured for the connection pool cannot be tested before they are
used. Errors are only reported after the connection fails. Errors typically occur during an
administrative operation (such as unsubscribing a subscription), or in response to an
asynchronous message for a subscription from DOE. On a system with existing DOE-C
subscriptions, the initial resynchronization at startup would implicitly test the technical user.

Solution: Check the username and password configured for this user in the Connection Pool
configured for the package. If it is incorrect, edit the properties used.

Note: If you change the username or password property of a DOE-C connection, you must
reopen the same dialog and click Test Connection after saving. Otherwise the error state
of this DOE-C package cannot be cleaned up. If you do not click Test Connection, the
username or password is correct, but the error state of the DOE-C package cannot be cleaned
up.

Application and Application User Management Issues
Review this list of documented issues for applications or application users managed by Sybase
Control Center.
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Wrong Application for Code Error
Problem: Application registration using a Windows Mobile emulator appears successful in
Sybase Control Center, but the application log shows a Wrong Application for Code
error when the application attempts to connect to Unwired Server.

This error occurs when you:

• Hard reset a Windows Mobile device emulator,
• Close an emulator without saving the emulator state, or
• Uninstall and reinstall the Unwired Server client software on the device.

Explanation: Because emulators do not generate unique application IDs, the Unwired Server
messaging software on the device creates an application ID during installation and stores it in
the emulator application registry. After registration, this permanent link between the emulator
and the application ID must remain.

Hard resetting the emulator, closing the emulator without saving the emulator state, or
uninstalling and reinstalling the Unwired Server client software purges the device registry and
breaks the link between Unwired Server and the device software. When you attempt to
reconnect, Unwired Server creates a new application ID for the device. Without the original
application ID, the server cannot identify the device emulator, and therefore, cannot establish
a relationship between the application and the activation code.

To avoid this problem so that the emulator and server remain synchronized, always save the
emulator state before you close the emulator, and refrain from hard resetting the emulator, or
uninstalling and reinstalling the client software.

Note: Before saving the state of an emulator, always uncradle the emulator using the Device
Emulation Manager. This allows the device emulator to be cradled when the save image is
loaded and used in the future.

Solution: Reconnect the emulator by either:

1. Deleting the original application from Unwired Server, then reregister the application,
or

2. Reregistering the application

User Name of Registered Application Connection Not Displayed
Problem: The configured user name of a registered application connection is not displayed
when you later review the properties for a device in Sybase Control Center. The Application
Connections tab shows other properties but not the user name.

Explanation: The user name used for a application connection registration is not stored or
handled as an application property.

Solution: To view the user name of the registered application in Sybase Control Center:
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1. In the left navigation pane, click the Applications node.
2. In the right administration pane, click the Application Users tab.
3. In the table of registered users, for the user.
4. You can also select the Application Connections tab, and check the users properties.

Internal Server Error When Clicking Applications
Problem : Once logged into Sybase Control Center, the administrator clicks Applications in
the navigation pane, and an Internal server error message is displayed.

After receiving this error, the administrator is further unable to register any applications
because the OK button remains disabled.

Solution:

1. Validate the error:
a. Open <UnwiredPlatform_InstallDir>\SCC-X_X\log

\gateway.log.

b. Look for this error: Caused by:
com.sybase.uep.sysadmin.management.exception.ImoWsExcept
ion: An error occurred loading a configuration file:
Attempted to read or write protected memory. This is
often an indication that other memory is corrupt.

2. Validate that the Sybase Unwired Server service is running and there are no errors being
reported in the Windows Application event log by that service.

3. Validate that the Messaging Server Administration Web Service is running:
a. Open a Web browser.
b. Open http://localhost:5100/MobileOffice/admin.asmx.
c. Select the GetDeviceList2 method, then click Invoke.
d. Check whether a valid XML response returns.

4. If anything in steps 1-3 is unexpected, you may have an installation or configuration issue.
Confirm this by:
a. Restarting the Sybase Unwired Server service.
b. Once available, repeat steps 2-3.

• Otherwise, open Sybase Control Center, and click Applications to try registering
an application again.

5. If you still get the same error and same behavior, contact Sybase Support.
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Glossary

Defines terms used in Sybase Control Center documentation.

Glossary: Sybase Unwired Platform
Defines terms for all Sybase Unwired Platform components.

administration perspective – Or administration console. The Unwired Platform
administrative perspective is the Flash-based Web application for managing Unwired Server.
See Sybase Control Center.

administrators – Unwired Platform users to which an administration role has been assigned.
A user with the "SUP Administrator" role is called a "platform administrator" and a user with
the "SUP Domain Administrator" role is called a "domain administrator". These
administration roles must also be assigned SCC administration roles to avoid having to
authenticate to Sybase Control Center in addition to Unwired Server:

• A domain administrator only requires the "sccUserRole" role.
• A platform administrator requires both the "sccAdminRole" and "sccUserRole" roles.

Adobe Flash Player – Adobe Flash Player is required to run Sybase Control Center. Because
of this player, you are required to run Sybase Control Center in a 32-bit browser. Adobe does
not support 64-bit browsers.

Advantage Database Server® – A relational database management system that provides the
messaging database for Sybase Unwired Platform. See messaging database.

Afaria® – An enterprise-grade, highly scalable device management solution with advanced
capabilities to ensure that mobile data and devices are up-to-date, reliable, and secure. Afaria
is a separately licensed product that can extend the Unwired Platform in a mobile enterprise.
Afaria includes a server (Afaria Server), a database (Afaria Database), an administration tool
(Afaria Administrator), and other runtime components, depending on the license you
purchase.

application – In Unwired Server (and visible in Sybase Control Center), and application is the
runtime entity that can be directly correlated to a native or mobile workflow application. The
application definition on the server establishes the relationship among packages used in the
application, domain that the application is deployed to, user activation method for the
application, and other application specific settings.

APNS – Apple Push Notification Service.

application connection – A unique connection to the application on a device.
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application connection template – a template for application connections that includes
application settings, security configuration, domain details, and so forth.

application node – In Sybase Control Center, this is a registered application with a unique ID.
This is the main entity that defines the behavior of device and backend interactions.

application registration – The process of registering an application with Sybase Unwired
Platform. Registration requires a unique identity that defines the properties for the device and
backend interaction with Unwired Server.

artifacts – Artifacts can be client-side or automatically generated files; for
example: .xml, .cs, .java, .cab files.

availability – Indicates that a resource is accessible and responsive.

BAPI – Business Application Programming Interface. A BAPI is a set of interfaces to object-
oriented programming methods that enable a programmer to integrate third-party software
into the proprietary R/3 product from SAP®. For specific business tasks such as uploading
transactional data, BAPIs are implemented and stored in the R/3 system as remote function
call (RFC) modules.

BLOB – Binary Large Object. A BLOB is a collection of binary data stored as a single entity
in a database management system. A BLOB may be text, images, audio, or video.

cache – The virtual tables in the Unwired Server cache database that store synchronization
data.See cache database.

cache group – Defined in Unwired WorkSpace, MBOs are grouped and the same cache
refresh policy is applied to their virtual tables (cache) in the cache database

cache partitions – Partitioning the cache divides it into segments that can be refreshed
individually, which gives better system performance than refreshing the entire cache. Define
cache partitions in Unwired WorkSpace by defining a partition key, which is a load parameter
used by the operation to load data into the cache from the enterprise information system
(EIS).

cache database – Cache database. The Unwired Server cache database stores runtime
metadata (for Unwired Platform components) and cache data (for MBOs). See also data tier.

CLI – Command line interface. CLI is the standard term for a command line tool or utility.

client application – See mobile application.

client object API – The client object API is described in the Developer Guide: BlackBerry
Native Applications, Developer Guide: iOS Native Applications, and Developer Guide:
Windows and Windows Mobile Native Applications.

cluster – Also known as a server farm. Typically clusters are setup as either runtime server
clusters or database clusters (also known as a data tier). Clustering is a method of setting up
redundant Unwired Platform components on your network in order to design a highly scalable
and available system architecture.
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cluster database – A data tier component that holds information pertaining to all Unwired
Platform server nodes. Other databases in the Unwired Platform data tier includes the cache,
messaging, and monitoring databases.

connection – Includes the configuration details and credentials required to connect to a
database, Web service, or other EIS.

connection pool – A connection pool is a cache of Enterprise Information System (EIS)
connections maintained by Unwired Server, so that the connections can be reused when
Unwired Server receives future requests for data.

For proxy connections, a connection pool is a collection of proxy connections pooled for their
respective back-ends, such as SAP Gateway.

connection profile – In Unwired WorkSpace, a connection profile includes the configuration
details and credentials required to connect to an EIS.

context variable – In Unwired WorkSpace, these variables are automatically created when a
developer adds reference(s) to an MBO in a mobile application. One table context variable is
created for each MBO attribute. These variables allow mobile application developers to
specify form fields or operation parameters to use the dynamic value of a selected record of an
MBO during runtime.

data change notification (DCN) – Data change notification (DCN) allows an Enterprise
Information System (EIS) to synchronize its data with the cache database through a push
event.

data refresh – A data refresh synchronizes data between the cache database and a back-end
EIS so that data in the cache is updated. See also scheduled data refresh.

data source – In Unwired WorkSpace, a data source is the persistent-storage location for the
data that a mobile business object can access.

data tier – The data tier includes Unwired Server data such as cache, cluster information, and
monitoring. The data tier includes the cache database (CDB), cluster, monitoring, and
messaging databases.

data vault – A secure store across the platform that is provided by an SUP client.

deploy – (Unwired Server) Uploading a deployment archive or deployment unit to an
Unwired Server instance. Unwired Server can then make these units accessible to users via a
client application that is installed on a mobile device.

There is a one-to-one mapping between an Unwired WorkSpace project and a server package.
Therefore, all MBOs that you deploy from one project to the same server are deployed to the
same server package.

deployment archive – In Unwired WorkSpace, a deployment archive is created when a
developer creates a package profile and executes the build operation. Building creates an
archive that contains both a deployment unit and a corresponding descriptor file. A
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deployment archive can be delivered to an administrator for deployment to a production
version of Unwired Server.

deployment descriptor –  A deployment descriptor is an XML file that describes how a
deployment unit should be deployed to Unwired Server. A deployment descriptor contains
role-mapping and domain-connection information. You can deliver a deployment descriptor
and a deployment unit—jointly called a deployment archive—to an administrator for
deployment to a production version of Unwired Server.

deployment mode – You can set the mode in which a mobile application project or mobile
deployment package is deployed to the target Unwired Server.

deployment profile – A deployment profile is a named instance of predefined server
connections and role mappings that allows developers to automate deployment of multiple
packages from Sybase Unwired WorkSpace to Unwired Server. Role mappings and
connection mappings are transferred from the deployment profile to the deployment unit and
the deployment descriptor.

deployment unit – The Unwired WorkSpace build process generates a deployment unit. It
enables a mobile application to be effectively installed and used in either a preproduction or
production environment. Once generated, a deployment unit allows anyone to deploy all
required objects, logical roles, personalization keys, and server connection information
together, without requiring access to the whole development project. You can deliver a
deployment unit and a deployment descriptor—jointly called a deployment archive—to an
administrator for deployment to a production version of Unwired Server.

development package – A collection of MBOs that you create in Unwired WorkSpace. You
can deploy the contents of a development package on an instance of Unwired Server.

device application – See also mobile application. A device application is a software
application that runs on a mobile device.

device notification – Replication synchronization clients receive device notifications when a
data change is detected for any of the MBOs in the synchronization group to which they are
subscribed. Both the change detection interval of the synchronization group and the
notification threshold of the subscription determine how often replication clients receive
device notifications. Administrators can use subscription templates to specify the notification
threshold for a particular synchronization group.

device user – The user identity tied to a device.

DML – Data manipulation language. DML is a group of computer languages used to retrieve,
insert, delete, and update data in a database.

DMZ – Demilitarized zone; also known as a perimeter network. The DMZ adds a layer of
security to the local area network (LAN), where computers run behind a firewall. Hosts
running in the DMZ cannot send requests directly to hosts running in the LAN.
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domain administrator – A user to which the platform administrator assigns domain
administration privileges for one or more domain partitions. The domain administrator has a
restricted view in Sybase Control Center, and only features and domains they can manage are
visible.

domains – Domains provide a logical partitioning of a hosting organization's environment, so
that the organization achieves increased flexibility and granularity of control in multitenant
environments. By default, the Unwired Platform installer creates a single domain named
"default". However the platform administrator can also add more domains as required.

EIS – Enterprise Information System. EIS is a back-end system, such as a database.

Enterprise Explorer – In Unwired WorkSpace, Enterprise Explorer allows you to define data
source and view their metadata (schema objects in case of database, BAPIs for SAP, and so
on).

export –  The Unwired Platform administrator can export the mobile objects, then import
them to another server on the network. That server should meet the requirement needed by the
exported MBO.

hostability – See multitenancy.

IDE – Integrated Development Environment.

JDE – BlackBerry Java Development Environment.

key performance indicator (KPI) – Used by Unwired Platform monitoring. KPIs are
monitoring metrics that are made up for an object, using counters, activities, and time which
jointly for the parameters that show the health of the system. KPIs can use current data or
historical data.

keystore – The location in which encryption keys, digital certificates, and other credentials in
either encrypted or unencrypted keystore file types are stored for Unwired Server runtime
components. See also truststore.

LDAP – Lightweight Directory Access Protocol.

local business object – Defined in Unwired WorkSpace, local business objects are not bound
to EIS data sources, so cannot be synchronized. Instead, they are objects that are used as local
data store on device.

logical role – Logical roles are defined in mobile business objects, and mapped to physical
roles when the deployment unit that contain the mobile business objects are deployed to
Unwired Server.

matching rules – A rule that triggers a mobile workflow application. Matching rules are used
by the mobile workflow email listener to identify e-mails that match the rules specified by the
administrator. When emails match the rule, Unwired Server sends the e-mail as a mobile
workflow to the device that matches the rule. A matching rule is configured by the
administrator in Sybase Control Center.
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MBO – Mobile business object. The fundamental unit of data exchange in Sybase Unwired
Platform. An MBO roughly corresponds to a data set from a back-end data source. The data
can come from a database query, a Web service operation, or SAP. An MBO contains both
concrete implementation-level details and abstract interface-level details. At the
implementation-level, an MBO contains read-only result fields that contain metadata about
the data in the implementation, and parameters that are passed to the back-end data source. At
the interface-level, an MBO contains attributes that map to result fields, which correspond to
client properties. An MBO may have operations, which can also contain parameters that map
to arguments, and which determines how the client passes information to the enterprise
information system (EIS).

You can define relationships between MBOs, and link attributes and parameters in one MBO
to attributes and parameters in another MBO.

MBO attribute – An MBO attribute is a field that can hold data. You can map an MBO
attribute to a result field in a back-end data source; for example, a result field in a database
table.

MBO binding – An MBO binding links MBO attributes and operations to a physical data
source through a connection profile.

MBO operation – An MBO operation can be invoked from a client application to perform a
task; for example, create, delete, or update data in the EIS.

MBO relationship – MBO relationships are analogous to links created by foreign keys in a
relational database. For example, the account MBO has a field called owner_ID that maps to
the ID field in the owner MBO.

Define MBO relationships to facilitate:

• Data synchronization
• EIS data-refresh policy

messaging based synchronization – A synchronization method where data is delivered
asynchronously using a secure, reliable messaging protocol. This method provides fine-
grained synchronization (synchronization is provided at the data level—each process
communicates only with the process it depends on), and it is therefore assumed that the device
is always connected and available. See also synchronization.

messaging database – The messaging database allows in-flight messages to be stored until
they can be delivered. This database is used in a messaging based synchronization
environment. The messaging database is part of the Unwired Platform data tier, along with the
cache, cluster, and monitoring databases.

mobile application – A Sybase Unwired Platform mobile application is an end-to-end
application, which includes the MBO definition (back-end data connection, attributes,
operations, and relationships), the generated server-side code, and the client-side application
code.
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Mobile Application Diagram – The Mobile Application Diagram is the graphical interface
to create and edit MBOs. By dragging and dropping a data source onto the Mobile Application
Diagram, you can create a mobile business object and generate its attribute mappings
automatically.

Mobile Application Project – A collection of MBOs and client-side, design-time artifacts
that make up a mobile application.

mobile workflow packages – Mobile workflow packages use the messaging synchronization
model. The mobile workflow packages are deployed to Unwired Server, and can be deployed
to mobile devices, via the Unwired Platform administrative perspective in Sybase Control
Center.

monitoring – Monitoring is an Unwired Platform feature available in Sybase Control Center
that allows administrators to identify key areas of weakness or periods of high activity in the
particular area they are monitoring. It can be used for system diagnostic or for
troubleshooting. Monitored operations include replication synchronization, messaging
synchronization, messaging queue, data change notification, device notification, package,
user, and cache activity.

monitoring database – A database that exclusively stores data related to replication and
messaging synchronization, queues status, users, data change notifications, and device
notifications activities. By default, the monitoring database runs in the same data tier as the
cache database, messaging database and cluster database.

monitoring profiles – Monitoring profiles specify a monitoring schedule for a particular
group of packages. These profiles let administrators collect granular data on which to base
domain maintenance and configuration decisions.

multitenancy – The ability to host multiple tenants in one Unwired Cluster. Also known as
hostability. See also domains.

node – A host or server computer upon which one or more runtime components have been
installed.

object query – Defined in Unwired WorkSpace for an MBO and used to filter data that is
downloaded to the device.

onboarding – The enterprise-level activation of an authentic device, a user, and an application
entity as a combination, in Unwired Server.

operation – See MBO operation.

package – A package is a named container for one or more MBOs. On Unwired Server a
package contains MBOs that have been deployed to this instance of the server.

palette – In Unwired WorkSpace, the palette is the graphical interface view from which you
can add MBOs, local business objects, structures, relationships, attributes, and operations to
the Mobile Application Diagram.
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parameter – A parameter is a value that is passed to an operation/method. The operation uses
the value to determine the output. When you create an MBO, you can map MBO parameters to
data-source arguments. For example, if a data source looks up population based on a state
abbreviation, the MBO gets the state from the user, then passes it (as a parameter) to the data
source to retrieve the information. Parameters can be:

• Synchronization parameters – synchronize a device application based on the value of the
parameter.

• Load parameters – perform a data refresh based on the value of the parameter.
• Operation parameters – MBO operations contain parameters that map to data source

arguments. Operation parameters determine how the client passes information to the
enterprise information system (EIS).

personalization key – A personalization key allows a mobile device user to specify attribute
values that are used as parameters for selecting data from a data source. Personalization keys
are also used as operation parameters. Personalization keys are set at the package level. There
are three type of personalization keys: Transient, client, server.

They are most useful when they are used in multiple places within a mobile application, or in
multiple mobile applications on the same server. Personalization keys may include attributes
such as name, address, zip code, currency, location, customer list, and so forth.

perspective – A named tab in Sybase Control Center that contains a collection of managed
resources (such as servers) and a set of views associated with those resources. The views in a
perspective are chosen by users of the perspective. You can create as many perspectives as you
need and customize them to monitor and manage your resources.

Perspectives allow you to group resources ways that make sense in your environment—by
location, department, or project, for example.

physical role – A security provider group or role that is used to control access to Unwired
Server resources.

Problems view – In Eclipse, the Problems view displays errors or warnings for the Mobile
Application Project.

provisioning – The process of setting up a mobile device with required runtimes and device
applications. Depending on the synchronization model used and depending on whether or not
the device is also an Afaria client, the files and data required to provision the device varies.

pull synchronization – Pull synchronization is initiated by a remote client to synchronize the
local database with the cache database. On Windows Mobile, pull synchronization is
supported only in replication applications.

push synchronization – Push is the server-initiated process of downloading data from
Unwired Server to a remote client, at defined intervals, or based upon the occurrence of an
event.

queue – In-flight messages for a messaging application are saved in a queue. A queue is a list
of pending activities. The server then sends messages to specific destinations in the order that
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they appear in the queue. The depth of the queue indicates how many messages are waiting to
be delivered.

relationship –  See MBO relationship.

relay server –  See also Sybase Hosted Relay Service.

resource – A unique Sybase product component (such as a server) or a subcomponent.

REST web services – Representational State Transfer (REST) is a style of software
architecture for distributed hypermedia systems such as the World Wide Web.

RFC – Remote Function Call. You can use the RFC interface to write applications that
communicate with SAP R/3 applications and databases. An RFC is a standalone function.
Developers use SAP tools to write the Advanced Business Application Programming (ABAP)
code that implements the logic of a function, and then mark it as "remotely callable," which
turns an ABAP function into an RFC.

role –  Roles control access to Sybase Unwired Platform resources. See also logical role and
physical role.

role mapping – Maps a physical (server role) to a logical (Unwired Platform role). Role
mappings can be defined by developers, when they deploy an MBO package to a development
Unwired Server, or by platform or domain administrators when they assign a security
configuration to a domain or deploy a package to a production Unwired Server (and thereby
override the domain-wide settings in the security configuration).

RSOE – Relay Server Outbound Enabler. An RSOE is an application that manages
communication between Unwired Server and a relay server.

runtime server – An instance of Unwired Server that is running. Typically, a reference to the
runtime server implies a connection to it.

SAP – SAP is one of the EIS types that Unwired Platform supports.

SCC – Sybase Control Center. A Web-based interface that allows you to administer your
installed Sybase products.

schedule – The definition of a task (such as the collection of a set of statistics) and the time
interval at which the task must execute in Sybase Control Center.

scheduled data refresh – Data is updated in the cache database from a back-end EIS, based on
a scheduled data refresh. Typically, data is retrieved from an EIS (for example, SAP) when a
device user synchronizes. However, if an administrator wants the data to be preloaded for a
mobile business object, a data refresh can be scheduled so that data is saved locally in a cache.
By preloading data with a scheduled refresh, the data is available in the information server
when a user synchronizes data from a device. Scheduled data refresh requires that an
administrator define a cache group as "scheduled" (as opposed to "on-demand").

security configuration – Part of the application user and administration user security. A
security configuration determines the scope of user identity, authentication and authorization
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checks, and can be assigned to one or more domains by the platform administrator in Sybase
Control Center. A security configuration contains:

• A set of configured security providers (for example LDAP) to which authentication,
authorization, attribution is delegated.

• Role mappings (which can be specified at the domain or package level)

security provider – A security provider and it's repository holds information about the users,
security roles, security policies, and credentials used by some to provide security services to
Unwired Platform. A security provider is part of a security configuration.

security profile – Part of the Unwired Server runtime component security. A security profile
includes encryption metadata to capture certificate alias and the type of authentication used by
server components. By using a security profile, the administrator creates a secured port over
which components communicate.

server connection – The connection between Unwired WorkSpace and a back-end EIS is
called a server connection.

server farm –  See also  cluster. Is the relay server designation for a cluster.

server-initiated synchronization –  See push synchronization.

SOAP –  Simple Object Access Protocol. SOAP is an XML-based protocol that enables
applications to exchange information over HTTP. SOAP is used when Unwired Server
communicates with a Web service.

solution – In Visual Studio, a solution is the high-level local workspace that contains the
projects users create.

Solution Explorer – In Visual Studio, the Solution Explorer pane displays the active projects
in a tree view.

SSO – Single sign-on. SSO is a credential-based authentication mechanism.

statistics – In Unwired Platform, the information collected by the monitoring database to
determine if your system is running as efficiently as possible. Statistics can be current or
historical. Current or historical data can be used to determine system availability or
performance. Performance statistics are known as key performance indicators (KPI).

Start Page – In Visual Studio, the Start Page is the first page that displays when you launch the
application.

structured data – Structured data can be displayed in a table with columns and labels.

structure object – Defined in Unwired WorkSpace, structures hold complex datatypes, for
example, a table input to a SAP operation.

subscription –  A subscription defines how data is transferred between a user's mobile device
and Unwired Server. Subscriptions are used to notify a device user of data changes, then these
updates are pushed to the user's mobile device.
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Sybase Control Center – Sybase Control Center is the Flash-based Web application that
includes a management framework for multiple Sybase server products, including Unwired
Platform. Using the Unwired Platform administration perspective in Sybase Control Center,
you can register clusters to manage Unwired Server, manage domains, security
configurations, users, devices, connections, as well as monitor the environment. You can also
deploy and MBO or workflow packages, as well as register applications and define templates
for them. Only use the features and documentation for Unwired Platform. Default features and
documentation in Sybase Control Center do not always apply to the Unwired Platform use
case.

Sybase Control Center X.X Service – Provides runtime services to manage, monitor, and
control distributed Sybase resources. The service must be running for Sybase Control Center
to run. Previously called Sybase Unified Agent.

Sybase Hosted Relay Service – The Sybase Hosted Relay Service is a Web-hosted relay
server that enables you to test your Unwired Platform development system.

Sybase Messaging Service – The synchronization service that facilitates communication
with device client applications.

Sybase Unwired Platform – Sybase Unwired Platform is a development and administrative
platform that enables you to mobilize your enterprise. With Unwired Platform, you can
develop mobile business objects in the Unwired WorkSpace development environment,
connect to structured and unstructured data sources, develop mobile applications, deploy
mobile business objects and applications to Unwired Server, which manages messaging and
data services between your data sources and your mobile devices.

Sybase Unwired WorkSpace – Sybase Unwired Platform includes Unwired WorkSpace,
which is a development tool for creating mobile business objects and mobile applications.

synchronization – A synchronization method where data is delivered synchronously using an
upload/download pattern. For push-enabled clients, synchronization uses a "poke-pull"
model, where a notification is pushed to the device (poke), and the device fetches the content
(pull), and is assumed that the device is not always connected to the network and can operate in
a disconnected mode and still be productive. For clients that are not push-enabled, the default
synchronization model is pull.See also messaging based synchronization.

synchronization group – Defined in Unwired WorkSpace, a synchronization group is a
collection of MBOs that are synchronized at the same time.

synchronization parameter – A synchronization parameter is an MBO attribute used to filter
and synchronize data between a mobile device and Unwired Server.

synchronization phase – For replication based synchronization packages, the phase can be
an upload event (from device to the Unwired Server cache database) or download event (from
the cache database to the device).
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synchronize –  See also data refresh. Synchronization is the process by which data
consistency and population is achieved between remote disconnected clients and Unwired
Server.

truststore – The location in which certificate authority (CA) signing certificates are stored.
See also keystore.

undeploy – Running undeploy removes a domain package from an Unwired Server.

Unwired Server – The application server included with the Sybase Unwired Platform
product that manages mobile applications, back-end EIS synchronization, communication,
security, transactions, and scheduling.

user –  Sybase Control Center displays the mobile-device users who are registered with the
server.

view –  A window in a perspective that displays information about one or more managed
resources. Some views also let you interact with managed resources or with Sybase Control
Center itself. For example, the Perspective Resources view lists all the resources managed by
the current perspective. Other views allow you to configure alerts, view the topology of a
replication environment, and graph performance statistics.

Visual Studio – Microsoft Visual Studio is an integrated development environment product
that you can use to develop device applications from generated Unwired WorkSpace code.

Welcome page – In Eclipse, the first set of pages that display when you launch the application.

workspace – In Eclipse, a workspace is the directory on your local machine where Eclipse
stores the projects that you create.

WorkSpace Navigator – In Eclipse, the tree view that displays your mobile application
projects.

WSDL file – Web Service Definition Language file. The file that describes the Web service
interface that allows clients to communicate with the Web service. When you create a Web
service connection for a mobile business object, you enter the location of a WSDL file in the
URL.
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